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This document describes the R&S®AREG800A, stock no. 1437.4400.02 and its options:
● R&S®AREG8-B9 Digital Baseband (1437.8011.xx)
● R&S®AREG8-B63 Analog stepped delay line (1437.8205.xx)
● R&S®AREG8-B97 System alignment (1437.9001.xx)
● R&S®AREG8-B98 Customer specific alignment (1437.9082.xx)
● R&S®AREG8-K109 Real-time interface (1437.9860.xx)
● R&S®AREG8-K527 Digital baseband extension to 2 GHz (1437.9882.xx)
● R&S®AREG8-K528 Digital baseband extension to 5 GHz (1437.9799.xx)
● R&S®AREG8-K549 Multi instrument synchronization (1437.9876.xx)
● R&S®AREG8-K553 Frontend control (1437.9782.xx)
● R&S®AREG8-K570 Digital baseband 2nd path (1437.9899.xx)
● R&S®AREG8-K740 Analog IF output interface (1437.9830.xx)
● R&S®AREG8-K741 Analog IF input interface (1437.9847.xx)
● R&S®AREG8-K812 Digital baseband additional object (1437.9853.xx)
● R&S®AREG8-K813 Extended doppler frequency shift (1437.9901.xx)
● R&S®AREG8-K814 Near object range (1437.9776.xx)
● R&S®AREG8-K980 HUMS (1437.9824.xx)
● R&S®AREG8-K986 Remote Control GPIB (1437.9818.xx)

Also, this document describes the TRX frontends of the R&S®AREG800A:
● Bistatic frontends:

– R&S®AREG8-24D 24 GHz to 24.25 GHz (1437.8640K02)
– R&S®AREG8-81D 76 GHz to 81 GHz (1437.8763K02)
– R&S®AREG8-81WD 76 GHz to 81 GHz (1437.9160K02)

● Monostatic frontends:
– R&S®AREG8-24S 24 GHz to 24.25 GHz (1437.8611K02)
– R&S®AREG8-81S 76 GHz to 81 GHz (1437.8734K02)
– R&S®AREG8-81WS 76 GHz to 81 GHz (1437.9153K02)

This manual describes firmware version FW 5.30.047.xx and later of the R&S®AREG800A.

© 2024 Rohde & Schwarz
Muehldorfstr. 15, 81671 Muenchen, Germany
Phone: +49 89 41 29 - 0
Email: info@rohde-schwarz.com
Internet: www.rohde-schwarz.com
Subject to change – data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
All other trademarks are the properties of their respective owners.

1179.3615.02 | Version 06 | R&S®AREG800A

Throughout this manual, products from Rohde & Schwarz are indicated without the ® symbol, e.g. R&S®AREG800A is indicated as
R&S AREG800A.

mailto:info@rohde-schwarz.com
http://www.rohde-schwarz.com


ContentsR&S®AREG800A

3User Manual 1179.3615.02 ─ 06

Contents
1 Safety and regulatory information......................................................13

1.1 Safety instructions......................................................................................................13

1.2 Labels on R&S AREG800A.........................................................................................16

1.3 Warning messages in the documentation................................................................ 16

1.4 Where to find key documents on Rohde & Schwarz............................................... 16

1.5 Korea certification class A......................................................................................... 17

2 Welcome............................................................................................... 18
2.1 Key features.................................................................................................................18

2.2 What's New.................................................................................................................. 18

2.3 Documentation overview............................................................................................19

2.3.1 Getting started manual..................................................................................................19

2.3.2 User manuals and help................................................................................................. 19

2.3.3 Service manual............................................................................................................. 19

2.3.4 Instrument security procedures.....................................................................................19

2.3.5 Printed safety instructions............................................................................................. 19

2.3.6 Data sheets and brochures........................................................................................... 20

2.3.7 Release notes and open source acknowledgment (OSA)............................................ 20

2.3.8 Application notes, application cards, white papers, etc.................................................20

2.3.9 Videos........................................................................................................................... 20

3 Getting started......................................................................................21
3.1 Preparing for use........................................................................................................ 21

3.1.1 Lifting and carrying........................................................................................................21

3.1.2 Unpacking and checking............................................................................................... 21

3.1.3 Choosing the operating site.......................................................................................... 21

3.1.4 Setting up the R&S AREG800A.................................................................................... 22

3.1.5 Considerations for test setup........................................................................................ 24

3.1.6 Connecting to power..................................................................................................... 25

3.1.7 Connecting to LAN........................................................................................................ 25

3.1.8 Connecting USB devices.............................................................................................. 26

3.1.9 Connecting to RF coaxial connectors........................................................................... 27

3.1.10 Connecting the R&S QAT100........................................................................................28



ContentsR&S®AREG800A

4User Manual 1179.3615.02 ─ 06

3.1.11 Connecting to Ref In/Ref Out........................................................................................ 29

3.1.12 Connecting to Digital IO DD.......................................................................................... 29

3.1.13 Connecting to Aux IF In/Aux IF Out.............................................................................. 30

3.1.14 Connecting a TRX frontend...........................................................................................30

3.1.15 Switching on or off.........................................................................................................32

3.2 Instrument tour............................................................................................................34

3.2.1 Front panel tour.............................................................................................................34

3.2.2 Rear panel tour............................................................................................................. 39

3.3 Trying out the instrument...........................................................................................45

3.3.1 Configuring static operation setups...............................................................................45

3.3.2 Saving and recalling settings........................................................................................ 47

3.4 Instrument control...................................................................................................... 50

3.4.1 Possible ways to operate the instrument...................................................................... 50

3.4.2 Means of manual interaction......................................................................................... 51

3.4.3 Understanding the display information..........................................................................51

3.4.4 Accessing the functionality............................................................................................55

3.4.5 Entering data.................................................................................................................56

3.4.6 Getting information and help......................................................................................... 58

3.4.7 Remote control..............................................................................................................59

3.4.8 Remote operation over VNC......................................................................................... 60

3.4.9 Remote operation over web UI..................................................................................... 60

4 About radar echo generation..............................................................63
4.1 Required options.........................................................................................................63

4.2 Radar echo generation with the R&S AREG800A.................................................... 65

4.3 Radar equation............................................................................................................ 65

4.4 Radar cross section (RCS).........................................................................................65

4.5 Doppler speed and Doppler shift...............................................................................66

4.6 Equivalent isotropically radiated power (EIRP)....................................................... 67

5 Generating radar echo signals........................................................... 68
5.1 Workflow to configure the R&S AREG800A............................................................. 68

5.2 Test setups...................................................................................................................69

5.2.1 Test setup with R&S QAT100 frontend..........................................................................69

5.2.2 Test setup with TRX-type frontend................................................................................ 74



ContentsR&S®AREG800A

5User Manual 1179.3615.02 ─ 06

5.2.3 Test setup with FE-type frontends.................................................................................76

5.2.4 Test setup with custom frontends..................................................................................81

5.2.5 Test setup in a HIL environment....................................................................................85

5.2.6 Test setup with a switching unit.....................................................................................89

5.2.7 Test setup for gPTP time synchronization.....................................................................93

5.2.8 Test setup for multiple instruments................................................................................94

5.3 Static radar objects.....................................................................................................96

5.3.1 Generating static radar objects..................................................................................... 96

5.3.2 Configuring static radar objects.....................................................................................98

5.4 Dynamic radar objects................................................................................................98

5.4.1 Generating dynamic radar objects................................................................................ 99

5.4.2 Configuring dynamic radar objects..............................................................................100

5.4.3 Creating a scenario with dynamic radar objects......................................................... 101

6 Configuring radar objects................................................................. 102
6.1 Radar Objects tile......................................................................................................102

6.2 Objects settings........................................................................................................ 103

6.3 Scenario settings...................................................................................................... 107

6.4 Logging settings....................................................................................................... 109

6.4.1 Logging Configuration settings....................................................................................110

6.4.2 Logging results............................................................................................................ 111

6.5 Units settings.............................................................................................................112

6.6 Radar Power settings................................................................................................115

6.7 Overview settings......................................................................................................116

6.7.1 Overview......................................................................................................................116

6.7.2 Valid Objects/Invalid Objects....................................................................................... 118

6.7.3 Object Monitoring........................................................................................................ 119

7 Configuring the measurement setup............................................... 121
7.1 Measurement Setup tile............................................................................................121

7.2 Frontend configuration.............................................................................................123

7.2.1 General settings.......................................................................................................... 124

7.2.2 TRX settings................................................................................................................126

7.2.3 QAT settings................................................................................................................132

7.2.4 Geometry settings....................................................................................................... 135



ContentsR&S®AREG800A

6User Manual 1179.3615.02 ─ 06

7.2.5 FE settings.................................................................................................................. 138

7.2.6 Custom frontend settings............................................................................................ 140

7.2.7 External instruments settings...................................................................................... 141

7.2.8 RX/TX external frontend settings................................................................................ 143

7.2.9 Cable correction settings.............................................................................................152

7.3 Sensor/DUT configuration........................................................................................156

7.3.1 Overview..................................................................................................................... 157

7.3.2 Sensor settings........................................................................................................... 158

7.4 Channel configuration.............................................................................................. 160

7.4.1 Overview..................................................................................................................... 160

7.4.2 Channel settings......................................................................................................... 162

7.5 Channel mapping...................................................................................................... 165

7.5.1 Channel Mapping settings...........................................................................................166

7.5.2 Adjust Level settings................................................................................................... 168

7.6 Switching unit configuration....................................................................................170

7.7 Reference oscillator..................................................................................................170

7.7.1 Required options......................................................................................................... 171

7.7.2 Reference frequency settings..................................................................................... 171

7.7.3 Reference output settings........................................................................................... 173

7.7.4 Adjustment settings.....................................................................................................174

7.8 Using power sensors................................................................................................175

7.8.1 About...........................................................................................................................175

7.8.2 Connecting R&S NRP power sensors to the R&S AREG800A...................................177

7.8.3 NRP power viewer...................................................................................................... 179

7.8.4 NRP sensor configuration........................................................................................... 179

7.8.5 NRP sensor mapping.................................................................................................. 184

8 Configuring the operation setup...................................................... 188
8.1 Operation Setup tile.................................................................................................. 188

8.2 Operation setup settings..........................................................................................189

8.2.1 General....................................................................................................................... 189

8.2.2 Settings....................................................................................................................... 192

8.2.3 Object marker settings................................................................................................ 194

8.2.4 Multi instrument settings............................................................................................. 195



ContentsR&S®AREG800A

7User Manual 1179.3615.02 ─ 06

8.3 Bandwidth Configuration settings...........................................................................197

8.4 Realtime Control Network settings......................................................................... 199

8.5 System Control Network settings............................................................................201

9 File and data management................................................................203
9.1 About the file system................................................................................................203

9.2 Restoring the (default) instrument configuration.................................................. 205

9.2.1 Preset, set to default and factory preset settings........................................................ 207

9.2.2 How to identify parameters which are not in a preset state........................................ 208

9.2.3 How to recall user settings automatically after preset.................................................208

9.2.4 Reference....................................................................................................................208

9.3 Protecting data.......................................................................................................... 209

9.4 Saving and recalling instrument settings...............................................................210

9.4.1 Save/recall settings..................................................................................................... 211

9.4.2 How to save and recall instrument settings.................................................................213

9.5 Exporting and importing remote command lists................................................... 214

9.6 Using the file manager..............................................................................................214

9.6.1 File manager settings..................................................................................................215

9.6.2 Map network share settings........................................................................................ 217

9.6.3 How to display all saved files...................................................................................... 218

9.6.4 How to map a network folder...................................................................................... 218

9.7 How to transfer files from and to the instrument...................................................220

9.7.1 Removing file system protection................................................................................. 221

9.7.2 Accessing the file system of the R&S AREG800A over FTP...................................... 222

9.7.3 Accessing the R&S AREG800A file system using SMB (Samba)...............................223

9.7.4 Using a USB storage device for file transfer............................................................... 225

9.7.5 Using a file server for test files exchange................................................................... 226

9.8 Creating screenshots of current settings...............................................................226

9.8.1 Hardcopy settings....................................................................................................... 226

9.8.2 How to save a hardcopy of the display....................................................................... 229

10 General instrument functions...........................................................231
10.1 Customizing the user interface................................................................................231

10.1.1 Display and keyboard settings.................................................................................... 232

10.1.2 Display update settings............................................................................................... 233



ContentsR&S®AREG800A

8User Manual 1179.3615.02 ─ 06

10.1.3 How to set the initial instrument settings.....................................................................234

10.2 Configuring global connectors................................................................................235

10.2.1 Required options......................................................................................................... 235

10.2.2 Global connectors....................................................................................................... 235

10.2.3 Global connectors settings..........................................................................................235

10.3 Organizing frequently used settings as favorites..................................................236

10.3.1 User menu settings..................................................................................................... 238

10.3.2 How to use the user menu for fast adjustments..........................................................238

10.3.3 Define user key actions settings................................................................................. 239

10.3.4 How to assign actions to the [User] key...................................................................... 240

10.4 Managing licenses and license keys.......................................................................241

10.4.1 Manage license keys settings..................................................................................... 241

10.4.2 Using the license server..............................................................................................244

10.4.3 How to move a portable license.................................................................................. 248

10.5 Using the security settings...................................................................................... 250

10.5.1 Protection level settings.............................................................................................. 251

10.5.2 Setting security parameters........................................................................................ 252

10.5.3 Configuring LAN services............................................................................................257

10.5.4 Password management.............................................................................................. 260

10.5.5 How to prevent unauthorized access.......................................................................... 263

10.6 Undoing or restoring actions...................................................................................266

10.7 Shutting down and rebooting the instrument........................................................ 267

11 Network operation and remote control............................................268
11.1 Overview of remote access modes......................................................................... 269

11.2 Remote control interfaces and protocols............................................................... 270

11.2.1 LAN interface.............................................................................................................. 271

11.2.2 USB interface.............................................................................................................. 273

11.2.3 GPIB interface (IEC/IEEE bus interface).....................................................................274

11.2.4 LXI browser interface.................................................................................................. 275

11.3 Remote control programs and libraries..................................................................275

11.4 Status reporting system........................................................................................... 278

11.4.1 Hierarchy of the status registers................................................................................. 278

11.4.2 Structure of a SCPI status register..............................................................................280



ContentsR&S®AREG800A

9User Manual 1179.3615.02 ─ 06

11.4.3 Status byte (STB) and service request enable register (SRE)....................................282

11.4.4 Event status register (ESR) and event status enable register (ESE)..........................283

11.4.5 Questionable status register (STATus:QUEStionable)................................................283

11.4.6 Operation status register (STATus:OPERation).......................................................... 284

11.4.7 Application of the status reporting system.................................................................. 284

11.4.8 Reset values of the status reporting system............................................................... 286

11.5 Remote access settings........................................................................................... 286

11.5.1 Network settings..........................................................................................................288

11.5.2 VISA resource strings................................................................................................. 292

11.5.3 GPIB address settings................................................................................................ 294

11.5.4 RS232 settings............................................................................................................294

11.5.5 Instrument emulations settings................................................................................... 295

11.5.6 Remote connections settings...................................................................................... 297

11.5.7 HUMS settings............................................................................................................ 299

11.5.8 HUMS enhanced settings........................................................................................... 300

11.5.9 QR code...................................................................................................................... 309

11.6 LXI settings................................................................................................................310

11.6.1 LXI status settings.......................................................................................................310

11.6.2 LXI browser settings....................................................................................................311

11.7 To configure the instrument for remote access.....................................................317

11.7.1 To find the VISA resource string..................................................................................317

11.7.2 To configure the accces over LAN.............................................................................. 318

11.8 To establish a remote control session over LAN...................................................322

11.8.1 To establish the connection with the LXI web browser................................................322

11.8.2 To establish the connection using VXI-11 protocol......................................................323

11.8.3 To establish the connection using socket communication...........................................328

11.9 To establish a remote control session over GPIB..................................................329

11.10 To establish a remote control session over USB...................................................330

11.11 To trace messages with the LXI web browser interface........................................330

11.12 To return to manual operation................................................................................. 331

11.13 To automate tasks with remote command scripts.................................................332

11.13.1 Show SCPI command................................................................................................. 334

11.13.2 Displaying an SCPI list................................................................................................334



ContentsR&S®AREG800A

10User Manual 1179.3615.02 ─ 06

11.13.3 SCPI recording export settings................................................................................... 336

11.13.4 How to record / create SCPI lists................................................................................ 337

11.13.5 How to convert and save SCPI lists............................................................................ 340

11.13.6 How to find out the SCPI commands for GUI functions.............................................. 341

11.14 To operate the instrument using VNC.....................................................................342

11.14.1 How to enable the VNC service.................................................................................. 342

11.14.2 How to set up remote operation from a desktop system.............................................342

11.14.3 How to set up remote operation from a smart device................................................. 344

11.15 References.................................................................................................................347

11.15.1 LXI functionality...........................................................................................................347

11.15.2 Code generator templates...........................................................................................348

11.15.3 Remote control states................................................................................................. 350

12 Remote control commands...............................................................351
12.1 Programming examples........................................................................................... 352

12.2 Common commands.................................................................................................353

12.3 Preset commands..................................................................................................... 357

12.4 CALibration subsystem............................................................................................359

12.5 DIAGnostic subsystem.............................................................................................362

12.6 HUMS remote control commands........................................................................... 365

12.7 DISPlay subsystem................................................................................................... 373

12.8 FORMat subsystem...................................................................................................377

12.9 HCOPy subsystem.................................................................................................... 379

12.9.1 Hard copy settings...................................................................................................... 380

12.9.2 Automatic naming....................................................................................................... 381

12.10 KBOard subsystem...................................................................................................384

12.11 MMEMory subsystem............................................................................................... 384

12.11.1 File naming conventions............................................................................................. 385

12.11.2 Accessing files in the default or in a specified directory..............................................386

12.11.3 Programming examples.............................................................................................. 387

12.11.4 Remote control commands......................................................................................... 389

12.12 SYSTem subsystem.................................................................................................. 395

12.13 SYSTem:COMMunicate:RT subsystem...................................................................425

12.14 SYSTem:COMMunicate:SYST subsystem.............................................................. 427



ContentsR&S®AREG800A

11User Manual 1179.3615.02 ─ 06

12.15 TEST subsystem....................................................................................................... 430

12.16 SOURce subsystem.................................................................................................. 432

12.16.1 Connector settings...................................................................................................... 433

12.16.2 Frequency commands.................................................................................................433

12.16.3 Radar object commands............................................................................................. 434

12.16.4 Units commands......................................................................................................... 444

12.16.5 Scenario commands................................................................................................... 447

12.16.6 Data logging commands............................................................................................. 451

12.16.7 Measurement setup commands..................................................................................453

12.16.8 Sensor commands...................................................................................................... 490

12.16.9 Operation setup commands........................................................................................ 493

12.16.10 SOURce:ROSCillator subsystem................................................................................505

12.17 SENSe, READ, INITiate and SLISt subsystems......................................................509

12.18 STATus subsystem....................................................................................................523

13 Troubleshooting and notifications................................................... 528
13.1 Notifications.............................................................................................................. 528

13.1.1 Volatile notifications.....................................................................................................528

13.1.2 Permanent notifications...............................................................................................529

13.2 SCPI notifications..................................................................................................... 529

13.3 Device-specific notifications....................................................................................529

13.4 Querying notifications.............................................................................................. 532

13.5 Resolving network connection failures.................................................................. 533

13.6 Resolving errors during internal adjustments....................................................... 534

13.7 Measuring USB cable quality...................................................................................535

13.8 Requesting instrument configuration and specifications.....................................535

13.8.1 Hardware configuration settings..................................................................................536

13.8.2 Versions/options settings............................................................................................ 537

13.8.3 How to query instrument configuration........................................................................538

13.9 Collecting information for technical support......................................................... 539

13.10 Contacting customer support..................................................................................540

14 Transporting....................................................................................... 542

15 Maintenance, storage and disposal................................................. 543



ContentsR&S®AREG800A

12User Manual 1179.3615.02 ─ 06

15.1 Cleaning..................................................................................................................... 543

15.2 Storage.......................................................................................................................543

15.3 Performing maintenance tasks................................................................................543

15.3.1 Internal adjustments....................................................................................................543

15.3.2 Date and time..............................................................................................................547

15.3.3 Check front panel........................................................................................................ 550

15.3.4 Check display screen.................................................................................................. 552

15.3.5 FPGA/uC update settings........................................................................................... 553

15.4 Disposal..................................................................................................................... 555

Annex.................................................................................................. 556

A Extensions for user files................................................................... 556

B Unit shortcuts.....................................................................................557

C Hardware interfaces...........................................................................559
C.1 GPIB-Bus interface................................................................................................... 559

Glossary: Terms and abbreviations................................................. 561

List of commands.............................................................................. 564

Index....................................................................................................574



Safety and regulatory informationR&S®AREG800A

13User Manual 1179.3615.02 ─ 06

1  Safety and regulatory information
The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following chapters.

Intended use

The product generates radio frequency (RF) signals for the development, production
and verification of electronic components, modules or devices. The product is intended
for industrial use, for example for production and conformance testing, maintenance
and engineering laboratories. 

Use the product only for its designated purpose. Any other use is considered improper
use. Observe the operating conditions and performance limits stated in the data sheet.

Target audience

This document targets at all users, including technicians, operators, administrators and
maintenance personnel. The required skills and experience of the users depend on the
test setup and application of the product.

Where do I find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:
● In Chapter 1.1, "Safety instructions", on page 13. The same information is provi-

ded in many languages as printed "Safety Instructions". The printed "Safety
Instructions" are delivered with the product.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

1.1  Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the data sheet,
manuals and the printed "Safety Instructions". If you are unsure about the appropriate
use, contact Rohde & Schwarz customer service.

Using the product requires specialists or specially trained personnel. These users also
need sound knowledge of at least one of the languages in which the user interfaces
and the product documentation are available.

Reconfigure or adjust the product only as described in the product documentation or
the data sheet. Any other modifications can affect safety and are not permitted.

Safety instructions
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Never open the casing of the product. Only service personnel authorized by
Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer service at
https://www.rohde-schwarz.com/support.

Lifting and carrying the product

The product is heavy. Do not move or carry the product by yourself. A single person
can only carry a maximum of 18 kg safely depending on age, gender and physical con-
dition. Look up the maximum weight in the data sheet. Use the product handles to
move or carry the product. Do not lift by the accessories mounted on the product.
Accessories are not designed to carry the weight of the product.

To move the product safely, you can use lifting or transporting equipment such as lift
trucks and forklifts. Follow the instructions provided by the equipment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing. If Rohde & Schwarz provides
accessories designed for your product, e.g. a carrying bag, you can use the product
outdoors.

Unless otherwise specified, you can operate the product up to an altitude of 2000 m
above sea level. The product is suitable for pollution degree 2 environments where
nonconductive contamination can occur. For more information on environmental condi-
tions such as ambient temperature and humidity, see the data sheet.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting to power

The product is an overvoltage category II product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such

Safety instructions
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as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:
● Before switching on the product, ensure that the voltage and frequency indicated

on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

● Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

● Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

● If you connect the product to an external power supply, use the one delivered with
the product or recommended in the product documentation. The external power
supply must conform to the country-specific regulations.

● Only connect the product to a power source with a fuse protection of maximum
20 A.

● Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Heavy product

Be careful when lifting, moving or carrying the product. Carrying the product requires a suffi-
cient number of persons or transport equipment.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

Safety instructions
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1.2  Labels on R&S AREG800A

Labels on the casing inform about:
● Personal safety, see "Connecting to power" on page 14.
● Product and environment safety, see Table 1-1.
● Identification of the product, see the serial number on the rear panel.
Table 1-1: Labels regarding R&S AREG800A and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its service life. For more information, see Chapter 15.4, "Disposal",
on page 555.

1.3  Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.4  Where to find key documents on Rohde & Schwarz

Certificates issued to Rohde & Schwarz that are relevant for your country are provided
at www.rohde-schwarz.com/key-documents, e.g. concerning:
● Quality management
● Environmental management
● Information security management
● Accreditations

Where to find key documents on Rohde & Schwarz

https://www.rohde-schwarz.com/key-documents
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1.5  Korea certification class A

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기
바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

Korea certification class A
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2  Welcome
The R&S AREG800A is a new high performance Automotive Radar Echo Generator
developed to meet demanding customer requirements. Offering excellent radar signal
characteristics, wide radar signal bandwidth and straightforward and intuitive operation,
the R&S AREG800A makes radar signal generation fast and easy.

2.1  Key features

Outstanding key features of the R&S AREG800A are:
● Simulation of echoes of stationary and highly dynamic objects
● Simulation of echoes with extremely short object distances
● Simulation of echoes of multiple independent objects
● Azimuth simulation with R&S QAT100
● IF signals with high instantaneous bandwidth
● Scalable solution from production test needs to road-ready vehicle simulators
● Fully harmonized with external frontends for a wide range of echo complexity
● Built-in real-time interface for dynamic scenario simulation
● Support of scenario simulation tools: DYNA4 from Vector, Open Simulation Inter-

face (OSI)
● Synchronization of multiple instruments of the R&S AREG800A and R&S QAT100

For more information, see data sheet.

2.2  What's New

This manual describes firmware version FW 5.30.047.xx and later of the
R&S®AREG800A.

Compared to the previous version, firmware version FW 5.30.047.xx feature pack pro-
vides the new features listed below:
● Added function to use custom frontends in test setups, see

– Chapter 7.2.6, "Custom frontend settings", on page 140
– Chapter 5.2.4, "Test setup with custom frontends", on page 81

● Added parameters for channel configuration, see
– "Nominal Input Gain" on page 163
– "Relative Input Level" on page 163

What's New
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2.3  Documentation overview

This section provides an overview of the R&S AREG800A user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/areg800a

2.3.1  Getting started manual

Introduces the R&S AREG800A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

2.3.2  User manuals and help

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control commands
with programming examples, and information on maintenance, instrument interfaces
and error messages. Includes the contents of the getting started manual.

The contents of the user manuals are available as help in the R&S AREG800A. The
help offers quick, context-sensitive access to the complete information.

All user manuals are also available for download or for immediate display on the Inter-
net.

2.3.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

2.3.4  Instrument security procedures

Deals with security issues when working with the R&S AREG800A in secure areas. It
is available for download on the internet.

2.3.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

Documentation overview

https://www.rohde-schwarz.com/manual/areg800a
https://gloris.rohde-schwarz.com
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2.3.6  Data sheets and brochures

The data sheet contains the technical specifications of the R&S AREG800A. It also
lists the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/areg800a

2.3.7  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/areg800a

2.3.8  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

2.3.9  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 2-1: Product search on YouTube

Documentation overview

http://www.rohde-schwarz.com/brochure-datasheet/areg800a
http://www.rohde-schwarz.com/firmware/areg800a
https://www.youtube.com/@RohdeundSchwarz
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3  Getting started

3.1  Preparing for use

Here, you can find basic information about setting up the product for the first time.

3.1.1  Lifting and carrying

Use the handles at the side, for lifting and carrying the R&S AREG800A, see "Lifting
and carrying the product" on page 14. Use the handles at the front, for mounting the
R&S AREG800A in a rack.

Figure 3-1: Instrument side view with front handles (1) and side handles (2)

3.1.2  Unpacking and checking

1. Unpack the R&S AREG800A carefully.

2. Retain the original packing material. Use it to protect the control elements and con-
nectors when transporting or shipping the R&S AREG800A later.
See also Chapter 14, "Transporting", on page 542.

3. Using the delivery notes, check the equipment for completeness.

4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

3.1.3  Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the data sheet.

For safety information, see "Choosing the operating site" on page 14.

Preparing for use
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Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the data sheet.
● Class B equipment is suitable for use in:

– Residential environments
– Environments that are directly connected to a low-voltage supply network that

supplies residential buildings
● Class A equipment is intended for use in industrial environments. It can cause

radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.1.4  Setting up the R&S AREG800A

See also:
● "Setting up the product" on page 14
● "Intended use" on page 13

3.1.4.1  Placing the R&S AREG800A on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the data
sheet.

2. WARNING! A stack of products can fall over and cause injury. Never stack more
than two products. Otherwise, mount them in a rack.
Stack as follows:

● All products must have the same dimensions (width and length).
● Do not exceed a total load of 50 kg placed on the product at the bottom of the

stack.

Preparing for use
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Left = Stacked correctly
Right = Stacked incorrectly, too many products

3. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

● Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity to provide sufficient airflow and ventilation.

● Do not place the product next to heat-generating equipment such as radiators
or other products.

3.1.4.2  Mounting the R&S AREG800A in a rack

To prepare the rack

1. Observe the requirements and instructions in "Setting up the product" on page 14.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the R&S AREG800A in a rack

1. Use an adapter kit that fits the dimensions of the R&S AREG800A to prepare the
instrument for rack mounting.

a) Order the rack adapter kit designed for the R&S AREG800A. For the order
number, see the data sheet.

b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter kit.

2. WARNING! The R&S AREG800A is heavy. Lift the R&S AREG800A with a lifting
equipment, see "Lifting and carrying the product" on page 14.
Lift the R&S AREG800A to shelf height.

3. Grab the handles at the front.

Preparing for use
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4. Push the R&S AREG800A onto the shelf until the rack brackets fit closely to the
rack.

5. Tighten all screws at the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S AREG800A in the rack.

To unmount the R&S AREG800A from a rack

1. Loosen the screws at the rack brackets.

2. WARNING! The R&S AREG800A is heavy. Lift the R&S AREG800A with a lifting
equipment, see "Lifting and carrying the product" on page 14.
Bring the lifting equipment to shelf height.

3. Remove the R&S AREG800A from the rack.

4. If placing the R&S AREG800A on a bench top again, unmount the adapter kit from
the R&S AREG800A. Follow the instructions provided with the adapter kit.

3.1.5  Considerations for test setup

Cable selection and electromagnetic interference (EMI)

Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:
● Use high-quality shielded cables, especially for the following connector types:

– BNC
Double-shielded BNC cables.
How to: "To connect to pluggable connectors" on page 28

– SMA
Double-shielded SMA cables.
How to: "To connect to screwable connectors" on page 27

– USB
Double-shielded USB cables.
How to: Chapter 3.1.8, "Connecting USB devices", on page 26.

– LAN
At least CAT6 STP cables.
How to: Chapter 3.1.7, "Connecting to LAN", on page 25

● Always terminate open cable ends.
● Ensure that connected external devices comply with EMC regulations.
● Use the cable G-SMA EF316 for the IF connection to the SMA connectors of the

instrument and the R&S QAT100. The cable is included in the delivery of the
R&S QAT100 and available under order number 1142.5889.00.
How to: "To connect to SMA connectors" on page 28

● Use the cables TRX CRTL Cable, IF TX CBL and IF RX CBL for connection of the
instrument and the TRX frontend. The cables are included in the delivery of the
TRX frontend and available under order number 1142.5889.00.

Preparing for use
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How to: "To connect to SMA connectors" on page 28

Signal input and output levels

Information on signal levels is provided in the data sheet. Keep the signal levels within
the specified ranges to avoid damage to the R&S AREG800A and connected devices.

Preventing electrostatic discharge (ESD)

Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

► NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).
Ground yourself to prevent electrostatic discharge damage:

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.

Over-the-air (OTA) tests

For over-the-air (OTA) tests, operate R&S AREG800A in shielded environment.

For more information, see data sheet.

3.1.6  Connecting to power

For safety information, see "Connecting to power" on page 14.

1. Plug the AC power cable into the AC power connector on the rear panel. Only use
the AC power cable delivered with the R&S AREG800A.

2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector and in the data
sheet.

3.1.7  Connecting to LAN

Network environment

Before connecting the product to a local area network (LAN), consider the following:
● Install the latest firmware to reduce security risks.
● For internet or remote access, use secured connections if applicable.
● Ensure that the network settings comply with the security policies of your company.

Contact your local system administrator or IT department before connecting your
product to your company LAN.

● When connected to the LAN, the product may potentially be accessed from the
internet, which may be a security risk. For example, attackers might misuse or
damage the product.

Preparing for use
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To connect to LAN

► Connect the LAN socket on the rear panel via an RJ-45 cable to the LAN.

Using DHCP (dynamic host configuration protocol), the R&S AREG800A assigns
the IP address automatically.

If connected to the LAN, the R&S AREG800A displays the IP address and the
hostname at the left bottom of the home screen.

2
1

1 = Hostname
2 = IP address

If disconnected from the LAN, the R&S AREG800A displays the IP address
0.0.0.0.

See also Chapter 11.7, "To configure the instrument for remote access", on page 317.

3.1.8  Connecting USB devices

You can connect or disconnect all USB devices from the R&S AREG800A during oper-
ation.

To connect USB storage devices

USB storage devices, such as memory sticks, allow data transfer from or to the
R&S AREG800A. You can also use them for firmware updates.

► Connect the USB storage device to any of the USB connectors.

To connect USB devices with external power supply

1. NOTICE! Connected devices with external power supply can feed back current into
the 5 V power supply of the USB interface and thus damage the R&S AREG800A.
Ensure that there is no connection between the positive pole of the power supply
and the +5 V power pin of the USB interface (VBUS).

2. Connect the USB storage device to any of the USB connectors on the front panel
or rear panel.

To connect a keyboard

► Connect the keyboard to any of the USB connectors on the front panel or rear
panel.

When connected, the R&S AREG800A detects the keyboard automatically. A detected
keyboard has the default layout English – US.

Preparing for use
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To connect a mouse

► Connect the mouse to any of the USB connectors.

When connected, the R&S AREG800A detects the mouse automatically.

To connect power sensors

Connect power sensors of the R&S NRP families to any of the USB connectors on the
front panel or rear panel.

See Chapter 7.8, "Using power sensors", on page 175.

3.1.9  Connecting to RF coaxial connectors

Here, you find information on how to prepare and to connect to RF coaxial connectors
of the R&S AREG800A. Use these RF connectors, for example, for output of the RF
signal or for input of an external reference signal.

To prepare for connecting

1. NOTICE! Damaged or not clean connections can lead to RF insertion loss and mis-
match, and even premature wear of the connectors.
Before connecting to the port, inspect the RF connector visually. Check that it is
clean, undamaged and mechanically compatible.

2. NOTICE! DC voltage at the RF connector can damage the instrument. Never apply
DC voltage to the RF input connectors.
Make sure that the values are within the DC limits given in the data sheet.

3. If your test setup has a DC component at the RF input, insert a DC blocker.

4. Use a high-quality RF cable that matches the RF connector type.
See "Cable selection and electromagnetic interference (EMI)" on page 24.

5. You can connect to two kinds of connectors:
● "To connect to screwable connectors" on page 27
● "To connect to pluggable connectors" on page 28

To connect to screwable connectors

The R&S AREG800A provides screwable RF connectors as in Table 3-1.

► NOTICE! Excessive tightening can damage the connectors.
To connect the cable with the connector, proceed as follows:

a) Carefully align the connector of the cable and the connector along a common
axis.

b) Mate the connectors along the common axis until the male pin of the inner con-
nector engages with the female socket of the outer connector.

c) Turn the nut of the outer connector until the connectors are firmly coupled.

Preparing for use
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d) Using a calibrated torque wrench torque the nut to the limit as in the table
below. Hold the opposite connector part stationary with a spanner.
Table 3-1: Connector name, type, size, torque limit and nut opening

Connector  Torque limit  Nut opening  

Type Name lb-Inch Nm Inch mm

SMA Ext Clk In

Sync In

Sync Out

Aux IF In

Aux IF Out

Rx IF In

Rx IF Out

Tx IF In

Tx IF Out

5 0.56 5/16 8

To connect to pluggable connectors

The R&S AREG800A provides pluggable Bayonet Neill-Concelman (BNC) connectors.

► To connect the RF cable with the BNC connector, proceed as follows:

a) Carefully align the connector of the cable and the BNC connector along a com-
mon axis.

b) Mate the connectors along the common axis until the male pin of the connector
of the cable engages with the female socket of the BNC connector.

For information on how to handle and maintain the RF port, to minimize measurement
deviations and ensure its longevity, see the application note 1MA99.

If you want to mount test port adapters to your RF connector, see the application note
1MA100.

3.1.10  Connecting the R&S QAT100

The R&S AREG800A can generate radar signals when connected to an external fron-
tend, e.g. the R&S QAT100. This section provides information on relevant connections
between R&S AREG800A and the R&S QAT100.

To connect to SMA connectors

For IF signal input and output the R&S AREG800A provides SMA connectors.

1. Before connecting, prepare the SMA connectors on the rear panel. See "To pre-
pare for connecting" on page 27.

2. Connect to the SMA connectors of the R&S AREG800A with the R&S QAT100.
See "To connect to screwable connectors" on page 27.

You have several options. Table 3-2 provides an example on relevant connections.

Preparing for use

https://www.rohde-schwarz.com/appnote/1MA99
https://www.rohde-schwarz.com/appnote/1MA100


Getting startedR&S®AREG800A

29User Manual 1179.3615.02 ─ 06

To connect to System Control

► Connect the socket of the "System Control" connector with an RJ-45 cable to the
"LAN" connector of the R&S QAT100. See Chapter 3.1.7, "Connecting to LAN",
on page 25.

Table 3-2 provides an overview on relevant connections.
Table 3-2: Connection between R&S AREG800A and R&S QAT100

Signal (direction) R&S AREG800A connector R&S QAT100 connector

IF out (Tx) "Tx IF Out 1" "Tx Ʃ"

IF in (Rx) "Rx IF In 1" "Rx Select"

Control (LAN) "System Control" "LAN"

To disconnect the R&S QAT100

1. NOTICE! If you connect or disconnect the control cable while the base unit is pow-
ered on, you can damage the R&S AREG800A.
Switch off the R&S AREG800A, see "To shut down the product" on page 33.

2. Disconnect the SMA connections between R&S AREG800A and R&S QAT100:

a) Untorque the nut using a calibrated torque wrench. Hold the opposite connec-
tor part stationary with a spanner.

b) Turn the nut of the outer connector until the connectors are detached.

3. To disconnect the connection cable:

a) Hold the connector at the sleeve.
b) To release the lock, pull the sleeve without turning.

Do not pull the cable.

3.1.11  Connecting to Ref In/Ref Out

To connect to "Ref In"/"Ref Out"

1. Before connecting, prepare the "Ref In"/"Ref Out" connectors on the rear panel.
See "To prepare for connecting" on page 27.

2. Connect to the "Ref In"/"Ref Out" connectors. See "To connect to pluggable con-
nectors" on page 28.

3.1.12  Connecting to Digital IO DD

The Digital IO DD connector comprises a QSFP+ (Quad Small Form-factor Pluggable)
socket that has two components: a QSFP+ cage and a QSFP+ connector. The QSFP+
cable is equipped with the QSFP+ plug.

Preparing for use
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1
2

3

1 = QSFP+ plug
2 = QSFP+ cage
3 = QSFP+ connector

To connect to Digital IO DD interface

1. For connection, use the QSFP+ cable R&S DIGIQ-HS.
See "Cable selection and electromagnetic interference (EMI)" on page 24.

2. Hold the QSFP+ plug of the cable by its panes.

3. Turn the QSFP+ cable, so that the release tab shows upwards.

4. Insert and push the QSFP+ plug into the QSFP+ cage.

To disconnect from Digital IO DD interface

1. NOTICE! If you pull the cable, you can damage the cable and the Digital IO DD
connector.
Pull the release tab.

2. Pull the QSFP+ plug out of the QSFP+ cage.

3.1.13  Connecting to Aux IF In/Aux IF Out

See "To connect to SMA connectors" on page 28.

3.1.14  Connecting a TRX frontend

The TRX frontend is delivered with two IF cables (IF TX CBL/IF RX CBL) and one con-
trol cable (TRX CRTL Cable). These cables are calibrated and dedicated to the partic-
ular TRX frontend. Each cable has its own serial number, printed on it.

To connect the "IF TX CBL"/"IF RX CBL" cables

1. Take the "IF TX CBL" cable delivered with the TRX frontend.
See "To check the serial number of the cables" on page 32.

Preparing for use
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2. Connect the "Tx IF Out" connector of the base unit to "Tx IF In" connector of the
TRX frontend.
Follow the instructions in Chapter 3.1.13, "Connecting to Aux IF In/Aux IF Out",
on page 30.

This connection carries the IF signal for the transmitting antenna and the reference
signal for the TRX frontend.

3. Take the "IF RX CBL" cable delivered with the TRX frontend.

4. Connect the "Rx IF Out" connector of the TRX frontend to "Rx IF In" connector of
the base unit.
Follow the instructions in Chapter 3.1.13, "Connecting to Aux IF In/Aux IF Out",
on page 30.

This connection carries the IF signal of the receiving antenna for the base unit.

5. NOTICE! Excessive bending can damage the cables.
Bend the "IF TX CBL"/"IF RX CBL" to a max. bending radius of 50 mm.

To connect the TRX CRTL Cable cable

1. NOTICE! If you connect or disconnect the control cable while the base unit is pow-
ered on, you can damage the R&S AREG800A.
Switch off the base unit.
See "To shut down the product" on page 33.

2. Take the TRX CRTL Cable cable delivered with the TRX frontend.
See "To check the serial number of the cables" on page 32.

3. Hold the connector at the sleeve so that the red dot is upwards.

4. Align the connector of the cable along a common axis.

5. Plug the control cable at the "Control" connector at the base unit.

The sleeve locks.

6. Plug the control cable at the "Control" connector at the TRX frontend.

The sleeve locks.

7. NOTICE! Excessive bending can damage the cables.
Bend the "TRX CRTL Cable" to a maximum bending radius of 50 mm.

To operate the TRX frontend

1. Switch on the base unit.
See "To shut down the product" on page 33.

2. CAUTION! Hot surface, see "Meaning of safety labels" on page 15.
Hold the TRX frontend by its sides.
Do not touch the waveguide surface. Depending on the ambient temperature, this
surface can become hot.

3. NOTICE! Overheating can damage the product.
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Prevent overheating as follows:

● Do not cover the TRX frontend module with thermally insulating material while
the R&S AREG800A is switched on.

● See also Chapter 3.1.4.1, "Placing the R&S AREG800A on a bench top",
on page 22.

To disconnect the TRX frontend

1. NOTICE! If you connect or disconnect the control cable while the base unit is pow-
ered on, you can damage the R&S AREG800A.
Switch off the base unit.
See "To shut down the product" on page 33.

2. To disconnect the "IF TX CBL"/"IF RX CBL" cables, proceed as follows for each of
the four connections:

a) Untorque the nut using a calibrated torque wrench. Hold the opposite connec-
tor part stationary with a spanner.

b) Turn the nut of the outer connector until the connectors are detached.

3. To disconnect the "TRX CRTL Cable":

a) Hold the connector at the sleeve.
b) To release the lock, pull the sleeve without turning.

Do not pull the cable.

To check the serial number of the cables

1. Switch on the base unit.
See Chapter 3.1.15, "Switching on or off", on page 32.

2. On the front panel, press [Setup].

3. Select "Setup" > "Instrument Assembly" > "Hardware Config" > "RF Assembly".

4. For each cable, compare the displayed serial number with the serial number prin-
ted on the cable.

3.1.15  Switching on or off

The following table provides an overview of power states, LEDs and positions of the
power switch.
Table 3-3: Overview of power states

State LED Position of power switch

Off  gray [0]

Standby  orange [I]

Ready  green [I]
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To switch on the R&S AREG800A

The R&S AREG800A is off but connected to power. See Chapter 3.1.6, "Connecting to
power", on page 25.

1. Set the switch on the power supply to position [I] on the rear panel.

The LED of the [On/Standby] key on the front panel is orange.

2. Press the [On/Standby] key on the front panel.

The LED changes to green. The R&S AREG800A boots.

After booting, the R&S AREG800A starts up displaying the home screen on the
screen on the front panel.

To check start-up functions

When starting for the first time, the R&S AREG800A starts with the default settings.
When restarting, the R&S AREG800A recalls the instrument configuration before shut-
down.

See Chapter 9.4, "Saving and recalling instrument settings", on page 210.

When switched on, the R&S SMW automatically monitors main functions. You can
query erroneous functions. In addition to automatic monitoring, you can perform main-
tenance tasks. See the following:

● Chapter 13.4, "Querying notifications", on page 532

To shut down the product

The product is in the ready state.

► Press the [On/Standby] key.

The operating system shuts down. The LED changes to orange.

In the standby state, the power switch circuits are active. To deactivate them, discon-
nect the instrument from the power supply.

To disconnect from power

The R&S AREG800A is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the toggle switch on the power supply to position [0].

The LED of the [On/Standby] key is switched off.

2. Disconnect the R&S AREG800A from the power source.

Preparing for use
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3.2  Instrument tour

This chapter explains the control elements and the connectors of the R&S AREG800A.
The views of the front panel and the rear panel help you to get familiar with the instru-
ment and to perform first steps. For specifications of the interfaces, see the data sheet.

The meanings of the labels on the R&S AREG800A are described in Chapter 1.2,
"Labels on R&S AREG800A", on page 16.

3.2.1  Front panel tour

This section provides an overview of the control elements and connectors on the front
panel of the R&S AREG800A. On the rear panel, you find all further connectors of the
unit. The user interface can be displayed on a remote PC station used to manually
remote control the instrument.

1 2 3 4 5 6 7

89

Figure 3-2: R&S AREG800A front panel controls and connectors

1 = Utility keys, page 36
2 = Touchscreen, page 35
3 = Function keys, page 36 and Keypad, page 36
4 = Navigation controls, page 37
5 = Display keys, page 38
6 = SD card slot, page 39
7 = USB, page 39
8 = Sensor, page 39
9 = On/Standby, page 36
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3.2.1.1  Touchscreen

The most important settings are displayed on the screen on the front panel. The screen
display also provides status and setting information and allows you to quickly reconfig-
ure the signal flow. The screen is touch-sensitive, offering an alternative means of user
interaction for quick and easy handling of the instrument.

The screen at the front panel is the graphical user interface. It shows the settings dia-
logs and parameters, see Chapter 3.4.3, "Understanding the display information",
on page 51. The screen is touch-sensitive, offering an alternative means of user inter-
action for quick and easy handling of the instrument.

Figure 3-3: Touchscreen

Any user interface elements that react to a click by a mouse pointer also react to a tap
on the screen, and vice versa. Using the touchscreen, you can perform the following
tasks (among others) by the tap of your finger:
● Changing a setting
● Selecting new settings
● Scrolling through the list of parameters
● Saving or recalling settings
● Routing the signal flow
● Opening and closing dialogs

See also:
● Chapter 3.4, "Instrument control", on page 50, for operating the touchscreen.
● Chapter 15.1, "Cleaning", on page 543, for cleaning the touchscreen.

Instrument tour
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3.2.1.2  Keys

Utility keys

The utility keys cause the R&S AREG800A to return to a defined instrument state and
provide information on the instrument and assistance.
Table 3-4: Utility keys

Utility key Assigned functions

[Preset] Sets the instrument to a defined state

[Local] Switches from remote control to local (manual) control

[Setup] Accesses the general instrument settings

[Help] Displays context-sensitive help text

On/Standby

The [On/Standby] key switches the instrument from the standby to the ready state or
vice versa.

The LED above the [On/Standby] key indicates the instrument state, see Chap-
ter 3.1.15, "Switching on or off", on page 32.

Function keys

Function keys provide access to the most common generator settings and functions.
You can find a detailed description of the corresponding functions in the user manual.
Table 3-5: Function keys

Function key Assigned functions

[Freq] Requires a connected external frontend, e.g., TRX frontends or an
R&S QAT100.

Opens the "Frontend Config" dialog and selects the "Frontend Center
Frequency" of the connected external frontend.

If several external frontends are connected, switches between the "Fron-
tend Center Frequency" setting of the connected external frontends.

[Level] Opens the "Radar Power" dialog, switches on or switches off selected
radar channels.

[Mod On/Off] Opens and closes the "Objects" dialog. In particular, selects the "Channel
x" tab of the first available radar channel.

[RF On/Off] Activates and deactivates all available radar objects of all radar channels.

Keypad

The keypad is used to enter alphanumeric parameters, including the corresponding
units. It contains the following keys:

Instrument tour



Getting startedR&S®AREG800A

37User Manual 1179.3615.02 ─ 06

Table 3-6: Keys on the keypad

Type of key Description

Alphanumeric keys Enter numbers and (special) characters in edit dialog boxes.

Decimal point Inserts a decimal point "." at the cursor position.

Sign key Changes the sign of a numeric parameter. For an alphanumeric parame-
ter, inserts a "-" at the cursor position.

Unit keys

(G/n dBμV, M/μ μV, k/m mV and
x1 dB(m))

These keys add the selected unit to the entered numeric value and com-
plete the entry.

For level entries (e.g. in dB) or dimensionless values, all units have the
value "1" as multiplying factor. Thus, they have the same function as an
[Enter] key.

Navigation controls

The navigation controls include a rotary knob, navigation keys, and the display keys.
They allow you to navigate within the display or within dialog boxes.

Rotary knob

The rotary knob has several functions:

● Increments (clockwise direction) or decrements (counterclockwise direction) the
instrument parameter at a defined step width for a numeric entry.

● Moves the selection, e.g. to a function block in the block diagram
● Shifts the selection bar within focused areas (e.g. lists).
● Acts like the [Enter] key, when it is pressed.

Editing keys

Editing keys enable you to confirm an entry, delete individual characters, or exit the
current operation.
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Table 3-7: Editing keys

Type of key Description

[Esc] key Closes all kinds of dialog boxes, if the edit mode is not active. Quits the
edit mode, if the edit mode is active. In dialog boxes that contain a "Can-
cel" button it activates that button.

For "Edit" dialog boxes, the following mechanism is used:
● If data entry has been started, it retains the original value and

closes the dialog box.
● If data entry has not been started or has been completed, it closes

the dialog box.

[Enter] key Has the same effect as pressing the rotary knob
● Concludes the entry of dimensionless entries. The new value is

accepted.
● With other entries, this key can be used instead of the default unit

key.
● In a dialog box, selects the default or focused element.
● Calls the next dialog level.
● Confirms and closes open input windows.

[Backspace] key Deletes the character to the left of the cursor in editing mode.

Navigation keys

The navigation keys can be used alternatively to the rotary knob to navigate through
dialog boxes, diagrams, or tables.
Table 3-8: Navigation keys

Type of key Description

[Up/Down] key The [Up] and the [Down] key does the following:
● In a numeric edit dialog box, increase or decrease the instrument

parameter.
● In a list, scroll forward and backward through the list entries.
● In a table, move the selection bar vertically.
● In windows or dialog boxes with vertical scrollbar, move the scroll-

bar.

[Left/Right] key The [Left] and the [Right] key does the following:
● In an alphanumeric edit dialog box, move the cursor.
● In a list, scroll forward and backward through the list entries.
● In a table, move the selection bar horizontally.
● In windows or dialog boxes with horizontal scrollbar, move the

scrollbar.

Display keys

The display keys arrange different windows on the display.
Table 3-9: Display keys

Display key Assigned functions

[Home] Returns to the initial feature screen.

[Next window] Toggles between the entry fields in the taskbar.

[On/Off] ● Switches highlighted elements or a function block on and off.
● Switches between two or more settings, e.g. items of selection lists.

At the end of a list, the cursor is set on the first entry again.
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Display key Assigned functions

[Undo] Reverts the last operation.

[User] Adds a parameter to the user menu for quick access.

3.2.1.3  Connectors

Various interface connectors are on the front panel of the R&S AREG800A.

SD card slot
SD card slot.

USB
Female USB (universal serial bus) 2.0 connector of type A, to connect devices like
external USB devices, a mouse or a keyboard for enhanced operation.
You can also connect R&S NRP power sensors (with an R&S NRP-Z4 or an R&S
NRP-ZKU adapter cable) for external power measurements. Also, you can connect a
memory stick for software updates and data exchange.
Further USB connectors of type A are available on the rear panel.
How to: Chapter 3.1.8, "Connecting USB devices", on page 26

Sensor
Connector for R&S NRP sensors.

The connector is a six-pole ODU Mini-Snap® series B connector.
A power sensor is connected to the R&S AREG800A by inserting the male connector.
To disconnect, pull the connector by its sleeve. You cannot disconnect the sensor sim-
ply by pulling at the cable or the rear part of the connector.
The R&S AREG800A supports the use of R&S NRP power sensors in various ways
including the use as a power viewer.
How to: Chapter 7.8.2, "Connecting R&S NRP power sensors to the R&S AREG800A",
on page 177

3.2.2  Rear panel tour

This section provides an overview of the connectors on the rear panel of the instru-
ment. For technical data of the connectors, refer to the data sheet.
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1 2

3

Figure 3-4: R&S AREG800A rear panel

1 = Connectors for control, synchronization and multi-purpose signals, page 41
2 = Power switch, power supply, monitor, LAN and USB connectors, page 42
3 = Digital IO DD connectors and instrument boards, page 44
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3.2.2.1  Control, synchronization and multi-purpose connectors

2

4

6

7

8

1

5

3

Figure 3-5: Connectors for control, synchronization and multi-purpose signals

1 = Control, page 41
2 = Real Time Control, page 41
3 = System Control, page 41
4 = Sync In, Sync Out, page 41
5 = Ext Clk In, page 42
6 = Ref In/Ref Out, page 42
7 = User x, page 42
8 = IEEE 488, page 42

Control
Four propriety bus connectors "Control 1" to "Control 4" for control of TRX frontends.
How to: Chapter 3.1.14, "Connecting a TRX frontend", on page 30

Real Time Control
RJ-45 connector to transfer real-time data in dynamic radar scenarios. Real-time data
transfer is required for hardware in the loop (HiL) or vehicle in the loop (VIL) testing.

System Control
RJ-45 connector to control R&S QAT100 frontends.
How to: Chapter 3.1.7, "Connecting to LAN", on page 25

Sync In, Sync Out
SMA female connectors for synchronization of multi-device setups including more
instruments.
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How to: "To connect to SMA connectors" on page 28

Ext Clk In
SMA female connector for input of an external reference signal.
How to: "To connect to SMA connectors" on page 28

Ref In/Ref Out
Input/output for external reference signal.
BNC connectors for 10 MHz reference signals.
How to: Chapter 3.1.11, "Connecting to Ref In/Ref Out", on page 29

User x
BNC multipurpose connectors for defining output signals.
Table 3-10 lists the signals assigned to the User x connectors in the default instrument
state.
Table 3-10: Default configuration of the User x connectors

Connector Direction Default assigned signal

"User 1"/"User 2" "Output" "Object Marker"

 "Not used" "None"

See also Chapter 10.2, "Configuring global connectors", on page 235.

IEEE 488
General purpose interface bus (GPIB) interface for remote control of the instrument.
The interface is in compliance with the standards IEC 625, IEEE 488 and SCPI.
Use this interface to connect a computer for remote control of the R&S AREG800A. To
set up the connection, use high-quality shielded cables. See "Cable selection and elec-
tromagnetic interference (EMI)" on page 24.
See also Chapter C.1, "GPIB-Bus interface", on page 559 and Chapter 11, "Network
operation and remote control", on page 268.

3.2.2.2  Monitor, LAN, USB and power connectors

2 41 3 5 6

Figure 3-6: Power switch, power supply, monitor, LAN and USB connectors
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1, 2 = DP, HDMI, page 43
3 = LAN, page 43
4 = USB, page 43
5 = Serial number
6 = AC power supply connector and switch, page 43

DP, HDMI
Display port (DP) and HDMI port for connecting external monitor.

LAN
RJ-45 connector to connect the R&S AREG800A to a LAN for remote control, remote
operation, and data transfer.
How to: Chapter 3.1.7, "Connecting to LAN", on page 25

USB
Two female USB (universal serial bus) 3.0 connectors of type A. You can connect devi-
ces like a keyboard, a mouse, a memory stick or the R&S NRP-Z4 cable for the R&S
NRP power sensors.
How to: Chapter 3.1.8, "Connecting USB devices", on page 26

AC power supply connector and switch
Mains power switch for performing the following tasks:
● Connecting the internal power supply to the power source
● Disconnecting the internal power supply from the power source
How to: Chapter 3.1.6, "Connecting to power", on page 25.
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3.2.2.3  DIG I/Q and RF connectors

3 54 62 9871 10

Figure 3-7: Digital IO DD connectors and instrument boards

1 = Digital IO DD, page 44
2, 10 = Aux IF In, page 44
3, 9 = Tx IF Out, page 45
4, 8 = Aux IF Out, page 44
5, 7 = Rx IF In, page 45
6 = Four instrument boards "A" to "D" (4x R&S AREG8-B9)

Digital IO DD
Digital I/Q connectors "Digital IO DD 1" to "Digital IO DD 4" provided for future use; one
connector per instrument board (R&S AREG8-B9).

Aux IF In
SMA female connectors "Aux IF In 1" and "Aux IF In 2" for input of an additional inter-
ferer to the generated echo signal; two connectors per instrument board (R&S AREG8-
B9).
How to: "To connect to SMA connectors" on page 28

Aux IF Out
SMA female connectors "Aux IF Out 1" and "Aux IF Out 2" for output of IF signals for
signal analysis; two connectors per instrument board (R&S AREG8-B9).
How to: "To connect to SMA connectors" on page 28

Instrument tour



Getting startedR&S®AREG800A

45User Manual 1179.3615.02 ─ 06

Rx IF In
SMA female connectors "Rx IF In 1" and "Rx IF In 2" for input of the intermediate fre-
quency (IF) signal from the external frontend to the R&S AREG800A (Rx); two connec-
tors per instrument board (R&S AREG8-B9).
How to: "To connect to SMA connectors" on page 28

Tx IF Out
SMA female connectors "Tx IF Out 1" and "Tx IF Out 2" for output of the intermediate
frequency (IF) signal from R&S AREG800A to the external frontend (Tx); two connec-
tors per instrument board (R&S AREG8-B9).
How to: "To connect to SMA connectors" on page 28

3.3  Trying out the instrument

This chapter introduces the first steps with the R&S AREG800A. It shows how to oper-
ate and configure the instrument using simple examples. The complete description of
the functionality and its usage is given in the R&S AREG800A user manual.

Basic instrument operation is described in Chapter 3.4, "Instrument control",
on page 50.

Prerequisites

● The R&S AREG800A is set up, connected to power, and started up.
See Chapter 3.1, "Preparing for use", on page 21.

● The R&S AREG800A is connected to an external frontend, e.g. the R&S QAT100.
See Chapter 3.1.10, "Connecting the R&S QAT100", on page 28.

● The R&S AREG800A is manually operated via the touchscreen.

Try out the following:

● Configuring static operation setups.........................................................................45
● Saving and recalling settings.................................................................................. 47

3.3.1  Configuring static operation setups

To specify characteristics of the radar object

1. In the tile diagram, select "Operation Setup".

2. Specify the radar object movement of the requirement:

● Select "Mode > Static" for simulation of static radar objects.
● Select "Mode > Dynamic" for simulation of dynamic radar objects.

3. Specify the reference of the radar object:

● Select "Object Reference > Origin", if the R&S AREG800A is the object refer-
ence.

Trying out the instrument
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● Select "Object Reference > Mapped Sensor", if a sensor is the object refer-
ence. This sensor is connected

4. Click "Apply".

The settings are applied.

To specify the radar channel bandwidth

1. In the tile diagram, select "Operation Setup > Bandwidth Config".

2. Set the bandwidths of the radar channels, e.g. "Bandwidth A > 1 GHz".
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3. Click "Apply" and "Ok".

The bandwidth settings for an external frontend connected to board "A" are
applied.

For detailed information on operating setups including simulation of dynamic scenarios,
see Chapter 8, "Configuring the operation setup", on page 188.

3.3.2  Saving and recalling settings

To restore the results of our measurements later, we save the instrument settings in a
file.

To save the instrument settings in a file

We assume, a test configuration as described in Chapter 3.3.1, "Configuring static
operation setups", on page 45.

1. Press the [Setup] key on the front panel.

2. In the "Setup" menu, select "Settings > Save/Recall".

3. In the "Save/Recall" dialog, select "Operation Mode > Save".
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4. Select the "Filename" input field, use the on-screen keyboard, and enter MyTest-
Signal.

5. Click "Save".

The file MyTestSignal.savrcltxt is stored in the default direc-
tory /var/user/.

To load saved instrument settings

You can restore the settings to the instrument at any time using the settings file.

1. Press the [Preset] button to restore the default instrument settings so you can
check that the stored user settings are restored afterwards.

2. Press the [Setup] key on the front panel.

3. In the "Setup" menu, select "Settings > Save/Recall".

4. In the "Save/Recall" dialog, select "Operation Mode > Recall".
Navigate to the directory the file is saved in and select the MyTestSignal file.

Trying out the instrument
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5. Click "Recall".

All instrument settings are restored and the display resembles Chapter 3.3.1, "Con-
figuring static operation setups", on page 45, which shows the instrument display
right before the settings were saved.

How to display all parameters with values different to their preset values
When you load a file to your instrument, you do not have enough information on the
changed settings. In such case, it is useful to visualize all parameters that have been
changed from their default state.

Try out the following:
● Touch and hold a spot in the tile diagram for at least 1 second to access the con-

text-sensitive menu.
● Select "Mark All Parameters Changed from Preset".

Trying out the instrument
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● All changed parameters are highlighted.

See also Chapter 9, "File and data management", on page 203.

3.4  Instrument control

This chapter provides an overview on how to work with the R&S AREG800A.

It covers the following topics:

● Possible ways to operate the instrument................................................................ 50
● Means of manual interaction...................................................................................51
● Understanding the display information....................................................................51
● Accessing the functionality......................................................................................55
● Entering data...........................................................................................................56
● Getting information and help...................................................................................58
● Remote control........................................................................................................59
● Remote operation over VNC...................................................................................60
● Remote operation over web UI............................................................................... 60

3.4.1  Possible ways to operate the instrument

There are three ways to operate the R&S AREG800A:
● Manual operation:

Use the touchscreen, hard keys and rotary knob, or an optional mouse and/or key-
board.

● Remote control:
Create programs to automatize repeating settings, tests and measurements. The
instrument is connected to a computer running the program.

Instrument control
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This way of operation is described in Chapter 11, "Network operation and remote
control", on page 268.

● Remote operation from a computer:
Remote monitoring and control of the instrument from a connected computer is
based on the common cross-platform technology VNC (Virtual Network Comput-
ing). On the remote computer, any standard web browser (supporting Java) or a
dedicated VNC client (like Ultr@VNC) can be used. See also Chapter 3.4.8,
"Remote operation over VNC", on page 60.

The following sections show how to operate the instrument manually.

3.4.2  Means of manual interaction

For the manual interaction with the R&S AREG800A, you have several methods that
you can use as an alternative to perform a task:
● Touchscreen:

Touchscreen operation is the most direct way to interact. Almost all control ele-
ments and actions on the screen are based on the standard operating system con-
cept. You can tap any user interface element to set parameters in dialog boxes,
enter data, scroll within a dialog etc., as if you work with a mouse pointer.
Tapping the screen works like clicking mouse buttons:
– Touch quickly = click: Selects a parameter or provokes an action.
– Touch and hold = right-click: Opens a context-sensitive menu.
– Touch and swipe = drag: Scrolls through the contents of a display element

larger than the screen, e.g. a list or a table.
● Function keys and rotary knob:

The front panel provides nearly all functions and controls to operate the instrument
in the classic way, without touchscreen.

● Optional mouse and/or keyboard:
These devices work like known from PCs. The navigation keys on the front panel
correspond to the keys on the keyboard.

This manual describes the manual interaction with the instrument via the touchscreen.
It mentions the alternative methods using the keys on the instrument or the on-screen
keypads if it deviates from the standard operating procedures. The usage of the touch-
screen and navigation keys is described in Chapter 3.4.4, "Accessing the functionality",
on page 55.

Throughout the manual, the term "select" refers to any of the following methods:
● Using a finger on the touchscreen
● Using a mouse pointer in the display
● Using a key on the instrument or on a keyboard

3.4.3  Understanding the display information

The home screen of the R&S AREG800A displays all main settings and generator
states, divided into main operation areas.
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21

Figure 3-8: Home screen

1 = Taskbar/softkey bar with "Home" and "Info" key
2 = Tile diagram

● Taskbar....................................................................................................................52
● Tile diagram............................................................................................................ 53
● Additional display characteristics............................................................................ 53

3.4.3.1  Taskbar

The "Taskbar" shows a home and an info button, and assigns a labeled button when-
ever you open a dialog. If more dialogs are open than the taskbar can display, touch
and swipe the taskbar to scroll up and down.

The buttons shown in the following example represent the variants.
Table 3-11: Example of buttons in the taskbar

"Home" button

Returns to the home screen.

 

"Busy" indicator

Indicates a running process.

 

"User Menu"

Lists parameters that can be defined for quick access.
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Shows the current remote access connections when the instrument is remotely con-
trolled.

Tip: An indicator in the "System Config" tile shows the current remote control status.

R&S NRP power sensors

Shows a connected external power sensor. The button displays the current readings
when the sensor is active.

Active dialogs

Indicates the dialog name of each active dialog in a separate button.

"Info" key

Provides access to status and error messages.

Note: The warning symbol signifies a permanent error message.

3.4.3.2  Tile diagram

The tile diagram is the main entry to the settings of the R&S AREG800A.

Tile Access to:

"Radar Objects" ● RF ON
● Configuration
● Units
● Radar Power
● Overview
● Graphics

"Measurement Setup" ● Preset Behavior On
● Configuration
● Channel Mapping
● Units
● Overview
● Reference Frequency
● Power Sensors

– NRP Power Viewer
– NRP Sensor Mapping

"System Config" ● Setup
● Info/Notifications
● Remote Access
● Save/Recall

"Operation Setup" Opens the operation setup dialog with tabs
● Operation Setup
● Bandwidth Config
● Realtime Control Network
● System Control Network

3.4.3.3  Additional display characteristics

The following section provides a short insight on the indication of the screen in general,
and significant elements that you see under specific operating modes, in dialogs or set-
tings.

● Appearance of active elements
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– Active elements like On/Off switches, state buttons have a blue background.
– Selected elements are framed or highlighted orange.
– Inactive elements are gray.

● On-Screen keypads
As additional means of interacting with the instrument without having to connect an
external keyboard, either a numerical or alphanumerical on-screen keypad appears
when you activate an entry field (see Chapter 3.4.5, "Entering data", on page 56).

● Info line
The "Info line" shows brief status information and error messages. It appears when
an event generates a message. If selected, the R&S AREG800A shows informa-
tion on static errors and the error history.

● Key parameters indicated in tab labels
Most dialogs are divided into tabs with logically grouped parameters. The tab label
expresses the content and can also contain status indicators.

1

2

1 1 1

2

1 = Tab label
2 = Status indicators

● Scrollbar handle
An arrow icon that appears when you touch a scrollbar helps you to scroll in a dia-
log or list.

● Progress indicators
A busy icon indicates a currently running process. If a process takes some time, a
progress bar shows the current state.

● Context-sensitive menus
Within the entire screen display, including single parameters, you can access con-
text-sensitive menus that provide some additional functions.
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3.4.4  Accessing the functionality

All functionalities are provided in dialog boxes as known from computer programs. You
can control the instrument intuitively with the touchscreen. This section provides an
overview of the accessing methods.

The instrument's functions and settings can be accessed by selecting one of the follow-
ing elements:
● System and function keys on the front panel of the instrument
● Taskbar/softkeys on the touchscreen
● Context-sensitive menus for specific elements on the touchscreen, or with the

rotary knob (press and hold).
● Elements on the status bar in the touchscreen
● Displayed setting on the touchscreen that means block diagram and all settings

available in dialogs.

To open a dialog box

► Perform one of the following actions:

● Tap the required tile, and then the menu entry.
● Tap the minimized view (button) on the taskbar.

Some of the utility keys access a dedicated dialog, too.

Instrument control



Getting startedR&S®AREG800A

56User Manual 1179.3615.02 ─ 06

To minimize a dialog box

► To return to the home screen, tap the "Home" button.

To close a dialog box

To close a dialog box, you have the same controls as you know from computers or
devices with touchscreen.

► Perform one of the following actions:

● Tap the "Close" icon in the upper right corner.
● Press the [Esc] key on the front panel.
● Drag and drop a minimized dialog from the taskbar to the tile diagram.

To select an option in a dialog box

► Tap the required option.

3.4.5  Entering data

Some parameters have their own key on the front panel.

For data input in dialog boxes, the instrument provides on-screen keypads for entering
numeric and alphanumeric values. Thus, you can always set the parameters via the
touchscreen, the front panel, or an external keyboard.

To correct an entry

1. Using the arrow keys, move the cursor to the right of the entry you want to delete.

2. Press the [Backspace] key.

3. Deletes the entry to the left of the cursor.

4. Enter your correction.

To complete the entry

► Press the [Enter] key or the rotary knob.

To abort the entry

► Press the [Esc] key.
The dialog box closes without changing the settings.

Instrument control
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3.4.5.1  Entering numeric parameters

To enter values with the on-screen keypad

For numeric settings, the instrument displays the numeric keypad. The units specified
correspond to the units of the parameter.

1. Enter the numeric value.

Tip: For quick entry, you can enter a value in exponential representation, e.g. 1e7
for 10000000.

2. Tap the unit button to complete the entry.

The unit is added to the entry.

Tip: For quick unit change, you can enter shortcuts, e.g. for a frequency value
1e8h for 100 MHz.
For an overview of shortcuts supported by the R&S AREG800A, see Chapter B,
"Unit shortcuts", on page 557.

3. If the parameter does not require a unit, confirm the entered value by pressing
"Enter".

To enter values by using the front panel controls

1. Change the currently used parameter value by using the rotary knob or the [Up/
Down] keys.

2. If the parameter does not require a unit, confirm the entered value by pressing the
[Enter] key or any of the unit keys.
The instrument highlights the editing line to confirm the entry.

If you edit numeric data in tables, the entry field must be in edit mode: Press [Enter], or
the rotary knob to activate the edit mode.

3.4.5.2  Entering alphanumeric parameters

If a field requires alphanumeric input, you can use the on-screen keyboard to enter let-
ters and (special) characters.

3.4.5.3  Undo and redo actions

Accessed via the context-sensitive menus, "Undo" allows you to restore one or more
actions on the instrument. Depending on the available memory, the "Undo" steps can
restore all actions.

Instrument control
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"Redo" restores a previously undone action.

3.4.6  Getting information and help

In some dialog boxes, graphics are included to explain the way a setting works.

For further information, you can use the following sources:
● Tooltips give the value range of the parameter.
● The context help provides functional description on a setting.
● The general help explains a dialog box, provides instructions, and general informa-

tion.

To display context help

► To access a help topic, perform one of the following:

a) Tap and hold the parameter for which you need information and tap "Help" in
the context menu.

b) Tap the parameter and press the [Help] key.

The "Help" dialog opens. You can browse the help for further information.

Contents of the help dialog box

The help dialog box covers two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system also provides an "Index" and a "Find" area, and "Zoom" functions that
are accessed via the corresponding buttons.

To open general help

► Press the yellow [Help] key on the front panel.

Instrument control
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If a dialog box is opened, the help topic for the current tab is shown. Otherwise the
"Contents" page appears.

Navigating in the table of contents and in the help topics

1. To move through the displayed contents entries, tap on an entry and scroll or use a
connected mouse or the [Up/Down] keys.
Entries with a plus sign contain further entries.

2. To display a help topic, tap on the topic name or double-click the topic name or
press the [Enter] key.

3. To follow a cross-reference, tap on the link text.

4. To return to the previous page, select "Back".
This function scrolls back all steps you have performed before.

5. Use the "scroll bars" to shift the visible section of content shown.

6. To maximize the "Topics" area, tap the "Hide Contents Tree" button to hide the con-
tents tree.

Using the index

1. Select the "Index" button.

2. Enter the first characters of the topic you are interested in.

The entries starting with these characters are displayed.

3. Tap on the index entry.

The corresponding help topic is displayed.

3.4.7  Remote control

In addition to working with the R&S AREG800A interactively, located directly at the
instrument, it is also possible to operate and control it from a remote PC.

The R&S AREG800A supports various methods for remote control:
● Connecting the instrument to a LAN (see Chapter 3.1.7, "Connecting to LAN",

on page 25)
● Using the LXI browser interface in a LAN
● Connecting a PC via the IEC-bus (IEEE 488) interface
● Remote control via the USB interface

For remote control over LAN or USB, you can use the R&S VISA (Virtual Instrument
Software Architecture) library provided for download at the Rohde & Schwarz website
http://www.rohde-schwarz.com/rsvisa.

Instrument control
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How to configure the remote control interfaces is described in Chapter 11, "Network
operation and remote control", on page 268.

3.4.8  Remote operation over VNC

The VNC is an application which can be used to access and control the instrument
from a remote computer through a LAN connection. While the instrument is in opera-
tion, the instrument screen contents are displayed on the remote computer, and VNC
provides access to all applications, files, and network resources of the instrument.
Thus, remote operation of the instrument is possible.

Instrument control from a remote computer
To access the basic utility functions of the R&S AREG800A, perform a right mouse
click the block diagram and select "Key Emulation".
A key panel to the right of the block diagram gives access to the utility functions provi-
ded by the front panel keys.

The VNC is an add-on program, included in operating system Linux/Unix, and available
as a free-of-charge download on the internet.

See also Chapter 11.14, "To operate the instrument using VNC", on page 342.

3.4.9  Remote operation over web UI

You can configure the R&S AREG800A, for example in a multi instrument test setup,
over web user interface (web UI). All instruments must be connected to the same LAN.

How to: Chapter 5.2.8, "Test setup for multiple instruments", on page 94.
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Access:

► In the address field of the browser, enter <ipaddress>/webui.

1 2

3

4

1 = Overview area
2 = Theming
3 = Setup area
4 = Configuration area

The web UI allows you to define your operation setup and configure the connected
instruments.

Settings:

Overview area............................................................................................................... 61
Theming........................................................................................................................ 61
Setup area.....................................................................................................................61
Configuration area.........................................................................................................62

Overview area
Displays an overview of all objects within the radar object simulation scenario.
See Chapter 6.7, "Overview settings", on page 116.

Theming
Selects the theming of the web UI interface. You can select light or dark theming.

Setup area
In this area, you can define your operation setup.
"Device Overview"

Displays the instruments in the test setup. Click on the instrument to
select the respective R&S AREG800A for configuration in the config-
uration area.

Instrument control
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"Operation Setup"
Define the operation setup settings for all connected instruments.
See Chapter 8.2, "Operation setup settings", on page 189.

"Scenario" Requires "Operation Setup > Mode > Dynamic".
Select a scenario file stored on your instrument and play the sce-
nario.
See Chapter 6.3, "Scenario settings", on page 107.

Configuration area
You can configure the selected R&S AREG800A.
See Chapter 7.2, "Frontend configuration", on page 123.

Instrument control
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4  About radar echo generation
This chapter provides information on required options and principles of radar echo gen-
eration. Also, application examples and background information on parameters for
radar echo generation are given.

4.1  Required options

The basic equipment layout for generating radar signals includes R&S AREG800A
base unit (R&S AREG8-B9) including one IF path.

Extensions to the base unit require installation of further options. Extend the
R&S AREG800A as follows:
● Increase the number of IF paths and IF bandwidth, see Table 4-1.
● Extend simulation capabilities of simulated radar objects, see Table 4-2.
● Install additional interfaces at the R&S AREG800A for the following tasks:

– Real-time radar object simulation (HiL/ViL)
– Synchronization of multiple R&S AREG800A instruments
– Adding external frontends to the test setup
– Output of analog IF signals
– Input of analog IF signals
– Remote control of the R&S AREG800A via the GPIB interface
See Table 4-3.

● Align setups that include the R&S AREG800A and TRX frontends, see Table 4-4.

Table 4-1: R&S AREG800A base unit configuration

Option Designation Remark

R&S AREG8-B9 Digital baseband board Installable up to four times. Provides one IF path, IF
bandwidth of 1 GHz, one radar object.

R&S AREG8-K570 Digital baseband, sec-
ond IF path for option
B9

Requires R&S AREG8-B9.

Installable up to four times, one per R&S AREG8-B9.
Adds a second IF path per digital baseband board.

R&S AREG8-K527 Digital baseband,
extension to 2 GHz

Requires R&S AREG8-B9.

Installable up to eight times, one per IF path. Extends the
IF bandwidth to 2 GHz.

R&S AREG8-K528 Digital baseband,
extension to 5 GHz

Requires R&S AREG8-B9 and R&S AREG8-K527.

Installable up to four times, one per R&S AREG8-B9.
Extends the IF bandwidth to 5 GHz.

Required options
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Table 4-2: R&S AREG800A artificial objects configuration

Option Designation Remark

R&S AREG8-B63 Analog stepped delay
line

Requires R&S AREG8-B9.

Installable up to four times, one per R&S AREG8-B9. For
simulation of short-range radar objects, one object per
R&S AREG8-B63.

R&S AREG8-K812 One additional object
for installed paths

Requires R&S AREG8-B9.

Installable up to seven times, i.e. up to eight channels are
available per R&S AREG8-B9.

R&S AREG8-K813 Extended Doppler fre-
quency shift

Requires R&S AREG8-B9.

Extended Doppler frequency shifts of up to 10 MHz for all
installed radar objects.

R&S AREG8-K814 Near object range Requires R&S AREG8-B9.

Simulation of distances between frontend and device
under test down to the length of the air gap, when using
the FMCW modulation scheme.

Table 4-3: R&S AREG800A interfaces configuration

Option Designation Remark

R&S AREG8-K109 Real-time interface Open simulation interface (OSI) to simulate radar objects
in real time, e.g. for HiL/ViL environments.

R&S AREG8-K549 Multi-instrument syn-
chronization

Controls and synchronizes up to eight R&S AREG800A
secondary instruments. Requires one option per instru-
ment.

R&S AREG8-K553 Frontend control Controls external frontends, e.g. R&S FE44S or custom
frontends, in the test setup.

R&S AREG8-K740 Analog IF output inter-
face

Required for output of an analog IF signal.

R&S AREG8-K741 Analog IF input inter-
face

Required for input of an analog IF signal and for EIRP
measurement.

R&S AREG8-K986 Remote control GPIB Required for remote control of the R&S AREG800A via
the GPIB interface.

Table 4-4: R&S AREG800A and TRX frontend alignment

Option Designation Remark

R&S AREG8-B97 System alignment Aligns dedicated IF channels and connected TRX fron-
tends.

R&S AREG8-B98 Customer specific
alignment

Aligns dedicated IF channels and connected TRX fron-
tends as specified by customer data.

For more information, see data sheet.

Required options
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4.2  Radar echo generation with the R&S AREG800A

The R&S AREG800A generates radar echo signals by delaying received radar signals,
either from up to four connected mmWave (TRX-type) frontends, from up to eight con-
nected R&S QAT100 antenna arrays, from up to four connected FE-type frontends or
from up to four custom frontends.

Additionally to delaying the signals, you can also apply an object attenuation and radial
velocity. From the attenuation and the range, the R&S AREG800A calculates the radar
cross section (RCS) of the object, where the RCS indicates the size of the simulated
radar object. Use the object attenuation to vary the RCS values of the individual
objects separately.

With a mmWave (TRX-type) frontend, an FE-type frontend or a custom frontend, you
can simulate up to eight radar objects.

With the R&S QAT100, you can define the azimuth angular direction for the simulated
artificial radar objects.

4.3  Radar equation

The radar equation describes how much reflected RF power is received by a radar
sensor from a reflecting object. In this implementation, the radar equation (Equa-
tion 4-1) is the basis for all attenuation and level calculations.

Equation 4-1: Radar equation

Radar equation elements:
● PRX: Received power at the radar sensor
● PTX: Transmitted radar signal power from the radar sensor
● GRX: Gain of the radar receive antenna
● GTX: Gain of the radar transmit antenna
● λ = c/f is the wavelength of the radar signal and

– c = 299700000 m/s is the speed of light in the air
– f: frequency of the radar signal

● RCS: Radar cross section
● R: Distance between radar and a reflecting object

4.4  Radar cross section (RCS)

Radar cross section is a parameter which describes how much of the incoming radar
signal at the object gets reflected back to the radar sensor. The RCS does not repre-
sent the physical size of an object but is rather a virtual parameter. Multiply the RCS by

Radar cross section (RCS)
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the power density of the radar signal at the location of the object to get the signal
power reflected back to the radar sensor.

The RCS value is often expressed in dBsm2 (dB square meters).

Many parameters affect the RCS of an object, for example:
● Geometrical shape of the object, like surfaces, edges or size
● Material of the object
● Orientation of the object towards the radar sensor
● Polarization of the radar transmit antenna and the radar receive antenna
● Wavelength of the radar signal

RCS is sensitive to these parameters and is therefore difficult to list accurate RCS val-
ues for a given object.

Examples of typical RCS values at 76 GHz to 81 GHz:
● Truck: RCS = 20 dBsm2

● Car: RCS = 5 dBsm2

● Pedestrian: RCS = −4 dBsm2

In R&S AREG800A, the following parameters influence the RCS value: frequency,
object distance, air gap and object attenuation.

The RCS is calculated as follows:

RCS = λ2 / (4π) * R4 / A4 * 1/AttO, where:
● λ = c/f is the wavelength of the radar signal and

– c = 299700000 m/s is the speed of light in the air
– f: center frequency of the R&S AREG800A

● R: object distance
● A: Air gap between radar sensor and R&S AREG800A antennas
● AttO: object attenuation, converted from dB to linear scale

The logarithmic value to specify the RCS in dB is converted with 10*log.

4.5  Doppler speed and Doppler shift

To simulate the echo signals of moving objects, you can configure either the Doppler
speed or the Doppler shift for all objects individually. Also, you can derive the radial
velocity of each object. To select the format for configuration the Doppler dynamics,
see "Doppler Format" on page 113.

The Doppler shift fD is calculated as follows:

fD = 2(ν/c) * fRF, where:
● v: radial speed of the object

Doppler speed and Doppler shift
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● fRF: frequency of the RF output signal
● c = 299700000 m/s: speed of light in the air.

4.6  Equivalent isotropically radiated power (EIRP)

The EIRP is calculated of the maximum power emitted by an ideal isotropic antenna in
all directions which is transmitted as equivalent into a single direction with the highest
antenna gain.

The EIRP value of the radar sensor is calculated from the measured RX power at the
frontend, the antenna gain, the air gap, the instrument's internal gain and the tempera-
ture compensation with the following equation:

EIRP [dB] = (PRX − G1) + 20 * log A − GRX − 20 * log λ

Where:
● A = air gap
● λ = wavelength of the radar transmission
● GRX = R&S AREG800A antenna gain
● G1 = internal gain from RX waveguide port to power sensor
● PRX = received power at the frontend

Equivalent isotropically radiated power (EIRP)
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5  Generating radar echo signals
This chapter provides an overview on radar echo signal generation tasks. It covers the
following topics.

● Workflow to configure the R&S AREG800A............................................................68
● Test setups..............................................................................................................69
● Static radar objects................................................................................................. 96
● Dynamic radar objects............................................................................................ 98

5.1  Workflow to configure the R&S AREG800A

To configure a measurement setup on with the R&S AREG800A, the principle order is
the following:

1 2

34

Figure 5-1: Workflow to configure a measurement setup with the R&S AREG800A

1 = System configuration
2 = Operation setup configuration
3 = Measurement setup configuration
4 = Radar objects configuration

To configure your measurement setup, the following steps are necessary:

1. In the "System Config" tile, configure the basic system parameters, e.g. remote
interface.

Workflow to configure the R&S AREG800A
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2. In the "Operation Setup" tile, configure the operation mode, e.g. a dynamic sce-
nario.
See Chapter 8, "Configuring the operation setup", on page 188.

3. In the "Measurement Setup" tile, configure the test setup, e.g. connected frontends
and sensors.
See Chapter 7, "Configuring the measurement setup", on page 121.

4. In the "Radar Objects" tile, configure object parameters and execute your measure-
ment.
See Chapter 6, "Configuring radar objects", on page 102.

5.2  Test setups

A typical test setup consists of the R&S AREG800A base unit with a connected fron-
tend. You can connect the R&S AREG800A to following frontend types:

● TRX-type (millimeterwave) frontend, e.g. R&S AREG8-81S/-81D
● R&S QAT100 advanced antenna array
● FE-type frontend, e.g. R&S FE44S
● Custom frontends

The R&S AREG800A receives a radar signal from the DUT (device under test) in the
specified frequency band (e.g. 24 GHz or 77 GHz). It downconverts the signal to the
intermediate frequency (IF). Depending on the installed options and current configura-
tion attenuation, delay and Doppler shift are applied.

The modified IF signal is upconverted to the RF (radio frequency) and retransmitted to
the DUT. Based on the difference between the transmitted and the received signal the
DUT calculates the key parameters of the artificial objects generated by the
R&S AREG800A.

5.2.1  Test setup with R&S QAT100 frontend

QAT-type frontends are considered, for example, to simulate dynamic driving test sce-
narios or for hardware in the loop (HIL) testing.

With a QAT-type frontend, you can simulate one radar object per radar channel. Using
a QAT-type frontend allows you to simulate the radar objects in different horizontal and
vertical angle settings.

See Chapter 7.2.4, "Geometry settings", on page 135.

Test setups
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1

DUT Frontend Syst. Crtl

Rx IF In

LAN

IF In

Tx IF OutIF Out
Radar 
 echo
 generator

IF Out

Control

RF In

IF InRF Out

2 3
4 5 6

7

Figure 5-2: Test setup: Radar echo generator and R&S QAT100 frontend

1 = Shielded Box
2 = Device under test (DUT)
3 = Radar echo signal
4 = QAT-type frontend R&S QAT100
5 = Connection R&S QAT100 frontend to radar echo generator
6 = Radar echo generator R&S AREG800A
7 = Radar signal

To connect the R&S AREG800A to an R&S QAT100 frontend

The R&S AREG800A is connected to power and switched on.

► Connect all connectors for connections between the R&S AREG800A,
R&S QAT100 frontend and DUT as in Table 5-1.
Table 5-1: R&S QAT100 frontend: Signals and connections

Signal R&S QAT100 R&S AREG800A

LAN (Control) "LAN" "System Control"

IF Out "Rx Select" "Tx IF Out"

IF In "TX Σ" "Rx IF In"

To configure the QAT-type frontend in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Frontend Config" tab.

The "Config" side tab opens.

3. Select "Add QAT".

A QAT-type frontend is added and is displayed as a side tab.

4. Select the "QAT" side tab.

5. To configure the QAT-type frontend:

a) Configure the QAT settings.
See Chapter 7.2.3, "QAT settings", on page 132.

b) Select "QAT Channel Mode > Single".

Test setups
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To configure the Sensor/DUT in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Sensor/DUT Config" tab.

3. If necessary, add a sensor with "Add Sensor".

4. Select the "Sensor" side tab of your sensor.

5. Configure the sensor settings.
See Chapter 7.3.2, "Sensor settings", on page 158.

To configure the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Config" tab.

3. Select the "Overview" side tab.

4. Activate "Channel x".

5. Select the "Channel x" side tab.

6. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

To map the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Mapping" tab.

3. Map the "Frontend" in the channel-mapping table.

a) Select "Q1: QATΣ1".

4. Map the Sensor/DUT in the channel-mapping table.

a) Select "S1: Sensor".

The exemplary test setup is now configured. The channel-mapping table looks as
follows:

Test setups
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5. Click "Adjust Level".

6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

Test setup with two R&S QAT100 frontends

To test more radar sensors at the same time and to extend the field of view, you can
use two or more QAT-type frontends in your test setup.

In a test setup with two R&S QAT100 frontends, for example, the LAN (Control) con-
nection is established via a switch.

When using a LAN switch and DHCP is set on the R&S AREG800A, connect the
DHCP server to the LAN switch. If no DHCP connection is available, set a static IP
address in the same subnet for R&S AREG800A and the QAT-type frontend.

DUT

Frontend 2

Rx IF 2 In

LAN

IF In 2

Tx IF 2 OutIF Out 2

Radar echo generator

IF Out

Control

RF In

IF InRF Out

Frontend 1 Syst. Crtl

Rx IF 1 In

LAN

IF In 1

Tx IF 1 OutIF Out 1

IF Out

Control

RF In

IF InRF Out

Switch

Figure 5-3: Test setup: Radar echo generator with two R&S QAT100 frontends
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To connect the R&S AREG800A to two R&S QAT100 frontends

The R&S AREG800A is connected to power and switched on.

► Connect all connectors for connections between the R&S AREG800A,
R&S QAT100 frontends and DUT as in Table 5-1.
Table 5-2: R&S QAT100 frontend: Signals and connections

Signal Frontend 1
R&S QAT100

Frontend 2
R&S QAT100

R&S AREG800A

LAN (Control) "LAN"

(connect to LAN
switch)

 "System Control"

(connect to LAN switch)

IF Out 1 "Rx Select"  "Tx IF Out" 1

IF In 1 "TX Σ"  "Rx IF In" 1

LAN (Control)  "LAN"

(connect to LAN switch)

 

IF Out 2  "Rx Select" "Tx IF Out" 2

IF In 2  "TX Σ" "Rx IF In" 2

To configure two R&S QAT100 frontends in the test setup

1. Configure the first and second R&S QAT100 frontends after one another.
Follow the descriptions under "To configure the QAT-type frontend in the test setup"
on page 70.

2. Configure the Sensor/DUT for the first and second R&S QAT100 frontends after
one another.
Follow the descriptions under "To configure the Sensor/DUT in the test setup"
on page 71.

3. Configure the channels for the first and second R&S QAT100 frontends after one
another.
Follow the descriptions under "To configure the channels in the test setup"
on page 71.

4. Map the channels for the first and second R&S QAT100 frontends.

a) Select the "Measurement Setup" tile > "Configuration".
b) Select the "Channel Mapping" tab.
c) In the channel-mapping table, select "Q1: QATΣ1" to map the first

R&S QAT100 frontend.
d) Map the Sensor/DUT for the first R&S QAT100 frontend in the channel-map-

ping table.
e) In the channel-mapping table, select "Q2: QATΣ1" to map the second

R&S QAT100 frontend.
f) Map the Sensor/DUT for the second R&S QAT100 frontend in the channel-

mapping table.

Test setups
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The exemplary test setup is now configured. The channel-mapping table looks as
follows:

5. Click "Adjust Level".

6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

5.2.2  Test setup with TRX-type frontend

TRX-type frontends are considered, for example, for component testing.

With a TRX-type frontend, you can simulate up to eight radar objects per IF channel.

DUT Frontend

Rx IF In

Control

IF In

Tx IF OutIF Out
Radar 
 echo
 generator

IF OutRF In

IF InRF Out

1 2 3
4 5 6

7

Control Control x

Figure 5-4: Test setup: Radar echo generator and TRX-type frontend

1 = Shielded Box
2 = Device under test (DUT)
3 = Radar echo signal
4 = TRX-type frontend
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5 = Connection TRX-type frontend to radar echo generator
6 = Radar echo generator R&S AREG800A
7 = Radar signal

To connect the R&S AREG800A to a TRX-type frontend

The R&S AREG800A is connected to power and switched on.

► Connect all connectors for connections between the R&S AREG800A, TRX-type
frontend and DUT as in Table 5-3.
Table 5-3: TRX-type frontend: Signals and connections

Signal TRX-type frontend R&S AREG800A

Control "Control" "System Control"

IF Out "IF In" "Tx IF Out"

IF In "IF Out" "Rx IF In"

To configure the TRX-type frontend in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Frontend Config" tab.

The "Config" side tab opens.

3. If necessary, change the "Alias" name of the TRX-type frontend.

4. Select the "TRX" side tab.

5. To configure the TRX-type frontend:

a) Configure the TRX settings.
See Chapter 7.2.2, "TRX settings", on page 126.

To configure the Sensor/DUT in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Sensor/DUT Config" tab.

3. If necessary, add a sensor with "Add Sensor".

4. Select the "Sensor" side tab of your sensor.

5. Configure the sensor settings.
See Chapter 7.3.2, "Sensor settings", on page 158.

To configure the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Config" tab.

3. Select the "Overview" side tab.

4. Activate "Channel x".
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5. Select the "Channel x" side tab.

6. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

To map the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Mapping" tab.

3. Map the "Frontend" in the channel-mapping table.

a) Select "T1: TRX".

4. Map the Sensor/DUT in the channel-mapping table.

a) Select "S1: Sensor".

The exemplary test setup is now configured. The channel-mapping table looks as
follows:

5. Click "Adjust Level".

6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

5.2.3  Test setup with FE-type frontends

FE-type frontends are considered, for example, for testing in the 5G frequency range.

You can use two FE-type frontends (e.g. R&S FE44S) in your test setup, one frontend
in RX-mode (receive mode) and one frontend in TX mode (transmit mode).

For more information, see also the user manual of the external frontend.
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Figure 5-5: Test setup: Radar echo generator with two FE-type frontends (RX and TX mode)

1 = Shielded box with device under test (DUT)
2 = Radar signal
3 = FE-type frontend in RX mode
4 = Radar echo generator
5 = FE-type frontend in TX mode
6 = Radar echo signal

To connect the R&S AREG800A to the FE-type frontends

The R&S AREG800A is connected to power and switched on.

1. Connect all connectors for connections between the R&S AREG800A, FE-type
frontend (RX mode) and DUT as in Table 5-4.
Table 5-4: FE-type frontend (RX mode): Signals and connections

Signal FE-type frontend R&S AREG800A

RF "RF In/Out" -

IF "IF Out" "Rx IF In"

LAN (connection via LAN-
switch)

"LAN" LAN

Reference (connection via split-
ter)

"Ref In" Ref Out

2. Connect all connectors for connections between the R&S AREG800A, FE-type
frontend (TX mode) and DUT as in Table 5-5.
Table 5-5: FE-type frontend (TX mode): Signals and connections

Signal FE-type frontend R&S AREG800A

RF "RF In/Out" -

IF "IF In" "Tx IF Out"
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Signal FE-type frontend R&S AREG800A

LAN (connection via LAN-
switch)

"LAN" LAN

Reference (connection via split-
ter)

"Ref In" Ref Out

To configure the FE-type frontends in the test setup

1. When using the R&S FE44S as FE-type frontend in your test setup: set "Operation
Setup" > "Bandwidth Config" > "Bandwidth x" > "5 GHz".

2. Select the "Measurement Setup" tile > "Configuration".

3. Select the "Frontend Config" tab.

The "Config" side tab opens.

4. If necessary, change the "Alias" name of the FE-type frontend.

5. Select the "FE" side tab.

6. To configure the FE-type frontends:

a) Select the"RX Frontend" from the list of available frontends.
b) Select the"TX Frontend" from the list of available frontends.
c) Click "Connect".
d) Configure the frontend settings for both connected frontends.

See Chapter 7.2.5, "FE settings", on page 138.
e) To configure the "RX Frontend" and "TX Frontend" settings, click  for the

respective frontend.
See Chapter 7.2.8, "RX/TX external frontend settings", on page 143.

To configure the Sensor/DUT in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Sensor/DUT Config" tab.

3. If necessary, add a sensor with "Add Sensor".

4. Select the "Sensor" side tab of your sensor.

5. Configure the sensor settings.
See Chapter 7.3.2, "Sensor settings", on page 158.

To configure the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Config" tab.

3. Select the "Overview" side tab.

4. Activate "Channel x".

5. Select the "Channel x" side tab.
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6. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

To map the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Mapping" tab.

3. Map the "Frontend" in the channel-mapping table.

a) Select "F1: FE".

4. Map the Sensor/DUT in the channel-mapping table.

a) Select "S1: Sensor".

The exemplary test setup is now configured. The channel-mapping table looks as
follows:

5. Click "Adjust Level".

6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

To connect FE-type frontends with coupled LO signal

In a test setup with more than one external frontend, you can build a phase coherent
test setup when using the same LO signal for all connected frontends. Connecting mul-
tiple devices by their used LO signals is useful, for example, in setups with multiple
input streams to reduce the phase noise. To use the same LO signal on coupled exter-
nal frontends, both devices have to use the same LO frequency for upconversion and
downconversion. For coupled frontends of the same type, e.g. two R&S FE44S, make
sure to select the same frequency band configuration for all frontends.
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Figure 5-6: Test setup: Radio echo generator with two FE-type frontends (RX and TX mode) with cou-
pled LO signal

For LO coupling, you can decide which of the frontends provides the LO signal. In this
example, the RX frontend provides the LO signal.

1. Connect the test setup as described in "To connect the R&S AREG800A to the FE-
type frontends" on page 77.

2. Connect the "LO out" connector of the RX frontend to the "LO in" connector of the
TX frontend.

3. Configure the test setup as described in "To configure the FE-type frontends in the
test setup" on page 78.

4. Click  to open the "RX Frontend" or "TX Frontend" configuration dialog, respec-
tively.

5. In the "RX Frontend" configuration dialog, select the "LO Config" tab.

a) Select "Mode > Internal".
b) Select "Out State > On".

The "LO OUT Frequency" provided by the frontend is displayed.
See Chapter 7.2.8.5, "LO Config settings", on page 150.

6. In the "TX Frontend" configuration dialog, select the "LO Config" tab.

a) Select "Mode >External".
b) Select "Out State > Off".

The "Mandatory LO IN Frequency" is displayed.
See Chapter 7.2.8.5, "LO Config settings", on page 150.
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5.2.4  Test setup with custom frontends

Custom frontends are considered, for example, for integrated sensing and communica-
tion (ISAC). You can define a custom frontend in your test setup, one path in RX-mode
(receive mode) and one path in TX mode (transmit mode).

For custom frontends, the R&S AREG800A can calculate RCS, Doppler shift fre-
quency, antenna corrections, cable corrections, etc. in the same way as for QAT-type,
TRX-type or FE-type frontends.

The R&S AREG800A can use custom frontends for internal calculations in the follow-
ing ways:
● A custom frontend (external frequency converters) is connected to the

R&S AREG800A.

Tx IF Out 1

AREG800A

Custom frontend TX

IF InRF Out

Custom frontend RX

IF OutRF In
DUT

Rx IF In 1

1 2 4 6

78

3 5

Figure 5-7: Test setup: Radar echo generator with two custom frontends (RX and TX mode)

1 = Shielded box with device under test (DUT)
2 = Radar signal
3 = "RF signal path" on page 82
4 = Custom frontend in RX mode
5 = "IF signal path" on page 82
6 = Radar echo generator
7 = Custom frontend in TX mode
8 = Radar echo signal

● Define a "virtual" custom frontend when using the IF signal of the R&S AREG800A
directly, e.g. when connecting an antenna to the IF connectors of the
R&S AREG800A without using a custom frontend in your test setup.
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AREG800ADUT
Rx IF In 1
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Figure 5-8: Test setup: Antennas connected directly to the radar echo generator

1 = Shielded box with device under test (DUT)
2 = Radar signal
3 = "RF signal path" on page 82
4 = Radar echo generator
5 = Radar echo signal

RF signal path

For the connected antenna, the R&S AREG800A can calculate a corrected antenna
gain from an "Antenna Gain List" defined in the "Frontend Config" dialog of the custom
frontend. For calculating the antenna correction, the R&S AREG800A uses the values
of the antenna gain list together with the sensor center frequency and the sensor band-
width.

See also
● "Antenna Gain List" on page 128
● Chapter 7.3.2, "Sensor settings", on page 158

IF signal path

IF cable between custom frontend and R&S AREG800A. For the connection cable, the
R&S AREG800A can calculate a cable correction defined in the "Cable Correction" set-
tings in the "Frontend Config" dialog of the custom frontend.

For cable correction, set a "User Attenuation" and "User Delay" or load an external
*.s2p file for the RX and TX cable. For calculating the cable correction, the
R&S AREG800A uses the IF center frequency of the custom frontend and the sensor
bandwidth.

See also
● Chapter 7.2.6, "Custom frontend settings", on page 140
● Chapter 7.2.9, "Cable correction settings", on page 152
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To connect antennas to the R&S AREG800A

The R&S AREG800A is connected to power and switched on.

1. Connect a transmit antenna to the "Tx IF Out" connector of the R&S AREG800A.

2. Connect a receive antenna to the "Rx IF In" connector of the R&S AREG800A.

To connect custom frontends to the R&S AREG800A

The R&S AREG800A is connected to power and switched on.

1. Connect all connectors for connections between the R&S AREG800A, custom
frontend (RX mode) and DUT as follows:
Table 5-6: Custom frontend (RX mode): Signals and connections

Signal Custom frontend R&S AREG800A

RF "RF In" -

IF "IF Out" "Rx IF In"

2. Connect all connectors for connections between the R&S AREG800A, custom
frontend (TX mode) and DUT as follows:
Table 5-7: Custom frontend (TX mode): Signals and connections

Signal Custom frontend R&S AREG800A

RF "RF Out" -

IF "IF In" "Tx IF Out"

To configure custom frontends in the test setup

When connecting antennas directly to the Rx/Tx IF connectors of the R&S AREG800A,
you can define a "virtual" custom frontend in the same way as a custom frontend con-
nected to the R&S AREG800A in your test setup.

1. Set "Operation Setup" > "Bandwidth Config" > "Bandwidth x".

Choose "Bandwidth x" according to the frequency occupation of your signal:
● "1 GHz": for signal frequencies from 1.1 GHz to 2.1 GHz
● "2 GHz": for signal frequencies from 700 MHz to 2.7 GHz
● "5 GHz": for signal frequencies from 700 MHz to 5.7 GHz

2. Select the "Measurement Setup" tile > "Configuration".

3. Select the "Frontend Config" tab.

The "Config" side tab opens.

4. If necessary, change the "Alias" name of the custom frontend.

5. Select the "CFE" side tab.

6. Define the air gap between custom frontend and DUT.

a) Set the"RX Air Gap".
b) Set the"TX Air Gap".
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7. Click "Cable Correction" and define the cable correction for both RX and TX fron-
tends, in your test setup.
See also Chapter 7.2.9, "Cable correction settings", on page 152.

8. Click "Antenna Gain List" and define a list or import an existing list from a directory.
See also "Antenna Gain List" on page 128.

9. Click "Geometry" and define the angle and rotation frontend to sensor for your test
setup.
See also Chapter 7.2.4, "Geometry settings", on page 135.

To configure the Sensor/DUT in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Sensor/DUT Config" tab.

3. If necessary, add a sensor with "Add Sensor".

4. Select the "Sensor" side tab of your sensor.

5. Configure the sensor settings.
See Chapter 7.3.2, "Sensor settings", on page 158.

To configure the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Config" tab.

3. Select the "Overview" side tab.

4. Activate "Channel x".

5. Select the "Channel x" side tab.

6. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

To map the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Mapping" tab.

3. Map the "Frontend" in the channel-mapping table.

a) Select "CF1: CFE".

4. Map the Sensor/DUT in the channel-mapping table.

a) Select "S1: Sensor".

The exemplary test setup is now configured. The channel-mapping table looks as
follows:
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5. Click "Adjust Level".

6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

5.2.5  Test setup in a HIL environment

For scenario validation, e.g. like testing of moving targets in realistic road scenarios,
you can use the R&S AREG800A in combination with QAT-type frontends in a hard-
ware in the loop (HIL) setup.
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Figure 5-9: Test setup: Radar echo generator and QAT-type frontend in HIL setting

1 = HIL test system
2 = Real-time connection HIL test system to R&S AREG800A
3 = Radar echo generator R&S AREG800A
4 = Connection QAT-type frontend to radar echo generator
5 = Shielded Box
6 = QAT-type frontend QAT 100
7 = Radar echo signal
8 = Radar signal
9 = Device under test (DUT)
10 = Real-time connection DUT to HIL test system

To connect the HIL test setup

The R&S AREG800A is connected to power and switched on.

1. Connect all connectors for connections between the R&S AREG800A and QAT-
type frontend as in Table 5-8.
Table 5-8: HIL test setup: Signals and connections R&S QAT100 to R&S AREG800A

Signal R&S QAT100 R&S AREG800A

LAN (Control) "LAN" "System Control"

IF Out "Rx Select" "Tx IF Out"

IF In "TX Σ" "Rx IF In"

2. Set up the DUT for operation with the HIL test system.
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3. Start the transmission of the real-time control data via the open simulation interface
(OSI) from the HIL test system.

To configure the HIL test setup

1. Select the "Operation Setup" tile.

2. Select the "General" side tab in the "Operation Setup" tab

a) Select "Mode > Dynamic".
b) Select "Data Source > HiL/ViL".
c) Configure your "Host IP Address / Hostname".
d) Configure your "Host Port".
e) Select your "HiL-Protocol".

See Chapter 8.2.1, "General", on page 189.

3. Click "Apply".

4. Confirm the settings with "OK".

5. Select the "Settings" side tab in the "Operation Setup" tab.

a) Configure the settings.
See Chapter 8.2.2, "Settings", on page 192.

6. Select the "Object Marker" side tab in the "Operation Setup" tab.

a) Configure the settings.
See Chapter 8.2.3, "Object marker settings", on page 194.

To configure the QAT-type frontend in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Frontend Config" tab.

The "Config" side tab opens.

3. Select "Add QAT".

A QAT-type frontend is added and is displayed as a side tab.

4. If necessary, change the "Alias" name of the QAT-type frontend.

5. Select the "QAT" side tab.

6. To configure the QAT-type frontend:

a) Configure the QAT settings.
See Chapter 7.2.3, "QAT settings", on page 132.

b) Select "QAT Channel Mode > Single".

To configure the Sensor/DUT in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Sensor/DUT Config" tab.

3. If necessary, add a sensor with "Add Sensor".
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4. Select the "Sensor" side tab of your sensor.

5. Configure the sensor settings.
See Chapter 7.3.2, "Sensor settings", on page 158.

To configure the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Config" tab.

3. Select the "Overview" side tab.

4. Activate "Channel x".

5. Select the "Channel x" side tab.

6. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

To map the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Mapping" tab.

3. Map the "Frontend" in the channel-mapping table.

a) Select "Q1: QATΣ1".

4. Map the Sensor/DUT in the channel-mapping table.

a) Select "S1: Sensor".

The exemplary test setup is now configured. The channel-mapping table looks as
follows:

5. Click "Adjust Level".
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6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

5.2.6  Test setup with a switching unit

To expand your test setup with two subchannels for each channel of the
R&S AREG800A, you can add a switching unit to your test setup.

Expanding the test setup is helpful, e.g. if you have only two channels available on
your R&S AREG800A and four segments available on your QAT-type frontend.

In the following example, an R&S AREG800A is connected with a switching unit
R&S OSP and a QAT-type frontend R&S QAT100.

Syst. Crtl

Rx IF In 1

Tx IF Out 1

AREG800A

Switch

Rx IF In 2

Tx IF Out 2

M02

C (K11)

C (K12)

M01

C (K11)

C (K12)

Switching unit

Rx B

Rx A

Tx B

Tx A

Rx C

Rx D

Tx C

Tx D

QAT100

State 1

State 0

State 1

State 0

State 0

State 0

State 1

State 1

LANLAN

DUT

RF In

RF Out

1 3 5 62 4

Figure 5-10: Test setup: Radar echo generator with switching unit and QAT-type frontend

1 = Radar echo generator R&S AREG800A
2 = Connection radar echo generator to switching unit
3 = Switching unit with modules M01 and M02, e.g. R&S OSP
4 = Connection switching unit to QAT-type frontend
5 = QAT-type frontend
6 = Shielded Box with device under test (DUT)

To connect the switching unit in a test setup

In a test setup with an R&S AREG800A, a switching unit and a QAT-type frontend, the
LAN (Control) connection is established via a switch.

When using a LAN switch and DHCP is set on the R&S AREG800A, connect the
DHCP server to the LAN switch. If no DHCP connection is available, set a static IP
address in the same subnet for R&S AREG800A and the QAT-type frontend.
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The R&S AREG800A is connected to power and switched on.

1. Connect the LAN connections between R&S AREG800A, switching unit and QAT-
type frontend.

2. Connect all connectors for connections between R&S AREG800A and switching
unit as in Table 5-9.
Table 5-9: Test setup with switching unit: Signals and connections R&S AREG800A to switching

unit

Signal R&S AREG800A Switching unit R&S OSP
(module M01 and M02)

Channel 1 (RX) "Rx IF In 1" M02: "C", "K11"

Channel 1 (TX) "Tx IF Out 1" M02: "C", "K12"

Channel 2 (RX) "Rx IF In 2" M01: "C", "K11"

Channel 2 (TX) "Rx IF In 2" M01: "C", "K12"

On the module of the switching unit:
● "C": Common (terminal port)
● "Kxx": Relay

3. Connect all connectors for connection between switching unit and QAT-type fron-
tend as in Table 5-10.
Table 5-10: Test setup with switching unit: Signals and connections switching unit to

R&S QAT100

Signal Switching unit R&S OSP
(module M01 and M02)

R&S QAT100

Subchannel A1.1 M02: "C", "K11"

State 0

"Rx B"

Subchannel A1.2 M02: "C", "K11"

State 1

"Rx A"

Subchannel A1.1 M02: "C", "K12"

State 0

"Tx B"

Subchannel A1.2 M02: "C", "K12"

State 1

"Tx A"

Subchannel A2.1 M01: "C", "K11"

State 0

"Rx C"

Subchannel A2.2 M01: "C", "K11"

State 1

"Rx D"

Subchannel A2.1 M01: "C", "K12"

State 0

"Tx C"

Subchannel A2.2 M01: "C", "K12"

State 1

"Tx D"
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To configure the switching unit in the test setup

Switching unit and QAT-type frontend are powered and are connected to LAN and the
switch.

For detailed information, see the user manual of the switching unit and the QAT-type
frontend.

1. Connect the System Control connector to the switch to establish the LAN connec-
tion between all instruments in the test setup.

2. On the home screen, select the "Operation Setup" tile.

3. Activate "Use Switching Unit" and return to the home screen.

4. On the home screen, select the "Measurement Setup" tile > "Configuration".

The "Switching Unit Config" tab opens automatically.

5. Enter the "IP / Hostname" of your switching unit.

6. Click "Connect".

To configure the QAT-type frontend in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Frontend Config" tab.

The "Config" side tab opens.

3. Select "Add QAT".

A QAT-type frontend is added and is displayed as a side tab.

4. If necessary, change the "Alias" name of the QAT-type frontend.

5. Select the "QAT" side tab.

6. To configure the QAT-type frontend:

a) Configure the QAT settings.
See Chapter 7.2.3, "QAT settings", on page 132.

b) Select "QAT Channel Mode > Multiple".

To configure the Sensor/DUT in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Sensor/DUT Config" tab.

3. If necessary, add a sensor with "Add Sensor".

4. Select the "Sensor" side tab of your sensor.

5. Configure the sensor settings.
See Chapter 7.3.2, "Sensor settings", on page 158.

To configure the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".
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2. Select the "Channel Config" tab.

3. Select the "Overview" side tab.

4. Activate "Channel 1" and "Channel 2".

5. Select the "Channel 1" side tab.

6. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

7. For the "Switching Unit":

a) For "Channel RX", select "M02 K11 1x2".
b) For "Channel TX", select "M02 K12 1x2".

8. Select the "Channel 2" side tab.

9. Configure the channel settings.
See Chapter 7.4.2, "Channel settings", on page 162.

10. For the "Switching Unit":

a) For "Channel RX", select "M01 K11 1x2".
b) For "Channel TX", select "M01 K12 1x2".

To map the channels in the test setup

1. Select the "Measurement Setup" tile > "Configuration".

2. Select the "Channel Mapping" tab.

3. Map the "Frontend" in the channel-mapping table.

a) For subchannel "A1.1", select "Q1: QAT B1".
b) For subchannel "A1.2", select "Q1: QAT A1".
c) For subchannel "A2.1", select "Q1: QAT C1".
d) For subchannel "A2.2", select "Q1: QAT D1".

4. Map the Sensor/DUT in the channel-mapping table.

a) For subchannels "A1.1", "A1.2", "A2.1" and "A2.2" select "S1:Sensor".

The exemplary test setup is now configured. The channel-mapping table looks as
follows:

Test setups
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5. Click "Adjust Level" for each single subchannel or "Adjust All Levels".

6. If necessary, click "Adjust Level Settings".
See Chapter 7.5.2, "Adjust Level settings", on page 168.

5.2.7  Test setup for gPTP time synchronization

You can use the R&S AREG800A in a gPTP time synchronization configuration, for
example in a HIL test setup, see Chapter 5.2.5, "Test setup in a HIL environment",
on page 85.

For more information, see also
● "Time Protocol" on page 549
● "HiL - Update Mode" on page 193

Your HIL test system requires a gPTP clock source with compatible configuration and a
network interface card (NIC) with hardware timestamp support.

In this example, we assume you use the linuxptp package.

1. On the HIL test system, use ptp4l to provide the clock source.

a) Use the configuration file gPTP.cfg.
b) When using automotive-master.cfg, make the following changes to the

file:

● set priority1 246
● unset BMCA noop
● unset inhibit_announce
● unset inhibit_delay_req

2. Call ptp4l:

Test setups
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ptp4l -i <name of your ethernet device> -f <ptpconfig
root>/gPTP.cfg -m
The name of your Ethernet device can be, e.g. eth0.

3. Synchronize the R&S AREG800A to the HIL test system‘s system clock.

a) Run phc2sys:
phc2sys -s CLOCK_REALTIME -c <name of your ethernet
device>

4. Check the synchronization.

a) Write an arbitrary timestamp to the NIC and check the time displayed on the
R&S AREG800A:
phc_ctl <name of your ethernet device> set
1592817646.744752137

5.2.8  Test setup for multiple instruments

You can use more than one R&S AREG800A in a test setup, for example to expand
the available radar channels in a HIL test setup.

For easy access, you can configure the instruments via the web UI. This method is
helpful if, for example, not all instruments in the test setup are freely accessible.

The following example shows a HIL test setup with the R&S AREG800A as primary
instrument with an additional R&S AREG800A as secondary instrument. Both instru-
ments have connected QAT-type frontends.

Test setups
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Figure 5-11: Test setup: Multi-instrument setup with radio echo generators and QAT-type frontends in
HIL environment

To connect multiple instruments

1. Connect the primary R&S AREG800A. The control connection is done via LAN
switch.
See Chapter 5.2.5, "Test setup in a HIL environment", on page 85.

2. Connect the secondary R&S AREG800A. The control connection is done via LAN
switch.
See Chapter 5.2.1, "Test setup with R&S QAT100 frontend", on page 69.

3. Connect the "Ref Out" connector of the primary instrument to the "Ref In" connec-
tor of the secondary instrument.

4. Connect the primary instrument, the secondary instrument and the PC/Laptop used
for the configuration via web UI to the same LAN.

To configure the multi-instrument setup

You can configure the connected instruments in a multi-instrument setup via the web
UI.

Test setups
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See Chapter 3.4.9, "Remote operation over web UI", on page 60.

1. In the address field of the browser, enter <ip address>/webui.

2. Configure the primary instrument.

a) In the "Device Overview", select the R&S AREG800A.
b) In the "Operation Setup", select the "Multi Instrument" tab.

See Chapter 8.2.4, "Multi instrument settings", on page 195.
c) Select "Multi Instrument Mode > Primary".
d) Click "Add Secondary".
e) Enter the IP address of the secondary R&S AREG800A.
f) Click "Connect".
g) Configure the operation setup.

See Chapter 8.2, "Operation setup settings", on page 189.
h) Configure the configuration settings.

See Chapter 7.2, "Frontend configuration", on page 123.
See Chapter 7.3, "Sensor/DUT configuration", on page 156.
See Chapter 7.4, "Channel configuration", on page 160.
See Chapter 7.5, "Channel mapping", on page 165.

3. Configure the secondary instrument.

a) Configure the configuration settings.
See Chapter 7.2, "Frontend configuration", on page 123.
See Chapter 7.3, "Sensor/DUT configuration", on page 156.
See Chapter 7.4, "Channel configuration", on page 160.
See Chapter 7.5, "Channel mapping", on page 165.

5.3  Static radar objects

This section describes how to generate static radar objects. Static radar objects allow
you to simulate targets with defined range, radial velocity and target size.

5.3.1  Generating static radar objects

How to add and configure an R&S QAT100 frontend as static radar object:

1. Select "Operation Setup" > "Mode > Static".

2. Confirm with "Apply" and "OK".

3. Select "Measurement Setup > Configuration".

4. Select "Frontend Config" > "Add QAT" to add a new R&S QAT100 frontend.

5. Select the side-tab of the R&S QAT100 frontend.

6. Configure the settings for the R&S QAT100 frontend.

Static radar objects
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a) Set the value for "Air Gap".
b) Click "Geometry".

● Set the "Angle Frontend to Sensor".
● Set the "Rotation Frontend to Sensor".
● Select the "Orientation" parameter.
See "Geometry" on page 133.

c) Set "QAT Channel Mode > Single" and set the "Frontend Center Frequency".
d) Set under "QAT Hostname" the hostname or IP address of the connected

R&S QAT100 frontend.
See also Chapter 7.2.3, "QAT settings", on page 132.

7. Click "Connect".

When successfully connected, the serial number of the R&S QAT100 frontend is
displayed.

8. Select "Channel Config".

9. Activate the IF channel.
See also Chapter 7.4, "Channel configuration", on page 160.

10. Select "Channel Mapping".

11. Select "Frontend" for the respective IF channel in the table and map the frontend to
the IF channel.
See also Chapter 7.5, "Channel mapping", on page 165.

12. Click "Adjust Level" for the IF channel.
See also Chapter 7.5.2, "Adjust Level settings", on page 168.

Static radar objects
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5.3.2  Configuring static radar objects

Requires "Operation Setup" > "Mode > Static".

1. Select the "Radar Objects" tile > "Units".

2. Define the "Units" settings.
See Chapter 6.5, "Units settings", on page 112

3. Select the "Radar Objects" tile > "Configuration".

4. Define the values in the channel table.
See Chapter 6.2, "Objects settings", on page 103.

5. Select the "Radar Objects" tile > "Radar Power".

6. Check the "Radar Power" information.
See Chapter 6.6, "Radar Power settings", on page 115.

7. Select the "Radar Objects" tile > "Overview".

a) Check your radar objects.
See Chapter 6.7.1, "Overview", on page 116 and Chapter 6.7.2, "Valid Objects/
Invalid Objects", on page 118.

b) If you want to stream valid radar objects to a host, configure the settings in the
"Object Monitoring" tab.
See Chapter 6.7.3, "Object Monitoring", on page 119.

5.4  Dynamic radar objects

This section describes a test setup and how to generate dynamic radar objects and a
scenario. Dynamic radar objects allow you to simulate targets moving in azimuth,
range, radial velocity and target size.

Dynamic radar objects
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5.4.1  Generating dynamic radar objects

How to add and configure an R&S QAT100 frontend as dynamic radar object for a sce-
nario in single instrument mode:

1. Select "Operation Setup" > "Mode > Dynamic".

2. Select "Data Source > Scenario" and "Multi Instrument Mode > OFF".

3. Confirm with "Apply" and "OK".

4. Select "Measurement Setup > Configuration".

5. Select "Frontend Config" > "Add QAT" to add a new R&S QAT100 frontend.

6. Select the side-tab of the R&S QAT100 frontend.

7. Configure the settings for the R&S QAT100 frontend.

a) Set the value for "Air Gap".
b) Click "Geometry".

● Set the "Angle Frontend to Sensor".
● Set the "Rotation Frontend to Sensor".
● Select the "Orientation" parameter.
See "Geometry" on page 133.

c) Set "QAT Channel Mode > Single" and set the "Frontend Center Frequency".
d) Set under "QAT Hostname" the hostname or IP address of the connec-

tedR&S QAT100 frontend.
See also Chapter 7.2.3, "QAT settings", on page 132.

8. Click "Connect".

Dynamic radar objects
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When successfully connected, the serial number of the R&S QAT100 frontend is
displayed.

9. Select "Channel Config".

10. Activate the IF channel.
See also Chapter 7.4, "Channel configuration", on page 160.

11. Select "Channel Mapping".

12. Select "Frontend" for the respective IF channel in the table and map the frontend to
the IF channel.
See also Chapter 7.5, "Channel mapping", on page 165.

13. Click "Adjust Level" for the IF channel.
See also Chapter 7.5.2, "Adjust Level settings", on page 168.

5.4.2  Configuring dynamic radar objects

Requires "Operation Setup" > "Mode > Dynamic".

We assume that the "Data Source" is selected and configured for your test setup.

1. If you want to log data of your dynamic radar scenario, select the "Radar Objects"
tile > "Logging".

a) Select the "Logging Level".
b) Switch "State > ON".

See Chapter 6.4, "Logging settings", on page 109.

2. Select the "Radar Objects" tile > "Units".

3. Define the "Units" settings.
See Chapter 6.5, "Units settings", on page 112

4. Select the "Radar Objects" tile > "Radar Power".

5. Check the "Radar Power" information.
See Chapter 6.6, "Radar Power settings", on page 115.

6. Select the "Radar Objects" tile > "Overview".

a) Check your radar objects.
See Chapter 6.7.1, "Overview", on page 116 and Chapter 6.7.2, "Valid Objects/
Invalid Objects", on page 118.

Dynamic radar objects
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b) If you want to stream valid radar objects to a host, configure the settings in the
"Object Monitoring" tab.
See Chapter 6.7.3, "Object Monitoring", on page 119.

5.4.3  Creating a scenario with dynamic radar objects

How to create a scenario with dynamic radar objects for simulating moving targets:

Requires "Operation Setup" > "Mode > Dynamic" and "Data Source > Scenario". See
Chapter 5.4.1, "Generating dynamic radar objects", on page 99.

1. Select "Radar Objects > Scenario".

2. Click "Select File".

The "Select Scenario" dialog opens.

3. Select an existing data list file from the default directory or from a specific directory.

4. Configure the scenario.

a) Set the values for "Start [hh:mm:ss:fff]" and "Stop [hh:mm:ss:fff]".
b) Select the "Replay Mode".

See also Chapter 6.3, "Scenario settings", on page 107.

5. Click "Play" to start the scenario.

Dynamic radar objects
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6  Configuring radar objects
In its basic configuration, the R&S AREG800A allows the generation of radar objects.
This section introduces step-by-step instructions illustrating typical radar object genera-
tion scenarios.

For information of basic principles of radar object generation, see Chapter 4, "About
radar echo generation", on page 63.

● Radar Objects tile..................................................................................................102
● Objects settings.....................................................................................................103
● Scenario settings...................................................................................................107
● Logging settings....................................................................................................109
● Units settings.........................................................................................................112
● Radar Power settings............................................................................................115
● Overview settings..................................................................................................116

6.1  Radar Objects tile

Access:

1. On the home screen, select the "Radar Objects" tile.

The "Radar Objects" selection opens.

Radar Objects tile
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2. In the "Radar Objects" selection, configure further settings:

● Activate RF signal generation.
● Configure radar objects for up to eight channels.
● Configure units of radar object parameters.
● Visualize simulated radar objects, connected frontends and connected sensors.

6.2  Objects settings

Access:

► Select "Radar Objects > Configuration".

The "Objects" dialog opens and contains up to eight tabs for configuration of up to
eight channels, one tab per channel. Each tab provides settings for individual con-
figuring the simulation of up to eight individual radar objects.

Settings:

Channel x.................................................................................................................... 104
Object table................................................................................................................. 104

└ Object............................................................................................................105
└ State..............................................................................................................105
└ Range........................................................................................................... 105
└ Attenuation....................................................................................................106
└ Doppler Speed..............................................................................................106
└ Doppler Shift................................................................................................. 106
└ Horizontal Angle............................................................................................106
└ RCS.............................................................................................................. 107

Objects settings
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Channel x
Displays the channel tab. The name in the channel tab displays the channel alias.
If fully equipped, the "Objects" dialog provides up to eight tabs "Channel 1" to "Channel
8" to configure up to eight radar channels individually. Each radar channel resembles
one IF path and has a dedicated channel ID "A1" to "D2" as illustrated in the table
below.

Channel "1" "2" "3" "4" "5" "6" "7" "8"

Channel ID "A1" "A2" "B1" "B2" "C1" "C2" "D1" "D2"

The number of simulated radar channels corresponds to the number of IF paths and
depends on the installed options. See Chapter 4.1, "Required options", on page 63.
When using a switching unit:
● Channel:

IF connection from R&S AREG800A to the switching unit.
● Subchannel:

Connection from the switching unit to the frontend. The subchannels are displayed
as side tabs.

For example, for "Channel 1" with channel ID "A1" the side tabs "A.1.1" and "A.1.2" are
displayed.

Object table
Each radar channel can simulate up to eight radar objects. Configuration is provided in
a table, where the rows constitute the individual radar object and the columns consti-
tute radar object characteristics. For each radar object, you can configure simulation
state, range, Doppler speed and horizontal angle. Depending on the unit setting, you
can also configure attenuation or radar cross section (RCS).

Objects settings
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For all parameters specifying the radar objects, you can change the units and change
the format for configuration of Doppler dynamics. See Chapter 6.5, "Units settings",
on page 112.

Object ← Object table
Displays the number of the simulated radar object.
If fully equipped, the R&S AREG800A can simulate up to eight radar objects "1" to "8".
See Table 4-2.

State ← Object table
Activates simulation of the radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:STATe] on page 438
[:SOURce<hw>]:AREGenerator:OBJect:ALL[:STATe] on page 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>][:STATe]
on page 438

Range ← Object table
Sets the range of the simulated radar object.
The range depends on the installed option (e.g. R&S AREG8-B63 for short range tar-
gets) and on the cable delay settings, the air gap and the bandwidth option.
For more information, see the data sheet.

Objects settings
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Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>:RANGe on page 442
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RANGe
on page 442

Attenuation ← Object table
Requires "Radar Objects > Units > Keep Constant > Attenuation".
Sets the attenuation of the simulated radar object.
The attenuation depends on the input power, i.e. a lower input signal can be amplified
more. If the gain control reaches the upper limit, a message is displayed.
See Chapter 4.3, "Radar equation", on page 65.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>:ATTenuation on page 439
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:
ATTenuation on page 439

Doppler Speed ← Object table
Requires "Radar Objects > Units > Doppler Format > Doppler Speed".
Sets the Doppler speed of the simulated radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler[:SPEed] on page 440
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler[:
SPEed] on page 440

Doppler Shift ← Object table
Requires "Radar Objects > Units > Doppler Format > Doppler Shift".
Sets the Doppler shift of the simulated radar object.
R&S AREG8-K813: Install this option, if your test setup requires simulation of radar
objects with Doppler shifts higher than 100 kHz.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler:FREQuency
on page 441
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler:
FREQuency on page 441

Horizontal Angle ← Object table
Sets the horizontal angle of the simulated radar object.
The allowed range of the horizontal angle depends on the measurement setup. If you
set "Object Reference > Origin" and "Sensor/DUT Config > Relative Distance" is not 0
cm, the horizontal angle limits cannot be calculated and are set to +/- 180°. In that
case, check the object validity under "Radar Objects > Overview".
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>:ANGLe:HORizontal on page 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ANGLe:
HORizontal on page 439

Objects settings



Configuring radar objectsR&S®AREG800A

107User Manual 1179.3615.02 ─ 06

RCS ← Object table
Requires "Radar Objects > Units > Keep Constant > RCS".
Sets the radar cross section (RCS) of the simulated radar object.
The RCS value is calculated depending on range, attenuation, horizontal angle of the
radar object. See Chapter 4.3, "Radar equation", on page 65.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJect<ch>:RCS on page 442
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RCS
on page 443

6.3  Scenario settings

The "Scenario" dialog allows you to load and play files to simulate dynamic radar sce-
narios.

Access:

1. In the "Operation Setup" tile, select the following:

a) Select "Mode > Dynamic".
b) Select "Data Source > Scenario".

The scenario settings become available in the radar objects selection.

2. Select "Radar Objects > Scenario".

The "Scenario" dialog provides settings to load and play files for dedicated dynamic
radar scenarios.

Settings:

Running/Stop/Position Player..................................................................................... 108
Select File................................................................................................................... 108
Start [hh:mm:ss.fff]...................................................................................................... 108

Scenario settings
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Position [hh:mm:ss.fff].................................................................................................108
Stop [hh:mm:ss.fff]...................................................................................................... 108
Replay Mode............................................................................................................... 109
Reset...........................................................................................................................109
Play............................................................................................................................. 109
Pause.......................................................................................................................... 109
Stop.............................................................................................................................109

Running/Stop/Position Player
Displays the current position in time, while playing the file.
You can monitor the current position via Position [hh:mm:ss.fff].
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:PROGress on page 449
[:SOURce<hw>]:AREGenerator:SCENario:STATus on page 450

Select File
Provides access to the standard "File Select" function of the instrument. The provided
navigation possibilities in the dialog are self-explanatory.
See also Chapter 9, "File and data management", on page 203. The dialog allows you
to select user-defined and recent files. Table 6-1 provides an overview.
Table 6-1: Supported scenario file types

File extension Remark

*.osi ● Generated from Open Simulation Interface
(OSI) library

● No software option required

*.sm ● Encrypted
● Propriety Rohde & Schwarz file format

Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:FILE on page 448
[:SOURce<hw>]:AREGenerator:SCENario:FILE:CATalog on page 448

Start [hh:mm:ss.fff]
Sets the start position in the loaded file.
Data which chronologically precedes the start position is not replayed by the player.
The entered timestamp must chronologically always precede the entry under Stop.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STARt on page 448

Position [hh:mm:ss.fff]
Displays the current play position in the file.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:POSition:ACTual on page 448

Stop [hh:mm:ss.fff]
Sets the end position in the file.

Scenario settings
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Data which chronologically follows the end position is not replayed by the player. When
the player reaches the "Stop" position, it returns to the "Start" position ("Replay Mode >
Loop"). The entered timestamp must chronologically always follow the entry under
Play.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STOP on page 449

Replay Mode
Defines, if the files are played once or continuously.
Replayed are files within the defined start position and stop position. See "Start
[hh:mm:ss.fff]" on page 108 and "Stop [hh:mm:ss.fff]" on page 108.
"Single" Files are played once within the defined positions in the file.
"Loop" Files are played continuously within the defined positions in the file.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:REPLay[:MODE] on page 449

Reset
Resets the "Start", "Stop" and "Position" parameters of the replayed scenario.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:RESet on page 450

Play
Plays the selected file.
For supported file types, see Table 6-1.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:STARt on page 450

Pause
Pauses the player.
After pausing, you can resume playing the file by clicking "Play" again.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:PAUSe on page 448

Stop
Stops the player.
After stopping, you can resume playing the file by clicking "Play" again. The file plays
from the start position.
Remote command: 
[:SOURce<hw>]:AREGenerator:SCENario:STOP on page 450

6.4  Logging settings

The "Logging" dialog allows you to acquire, manage and save logged data of dynamic
radar scenarios.

Logging settings
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Access:

1. In the "Operation Setup" tile, select the following:

a) Select "Mode > Dynamic".
b) Select "Data Source > Scenario".

The scenario settings become available in the radar objects selection.

2. Select "Radar Objects > Logging".

The "Logging" dialog provides settings to acquire, manage and save logged data
for dedicated dynamic radar scenarios.

Settings:

● Logging Configuration settings..............................................................................110
● Logging results...................................................................................................... 111

6.4.1  Logging Configuration settings

Access:

► Select "Radar Objects > Logging > Logging Config".

The "Logging Config" tab provides settings to activate logging and to configure the
scope and the timebase of logged data.

Settings:

State............................................................................................................................ 110
Logging Level.............................................................................................................. 110

State
Activates logging.
You can define the scope of logged data, see "Logging Level" on page 110.
Remote command: 
[:SOURce<hw>]:AREGenerator:DLOGging[:STATe] on page 451

Logging Level
Defines the scope of logged data.

Logging settings
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"All" Logged data includes information on errors, warnings and info mes-
sages.

"Error and Warning"
Logged data includes information on errors and warnings.

"Error" Logged data includes information on errors.
Remote command: 
[:SOURce<hw>]:AREGenerator:DLOGging:LEVel on page 451

6.4.2  Logging results

Access:

► Select "Radar Objects > Logging > Logging".

The "Logging Config" tab provides settings to activate logging and to configure the
scope and the timebase of logged data.

Settings:

Logging table............................................................................................................... 111
Error | Warning | Info................................................................................................... 112
Clear............................................................................................................................112
Save............................................................................................................................ 112

Logging table
Provides logging information in a table.
"Level" Displays the type of logged data that is "Error", "Warning" or "Info".

Adjust the scope of logged data, for example, when you want to log
error information only. See "Logging Level" on page 110.

Logging settings
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"Time Stamp" Displays the timestamp of the logging information regarding the
selected timebase. See "Timebase" on page 192.

"Text" Provides detailed information for each type and event of the logged
data.

Remote command: 
[:SOURce<hw>]:AREGenerator:DLOGging:DATA on page 451

Error | Warning | Info
Displays the number of counts for each type of logged data. The types are "Error",
"Warning" and "Info".
Displayed are up to 100 counts for each type.
Remote command: 
[:SOURce<hw>]:AREGenerator:DLOGging:NERRor? on page 452
[:SOURce<hw>]:AREGenerator:DLOGging:NWARning? on page 452
[:SOURce<hw>]:AREGenerator:DLOGging:NINFo? on page 452

Clear
Removes all logging information from the logging table. Also, the function resets the
counts for each type of logged data.
Remote command: 
[:SOURce<hw>]:AREGenerator:DLOGging:CLEar on page 452

Save
Accesses a standard file dialog for saving log data in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The generated files are saved in the selected directory with file extension *.csv.

Remote command: 
[:SOURce<hw>]:AREGenerator:DLOGging:SAVE on page 452

6.5  Units settings

Access:

► Select "Radar Objects > Units".

The "Units" dialog provides settings to configure units of parameters of the simula-
ted radar objects.

Units settings
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You can set the units as illustrated in the table below, the first unit representing the
default unit.
Table 6-2: Radar object parameter units

Range Doppler speed Doppler shift Horizontal angle RCS

m, cm, ft km/h, m/s, mph Hz, kHz, MHz Deg, rad dBsm2, m2

Settings:

Range Unit...................................................................................................................113
RCS Unit......................................................................................................................113
Horizontal Angle Unit...................................................................................................113
Doppler Format............................................................................................................113
Speed Unit...................................................................................................................114
Shift Unit......................................................................................................................114
Keep Constant.............................................................................................................114
Speed of Light............................................................................................................. 114

Range Unit
Sets the unit of the range of the simulated radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:RANGe on page 445

RCS Unit
Sets the unit of the radar cross section (RCS) of the simulated radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:RCS on page 445

Horizontal Angle Unit
Sets the unit of the horizontal angle of the simulated radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:ANGLe on page 445

Doppler Format
Defines the format for configuration of Doppler dynamics.

Units settings
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"Doppler Speed"
Configure the Doppler speed "Radar Objects > Configuration > Obj x
> Doppler Speed".

"Doppler Shift" Configure the Doppler shift "Radar Objects > Configuration > Obj x >
Doppler Shift".

Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:DOPPler on page 446

Speed Unit
Sets the unit of the Doppler speed of the simulated radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:SPEed on page 446

Shift Unit
Sets the unit of the Doppler shift of the simulated radar object.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:SHIFt on page 446

Keep Constant
Selects the parameter used as constant value for the calculation of the simulated radar
object. You can edit the other parameters required for the calculation.
The "RCS" parameter depends on the range, the radar sensor frequency and the air
gap.

Example: 
If you select "Attenuation" to keep constant for the calculation, the value for "RCS"
changes if you set another parameter, e.g. "Range".

See the radar equation and the equation for RCS, Chapter 6, "Configuring radar
objects", on page 102.
"Attenuation" Uses the current value for attenuation as constant for the calculation.
"RCS" Uses the current value for RCS as constant for the calculation.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:KCONstant on page 447

Speed of Light
Sets the value of speed of light for internal calculations.
The defined value of speed of light is used for calculation of the Doppler shift, the dis-
tance and the RCS.
For example, if the sensor firmware works with a different definition of the speed of
light, set a value for this parameter to minimize errors in the calculation of Doppler
speed and Doppler shift.
See Chapter 4.5, "Doppler speed and Doppler shift", on page 66.
Remote command: 
[:SOURce<hw>]:AREGenerator:UNITs:C on page 447

Units settings
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6.6  Radar Power settings

Access:

► Select one of the following:

● In the taskbar, select the "Radar Power" button.
● In the tile diagram, select "Radar Objects > Radar Power".

The "Radar Power" dialog provides status information of the input power of each
radar channel.

Settings:

A1 to D2.......................................................................................................................115
Input power LED info...................................................................................................116

A1 to D2
Displays the state of the power LED and the related radar channel.
The following states of the power LED are available:
"Ok"

The channel is active and works properly. The power LED lights
green.

"Error"

Displays an error for the channel. The power LED lights red.
"Warning"

Displays a warning for the channel. The power LED lights yellow.
"Inactive" The channel is inactive and is not displayed. The power LED lights

gray.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:CONDition on page 458
[:SOURce<hw>]:AREGenerator:RADar:POWer:INDicator? on page 458
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Input power LED info
Displays a status message for the input power for the related radar channel.
"Ok" Status message: "Input power ok".

The power LED lights green.
"Error" Status message:

● "Input power above upper limit"
● "Input power below lower limit"
The power LED lights red.

"Warning" Status message:
● "Input power high"
● "Input power low"
The power LED lights yellow.

"Inactive" No active channel. The power LED lights gray.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:CONDition:INFO on page 458

6.7  Overview settings

Access:

► Select "Radar Objects > Overview".

The "Overview" dialog provides an overview of all objects within the radar object
simulation scenario. Also it provides detailed information on valid and invalid radar
objects.

● Overview............................................................................................................... 116
● Valid Objects/Invalid Objects.................................................................................118
● Object Monitoring.................................................................................................. 119

6.7.1  Overview

Access:

► Select "Radar Objects > Overview > Overview".

The "Overview" tab provides an overview of all objects within the radar object simu-
lation scenario.

Overview settings
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Understanding the displayed information

The polar coordinates map in the "Overview" tab displays valid and invalid radar
objects, frontends and sensors. You can configure how the items are displayed.

1 = Valid radar objects
2 = Invalid radar objects
3 = Frontends connected to the R&S AREG800A
4 = Sensors connected to the R&S AREG800A

Working with the polar coordinates map

You can either work with "Autoscale" activated or deactivated.

1. Activate "Autoscale". Displays by default all available channels with maximum dis-
tance.

Overview settings



Configuring radar objectsR&S®AREG800A

118User Manual 1179.3615.02 ─ 06

a)

Click 1x: Displays the most distant object.
Click 2x: Displays the measurement setup configuration.

b)

Back to the previous selection.

2. Deactivate "Autoscale".

a) Enter the maximum distance.

3. Work with the polar coordinates map:

a) Click and hold the left mouse button. Move the mouse to select a rectangular
part of the displayed radar objects overview.

b) Click and hold the left mouse button. Move the mouse to shift the selected part.
c) Double-click the left mouse button to return to the default overview.

6.7.2  Valid Objects/Invalid Objects

Access:

► Select "Radar Objects > Overview > Valid Objects/Invalid Objects".

The "Valid Objects"/"Invalid Objects" tabs provide an overview of all valid and inva-
lid objects of the radar object simulation scenario.

You can simulate up to 64 valid objects. The number depends on the installed
options. For more information, see the data sheet.

Overview settings
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Invalid objects have parameters defined outside of the valid range and therefore
you cannot map these objects to the channel.

Settings:

Valid objects table........................................................................................................119
Invalid objects table.....................................................................................................119

Valid objects table
Provides an overview on valid radar objects in a table.
All radar objects are listed that have a valid configuration including the following:
● Object number, see "Object" on page 105.
● Range, see "Range" on page 105.
● Attenuation, see "Attenuation" on page 106
● Doppler speed or Doppler shift, see "Doppler Speed" on page 106 or "Doppler

Shift" on page 106.
● Horizontal angle, see "Horizontal Angle" on page 106.
● Radar cross section, see "RCS" on page 107.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJects:VALid on page 443
[:SOURce<hw>]:AREGenerator:OBJects:VALid:CATalog? on page 443

Invalid objects table
Provides an overview on invalid radar objects in a table.
All radar objects are listed that have an invalid configuration including the following:
● Object number, see "Object" on page 105.
● Range, see "Range" on page 105.
● Attenuation, see "Attenuation" on page 106
● Doppler speed or Doppler shift, see "Doppler Speed" on page 106 or "Doppler

Shift" on page 106.
● Horizontal angle, see "Horizontal Angle" on page 106.
● Radar cross section, see "RCS" on page 107.
Remote command: 
[:SOURce<hw>]:AREGenerator:OBJects:INValid? on page 443
[:SOURce<hw>]:AREGenerator:OBJects:INValid:CATalog? on page 444

6.7.3  Object Monitoring

With the "Object Monitoring" feature, you can stream valid radar objects from the over-
view to a host (external PC).

The host has to provide a UDP server to which the R&S AREG800A connects. Based
on the "Timebase" setting defined in the "Operation Setup" settings, the timestamp in
the OSI protocol provides information when the radar object was generated. Data is
transferred in the OSI format "osi3::sensorDataSeries".

See "Timebase" on page 192.
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Access:

► Select "Radar Objects > Overview > Object Monitoring".

The "Object Monitoring" tab opens.

Settings:

Host IP Address / Hostname.......................................................................................120
Host Port..................................................................................................................... 120
Streaming Active......................................................................................................... 120

Host IP Address / Hostname
Sets hostname or IP address of the host (external PC) where the objects get streamed
to.
Remote command: 
[:SOURce<hw>]:AREGenerator:OMONitoring:HOSTname on page 444

Host Port
Sets the port of the host (external PC) where the objects get streamed to.
Remote command: 
[:SOURce<hw>]:AREGenerator:OMONitoring:PORT on page 444

Streaming Active
Sets the streaming state.
Remote command: 
[:SOURce<hw>]:AREGenerator:OMONitoring[:STATe] on page 444
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7  Configuring the measurement setup
This chapter provides settings to configure a radar measurement setup. It includes
configuring TRX-type, QAT-type, FE-type frontends or custom frontends, configuring
radar sensors (DUT), configuring IF channels and mapping IF channels.

IF channels include the channel ID, the specified radar objects, the connected frontend
and the radar sensor (DUT).

● Measurement Setup tile........................................................................................ 121
● Frontend configuration.......................................................................................... 123
● Sensor/DUT configuration.....................................................................................156
● Channel configuration........................................................................................... 160
● Channel mapping..................................................................................................165
● Switching unit configuration.................................................................................. 170
● Reference oscillator.............................................................................................. 170
● Using power sensors.............................................................................................175

7.1  Measurement Setup tile

Access:

1. On the home screen, select the "Measurement Setup" tile.

2. In the "Measurement Setup" selection, you can access further settings for perform-
ing the following:

● Set the preset behavior of the R&S AREG800A.
● Configure frontend connections and characteristics of the connected frontend,

e.g. an R&S QAT100.
● Configure available radar channel and channel properties.
● Configure channel mapping, where you can map frontends and sensors to a

radar channel.

Measurement Setup tile
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Preset Behavior On
Activates, if the R&S AREG800A acts as after an instrument preset or not.
If activated ("Preset Behavior On > On"), the R&S AREG800A presets all parameters
except the measurement setup.
Remote command: 
[:SOURce<hw>]:AREGenerator:MEASurement:KEEPsettings on page 456

Measurement Setup tile
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7.2  Frontend configuration

Access:

► Select "Measurement Setup > Configuration > Frontend Config".

The "Frontend Config" tab of the "Measurement Setup" dialog opens.

The side-tab provides settings to configure connected external frontends, e.g. an
R&S QAT100. Also, you can configure individual characteristics of up to eight connec-
ted frontends. Each connected frontend has a dedicated configuration in the corre-
sponding side tab.

Settings:

● General settings....................................................................................................124
● TRX settings..........................................................................................................126
● QAT settings..........................................................................................................132
● Geometry settings.................................................................................................135
● FE settings............................................................................................................ 138
● Custom frontend settings...................................................................................... 140
● External instruments settings................................................................................141
● RX/TX external frontend settings.......................................................................... 143
● Cable correction settings.......................................................................................152

Frontend configuration
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7.2.1  General settings

Access:

► Select "Measurement Setup > Configuration > Frontend Config > Config".

The "Config" side-tab of the "Frontend Config" tab opens.
The "Config" side-tab provides settings to configure general settings of each con-
nected external frontend:
● For TRX-type frontends, configure up to four TRX frontends "T1" to "T4".
● For QAT-type frontends, configure up to eight QAT frontends "Q1" to "Q8".
● For FE-type frontends, configure up to four external frontends "FE1" to "FE4".
● For custom frontends, configure up to four external frontends "CF1" to "CF4".

Also, each connected frontend has a dedicated configuration in the corresponding
side-tab.

Settings:

ID.................................................................................................................................124
Alias............................................................................................................................ 125
Type............................................................................................................................ 125
Remove.......................................................................................................................125
Add..............................................................................................................................125
Show Connector..........................................................................................................125

ID
Displays the identification name of the connected frontend.
For example, the first connected R&S QAT100 is displayed as "Q1".

Frontend configuration
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Alias
Sets the alias of the frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:ALIas on page 475

Type
Displays the type of the connected frontend that is "TRX", "QAT", "FE" or "CFE" (cus-
tom frontend).
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:TYPE? on page 480

Remove
Removes the configuration of the connected frontend.
Also, the corresponding side tab labeled, e.g. "QAT" "ID = Qx", is removed to the right
of the dialog. "x" represents the number of the added frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>|CFE<ch>:RMV
on page 470

Add
Opens a list to select a frontend to add and configure.

After selection, a line with contiguous numeration is added below the already listed
frontends. The "Alias" is assigned automatically. Also, a new side tab labeled, e.g.
"QAT" "ID = Qx" appears to the right of the dialog. "x" represents the number of the
added frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:ADD on page 468
[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>:ADD on page 468
[:SOURce<hw>]:AREGenerator:FRONtend:CFE<ch>:ADD on page 468

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Frontend configuration
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7.2.2  TRX settings

Access:

► Select "Frontend Config > TRX".

The "TRX" "ID = Tx" side-tab provides settings related to the connected TRX-type
frontend that is represented by its "ID". "x" can range from 1 to 4.

The following settings are individual for each connected TRX-type frontend:
● Physical settings of the radar signal path between frontend and radar sensor
● Connection settings of the TRX-type frontend
● Channel and frequency settings of the TRX-type frontend
● EIRP settings for the power sensor connected to the TRX-type frontend

Settings:

Air Gap........................................................................................................................ 127
Cable Correction......................................................................................................... 127
Geometry.................................................................................................................... 127
Antenna Gain.............................................................................................................. 127
AREG Antenna Gain TX............................................................................................. 128
AREG Antenna Gain RX............................................................................................. 128
Antenna Gain List........................................................................................................128

└ Frequency Points..........................................................................................129
└ Import............................................................................................................129
└ Frequency (GHz), Gain Rx (dBi), Gain Tx (dBi)............................................130
└ Export............................................................................................................130

Frontend Bandwidth.................................................................................................... 130
Frontend Center Frequency........................................................................................ 130
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Frontend Serial Number..............................................................................................130
Frontend Type............................................................................................................. 131
EIRP............................................................................................................................131

└ Power Sensor............................................................................................... 131
└ Eirp................................................................................................................131
└ Meas. Port.....................................................................................................131

Air Gap
Specifies the length of the gap between frontend and target.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:OTA:OFFSet
on page 467

Cable Correction
Accesses a dialog to correct effects occurring in the connection cable such as delay
and attenuation. See Chapter 7.2.9, "Cable correction settings", on page 152.

Geometry
Set the parameters to define the geometry between frontend and radar sensor.
See Chapter 7.2.4, "Geometry settings", on page 135.

Antenna Gain
Select the source for setting/defining/configuring the antenna gain.
● "Factory"

Displays the antenna gain separately for TX and RX.
"AREG Antenna Gain TX" on page 128
"AREG Antenna Gain RX" on page 128

● "Table"
Define the antenna gain for TX and RX in a list for up to 128 frequency points. You
can also import a list with frequency points or export your defined list.
External files require a file extension *.txt.
The file format is a text file as comma-separated list with the list elements fre-
quency, RX gain and TX gain. For example:
Frequency[Hz] RX[Dbi] TX[Dbi]
7.6e+10,10,10
7.61e+10,10.1,10.1
7.62e+10,10.2,10.2

"Antenna Gain List" on page 128
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Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:
MODE] on page 471
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:
STATe] on page 471

AREG Antenna Gain TX
Requires "Antenna Gain > Factory".
Displays the antenna gain of a transmitting antenna (TX) that is mounted at the
R&S AREG800A.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:GAIN:TX
on page 475

AREG Antenna Gain RX
Requires "Antenna Gain > Factory".
Displays the antenna gain of the receiving antenna (RX) that is mounted at the
R&S AREG800A.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:GAIN:RX
on page 474

Antenna Gain List
For TRX-type frontends: Requires "Antenna Gain > Table".
Opens a dialog to define frequency and antenna gain RX/TX for up to 512 frequency
points in a table. You can also import an external list from a directory or export the
defined list to a file.

Frontend configuration
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Frequency Points ← Antenna Gain List
Sets the number of frequencies that you want to define in the list.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:FPOints on page 471

Import ← Antenna Gain List
Opens a dialog to import an external list with file extension *.txt.

To import a file, you have the following options:
● "Import File": Imports a file from a directory.
● "Predefined Files": Imports a predefined file for standard antennas, stored on the

R&S AREG800A.
● "Recent Files": Imports a file that was recently used.

The file format is a text file as comma-separated list with the list elements frequency,
RX gain and TX gain.

Example: 
Frequency[Hz] RX[Dbi] TX[Dbi]
7.6e+10,10,10
7.61e+10,10.1,10.1
7.62e+10,10.2,10.2

Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:ANTenna:CUSTom:IMPort:
PREDefined:CATalog? on page 473
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:IMPort on page 473
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:IMPort:PREDefined on page 473
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Frequency (GHz), Gain Rx (dBi), Gain Tx (dBi) ← Antenna Gain List
Sets the respective frequency and antenna gain RX/TX values for the custom antenna.
You can also set the respective values for a selected row of the list.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:FLISt on page 472
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:FLISt:ROW<di> on page 472
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:RX|TX:GLISt on page 474
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:RX|TX:GLISt:ROW<di> on page 474

Export ← Antenna Gain List
Opens a dialog to export the defined frequency table to an external list file with file
extension *.txt in a directory.

Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:
ANTenna:CUSTom:EXPort on page 472

Frontend Bandwidth
Displays the maximum processible bandwidth of the frontend in the current setting.
The frequency bandwidth depends on the configuration of the R&S AREG800A and
the configuration of the frontend included in the test setup. For more information, see
the data sheet.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>:BW
on page 475

Frontend Center Frequency
Sets the RF center frequency of the frontend which is used for downconversion.
The frontend center frequency and frequency range depend on the configuration of the
R&S AREG800A and the configuration of the frontend included in the test setup. For
more information, see the data sheet.
Note:
When using custom frontends, the IF center frequency instead of the RF center fre-
quency is configurable in the frontend configuration. The IF center frequency with the
sensor bandwidth is used for the cable correction, whereas the sensor frequency and
bandwidth is used for the antenna correction.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CENTer on page 479

Frontend Serial Number
Displays the 6-digit serial number of the connected TRX-type frontend.
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Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:SNUMber
on page 479

Frontend Type
Displays the name of the connected TRX-type frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:NAME?
on page 480

EIRP
In this section of the frontend configuration dialog you select the connected R&S NRP
power sensor and measurement port for Equivalent Isotropic Radiated Power (EIRP)
calculation on the respective mmWave (TRX-type) frontend.

Power Sensor ← EIRP
Selects the R&S NRP power sensor used to calculate the EIRP value.
You can connect more than one R&S NRP power sensor to the R&S AREG800A, for
example to the "Sensor" or to the "USB" connectors.
To measure the EIRP, connect the R&S NRP power sensor in one of the following
ways:
● Connect the RF connector of the R&S NRP power sensor to the "RX power" output

connector of the frontend
● Connect the RF connector of the R&S NRP power sensor to the"Aux IF Out" of the

R&S AREG800A
See Chapter 7.8.2, "Connecting R&S NRP power sensors to the R&S AREG800A",
on page 177.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP:SENSor
on page 483

Eirp ← EIRP
Displays the calculated EIRP value.
See Chapter 4.6, "Equivalent isotropically radiated power (EIRP)", on page 67.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP? on page 483

Meas. Port ← EIRP
Selects the measurement port for calculating the EIRP value. The measurement port is
the reference port of the connected R&S NRP power sensor.
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"RX Power" The R&S NRP power sensor is connected to "RX power" of the fron-
tend for EIRP calculation.

"Aux IF Out" The R&S NRP power sensor is connected to "Aux IF Out" of the
R&S AREG800A for EIRP calculation.

Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP:PORT on page 483

7.2.3  QAT settings

Access:

► Select "Frontend Config > QAT".

The "QAT" "ID = Qx" side-tab provides settings related to the connected
R&S QAT100. The frontend is represented by its "ID". "x" can range from 1 to 8.

The following settings are individual for each connected R&S QAT100:
● Physical settings of the radar signal path between frontend and radar sensor
● Connection settings of the R&S QAT100
● Channel and frequency settings of the R&S QAT100 output signal

Settings:

Air Gap........................................................................................................................ 133
Cable Correction......................................................................................................... 133
QAT Hostname............................................................................................................133
Geometry.................................................................................................................... 133
Connect.......................................................................................................................133
QAT Channel Mode.....................................................................................................133
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QAT Channels.............................................................................................................134
Frontend Bandwidth.................................................................................................... 134
Frontend Center Frequency........................................................................................ 134

Air Gap
Specifies the length of the gap between frontend and target.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:OTA:OFFSet
on page 467

Cable Correction
Accesses a dialog to correct effects occurring in the connection cable such as delay
and attenuation. See Chapter 7.2.9, "Cable correction settings", on page 152.

QAT Hostname
Sets hostname or IP address of the connected R&S QAT100.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:HOSTname on page 469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:IPADdress on page 469

Geometry
Set the parameters to define the geometry between frontend and radar sensor.
See Chapter 7.2.4, "Geometry settings", on page 135.

Connect
Triggers a connection procedure to connect the R&S AREG800A with the external
frontend in the network.
Also, the connection status is displayed as a message and via the icon  on the side-
tab.
"Disconnected"

Default setting with no network connection to the frontend.
"ConnectionError"

Network connection error.
"Connected" Valid network connection.
"UpdateError" Error during transfer of a changed setting for the frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:
CONNect|DISConnect on page 469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:STATus?
on page 470

QAT Channel Mode
Sets the channel mode for configuration of the channels at the connected
R&S QAT100.
The configuration of the channels is described in Table 7-1.
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Table 7-1: R&S QAT100: Channel mode and related channel settings

"QAT Channel Mode" "QAT Channels" "Frontend Bandwidth" "Frontend Center Fre-
quency"

"Single" "2" 1 GHz 76.5 GHz

"Multiple" "8" 1 GHz 76.5 GHz

"Single" Sets for single channel mode at connected R&S QAT100 including
channel settings. In this mode you can map the sum of channels (e.g.
"QAT Σ1"in the channel mapping. For details, see the table above.

"Multiple" Sets for multiple channel modes at connected R&S QAT100 including
channel settings. In this mode you can map a defined radar channel
(e.g. "QAT B2") in the channel mapping. For details, see the table
above.

Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:MODE on page 470

QAT Channels
Displays the number of channels set at the connected R&S QAT100.
The number of channels depends on the "QAT Channel Mode", see Table 7-1.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:CHANnels? on page 468

Frontend Bandwidth
Displays the maximum processible bandwidth of the frontend in the current setting.
The frequency bandwidth depends on the configuration of the R&S AREG800A and
the configuration of the frontend included in the test setup. For more information, see
the data sheet.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>:BW
on page 475

Frontend Center Frequency
Sets the RF center frequency of the frontend which is used for downconversion.
The frontend center frequency and frequency range depend on the configuration of the
R&S AREG800A and the configuration of the frontend included in the test setup. For
more information, see the data sheet.
Note:
When using custom frontends, the IF center frequency instead of the RF center fre-
quency is configurable in the frontend configuration. The IF center frequency with the
sensor bandwidth is used for the cable correction, whereas the sensor frequency and
bandwidth is used for the antenna correction.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CENTer on page 479
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7.2.4  Geometry settings

Set the parameters to define the geometry between frontend and radar sensor.

The following figures show a positive angle in the direction of the arrow.

Frontend 1

Frontend 2
Frontend 3

1

3

Sensor

2

Figure 7-1: TRX/QAT/FE-type, custom frontend: Geometry parameter (horizontal orientation)

1 = Rotation frontend to sensor
2 = Air gap (reference point frontend center)
3 = Angle frontend to sensor (reference point frontend center)
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QA
T 

1

Sensor

2

3

1

Figure 7-2: QAT-type frontend: Geometry parameter (vertical orientation)

1 = Rotation frontend to sensor (for vertical orientation: Rotation = 0)
2 = Air gap (reference point QAT center)
3 = Angle frontend to sensor (reference point QAT center)

Access:

1. Select "Measurement Setup" tile > "Configuration" > "Frontend Configuration" tab.

2. Open the "Geometry" settings for the connected frontend.

● For TRX-type frontends, select "TRX" side tab > "Geometry".
● For QAT-type frontends, select "QAT" side tab > "Geometry".
● For FE-type frontends, select "FE" side tab > "Geometry".
● For custom frontends, select "CFE" side tab > "Geometry".

Settings:

Angle Frontend to Sensor........................................................................................... 137
Rotation Frontend to Sensor....................................................................................... 137
Orientation...................................................................................................................137
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Angle Frontend to Sensor
Sets the angle between frontend and radar sensor.
The reference point for the definition of the angle is the center of the frontend. The
angle describes the deviation of the position of the frontend from the 0° center position
of the field of view of the radar.
● Positive angle frontend to sensor: Counterclockwise deviation of frontend position

to center position.
● Negative angle frontend to sensor: clockwise deviation of frontend position to cen-

ter position.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:ATS on page 467

Rotation Frontend to Sensor
Sets the rotation angle between frontend and sensor.
The reference point for the definition of the angle is the center of the frontend. The
rotation describes the deviation of the position of the frontend from a 90° angle to the
direct line of sight of the sensor.
For TRX-type or custom frontends, this parameter has currently no impact since it is a
single sensor and no sensor array.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:RTS on page 479

Orientation
Requires a QAT-type frontend.
Selects the orientation parameter of the QAT in the test setup.
"Horizontal" The QAT is placed horizontally in the test setup.
"Vertical" The QAT is placed vertically in the test setup.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:OR on page 470
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7.2.5  FE settings

Access:

► Select "Frontend Config > FE".

The "FE" "ID = Fx" side-tab provides settings related to the connected FE-type
external frontend that is represented by its "ID". "x" can range from 1 to 4.

The following settings are individual for each connected FE-type frontend:
● Physical settings of the radar signal path between frontend and radar sensor
● Connection settings of the FE-type frontend
● Channel and frequency settings of the FE-type frontend

Settings:

External Instruments................................................................................................... 138
Cable Correction......................................................................................................... 139
Antenna Gain List........................................................................................................139
Geometry.................................................................................................................... 139
RX / TX Air Gap.......................................................................................................... 139
RX / TX Frontend........................................................................................................ 139
Frontend Configuration............................................................................................... 139
Connect.......................................................................................................................139
Frontend Bandwidth.................................................................................................... 139
Frontend Center Frequency........................................................................................ 140

External Instruments
Accesses a dialog to manage the connected external instruments.
See Chapter 7.2.7, "External instruments settings", on page 141.
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Cable Correction
Accesses a dialog to correct effects occurring in the connection cable such as delay
and attenuation. See Chapter 7.2.9, "Cable correction settings", on page 152.

Antenna Gain List
See "Antenna Gain List" on page 128.

Geometry
See Chapter 7.2.4, "Geometry settings", on page 135.

RX / TX Air Gap
Specifies the length of the gap between frontend and target.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>|CFE<ch>:RX|TX:OTA:
OFFSet on page 467

RX / TX Frontend
Selects the external frontend to connect to the R&S AREG800A.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>:RX|TX:EFRontend
on page 469

Frontend Configuration
Accesses the dialog to configure the external frontend settings.
See Chapter 7.2.8, "RX/TX external frontend settings", on page 143.

Connect
Triggers a connection procedure to connect the R&S AREG800A with the external
frontend in the network.
Also, the connection status is displayed as a message and via the icon  on the side-
tab.
"Disconnected"

Default setting with no network connection to the frontend.
"ConnectionError"

Network connection error.
"Connected" Valid network connection.
"UpdateError" Error during transfer of a changed setting for the frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:
CONNect|DISConnect on page 469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:STATus?
on page 470

Frontend Bandwidth
Displays the maximum processible bandwidth of the frontend in the current setting.
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The frequency bandwidth depends on the configuration of the R&S AREG800A and
the configuration of the frontend included in the test setup. For more information, see
the data sheet.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>:BW
on page 475

Frontend Center Frequency
Sets the RF center frequency of the frontend which is used for downconversion.
The frontend center frequency and frequency range depend on the configuration of the
R&S AREG800A and the configuration of the frontend included in the test setup. For
more information, see the data sheet.
Note:
When using custom frontends, the IF center frequency instead of the RF center fre-
quency is configurable in the frontend configuration. The IF center frequency with the
sensor bandwidth is used for the cable correction, whereas the sensor frequency and
bandwidth is used for the antenna correction.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CENTer on page 479

7.2.6  Custom frontend settings

Access:

► Select "Frontend Config > CFE".
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The "CFE" "ID = CFx" side-tab provides settings related to the connected custom
frontend that is represented by its "ID". "x" can range from 1 to 4.

The following settings are individual for each connected custom frontend:
● Physical settings of the radar signal path between frontend and radar sensor
● Channel and frequency settings of the custom frontend

Settings:

Cable Correction......................................................................................................... 141
Antenna Gain List........................................................................................................141
Geometry.................................................................................................................... 141
RX / TX Air Gap.......................................................................................................... 141
IF Center Frequency................................................................................................... 141

Cable Correction
Accesses a dialog to correct effects occurring in the connection cable such as delay
and attenuation. See Chapter 7.2.9, "Cable correction settings", on page 152.

Antenna Gain List
See "Antenna Gain List" on page 128.

Geometry
See Chapter 7.2.4, "Geometry settings", on page 135.

RX / TX Air Gap
See "RX / TX Air Gap" on page 139.

IF Center Frequency
See "Frontend Center Frequency" on page 130.

7.2.7  External instruments settings

Access:

1. Select "Frontend Config > FE".
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2. In the "Frontend Config" tab, click "External Instruments".

The "External Instruments" tab allows you to manage the list of available FE-type
external frontends.

Settings:

Add Instrument............................................................................................................142
Delete All.....................................................................................................................143
External instrument information.................................................................................. 143

Add Instrument
Opens a dialog to add an external frontend to the list of available instruments.

See "External instrument information" on page 143.
Remote command: 
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:ADD on page 480
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:ISELect
on page 480
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:ALIas on page 481
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:HOSTname
on page 481

Frontend configuration



Configuring the measurement setupR&S®AREG800A

143User Manual 1179.3615.02 ─ 06

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:DEVice[:ID]
on page 481
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:APPLy on page 482

Delete All
Removes all external frontends from the list of available instruments.
Remote command: 
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:CLEan on page 482

External instrument information
The table provides information about available FE-type frontends.
"Instrument Name"

Sets the name of the FE-type frontend (optional).
"Hostname or IP"

Displays the hostname or IP address of the FE-type frontend.
"Device ID" Displays the device ID of the FE-type frontend.
"Delete" Removes the selected FE-type frontend from the list.
Remote command: 
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:LIST? on page 482
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:REName on page 482
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:DELete on page 482

7.2.8  RX/TX external frontend settings

Requires: An FE-type frontend is connected.

Access:

1. Select "Frontend Config > FE".

2. In the "Frontend Config", click .

The "External Instruments" tab allows you to manage the list of available FE-type
external frontends.
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Settings:

● General settings....................................................................................................144
● Versions and options information..........................................................................147
● Attenuator settings................................................................................................ 148
● Network settings....................................................................................................149
● LO Config settings.................................................................................................150

7.2.8.1  General settings

Access:

► Select the "Settings" tab.

The "Settings" tab provides settings to configure reference frequency and connec-
tion settings for the connected external frontend, e.g., R&S FE44S.

Settings

Reference Frequency..................................................................................................144
Connection Mode........................................................................................................ 145
Frequency Band Configuration................................................................................... 145

└ Mode.............................................................................................................145
└ Frequency Band Config................................................................................ 145
└ Frequency Band x.........................................................................................146

Reference Frequency
Sets the frequency of the reference signal between R&S AREG800A and frontend.
The R&S AREG800A provides a reference frequency of 10 MHz.
To use the reference frequencies of 640 MHz or 1 GHz, provide the respective refer-
ence frequency from another source to the frontend and set the respective value on
the R&S AREG800A.
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Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
REFerence on page 484
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
REFerence:LIST? on page 484

Connection Mode
Sets the mode of the SSL control connection between R&S AREG800A and external
frontend.
There is one communication channel to control the external frontend meaning that one
instrument controls the external frontend exclusively.
Once the external frontend is locked, the R&S AREG800A firmware reads out external
frontend characteristics such as intermediate frequency (IF) and frequency bands.
"Auto" The R&S AREG800A locks the external frontend when the connec-

tion is established.
The R&S AREG800A unlocks external frontend when the external
frontend is disconnected.
"Auto" is the recommended setting for the R&S AREG800A.

"Lock" The external frontend is locked permanently. No other instrument can
take over control.

"Simultaneous RX/TX"
Not available for R&S AREG800A (grayed out).

Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CMODe
on page 485

Frequency Band Configuration
Provides frequency band parameters of the external frontend.

Mode ← Frequency Band Configuration
Sets the mode for frequency band configuration of the external frontend.
"Auto" Configures the frequency band automatically.
"Manual" You can configure the frequency band manually.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND:CONFig:MODE on page 485

Frequency Band Config ← Frequency Band Configuration
Define the intermediate frequency (input) range of the external frontend.
"IF Low" A lower intermediate frequency is used on the external frontend,

resulting in a lower output frequency at the R&S AREG800A.
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"IF High" Requires: "Mode > Manual"
A higher intermediate frequency is used on the external frontend,
resulting in a higher output frequency at the R&S AREG800A.
Since the intermediate frequency in this setting is higher than the IF
frequency range of the R&S AREG800A, this setting is not recom-
mended.

Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND:CONFig:SELect on page 485
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND:CONFig:CATalog? on page 486

Frequency Band x ← Frequency Band Configuration
Displays the ranges of the frequency bands of the upconverted frequency of the con-
nected external frontend.
For example, R&S FE44S has one frequency band from 24.00 GHz to 44.00 GHz.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND<ch>:LOWer? on page 486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND<ch>:UPPer? on page 486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND:COUNt? on page 486
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7.2.8.2  Versions and options information

Access:

► Select the "Version / Options" tab.

The "Versions / Options" tab displays information on the firmware and hardware of
the connected external frontend.

Settings:

Firmware..................................................................................................................... 147
Hardware Config......................................................................................................... 147

Firmware
Displays firmware information on the control server and control library of the external
frontend. The information is displayed in a table and consists of installed packages and
versions.
"Package" Comprises the frontend control server and frontend control library.
"Version" Denotes the version of the installed package.
Remote command: 
n.a.

Hardware Config
Displays hardware information of the hardware components of the external frontend.
The information is displayed in a table and consists of the component name, its part
number and serial number, and revision version.
"Assembly" Displays the assembly part name for hardware component.
"Part Number" Displays the part number for each hardware component.
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"Serial Number"
Displays the serial number for each hardware component.

"Revision" Displays the revision version for each hardware component.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:IDN? on page 486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:OPT? on page 487

7.2.8.3  Attenuator settings

Access:

► Select the "Attenuator" tab.

The "Attenuator" tab provides settings to configure attenuation.

Settings:

Mode........................................................................................................................... 148
Attenuation.................................................................................................................. 148

Mode
Sets the attenuator mode of the external frontend.
"Auto" Sets the attenuation value automatically.

The frontend control connection provides this attenuation value from
the connected external frontend. "Auto" is the recommended setting.

"Manual" Sets an attenuation value manually.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:AMODe
on page 487

Attenuation
Requires "Mode > Manual".
Sets the attenuation of the external frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:POWer:
ATTenuation on page 487
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7.2.8.4  Network settings

Access:

► Select the "Network" tab.

The tab provides settings necessary to configure network settings of the external
frontend.

Settings:

Address Mode............................................................................................................. 149
IP Address...................................................................................................................149
Subnet Mask............................................................................................................... 150
Apply........................................................................................................................... 150

Address Mode
Selects the mode for assigning the IP address of the external frontend.
"Auto (DHCP)" The external frontend obtains the IP address and subnet mask auto-

matically.
"Static" You can configure IP address and subnet mask manually.
Remote command: 
n.a.

IP Address
Displays the IP address of the external frontend in the network.
To assign an IP address manually, select "Address Mode" > "Static".
By default, the external frontend is configured to use dynamic TCP/IP configuration
and to obtain the whole address information automatically.
If the network does not support DHCP or the attempt does not succeed, the external
frontend tries to obtain the IP address via Zeroconf (APIPA) protocol. IP addresses
assigned via Zeroconf start with the number blocks 169.254.*.*.
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Note: An IP address that is assigned via the Zeroconf protocol although the network
requires an IP address assigned via the DHCP server can cause network connection
failures.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:IPADdress?
on page 488

Subnet Mask
Displays the bit group of the subnet in the host identifier.
To assign the subnet mask manually, select "Address Mode" > "Static".
Remote command: 
n.a.

Apply
Applies any changes to the network configuration of the external frontend.
If you change the network configuration, the connection is aborted and you must re-
establish a connection to the frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:NETWork
on page 488

7.2.8.5  LO Config settings

Access:

► Select the "LO Config" tab.

Settings

Mode........................................................................................................................... 150
Out State..................................................................................................................... 151
Mandatory LO IN Frequency.......................................................................................151
LO OUT Frequency.....................................................................................................151

Mode
Selects the LO input source for the connected external frontend.
INTernal Uses the internally generated LO signal.
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EXTernal Uses an externally supplied LO signal.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:
MODE on page 488

Out State
Activates or deactivates the LO output of the connected external frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:
OUTPut:STATe on page 489

Mandatory LO IN Frequency
Requires "Mode > External".
Displays the required frequency on the "LO In" connector of the connected external
frontend.
Set the displayed frequency value for the externally supplied LO signal correctly on the
external frequency source.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:
INPut:FREQuency? on page 489

LO OUT Frequency
Requires "Out State > On".
Displays the current frequency on the "LO Out" connector of the connected external
frontend.
Remote command: 
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:
OUTPut:FREQuency? on page 489
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7.2.9  Cable correction settings

Access:

► Specify the cable correction:

● For TRX-type frontends, select "TRX > Cable Correction"
● For QAT-type frontends, select "QAT > Cable Correction"
● For FE-type frontends, select "FE > Cable Correction"
● For custom frontends, select "CFE > Cable Correction"
● For a channel of a switching unit, select "Channel Config" > "Channel x"

The "Cable Correction" dialog opens and provides tabs for each connected fron-
tend or each channel of a connected switching unit.

Each tab provides cable correction settings related to the connected frontend. The tab
specifies the frontend type and frontend ID:
● For TRX-type frontends: "TRX" displays the frontend alias and "ID = Tx" displays

the frontend ID.

Configure cable correction settings for one channel in RX direction and in TX direc-
tion.

● For QAT-type frontends: "QAT" displays the frontend alias and "ID = Qx" displays
the frontend ID.
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Configure cable correction settings for two or eight channels in RX direction and in
TX direction. To set the number of QAT channels, see "QAT Channel Mode"
on page 133.

● For FE-type frontends: "FE" displays the frontend alias and "ID = Fx" displays the
frontend ID.

Configure cable correction settings for one channel in RX direction and in TX direc-
tion.

● For custom frontends: "CFE" displays the frontend alias and "ID = CFx" displays
the frontend ID.

Configure cable correction settings for one channel in RX direction and in TX direc-
tion.

● For a channel of a switching unit: "CH-x" displays the respective channel of the
switching unit.
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You can configure each channel of the switching unit separately.

Cable correction values for TX direction and RX direction are configured in a table, see
"Cable correction table" on page 154.

Settings:

Cable correction table................................................................................................. 154
└ Channel number........................................................................................... 155
└ Source...........................................................................................................155
└ User Delay.................................................................................................... 155
└ User Attenuation........................................................................................... 155
└ s2p File......................................................................................................... 156

Cable correction table
Provides cable correction settings for TX and RX directions in a table.
For an overview of cable correction settings, see Table 7-2.
Table 7-2: Cable correction and frontend type

Frontend /
Switching unit

Channel number "Source" "User Delay" "User Attenuation"

QAT-type 2 or 8 "User"

"s2p-File"

Fixed value

Not available

Fixed value

From s2p-file

TRX-type 1 "User"

"s2p-File"

"Factory"

Fixed value

Not available

Not available

Fixed value

From s2p-file

Not available
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Frontend /
Switching unit

Channel number "Source" "User Delay" "User Attenuation"

FE-type

Custom

1 "User"

"s2p-File"

Fixed value

Not available

Fixed value

From s2p-file

Channel x 1 "User"

"s2p-File"

Fixed value

Not available

Fixed value

From s2p-file

Channel number ← Cable correction table
Displays the channel number.
● For TRX-type frontends, one channel only.
● For QAT-type frontends, two or eight channels.
● For FE-type frontends, one channel only.
● For custom frontends, one channel only.
● For a switching unit, one channel only.
Remote command: 
n.a.

Source ← Cable correction table
Selects the source for cable correction data.
"User" Sets user-defined cable correction data, i.e. fixed values for delay

and attenuation.
"s2p-File" Selects cable correction data from a file. Files containing correction

data have the extension *.s2p.

"Factory" For TRX-type frontends only.
Selects cable correction data for the TRX frontend from factory speci-
fication.

Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
MODE on page 475
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
MODE on page 476

User Delay ← Cable correction table
Requires "Source > User".
Sets a user-defined delay value.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
USER:DELay on page 477
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
USER:DELay on page 477

User Attenuation ← Cable correction table
Requires "Source > User" or "Source > s2p-File".
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Sets a user-defined attenuation value.
Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
USER:ATTenuation on page 476
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
USER:ATTenuation on page 477

s2p File ← Cable correction table
Requires "Source > S2P".
Opens a standard file-select dialog to load cable correction data from a file. Loaded
can be files with file extension *.s2p.

Remote command: 
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
USER:FILE on page 478
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
USER:FILE on page 478

7.3  Sensor/DUT configuration

Access:

► Select "Measurement Setup > Configuration > Sensor/DUT Config".

The "Sensor/DUT Config" tab of the "Measurement Setup" dialog opens.

Settings:

● Overview............................................................................................................... 157
● Sensor settings..................................................................................................... 158

Sensor/DUT configuration
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7.3.1  Overview

Access:

► Select "Measurement Setup > Configuration > Sensor/DUT Config > Overview".

The "Overview" side-tab provides a list of radar sensors included in the test setup.
You can configure individual characteristics of up to eight radar sensors. Each
radar sensor has a dedicated configuration in the corresponding side tab.

Settings:

ID.................................................................................................................................157
Alias............................................................................................................................ 157
Remove Sensor.......................................................................................................... 158
Add Sensor................................................................................................................. 158

ID
Displays the identification name of the radar sensor, e.g. "S1" for the radar sensor
included first in the test setup.
You can include up to eight radar sensors.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ID on page 493

Alias
Sets the alias of the radar sensor.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ALIas on page 491

Sensor/DUT configuration
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Remove Sensor
Removes the configuration of the radar sensor from the list.
Also, the corresponding side tab labeled "Sensor" "ID = Sx" is removed. "x" represents
the number of the radar sensor.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:RMV on page 493

Add Sensor
Adds a configuration for a radar sensor.
A line with contiguous numeration is added below the already listed radar sensors.
"Alias > Sensor" is assigned automatically. Also, a new side tab labeled "Sensor" "ID =
Sx" appears to the right of the dialog. "x" represents the number of the added radar
sensor.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ADD on page 490
[:SOURce<hw>]:AREGenerator:LAST:SENSor? on page 456

7.3.2  Sensor settings

Access:

► Select "Sensor/DUT Config > Sensor".

The "Sensor" "ID = Sx" side-tab provides settings related to the radar sensor that is
represented by its "ID". "x" can range from 1 to 8.
● Center frequency and frequency bandwidth of the output RF signal
● Relative distance and relative angle of the radar sensor relative to the signal

source

Settings:

Center Frequency....................................................................................................... 159
Bandwidth................................................................................................................... 159
Signal Crest Factor..................................................................................................... 159
Sensor to Origin.......................................................................................................... 159

Sensor/DUT configuration
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└ Relative Distance..........................................................................................159
└ Relative Angle...............................................................................................159

Dynamic Mode ID........................................................................................................159

Center Frequency
Sets the center frequency for the radar sensor.
Set it according to the center frequency of the radar sensor included in the test setup.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:CENTer on page 492

Bandwidth
Sets the bandwidth for the radar sensor.
Set it according to the bandwidth of the radar sensor included in the test setup.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:BW on page 491

Signal Crest Factor
Sets the crest factor for the signal.
The crest factor gives the difference in level between the peak level and RMS level
value in dB.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:CFACtor on page 491

Sensor to Origin
Configures relative distance and relative angle of radar sensor to origin.

Relative Distance ← Sensor to Origin
Sets the relative distance between radar sensor and origin.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:DISTance on page 492

Relative Angle ← Sensor to Origin
Sets the relative angle between radar sensor and origin.
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ANGLe on page 491

Dynamic Mode ID
Requires: "Operation Setup" > "Mode > Dynamic".
Sets the ID of the radar sensor according to the definition in the used protocol, e.g. in a
ZMQ OSI HIL protocol.
The mapping is defined in the object list of the used protocol, e.g. the "sensor_id" field
in the osi3::sensorData struct for all OSI protocols.
To use this ID for object mapping, set "Operation Setup" > "Settings" > "Object Refer-
ence > Mapped Sensor".
Remote command: 
[:SOURce<hw>]:AREGenerator:SENSor<ch>:DYNamic:ID on page 492

Sensor/DUT configuration
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7.4  Channel configuration

Access:

► Select "Measurement Setup > Configuration > Channel Config".

The "Channel Config" tab of the "Measurement Setup" dialog opens.

Settings:

● Overview............................................................................................................... 160
● Channel settings................................................................................................... 162

7.4.1  Overview

Access:

► Select "Measurement Setup > Configuration > Channel Config > Overview".

The "Overview" side-tab provides all available channels of the R&S AREG800A.
You can configure the state and alias for eight channels individually.

Settings:

ID.................................................................................................................................161
State............................................................................................................................161
Alias/Channel.............................................................................................................. 161
Channel Bandwidth..................................................................................................... 161

Channel configuration
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ID
Displays the identification name of the radar channel.
Displayed are eight radar channels that are designated "A1" to "D2". For details, see
"Channel x" on page 104.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:ID? on page 459

State
Activates the radar channel.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel[:STATe] on page 459

Alias/Channel
Sets the alias of the radar channel that is the channel name.
Also, displays this channel name in the "Channel Mapping" table in the "Channel" col-
umn.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:NAME on page 459

Channel Bandwidth
Displays the channel bandwidth.
The displayed bandwidths depend on the installed options, see Table 4-1.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:BW on page 457

Channel configuration
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7.4.2  Channel settings

Access:

► Select "Channel Config > Channel x".

The "Channel x" side-tab provides settings related to the radar channel. "x" can
range from 1 to 8.
● Optimization mode
● Intermediate frequency of the radar signal

Settings:

Optimization Mode...................................................................................................... 162
System Alignment....................................................................................................... 163
Nominal Input Gain..................................................................................................... 163
Relative Input Level.....................................................................................................163
Switching Unit............................................................................................................. 164

└ Channel RX/Channel TX...............................................................................164
└ Cable Correction...........................................................................................164

Optimization Mode
Selects the optimization mode.
For information on the I/Q modulation performance in any of the modes, see the data
sheet.
"Fast" Fast optimization by compensation for I/Q skew.

This mode is suitable in time sensitive environments and narrowband
signal.

Channel configuration
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"High Quality" Enables an optimization by compensation for I/Q skew and frequency
response correction.
This mode generates a flat signal over a large bandwidth but requires
longer setting time and leads to signal interruption.

Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:OPTimization:MODE on page 459

System Alignment
Aligns the system.
A system can be a pre-configured system of a R&S AREG800A with, e.g. frontends,
sensors, etc.
For systems without R&S AREG8-B97 and R&S AREG8-B98 factory alignment, end of
line testing and shipment for the frontend and R&S AREG800A is done separately.
With the R&S AREG8-B97 and R&S AREG8-B98, the alignment is done for frontend
and R&S AREG800A together, aligned and tested as ordered.

"Off" Default state. No option installed. System alignment not used.
Map any frontend or sensor to any channel.

"On" Requires R&S AREG8-B97.
System alignment is executed.
All frontends included in the test setup are mapped according to the
factory alignment.

"Table" Requires R&S AREG8-B98.
System alignment is executed.
The same mapping as for R&S AREG8-B97 is done. In addition, you
can define a table of certain center frequencies and bandwidths for
an additional alignment procedure which has an increased level line-
arity. The definitions in the table limit the possible settings for the
radar sensor settings in the "Sensor/DUT Config" dialog. The frontend
center frequency is set read-only and selected according to the con-
figured radar sensor frequency.

Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:SYSTem:ALIGnment on page 460

Nominal Input Gain
Sets a value to adjust the input gain of the channel manually.
The R&S AREG800A sets the nominal input gain automatically by using the "adjust
level" function in the channel mapping and displays the value in this parameter. You
can also set the input gain manually, for example to restore the value.
By using the save/recall function of the R&S AREG800A, the value is available after a
restart.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:INPut:NOMGain on page 460

Relative Input Level
Displays the actual input level of the analog to digital converter of the R&S AREG800A
in relation to full scale.

Channel configuration
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This value is the maximum measured during the defined "Observation Time for Peak
Detection" set in the "Adjust Level Settings". If the value is not steady enough, we rec-
ommend prolonging the observation time.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:INPut:RELLevel? on page 460

Switching Unit
Requires "Operation Setup" > "Operation Setup > Use Switching Unit".
Configures the channel connection between the R&S AREG800A and the switching
unit in the test setup.

Channel RX/Channel TX ← Switching Unit
Selects the switching unit connector (relay) of the switching unit connected to the
RX/TX channel of the R&S AREG800A.
Remote command: 
[:SOURce<hw>]:AREGenerator:SWUNit:RX on page 461
[:SOURce<hw>]:AREGenerator:SWUNit:TX on page 461
[:SOURce<hw>]:AREGenerator:SWUNit:RELays:CATalog? on page 461

Cable Correction ← Switching Unit
Accesses a dialog to correct effects occurring in the connection cable such as delay
and attenuation. See Chapter 7.2.9, "Cable correction settings", on page 152.

Channel configuration
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7.5  Channel mapping

Access:

► Select "Measurement Setup > Configuration > Channel Mapping".

The "Channel Mapping" tab of the "Measurement Setup" dialog opens.
The tab provides settings for channel mapping of up to eight radar channels in a
table. Also, it provides settings to adjust channel power levels and it provides
access to further settings to adjust channel power levels.

Settings:

● Channel Mapping settings.....................................................................................166
● Adjust Level settings............................................................................................. 168

Channel mapping
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7.5.1  Channel Mapping settings

Access:

► Select "Measurement Setup > Configuration > Channel Mapping".

The "Channel Mapping" tab of the "Measurement Setup" dialog opens.
The tab provides settings for channel mapping of up to eight radar channels in a
table, see "Channel mapping table" on page 166.

Settings:

Channel mapping table............................................................................................... 166
└ ID.................................................................................................................. 167
└ Alias/Channel................................................................................................167
└ Show Connector........................................................................................... 167
└ Switching Unit Con........................................................................................167
└ Frontend........................................................................................................167
└ Sensor/DUT.................................................................................................. 168
└ Adjust Level.................................................................................................. 168

Adjust All Levels..........................................................................................................168
Adjust Level Settings...................................................................................................168

Channel mapping table
Provides settings for channel mapping with up to eight radar channels, i.e. eight IF
paths.
Displayed are the channel ID and channel name for each radar channel. You can
check the location of the output connectors of the radar channel by clicking "Show
Connector". Also, you can select the mapping frontend and the mapping sensor, adjust
levels of each radar channel individually or adjust all radar channel levels at the same
time.

Channel mapping



Configuring the measurement setupR&S®AREG800A

167User Manual 1179.3615.02 ─ 06

ID ← Channel mapping table
Displays the identification name of the radar channel.
Displayed are eight radar channels that are designated "A1" to "D2". For details, see
"Channel x" on page 104.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:ID? on page 459

Alias/Channel ← Channel mapping table
Sets the alias of the radar channel that is the channel name.
Also, displays this channel name in the "Channel Mapping" table in the "Channel" col-
umn.
Remote command: 
[:SOURce<hw>]:AREGenerator:CHANnel:NAME on page 459

Show Connector ← Channel mapping table
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Switching Unit Con. ← Channel mapping table
Requires "Operation Setup" > "Operation Setup > Use Switching Unit".
Displays the channel RX / channel TX configuration between the switching unit and the
R&S AREG800A.

Remote command: 
[:SOURce<hw>]:AREGenerator:SWUNit:MAPPing<ch>[:SUBChannel<st>]:
CONFig? on page 464

Frontend ← Channel mapping table
Selects the external frontend and its channel that are mapped to the radar channel.

Channel mapping
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Remote command: 
[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:FE
on page 463

Sensor/DUT ← Channel mapping table
Selects the sensor that is mapped to the radar channel.
Remote command: 
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:SENSor on page 464
[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:SENSor
on page 464

Adjust Level ← Channel mapping table
Adjusts the input attenuation of the R&S AREG800A for the applied signal automati-
cally for the selected output channel. This adjustment maximizes the dynamic range for
the simulated objects.
Remote command: 
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel on page 462
[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:ADJust:
LEVel on page 462

Adjust All Levels
Adjusts the input attenuation of the R&S AREG800A for the applied signal automati-
cally for all output channels. This adjustment maximizes the dynamic range for the
simulated objects.
Remote command: 
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:ALL on page 462

Adjust Level Settings
Accesses a dialog to adjust level settings. See Chapter 7.5.2, "Adjust Level settings",
on page 168.

7.5.2  Adjust Level settings

Access:

► Select "Measurement Setup > Configuration > Channel Mapping > Adjust Level
Settings".

The "Adjust Level Settings" dialog opens and provides further settings for the auto-
matic adjustment of the input attenuation for the applied signal.

Channel mapping
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Adjusting the power level

The R&S AREG800A adjusts power levels correctly, if your test setup and configura-
tion meets the following requirements:
● Input signal is active
● Sensor frequency and bandwidth settings are correct
● Frontend frequency setting is correct
● Channel-mapping configuration is correct

Set the adjust level to prevent clipping for the digital IF channels of the R&S AREG8-
B9 and to maximize the dynamic range.

In the "Radar Power" tab, the message "Input power above upper limit" on the respec-
tive channel indicates clipping.

Use the adjust level function in the following events:
● After rebooting the R&S AREG800A
● After changing the frequency or bandwidth of the input signal
● When a higher input power is applied (i.e. the change of input power is higher than

the "Digital Headroom" adjustment)
● When the input power is low (SNR depending on digital saturation)

Settings:

Digital Headroom........................................................................................................ 169
Observation Time for Peak Detection......................................................................... 169

Digital Headroom
Sets the digital headroom of the channel output power.
Recommendation:
● Set a value higher than the change of input power during the measurement runtime
Remote command: 
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:DIGHeadroom
on page 462

Observation Time for Peak Detection
Sets the observation to determine the peaks of the channel output power level.
Observes the signal peak power for multiple detection cycles.
Recommendation:
● Set the value higher than a single sweep on the sensor (+ off time)
Remote command: 
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:OTIMe
on page 462

Channel mapping
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7.6  Switching unit configuration

Requires "Operation Setup" > "Operation Setup > Use Switching Unit".

Access:

► Select "Measurement Setup > Configuration > Switching Unit Config".

The "Switching Unit Config" tab of the "Measurement Setup" dialog opens.

Settings:

IP / Hostname............................................................................................................. 170
Connect/Disconnect.................................................................................................... 170

IP / Hostname
Sets the IP address or hostname of the connected switching unit in the test setup.
Remote command: 
[:SOURce<hw>]:AREGenerator:SWUNit:HOSTname on page 490

Connect/Disconnect
Triggers connection to the switching unit.
The R&S AREG800A connects or disconnects the switching unit as configured by its
IP address or hostname.
Remote command: 
[:SOURce<hw>]:AREGenerator:SWUNit:CONNect|DISConnect on page 490
[:SOURce<hw>]:AREGenerator:SWUNit:STATus? on page 490

7.7  Reference oscillator

The R&S AREG800A is equipped with an internal reference oscillator that generates a
reference frequency of 10 MHz. It is used as internal reference source for the synthe-
sizer.

The reference oscillator settings are not affected by an instrument preset ([Preset] key
or *RST) and the "Save/Recall" function. They are reset only by factory preset.

Reference oscillator
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7.7.1  Required options

R&S AREG800A base unit

For more information, see data sheet.

7.7.2  Reference frequency settings

Access:

► Select "Measurement Setup" > "Reference Frequency".

In the "Reference Frequency" tab, you can select the reference frequency signal
source and the frequency and synchronization bandwidth mode of an external ref-
erence signal.

The remote commands required to define these settings are described in Chap-
ter 12.16.10, "SOURce:ROSCillator subsystem", on page 505.

Settings:

Set to Default.............................................................................................................. 171
Source.........................................................................................................................172
Show Connector..........................................................................................................172
Deactivate RF Output (if external reference is missing)..............................................172
External Reference Frequency................................................................................... 172
Synchronization Bandwidth.........................................................................................172

Set to Default
Calls the default settings.

Reference oscillator
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Remote command: 
[:SOURce]:ROSCillator:PRESet on page 506

Source
Selects the reference frequency source.
"Internal" Uses the internal reference oscillator, either with calibrated or a user-

defined Adjustment Value.
Note: The internal reference frequency automatically uses Synchroni-
zation Bandwidth > Narrow. Thus, if you preset this parameter, or set
the reference source from "External" to "Internal" manually, the
R&S AREG800A sets the bandwidth to "Narrow".

"External" Uses an external reference signal.
Note: If the external reference is missing, the R&S AREG800A
issues a warning message and indicates the icon  (external refer-
ence missing).
To set the frequency of the external reference, see "External Refer-
ence Frequency" on page 172.

Remote command: 
[:SOURce]:ROSCillator:SOURce on page 506

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Deactivate RF Output (if external reference is missing)
Turns off the RF output when the external reference signal is selected, but no signal is
supplied.
This function prevents that no improper RF signal due to the missing external refer-
ence signal is used for measurements. A message indicates that the RF output is
deactivated.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe] on page 507

External Reference Frequency
Selects the frequency of the external reference signal.
Set the reference output frequency with the parameters in the Reference output set-
tings dialog.
"10 MHz" Selects 10 MHz for the external reference frequency signal.

"3.2 GHz" Grayed out (only for service).

Remote command: 
[:SOURce]:ROSCillator:EXTernal:FREQuency on page 507

Synchronization Bandwidth
Selects the synchronization bandwidth for an external reference signal, set with Source
> External.

Reference oscillator
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Note: If you preset or set the reference source from "External" to "Internal", the syn-
chronization bandwidth is reset to "Narrow".
"Narrow" The internal reference oscillator is synchronized to the external signal

with narrow bandwidth.
This setting is recommended if the phase noise of the external signal
is worse than the phase noise of the internal OCXO.

"Wide" Synchronizes the internal oscillator to the external signal with the
maximum possible bandwidth.
This mode is the recommended standard mode and for precise refer-
ence sources of high spectral purity.
Note: If the frequency of the external reference signal is outside the
locking range of the internal reference oscillator, spurs due to the dif-
ference of the internal and external reference frequency are gener-
ated in the reference PLL.
The R&S AREG800A issues an error message.
For more information, see data sheet.

Remote command: 
[:SOURce]:ROSCillator:EXTernal:SBANdwidth on page 507

7.7.3  Reference output settings

Access:

1. Select "Measurement Setup" > "Reference Frequency".

2. Select "Reference Output".

In the "Reference Output" tab, you can set the reference frequency value at the
output connectors.
As a result of parameter dependencies, "Preset This Parameter" sometimes does
not affect output dialogs.
The remote commands required to define these settings are described in Chap-
ter 12.16.10, "SOURce:ROSCillator subsystem", on page 505.

Settings:

Reference Output........................................................................................................173
Show Connector..........................................................................................................174

Reference Output
Selects the frequency reference output signal for downstream instruments.
"Off" Deactivates the reference signal output.

Reference oscillator
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"10 MHz" Requires "Reference Frequency > External Reference Frequency >
10 MHz".
Derives a signal with 10 MHz frequency from the internal reference
oscillator and provides this signal at the output.

Remote command: 
[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE on page 508

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

7.7.4  Adjustment settings

Access:

1. Select "Measurement Setup" > "Reference Frequency".

2. Select "Adjustment".

Settings:

Adjustment Active....................................................................................................... 174
Adjustment Value........................................................................................................ 174

Adjustment Active
Selects the adjustment mode.
"Off" Uses the calibrated internal reference frequency.
"On" Allows you to apply a deviation to the internal reference frequency,

according to your requirements.
Enter the value in the Adjustment Value field.

Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] on page 508

Adjustment Value
Sets a user-defined adjustment value for the internal reference frequency. This value
takes effect when it is activated with Adjustment Active.
● "0" represents the calibrated state.
● The setting range depends on the reference oscillator type and its factory calibra-

tion value.
Note:
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.

Reference oscillator
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Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue on page 508

7.8  Using power sensors

The R&S AREG800A works with any of the R&S NRP power sensors and thus sup-
ports various application tasks. Using power sensors, you can for example determine
attenuation characteristics of downstream equipment or cables. You can use the mea-
sured values to compensate the losses with internal control functions or with an exter-
nal control circuit in real time.

For information on the various possibilities of interoperability between
Rohde & Schwarz power sensors and Rohde & Schwarz signal generators, see the
application note 1GP141.

R&S NRP power sensors are highly accurate standalone measuring devices, suitable
for a wide range of applications. The power sensors communicate directly with the sig-
nal generator, calculate the average or peak power internally, include S-parameter cor-
rection and return the measurement results to the generator.

The R&S AREG800A supports up to four power sensors, allowing up to four power
measurements simultaneously.

Check the firmware version of the R&S NRP sensors regularly. Update the firmware, if
necessary.
For updates, see the Rohde & Schwarz website http://www.rohde-schwarz.com in sec-
tion "Power Meters & Voltmeters".

For working with power sensors, see:
● Connecting R&S NRP power sensors to the R&S AREG800A:

Provides an overview on the connectivity options, including connectors, connection
options and the required accessories.

● Chapter 7.8.3, "NRP power viewer", on page 179
Enables you to measure and monitor the RF output power or a user-defined signal
source.

● Chapter 7.8.4, "NRP sensor configuration", on page 179
Parameter settings of the specific R&S NRP power sensor.

● Chapter 7.8.5, "NRP sensor mapping", on page 184.
The firmware application lists all available power sensors, which are connected to
the instrument, or in the LAN. A scan function detects the power sensors in the net-
work. You can assign up to four sensors simultaneously.

7.8.1  About

The R&S AREG800A can perform up to four power measurements simultaneously.

Using power sensors

https://www.rohde/-schwarz.com/appnote/1GP141
http://www.rohde-schwarz.com
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Depending on the signal characteristic (CW, AM, pulsed, etc.) or the parameter to be
measured (average, peak, etc.) a suitable R&S power sensor must be used.

About the measuring principle, averaging filter, filter length, and achieving stable
results

A sensor measures the average or peak RF power of the source continuously. The
measurement results are displayed in the "NRP Power Viewer" dialog.

The power viewer function uses averaging filters for getting a stable readout.

Measurement results could be interfered, for instance, by too much noise in your
setup, by a bad suppression of harmonics or non-harmonics or when you reach the
sensitivity level of your power sensor.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time win-
dows. This approach is referred as a two-step averaging process.

The factor of 2 in the formula arises because the output signals from the microwave
detector are chopped at the same rate as the time windows to suppress low-frequency
noise. An independent measured value can only be obtained from two consecutive val-
ues.

The variable N in the formula indicates the filter length. The filter length then directly
influences the measurement time. The filter length can be selected automatically or it
can be manually set to a fixed value.

Depending on the R&S NRP power sensor type, the manual setting of the filter length
varies in resolution:
● Resolution = 1 for the R&S NRPxx power sensor family
● Resolution = 2n for R&S NRP-Zxx power sensors, with n = 1 to 16

Follow the following general recommendation to find out the optimum filter length:
● Always start a measurement in auto mode ("Filter > Auto").

Check if the measurement results are sufficient.
● If the power is not constant, select the filter length manually ("Filter > User").

Trigger the "Auto Once" function to search for the optimum filter length for the cur-
rent measurement conditions.
The estimated value is indicated as filter length.

● If the target measurement accuracy value is known, select "Filter > Fixed Noise".
The averaging factor is selected automatically and so that the sensor's intrinsic
noise (two standard deviations) does not exceed the specified noise content.

● Different sensor types achieve the same filtering result with different filter and time
window lengths.
The time window length depends on the sensor type:
– For most sensors, it is fixed to 20 ms.
– For the R&S NRP-Z81 sensor, it is 10 μs.

The R&S NRP-Z81 uses filter length that is 1000 times larger than the filter
length for other sensors.
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About zeroing

Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:
● During warm up after switching on or connecting the instrument
● After a substantial change of the ambient temperature
● After fastening the power sensor module to an RF connector at high temperature
● After several hours of operation
● When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.
● Switch off the RF power source for zeroing, but do not disconnect it from the power

sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Related settings and functions

● Measurements-related settings, like results, filter, filter length:
Chapter 7.8.3.1, "NRP power viewer settings", on page 179

● Software version of the connected power sensor:
:SENSe<ch>[:POWer]:TYPE? on page 522

● Acquisition of level correction data:

Additional information

See the Rohde & Schwarz website http://www.rohde-schwarz.com, section "Power
Meters & Voltmeters" for:
● R&S NRP power sensor manual.
● Information on the R&S NRP-Z5 sensor hub and the available accessories.
● Sensor software updates.

7.8.2  Connecting R&S NRP power sensors to the R&S AREG800A

R&S NRP sensors are connected to the R&S AREG800A in the following ways:
● Connection to the Sensor connector

– R&S NRP-ZK6 (six-pole interface cable) for R&S NRPxx power sensors
– No additional cable for R&S NRP-Zxx power sensors (cable is fixed on the sen-

sor)

Using power sensors
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● Connection to the USB connector
Requires the following cables, depending on the used sensor type:
– R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors
– R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S

NRP-Zxx family
● Connection via R&S NRP-Z5 sensor hub

The R&S NRP-Z5 USB sensor hub (high-speed USB 2.0) can host up to 4 R&S
NRP sensors. It provides simultaneous internal and external triggering of all con-
nected sensors.
Requires additional cables, depending on the used output connector of the hub.
Choose one of the following:
– Short extension cable R&S NRP-Z2 for connection to the sensor connector.

This six-pole connection provides the external trigger capability.
– Standard USB cable (USB type A to USB type B) to any USB type A connector

of the R&S AREG800A. This connection does not support external triggering.
● Connection via USB hub with external power supply unit

Requires the following cables, depending on the used sensor type:
– R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors
– R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S

NRP-Zxx family
● Connection via LAN for R&S NRPxxxSN power sensors

Using the Ethernet interface requires PoE (Power over Ethernet) to provide the
electrical power.
To establish the connection, you can use:
– A PoE Ethernet switch, e.g. R&S NRP-ZAP1 and an RJ-45 Ethernet cable.
– A PoE injector and an RJ-45 Ethernet cable.

Detection and mapping

The R&S AREG800A automatically detects a connected R&S NRP power sensor and
indicates it in the "NRP Power Viewer" and "NRP Sensor Mapping" dialogs.

By default, detected sensors are indicated as follows:
● A sensor connected at the Sensor socket is assigned as "Sensor 1".

If no sensor is connected to this socket, channel 1 remains unassigned.
● Sensors 2 to 4 are assigned to the sensors at the USB connectors, according to

their sequence of connection.

On connection, the R&S AREG800A immediately starts the measurement of a detec-
ted R&S NRP power sensor. If you perform an instrument preset ([Preset] key or
*RST), the R&S AREG800A stops the measurements. The connection and the map-
ping of the power sensors remain, the measurements must be restarted.
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7.8.3  NRP power viewer

The R&S AREG800A features the power viewer function for measuring or monitoring
signals with R&S NRP power sensors.

7.8.3.1  NRP power viewer settings

Access:

► Select "Power Sensors" > "NRP Power Viewer".

The "Power Viewer" tab lists the mapped R&S NRP power sensors with the mea-
sured parameter mode and the current readings. The "Config" button leads you to
the configuration dialog to set the parameters for each sensor.

The remote commands required to define these settings are described in Chap-
ter 12.17, "SENSe, READ, INITiate and SLISt subsystems", on page 509, including
the triggering of the measurement and the retrieval of measurement results.

Settings

Config..........................................................................................................................179

Config
Accesses the Chapter 7.8.4, "NRP sensor configuration", on page 179 dialog.

7.8.4  NRP sensor configuration

Access:

1. Select ""Measurement Setup"".

2. Select "Power Sensors" > "NRP Sensor Configuration".
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In this dialog you can configure the parameters for each mapped R&S NRP power
sensor in separate tabs.

The remote commands required to define these settings are described in Chap-
ter 12.17, "SENSe, READ, INITiate and SLISt subsystems", on page 509, including
the triggering of the measurement and the retrieval of measurement results.

Settings:

Sensor type and serial number................................................................................... 181
Level (Peak) / Level (Average)....................................................................................181
State............................................................................................................................181
Zero.............................................................................................................................181
Display........................................................................................................................ 181

└ Permanent.................................................................................................... 181
└ Display.......................................................................................................... 181

Use Frequency Of....................................................................................................... 182
Frequency................................................................................................................... 182
Level Offset State,Level Offset....................................................................................182
Filter............................................................................................................................ 182
Filter Length................................................................................................................ 183
Auto Once................................................................................................................... 183
Noise/Signal Ratio.......................................................................................................183
Timeout....................................................................................................................... 183
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Default Aperture Time................................................................................................. 183
Aperture Time..............................................................................................................183
S-Parameter................................................................................................................184
Enable Logging........................................................................................................... 184

Sensor type and serial number
The side tab label indicates type and serial number of an R&S NRP power sensor and
its mapping index.
The Level (Peak) / Level (Average) values display the current readings of the sensor.
Remote command: 
:SENSe<ch>[:POWer]:TYPE? on page 522
:SENSe<ch>[:POWer]:SNUMber? on page 521

Level (Peak) / Level (Average)
Indicates the measured peak or average level value.
You can also change the unit for the results display: Watt, dBm or dBμV.

Note: Peak level measurements are provided if the power sensor supports this feature.
Remote command: 
:READ<ch>[:POWer]? on page 515
:SENSe<ch>:UNIT[:POWer] on page 515

State
Enables level measurement of the R&S NRP power sensor.
Remote command: 
:INITiate<hw>[:POWer]:CONTinuous on page 514
To query the availability of a sensor at a given connector, use the command :
SENSe<ch>[:POWer]:STATus[:DEVice]? on page 522.

Zero
Activates the auto zeroing.
For details, see "About zeroing" on page 177.
Remote command: 
:SENSe<ch>[:POWer]:ZERO on page 523

Display
Sets the display mode for power readings.

Permanent ← Display
Enables the display of the power sensor with the currently measured value in the sta-
tus bar of the home screen.
You can activate the permanent display for several sensors.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe on page 517

Display ← Display
Sets the display of results on mean or peak power.
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Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority on page 517

Use Frequency Of
Selects the source for measurement.
"User" Sets a user defined frequency.

Example: 
If you have a frequency converting device between the generator and
the DUT. If the frequency converter doubles the frequency, you can
set twice the frequency in the R&S AREG800A. The R&S power sen-
sor considers this RF frequency setting.

Set the parameter Frequency to the measurement's frequency.
Remote command: 
:SENSe<ch>[:POWer]:SOURce on page 522

Frequency
Defines the frequency value if "Source > User" is used.
Remote command: 
:SENSe<ch>[:POWer]:FREQuency on page 520

Level Offset State,Level Offset
Activates and defines a level offset which is considered in the power measurement
result. The level offset value is always expressed in dB, irrespective of the display of
the measurement result.
This function allows you to consider, for example, an attenuator in the signal path.
Remote command: 
:SENSe<ch>[:POWer]:OFFSet on page 521
:SENSe<ch>[:POWer]:OFFSet:STATe on page 521

Filter
Selects the way the length of the used filter is defined.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 176.
"Auto" Selects the filter length automatically and adjusts it to the measured

value. The value is indicated with the parameter Filter Length.
When high output power is applied, the filter length and therefore the
measurement time can be short.
When low output power is applied, the filter length and therefore the
measurement time is increased which reduces the considered noise
content in your measurement.

"User" The filter length is defined manually, with the parameter Filter Length.
As the filter length works as a multiplier for the time window, constant
filter length results in a constant measurement time.
Values 1 and 2N are allowed.
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"Fixed Noise" The averaging factor is taken automatically in accordance to the
value Noise/Signal Ratio. Thus, the sensor's intrinsic noise (2 stan-
dard deviations) does not exceed the specified noise content.
To avoid long measurement times when the power is too low, set a
Timeout.
Timeout is the maximum acceptable measurement time which limits
the averaging factor and therefore leads to a more unstable readout.

Remote command: 
:SENSe<ch>[:POWer]:FILTer:TYPE on page 520

Filter Length
Sets or indicates the filter length, depending on the selected filter mode.
● "Filter > Auto" indicates the automatically adjusted filter length.
● "Filter > User" enables you to set the filter length manually.
● "Filter > Fixed Noise" hides the setting parameter.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO? on page 518
:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] on page 518

Auto Once
Searches the optimum filter length for the current measurement conditions. The result
is indicated with the parameter Filter Length.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 176.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:SONCe on page 519

Noise/Signal Ratio
For Filter > Fixed Noise, sets the noise content.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio on page 519

Timeout
For "Filter > Fixed Noise", sets a time limit for the averaging process.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe on page 519

Default Aperture Time
The sensor default setting is sufficient. Disable this parameter to specify a user-defined
aperture time per sensor, if, for example, the readings vary.
To obtain stable readings, set the Aperture Time exactly to one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:DEFault:STATe on page 516

Aperture Time
If "Use Default Aperture Time > Off", defines the acquisition time per sensor.
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For example, to obtain a sufficient low average value, set the aperture time exactly to
one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:TIMe on page 516

S-Parameter
S-Parameter correction is used to mathematically shift the reference plane to the DUT
by considering the S-parameters for any components connected upstream of the sen-
sor.
The S-Parameter table can be changed with the S-Parameters tool, provided as part of
the free R&S NRP Toolkit software. For more information, refer to the manual of the
connected R&S NRP power sensor.
Remote command: 
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe on page 517
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST? on page 517
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect on page 516

Enable Logging
Activates recording of R&S NRP power sensor readings in a log file.
There is 1 log file per sensor. The log files are created automatically and filled in con-
tinuously. They are text files with predefined filename SensLog<n>.txt, where <n>
indicates the connected sensor. Log files are stored on the internal memory, in the
directory /var/user/SensorLogging.

Each log file contains the measured value (2 readings when you work with peak sen-
sors), the sensor type, and the measurement time (timestamp). Logged data is not
overwritten. When a new measurement is started, the collected logging data is appen-
ded in the log file.
Check the used disc space regularly and remove log files to maintain storage capacity.
Note: The logging function is intended for measurements with long time intervals. It is
suitable source for data reconstructions if the connection to the sensor was interrupted.
Remote command: 
:SENSe<ch>[:POWer]:LOGGing:STATe on page 521

7.8.5  NRP sensor mapping

The "NRP Sensor Mapping" lists the sensors detected by the instrument.

Any R&S NRP sensor that supports the USB legacy protocol and is connected to one
of the USB interfaces, is detected automatically and added to the list. When you dis-
connect a power sensor, the R&S AREG800A removes it from the list accordingly.

R&S NRP sensors that are connected in the LAN or use the USBTMC protocol are
only detected by the scan search function.
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Access:

► Select "Power Sensors" > "NRP Sensor Mapping".

The dialog lists all detected R&S NRP sensors for selection and mapping. You can
also browse the network for sensors.
The list informs on the sensor type with serial number, specific features and the
revision of the sensor firmware.
For each sensor, you find the used protocol and the connector icon of the interface.
In the "Mapping" column, you can assign a mapping index to enable the sensor for
use. The list can contain several entries but the R&S AREG800A can only use up
to four sensors simultaneously.
The remote commands required to define these settings are described in Chap-
ter 12.17, "SENSe, READ, INITiate and SLISt subsystems", on page 509.

Settings

Sensor Mapping List................................................................................................... 185
Scan............................................................................................................................ 186
Clear............................................................................................................................186
Add Sensor/Hide 'Add Sensor'....................................................................................186
Add Sensor settings.................................................................................................... 186

└ Add LAN Sensor settings..............................................................................186
└ Add USB Sensor settings............................................................................. 186

Sensor Mapping List
Shows the sensors that are connected to the R&S AREG800A.
The table informs on the sensor type, specific features and the installed sensor firm-
ware. It also shows the interface the sensor is connected to, including the communica-
tion protocol and the mapping index.
Remote command: 
:SLISt[:LIST]? on page 512
:SLISt:ELEMent<ch>:MAPPing on page 514
:SLISt:SENSor:MAP on page 514
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Scan
Scans the network and the USB connections for sensors connected using the VISA
communication protocol, i.e. sensors that are addressed over LAN or USBTMC.
The instrument detects sensors communicating over the USB legacy protocol automat-
ically.
Remote command: 
:SLISt:SCAN[:STATe] on page 512

Clear
Removes the selected sensor from the sensor mapping list.
Remote command: 
:SLISt:CLEar:LAN on page 513
:SLISt:CLEar:USB on page 513
:SLISt:CLEar[:ALL] on page 514

Add Sensor/Hide 'Add Sensor'
Shows or hides the "Add Sensor" settings.

Add Sensor settings
Configures settings to add sensors connected to the R&S AREG800A over USB or
LAN.

Add LAN Sensor settings ← Add Sensor settings
Configures settings to add sensors connected to the R&S AREG800A over LAN.

"IP Address or Host Name"
Displays the host name or the IP address of a R&S NRP power sen-
sor.
If the R&S AREG800A does not detect a connected R&S NRP sen-
sor, you can assign the address information manually.

"Add LAN Sensor"
Adds a detected R&S NRP sensor connected in the LAN to the list of
sensors, including its device ID or name and its serial number.

Remote command: 
:SLISt:SCAN:LSENsor on page 512

Add USB Sensor settings ← Add Sensor settings
Configures settings to add sensors connected to the R&S AREG800A via USB.

"Device ID or Sensor Name"
Displays the device identifier or the name of the R&S NRP power
sensor.
If the R&S AREG800A does not detect a connected R&S NRP sen-
sor, you can assign the ID or name manually.

"Serial Number"
Displays the serial number of the R&S NRP power sensor.
If the R&S AREG800A does not detect a connected R&S NRPsensor,
you can assign the serial number manually.
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"Add USBTMC Sensor"
Adds a detected R&S NRP sensor connected at the USB interface to
the list of sensors, including its device ID or name and its serial num-
ber.

Remote command: 
:SLISt:SCAN:USENsor on page 513
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8  Configuring the operation setup
A typical operation setup consists of the R&S AREG800A base unit with connected
frontend.

● Operation Setup tile.............................................................................................. 188
● Operation setup settings....................................................................................... 189
● Bandwidth Configuration settings..........................................................................197
● Realtime Control Network settings........................................................................199
● System Control Network settings..........................................................................201

8.1  Operation Setup tile

Access:

1. On the home screen, select the "Operation Setup" tile.

2. In the "Operation Setup" selection, you can access further settings for performing
the following:

● Set the operation setup mode and object reference of the R&S AREG800A
See Chapter 8.2, "Operation setup settings", on page 189.

● Configure the bandwidth of the IF output signal for up to four IF paths.
See Chapter 8.3, "Bandwidth Configuration settings", on page 197.

● Configure real-time control network settings of the real-time interface for
dynamic radar simulation scenarios.
See Chapter 8.4, "Realtime Control Network settings", on page 199.

● Configure system control network settings of the system control interface for
control of the QAT frontend.
See Chapter 8.5, "System Control Network settings", on page 201.
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8.2  Operation setup settings

Access:

► Select "Operation Setup > Operation Setup".

The "Operation Setup" tab of the "Operation Setup" dialog opens.

Settings:

● General................................................................................................................. 189
● Settings................................................................................................................. 192
● Object marker settings.......................................................................................... 194
● Multi instrument settings....................................................................................... 195

8.2.1  General

Access:

► Select "Operation Setup > Operation Setup".

The "General" side-tab of the "Operation Setup" dialog opens.

Settings:

Mode........................................................................................................................... 190
Data Source................................................................................................................ 190
HiL - Protocol.............................................................................................................. 190
Host IP Adress/ Hostname..........................................................................................190
Host Port..................................................................................................................... 191
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Show Connector..........................................................................................................191
Use Switching Unit...................................................................................................... 191
Apply........................................................................................................................... 191
Ok................................................................................................................................191

Mode
Sets the operation setup mode.
"Static" Sets for static operation setups.
"Dynamic" Sets for dynamic operation setups. Dynamic operation requires addi-

tional data, see "Data Source" on page 190.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MODE on page 496

Data Source
Requires "Mode > Dynamic".
Sets the data source for the dynamic operation.
"Scenario" Sets for dynamic radar object simulation scenarios.
"HiL/ViL" Sets the data source to hardware in the loop (HIL) or vehicle in the

loop (ViL) scenarios.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:SOURce on page 498

HiL - Protocol
Requires "Data Source > HiL/ViL".
Sets the protocol type for hardware in the loop (HIL) or vehicle in the loop (ViL) scenar-
ios.
"ZMQ OSI" Sets zero message queue (ZMQ) asynchronous messaging library.

The expected payload is the SensorData defined in the open simula-
tion interface (OSI).

"DCP OSI" Sets distributed co-simulation protocol (DCP). The expected payload
is the SensorData defined in the open simulation interface (OSI).

"UDP OSI" Sets user datagram protocol (UDP). The expected payload is the
SensorData defined in the open simulation interface (OSI).

"UDP Raw" Sets for raw data transferred via the user datagram protocol (UDP).
Raw is a Rohde & Schwarz proprietary format.

Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:PROTocol on page 500

Host IP Adress/ Hostname
Requires "Data Source > HiL/ViL".
Sets the IP address or hostname of the instrument for the hardware in the loop (HIL) or
vehicle in the loop (ViL) scenario controller.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:IPADdress on page 499
[:SOURce<hw>]:AREGenerator:OSETup:HOSTname on page 499
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Host Port
Requires "Data Source > HiL/ViL".
Sets the host port of the instrument for the hardware in the loop (HiL) or vehicle in the
loop (ViL) scenario controller.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:PORT on page 500

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Use Switching Unit
Activates using a switching unit in the test setup, e.g. R&S OSP open switch and con-
trol platform.
A switching unit in the test setup allows you to connect up to eight QAT channels to
less than eight R&S AREG800A IF ports.
For example, you can control up to eight QAT channels via one radar channel.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe] on page 496

Apply
Applies the settings of the current operation setup configuration.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:APPLy on page 496

Ok
Applies the current operation setup configuration and exits the dialog.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:APPLy on page 496
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8.2.2  Settings

Access:

► Select "Operation Setup > Operation Setup > Settings".

The "Settings" side-tab of the "Operation Setup" dialog opens.

Settings:

Object Reference........................................................................................................ 192
Timebase.....................................................................................................................192
HiL - Update Mode...................................................................................................... 193

Object Reference
Sets the object reference.
"Origin" Sets the object reference to the origin in the polar coordinates map.

See Chapter 6.7.1, "Overview", on page 116.
"Mapped Sensor"

Sets a mapped sensor as object reference, see Chapter 7.3.1, "Over-
view", on page 157.

Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:REFerence on page 497

Timebase
Sets the timebase of the logged data.
"System" The system time from the setup menu serves as timebase, see Chap-

ter 15.3.2.1, "Date and time settings", on page 548.
"Simulation" The time stamp from the used scenario, e.g. from an OSI message,

serves as timebase.
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Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:TBASe on page 498

HiL - Update Mode
Sets the update mode for the HIL interface.
The timestamp is an optional part of the OSI packets.
"Immediate" Updates the simulated objects immediately on arrival of the OSI

packet.
If there is a timestamp in the OSI packet, the timestamp is not regar-
ded.

"Timestamp" Updates the simulated objects when the protocol signal reaches the
timestamp of the OSI packet.
Depending on the setting of the "Timebase", the update occurs as fol-
lows:
● "Timebase > Sytem":

Updates the simulated object after a predefined system time in
the timestamp of the OSI packet (absolute data). To have an
accurate simulation time reference, select "gPTP" as time proto-
col, see Chapter 15.3.2.1, "Date and time settings", on page 548.
"gPTP" synchronizes the time between host and
R&S AREG800A.

● "Timebase > Simulation":
Updates the simulated object with the first defined timestamp of
the OSI packet (relative data). The start time is determined inter-
nally, which means there is no time synchronization between host
and R&S AREG800A.

Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:HIL:UPD on page 501
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8.2.3  Object marker settings

Access:

► Select "Operation Setup > Operation Setup > Object Marker".

The "Object Marker" side-tab of the "Operation Setup" dialog opens.

Settings:

Delay........................................................................................................................... 194
On Time.......................................................................................................................194
Marker Source.............................................................................................................194

Delay
Sets a delay time for the start of the object marker.
The delay time delays the marker signal at the marker output relative to the signal gen-
eration start.
Remote command: 
[:SOURce<hw>]:AREGenerator:MARKer:OBJect:DELay on page 501

On Time
Sets the on time (pulse width) of the object marker.
Remote command: 
[:SOURce<hw>]:AREGenerator:MARKer:OBJect:ONTime on page 501

Marker Source
Sets the marker source used in the test setup.
"Object Setting"

Sets the object marker after a change in the radar object settings.
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"Scenario Restart"
Requires: "Mode > Dynamic" and "Data Source > Scenario".
Sets the object marker at the restart of the replayed scenario.

"OSI" Requires: "Mode > Dynamic".
For "Data Source > HiL/ViL": requires "HiL-Protocol > ZMQ OSI |
DCP OSI | UDP OSI".
Sets the object marker according to a timestamp defined in the open
simulation interface (OSI) protocol.

Remote command: 
[:SOURce<hw>]:AREGenerator:MARKer:OBJect:SOURce on page 502

8.2.4  Multi instrument settings

Access:

► Select "Operation Setup > Operation Setup > Multi Instr.".

The "Multi Instr." side-tab of the "Operation Setup" dialog opens.

You can configure a multi instrument setting also via web UI, see Chapter 3.4.9,
"Remote operation over web UI", on page 60.

Settings:

Multi Instrument Mode.................................................................................................196
Status.......................................................................................................................... 196
Host Name/IP Address................................................................................................196
Remove Secondary.....................................................................................................196
Add Secondary............................................................................................................196
Connect.......................................................................................................................197

Operation setup settings
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Multi Instrument Mode
Requires: "Operation Setup > Mode > Dynamic".
Defines the operation mode of the R&S AREG800A in a multi-instrument setup.

"OFF" The R&S AREG800A operates in a standalone mode.

"Primary" The R&S AREG800A operates as a primary instrument. In this mode,
the R&S AREG800A controls several R&S AREG800A instruments.

"Secondary" Requires a control connection between this R&S AREG800A instru-
ment and a primary R&S AREG800A instrument.
In this mode, the R&S AREG800A operates as a secondary instru-
ment that is controlled by a primary R&S AREG800A instrument.

Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:MODE on page 503

Status
Displays the connection state of the secondary instrument.
"Connected"

The secondary instrument is connected to LAN and controlled by a
primary instrument.

"Disconnected"

The secondary instrument is disconnected. No control by a primary
instrument possible.

Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:
CONNection[:STATe]? on page 503

Host Name/IP Address
Sets the IP address or hostname of the secondary instrument.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:
HOSTname on page 504

Remove Secondary
Removes the configuration of the secondary instrument.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:
REMove on page 504

Add Secondary
Adds the configuration of the secondary instrument. Also triggers connecting the pri-
mary instrument for control the secondary instrument.
You can add previous secondary instruments configurations without specifying the
hostname again. The firmware saves hostname of the secondary instrument for correct
mapping.

Operation setup settings
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Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary:ADD
on page 503

Connect
Triggers connection to all secondary instruments by establishing a control connection
via LAN.
The R&S AREG800A connects all secondary instruments as configured by their IP
address or hostname. See "Host Name/IP Address" on page 196.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:CONNect
on page 502

8.3  Bandwidth Configuration settings

Access:

► Select "Operation Setup > Bandwidth Config".

The "Bandwidth Config" tab of the "Operation Setup" dialog opens.

Settings:

Bandwidth x.................................................................................................................197
Configuration x............................................................................................................ 198
Apply/Ok......................................................................................................................198

Bandwidth x
Sets the bandwidth of the IF output channel frequencies.

Bandwidth Configuration settings
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You can set the bandwidth to 1 GHz, 2 GHz or 5 GHz.
"x" represents the individual board for each base unit (R&S AREG8-B9). If fully equip-
ped, you can set bandwidths of four IF output channels at boards "A" to "D". Available
bandwidths depend on the installed options, see Table 4-1.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:BW on page 497

Configuration x
Sets the configuration mode of the IF output channel.
"x" represents the individual board for each base unit (R&S AREG8-B9). If fully equip-
ped, you can set the configuration of four IF output channels at boards "A" to "D".
Available configurations depend on the installed options, see Table 4-1.
"Standard" The IF output channel works in standard mode.

The object generation is independent of the used modulation scheme
of the DUT. For minimum object distances, see the data sheet.

"FMCW Near Range"
Requires R&S AREG8-K814.
The IF output channel works in FMCW near range mode.
This setting allows you to simulate distances between frontend and
DUT down to the length of the air gap. The near object range simula-
tion works only for DUT using FMCW modulation scheme.

Remote command: 
:SOURce<hw>:AREGenerator:OSETup:CONFig on page 497

Apply/Ok
Applies the settings of the current bandwidth configuration and optionally exits the dia-
log.
"Apply" Applies the settings of the current bandwidth configuration.
"Ok" Applies the settings of the current bandwidth configuration and exits

the dialog.
Remote command: 
[:SOURce<hw>]:AREGenerator:OSETup:BW:APPLy on page 497

Bandwidth Configuration settings
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8.4  Realtime Control Network settings

Access:

► Select "Operation Setup > Realtime Control Network".

The "Realtime Control Network" tab of the "Operation Setup" dialog opens.

Settings:

Network Status............................................................................................................199
Restart Network.......................................................................................................... 199
Hostname....................................................................................................................200
Address Mode............................................................................................................. 200
IP Address...................................................................................................................200
Subnet Mask............................................................................................................... 200
MAC Address.............................................................................................................. 200
Show Connector..........................................................................................................200

Network Status
Indicates that the instrument is connected to the network.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:STATus on page 426
:SYSTem:COMMunicate:SYST:NETWork:STATus on page 428

Restart Network
Terminates the network connection of the instrument and sets it up again. You can use
this function to fix network problems.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:RESTart on page 426
:SYSTem:COMMunicate:SYST:NETWork:RESTart on page 429

Realtime Control Network settings
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Hostname
Displays the hostname of the instrument connected to the network.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork[:COMMon]:HOSTname on page 426
:SYSTem:COMMunicate:SYST:NETWork[:COMMon]:HOSTname on page 429

Address Mode
Selects the mode for assigning the IP address.
"Auto (DHCP)" Assigns the IP address automatically, provided the network supports

DHCP (Dynamic Host Configuration Protocol).
"Static" Enables you to assign the IP address manually.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:IPADdress:MODE on page 427
:SYSTem:COMMunicate:SYST:NETWork:IPADdress:MODE on page 429

IP Address
Sets the IP address of the instrument that is connected to the realtime/system control
network.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:IPADdress on page 427
:SYSTem:COMMunicate:SYST:NETWork:IPADdress on page 429

Subnet Mask
Sets the bit group of the subnet in the host identifier.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork[:IPADdress]:SUBNet:MASK on page 427
:SYSTem:COMMunicate:SYST:NETWork[:IPADdress]:SUBNet:MASK
on page 429

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the connected instrument.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:MACaddress on page 427
:SYSTem:COMMunicate:SYST:NETWork:MACaddress on page 430

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.
Remote command: 
n.a.

Realtime Control Network settings
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8.5  System Control Network settings

Access:

► Select "Operation Setup > System Control Network".

The "System Control Network" tab of the "Operation Setup" dialog opens.

Settings:

Network Status............................................................................................................201
Restart Network.......................................................................................................... 201
Hostname....................................................................................................................202
Address Mode............................................................................................................. 202
IP Address...................................................................................................................202
Subnet Mask............................................................................................................... 202
MAC Address.............................................................................................................. 202
Show Connector..........................................................................................................202

Network Status
Indicates that the instrument is connected to the network.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:STATus on page 426
:SYSTem:COMMunicate:SYST:NETWork:STATus on page 428

Restart Network
Terminates the network connection of the instrument and sets it up again. You can use
this function to fix network problems.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:RESTart on page 426
:SYSTem:COMMunicate:SYST:NETWork:RESTart on page 429

System Control Network settings
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Hostname
Displays the hostname of the instrument connected to the network.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork[:COMMon]:HOSTname on page 426
:SYSTem:COMMunicate:SYST:NETWork[:COMMon]:HOSTname on page 429

Address Mode
Selects the mode for assigning the IP address.
"Auto (DHCP)" Assigns the IP address automatically, provided the network supports

DHCP (Dynamic Host Configuration Protocol).
"Static" Enables you to assign the IP address manually.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:IPADdress:MODE on page 427
:SYSTem:COMMunicate:SYST:NETWork:IPADdress:MODE on page 429

IP Address
Sets the IP address of the instrument that is connected to the realtime/system control
network.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:IPADdress on page 427
:SYSTem:COMMunicate:SYST:NETWork:IPADdress on page 429

Subnet Mask
Sets the bit group of the subnet in the host identifier.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork[:IPADdress]:SUBNet:MASK on page 427
:SYSTem:COMMunicate:SYST:NETWork[:IPADdress]:SUBNet:MASK
on page 429

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the connected instrument.
Remote command: 
:SYSTem:COMMunicate:RT:NETWork:MACaddress on page 427
:SYSTem:COMMunicate:SYST:NETWork:MACaddress on page 430

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.
Remote command: 
n.a.

System Control Network settings
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9  File and data management
The R&S AREG800A uses files to save all instrument data. The instrument allows you
to save and to load instrument settings, and to import and to export user data for pro-
cessing in another instrument or later. Finally, you can create a screenshot of the cur-
rent settings displayed on the screen and save it as a file.

This section focuses on the functions provided for managing of user data files and cov-
ers the topics listed below.

For information on the related remote control commands, refer to Chapter 12.11,
"MMEMory subsystem", on page 384.

For information on how to save the displayed setting in a file, refer to Chapter 9.8,
"Creating screenshots of current settings", on page 226.

● About the file system.............................................................................................203
● Restoring the (default) instrument configuration................................................... 205
● Protecting data......................................................................................................209
● Saving and recalling instrument settings...............................................................210
● Exporting and importing remote command lists....................................................214
● Using the file manager.......................................................................................... 214
● How to transfer files from and to the instrument................................................... 220
● Creating screenshots of current settings...............................................................226

9.1  About the file system

Depending on the contained information, two file groups can be distinguished: system
and user files.

Due to security reasons, system files and the system directory are protected and there-
fore not accessible.
The scope of this section is only the files with user data.

This section is an overview of the R&S AREG800A file system and covers the following
topics:
● "Types of user data" on page 204
● "File storage location" on page 204
● "File handling" on page 204
● "File naming conventions" on page 205
● "File contents" on page 205

About the file system
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Types of user data

Depending on the content, the user data can be roughly divided into the following
data types:
● Settings, e.g. the current instrument settings, can be saved and loaded later or

used in other instrument of the same kind.
See Chapter 9.4, "Saving and recalling instrument settings", on page 210

● SCPI scripts, a series of commands that can be run to perform a task.
See Chapter 9.5, "Exporting and importing remote command lists", on page 214

Depending on the data storage method, user data can be:
● Persistent, i.e. user files that are recorded on the data storage.

Data is preserved when instrument is powered off and can be accessed and modi-
fied subsequently.

● Temporary, i.e. volatile data that the instrument retains while it is powered on.
Volatile data is immediately lost when the R&S AREG800A is switched off.

File storage location

Both, the user directory /var/user/ on the internal memory or the /usb/ directory
on the memory stick, can be used to preserve user-defined data. Any directory struc-
ture can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.

Default storage location

The R&S AREG800A stores user data in the user directory.

In the file system, user directory is always indicated as /var/user/.

In manual control, you access this directory via the "File Manager", see Chapter 9.6,
"Using the file manager", on page 214. In remote control, you can query it with the
command :SYSTem:MMEMory:PATH:USER?.

To query and change the default directory used for mass storage, use the command :
MMEMory:CDIRectory.

File handling

To access files and the file system of the instrument or to use the general file manage-
ment functions such as copying and moving data, use the standard "File Manager" dia-
log.

See Chapter 9.6, "Using the file manager", on page 214.

To transfer files from and to the instruments or to exchange files, use one of the follow-
ing alternatives:
● Connect a memory stick to one of the USB interfaces.

The instrument recognizes automatically a connected memory stick and assigns
the /usb/ drive to it.

● Connect the instrument to a LAN.

About the file system
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An instrument connected to a LAN supports two standard file transfer methods
from a remote client:
– FTP (file transfer protocol)
– File sharing according to the SAMBA/SMB (server message block) protocol.
Both file transfer methods access the folder /user, that is the /var/user/ folder
on the instrument.
For step-by-step description, see Chapter 9.7, "How to transfer files from and to the
instrument", on page 220.

● Map a network folder or a computer to an instrument connected to a LAN.
A mapped network folder is indicated as /shares/<"Local Folder">.
For step-by-step description, see Chapter 9.6.4, "How to map a network folder",
on page 218.

File naming conventions

To enable files to be used in different file systems, consider the following file naming
conventions:
● The filename can be of any length and is case-sensitive, i.e it is distinguished

between uppercase and lowercase letters.
● All letters and numbers are permitted (numbers are, however, not permitted at the

beginning of the filename).
● Avoid using special characters.
● Do not use slashes "\" and "/". These symbols are used in file paths.
● Avoid using the following filenames: CLOCK$, CON, COM1 to COM4,

LPT1 to LPT3, NUL or PRN
They are reserved by the operating system.

File contents

Network settings and remote settings cannot be saved and restored.

9.2  Restoring the (default) instrument configuration

The R&S AREG800A has various options to set default settings. You can preset the
R&S AREG800A to an initial state at any time as a known starting point for configura-
tions. It is often useful as a first step in troubleshooting when unusual results arise.

Overview of the characteristics of the preset functions

Select the preset option that most fits to your particular application:

● [Preset]
It is the most frequently used function.

Restoring the (default) instrument configuration
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A Preset executes a defined instrument setup to provide an initial instrument state
as a basis for a new configuration. It resets all parameters and switching states,
including also the states of inactive operating modes.
Network, remote access or system settings are retained.

► To execute a preset, press the [Preset] key at the front panel.

● "Set to Default"
Set To Default relates to individual dialogs or tabs and resets the associated set-
tings of the corresponding dialog. All other settings are retained.

► To reset the grouped settings, click "Set To Default".

● "Preset this parameter"
Sets a single parameter to its default value.

► To reset an individual parameter: Open its context-sensitive menu and select "Pre-
set this parameter...".

● "Factory Preset"
A factory preset is the most profound preset function that resets almost all instru-
ment settings, including reference oscillator, network and remote access settings.
Retained are the following settings:
– Security, password, and settings protected by these passwords
– User-defined data, like setups or data lists
– Settings that relate to an integration of the instrument in a measurement setup.

► To restore the factory defaults, select System Config > Setup > Settings > Factory
Preset.

Note: Perform a "Factory Preset" only if it is necessary. After a "Factory Preset",
the network connection to the instrument no longer exists.

Presetting the instrument to a user-defined instrument state

The reset functions set the parameters and operating modes to default values prede-
fined by the factory. Alternatively to these default settings, you can:

● Define user-specific recall settings to be restored after a preset

Restoring the (default) instrument configuration
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(see Chapter 9.2.3, "How to recall user settings automatically after preset",
on page 208)

● Store and reload user-defined instrument states
(see Chapter 9.4.2, "How to save and recall instrument settings", on page 213)

Mark / Do not mark parameters changed from preset

To survey the current state of the settings concerning default values, the
R&S AREG800A offers a feature that visually identifies deviations from the default val-
ues.

For more information, see Chapter 9.2.2, "How to identify parameters which are not in
a preset state", on page 208.

9.2.1  Preset, set to default and factory preset settings

Preset..........................................................................................................................207
Set To Default..............................................................................................................207
Preset this Parameter................................................................................................. 207
Execute Factory Preset...............................................................................................207

Preset
Resets all parameters and switching states, and closes all opened dialogs.
Note:
In contrast to the [Preset] key, the SCPI commands *RST and :SYSTem:PRESet do
not close open dialogs in the GUI.
Consider also the following possibilities:
● You can define the settings that are restored when you preset the instrument

(see Chapter 9.2.3, "How to recall user settings automatically after preset",
on page 208)

● You can reset the instrument to the factory state
(see "Execute Factory Preset" on page 207)

See also Table 9-1 that contains the key parameters that are reset by the correspond-
ing preset functions.
Remote command: 
*RST on page 355

Set To Default
Resets the associated settings of the corresponding dialog or tab.

Preset this Parameter
Restores the default value of a single parameter.

Execute Factory Preset
Resets the instrument to its factory settings.
Note: "Factory Preset" retains all security settings and does not delete any user files
like setups or user data.

Restoring the (default) instrument configuration
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See also Table 9-1 that contains the key parameters that are reset by the correspond-
ing preset functions.
Remote command: 
:SYSTem:FPReset on page 358

9.2.2  How to identify parameters which are not in a preset state

To recognize the current state of the settings related to their default values at the first
glance, enable a function that visually identifies parameters in states different than pre-
set.

To activate this display:

1. Open the context-sensitive menu (touch and hold the screen anywhere in the GUI
of the R&S AREG800A).

2. Select "Mark all parameters changed from preset".

If enabled, the corresponding settings are marked.

9.2.3  How to recall user settings automatically after preset

You can define the settings that are restored when you preset the instrument.

1. Configure the settings as required. Save them as described in Chapter 9.4.2, "How
to save and recall instrument settings", on page 213.

2. Save the settings as a file with the predefined filename UserPreset.savrcltxt.
Save this file in the directory /var/user/.

The filename UserPreset.savrcltxt and the directory /var/user/ are man-
datory.

Now when you press the [Preset] key or send the *RST command to the instru-
ment, the defined settings are restored.
An "Info" message appears and confirms, that a file with user-defined preset set-
ting is loaded.

9.2.4  Reference

See Table 9-1 for an overview of the main generator settings that are affected by the
corresponding preset functions. While the regular [Preset] key primarily resets the sig-
nal relevant parameters of the instrument, the "Factory Preset" affects almost all instru-
ment settings.

Restoring the (default) instrument configuration
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For information on the default values of further parameters, refer to the description of
the corresponding remote commands.
Table 9-1: Key parameters affected by preset and factory preset

Parameter Preset value Preset Factory
Preset

RF frequency x x x

RF level (RF output) off x x

Reference frequency settings (reference oscillator) - - x

Network settings - - x

Hostname - - x

GPIB address - - x

Start/Stop display update - - x

Display and keyboard settings - - x

Password and settings protected by passwords (e.g. dis-
abled LAN or USB)

- - -

Security settings - - -

User files (setups2), data lists, etc.) - - -

Air Gap 0.5 m - x

● 2) UserPreset.savrcltxt is renamed as UserPresetInactive.savrcltxt;
an existing file with the same name is overwritten.

If the default values in the "Remote Access" dialog had been changed, a factory preset
via remote control (:SYSTem:FPReset) terminates the connection to the instrument.
Security settings are never reset.

Resets all parameters and switching states, and closes all opened dialogs.

9.3  Protecting data

During operation, the R&S AREG800A saves user data permanently in the user direc-
tory, see "File storage location" on page 204.

To protect any classified data and to avoid saving any sensitive data on the
R&S AREG800A permanently, you have the following options:
● Activate the volatile mode. This mode redirects user data to the volatile memory,

see "Volatile Mode" on page 254.
The internal memory is write-protected.
Once you power off the instrument for at least five minutes, all volatile memory
modules lose their contents.

Protecting data
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Instead, you can redirect the user data to an external memory device, as, e.g., a
USB stick.
See also:
– "Default storage location" on page 204
– "Volatile Mode" on page 254
– Chapter 9.7.4, "Using a USB storage device for file transfer", on page 225

● Save user files temporarily in the /var/volatile directory, which remains
available only until the instrument is turned off.
You can access data in the volatile memory just as data that is saved permanently
in the /var/user/.
See also Chapter 9.6.3, "How to display all saved files", on page 218.

For detailed information on how to protect the instrument and sensitive data from unau-
thorized access, see the Instrument Security Document on the product website.

9.4  Saving and recalling instrument settings

Possibly you would like to restore or repeat a signal generation you performed under
specific conditions on the instrument. Or, in a test setup with more than one signal gen-
erator, you want to transfer the used settings to another R&S AREG800A. In these
cases, you can save and recall instrument and user settings, and possibly other related
data.

Save/Recall the complete instrument settings

Two different methods are available for managing complete instrument settings:
● Immediate (quick) Save/Recall

A defined set of instrument settings are saved or recalled quickly in just one step,
without defining a filename or storage location. This function enables a fast switch-
ing between different instrument settings.

● Save/Recall in files with user-defined names
The defined set of instrument settings are saved to a definable storage location.
The file extension is *.savrcltxt.
Settings files created in this way are visible in the file system and accessible with
the supported methods for file handling.

In the general case, a recall process replaces the instruments settings with the saved
values. An exception is the frequency and level settings. During recall of the instrument
settings, it is possible to retain the current settings or to overwrite them with the saved
values.

Saving and recalling instrument settings
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9.4.1  Save/recall settings

To access the dialog for saving and loading the complete instrument settings

1. Select "System Config > Save/Recall".

2. Select "Operation Mode > Save or Recall" to access the corresponding settings.

The provided settings for both operations are similar and closely related.

Settings:

Operation Mode...........................................................................................................211
Directory, File List and Filename................................................................................. 211
Recent files................................................................................................................. 212
Show SCPI List........................................................................................................... 212
SCPI List..................................................................................................................... 212
Save............................................................................................................................ 212
Save Immediate x....................................................................................................... 212
Exclude Frequency..................................................................................................... 212
Recall.......................................................................................................................... 212
Recall Immediate x......................................................................................................213
File Manager............................................................................................................... 213

Operation Mode
Accesses the settings for storing ("Save") and loading ("Recall") of the instrument set-
tings. Also, you can import SCPI-Files ("SCPI-Import") or export SCPI files ("SCPI-
Export").
See Chapter 9.5, "Exporting and importing remote command lists", on page 214.

Directory, File List and Filename
Note:
You access this generic standard function each time you perform one of the following:
● Save or load (settings) files

Saving and recalling instrument settings
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● Define a folder in that these files are saved
● Navigate through the file system.
The dialog name changes depending on the context. The provided functions are self-
explanatory and similar.
Use the settings for example as follows:
● To navigate through the file system, use the directory tree.
● To perform standard file management functions, like create directories, move, copy,

delete files and/or directories, use the standard "File Manager" function (see Chap-
ter 9.6, "Using the file manager", on page 214).

Remote command: 
To list all files in a directory:
:MMEMory:CDIRectory on page 390
:MMEMory:CATalog? on page 389

Recent files
Displays the files last used.

Show SCPI List
Opens the "SCPI List", which lists the current settings of the R&S AREG800A as SCPI
commands.
The R&S AREG800A provides this function for Operation Mode > SCPI-Export.

SCPI List
Contains a list of all SCPI commands corresponding to the current instrument settings.
See also "How to create a SCPI list with the current instrument settings in one step"
on page 338

Save
Saves the current instrument settings under the defined filename.
Remote command: 
:MMEMory:STORe:STATe on page 394

Save Immediate x
Stores the current instrument setting in one of the intermediate memories.
These instrument settings are retained until a different instrument setting is stored in
the intermediate memory. When the instrument is switched off, the contents of the
intermediate memories are retained.
Remote command: 
*SAV on page 356

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.
Remote command: 
[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL on page 434

Recall
Restores the selected configuration.

Saving and recalling instrument settings
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During recall, the instrument considers all related settings, for example sweeps in
active state or lists. An error message indicates the settings which cannot be imple-
mented.
Remote command: 
:MMEMory:LOAD:STATe on page 392

Recall Immediate x
Loads the selected configuration from one of the intermediate memories. A message
appears if no instrument configuration is stored in this memory.
Remote command: 
*RCL on page 355

File Manager
Accesses the "File Manager" dialog, see Chapter 9.6, "Using the file manager",
on page 214.

9.4.2  How to save and recall instrument settings

Instrument settings can be saved to a file and loaded again later, so that you can
repeat the tests with the same settings.

To access and recall instrument setups quickly

► Assign the appropriate action to the [User] key.
See Chapter 10.3.4, "How to assign actions to the [User] key", on page 240.

To save and recall instrument settings

1. Select "System Config > Save/Recall" > "Operation Mode > Save".

2. Select "Save Immediate 1".

The instrument saves its settings in the intermediate memory 1. The filename and
the storage location cannot be changed.

3. Adapt the instrument settings as required. Select "Save Immediate 2"

4. To restore the settings, select the "Operation Mode > Recall"

5. Select "Recall Immediate 1"

The instrument is restored to the previous state.

6. Select "Recall Immediate 2" to switch to the settings saved in the second file.

To save complete instrument settings

1. Select "System Config > Save/Recall" > "Operation Mode > Save".

2. In the file selection dialog, select a filename and storage location for the settings
file.

Saving and recalling instrument settings
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3. Select "Save".

A file with the defined name and path and the extension *.savrcltxt is created.

To restore instrument's configuration

Save the configuration as described in "To save complete instrument settings"
on page 213.

1. To restore settings, select "System Config > Save/Recall" > "Operation Mode >
Recall".

2. To retain the current frequency and level settings, enable "Save/Recall > Exclude
Frequency/Level"

3. In the file selection dialog, select the filename and storage location of the settings
file.

The settings are restored, but the frequency and level settings are retained; you
can repeat the signal generation with the same settings.
See also Chapter 9.2.3, "How to recall user settings automatically after preset",
on page 208.

9.5  Exporting and importing remote command lists

To set specific instrument settings or perform tasks automatically, you can create
scripts or import scripts that contain the settings in the form of remote control com-
mand sequences.

The R&S AREG800A also offers a SCPI macro recorder with code generator that is
used to record manual settings and create an executable script, see Chapter 11.13.4,
"How to record / create SCPI lists", on page 337.

Completed scripts are saved in files and possibly converted to different formats,
depending on the used language of the source code.

The R&S AREG800A supports the following commonly used languages:
● Plain SCPI: *.txt
● MATLAB: *.m
● NICVI: *.c
● Python: *.py
It is also possible to convert the SCPI command list to a user-specific language, see
Chapter 11.13.5, "How to convert and save SCPI lists", on page 340.

9.6  Using the file manager

The "File Manager" is a tool similar to a standard Windows Explorer. It helps you man-
age mass storage media and files saved on the R&S AREG800A.

Using the file manager
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You can perform the following tasks:
● Copying multiple files from disk to other media

See Chapter 9.7, "How to transfer files from and to the instrument", on page 220
● Copying files into another directory

See Cut, Copy&Paste and Delete
● Renaming and deleting files
● Creating directories

See Create New Directory
● Mapping shared network folders

See Chapter 9.6.4, "How to map a network folder", on page 218
● Displaying saved files

See Chapter 9.6.3, "How to display all saved files", on page 218

Access:

► Select "System Config > Save/Recall" > "File Manager".

Tip: Each "Save/Recall" dialog and each "File Select" dialog provides a quick
access to the "File Manger", i.e. whenever you select data lists or files with user
data.

The "File Manager" dialog provides all standard functions required for file manage-
ment. It displays the contents of the selected folder on the R&S AREG800A and
provides functions to rename, delete, copy, or move individual files.

9.6.1  File manager settings

Access:

► Select "System Config > Save/Recall" > "File Manager".

Using the file manager
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Settings:

Map Network Share.................................................................................................... 216
File Type......................................................................................................................216
Directory and Filename............................................................................................... 216
Cut, Copy&Paste and Delete...................................................................................... 216
Rename.......................................................................................................................216
Create New Directory..................................................................................................216

Map Network Share
Accesses the Map network share settings dialog where you can map one or more net-
work folders.
See also Chapter 9.6.4, "How to map a network folder", on page 218.

File Type
Selects the file type to be listed. If a file type with a specific file extension is selected,
only files with this extension are listed.

Directory and Filename
Selects the directory in which the file to be deleted or copied is located. The dialog lists
all files in this directory. Selected files are highlighted. The path is indicated above the
directory tree.
Unlike the "Save/Recall" and "File Select" dialogs, the "File Manager" displays the full
filenames including extensions.
Remote command: 
:MMEMory:CDIRectory on page 390

Cut, Copy&Paste and Delete
Standard file management functions.
Before a file is deleted, you have to confirm the delete operation.
Remote command: 
:MMEMory:DELete on page 392
:MMEMory:COPY on page 390

Rename
Renames the selected file or directory.
Remote command: 
:MMEMory:MOVE on page 393

Create New Directory
Creates a folder and opens an edit dialog box to enter name and path (absolute or rel-
ative to the current directory) of the new folder.
Remote command: 
:MMEMory:MDIRectory on page 392

Using the file manager



File and data managementR&S®AREG800A

217User Manual 1179.3615.02 ─ 06

9.6.2  Map network share settings

Access:

► Select "System Config > Save/Recall" > "File Manager > Map Network Share".

The "Map Network Share" dialog provides settings that are similar to the standard Win-
dows Explorer function "Map network drive". These settings help you to create up to 10
"shortcuts" to shared folders or computers in the network.

The dialog displays a list of current mapped network folders. The directory tree of the
"File Manager", "Save/Recall", and "File Select" dialogs indicate a mapped network
folder as /shares/<"Local Folder">.

See also Chapter 9.6.4, "How to map a network folder", on page 218.

Settings:

Network Folder............................................................................................................217
Local Folder................................................................................................................ 217
User Name.................................................................................................................. 218
Password.................................................................................................................... 218
Reconnect at Startup.................................................................................................. 218
Connect.......................................................................................................................218
Change........................................................................................................................218
Disconnect.................................................................................................................. 218

Network Folder
Enter the path of the folder or computer, e.g. //<IP Address>/user or //<server
name>/user.

Local Folder
Enter a letter or an alias name to describe the folder.

Using the file manager
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In the directory tree, a mapped network folder is indicated as /shares/
<"Local Folder">.

User Name
Enter a user name of a user that has the permission to access the selected network
folder.

Password
Enter the password of the selected user.

Reconnect at Startup
Enables reconnecting every time you start up the instrument.

Connect
Triggers the instrument to prove the credential and to map (i.e. connect) the selected
network folder or computer to the instrument.
You can map up to 10 network folders.

Change
Applies the changes.

Disconnect
Disconnects the network drive.

9.6.3  How to display all saved files

To display all files on the internal memory

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /var/user/.

To display all files on a connected USB flash drive

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /usb/.

To display all files in the volatile memory

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /var/volatile/.

9.6.4  How to map a network folder

Possibly you would like to transfer instrument or user settings to another
R&S AREG800A, distribute waveform files to several instruments or you have to

Using the file manager
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access frequently the same network drive. In these cases, on a R&S AREG800A con-
nected to a LAN you can create a shortcut to this network folder or this computer.

How to: see Chapter 3.1.7, "Connecting to LAN", on page 25.

To map a network folder, proceed as follows:

1. On the computer or the network folder you want to map, enable remote access.
You can specify a list of users allowed for remote access.
The remote access settings depend on the operating system the remote computer
is using. For step-by-step instructions, refer to the documentation of the particular
operating system.

2. On the R&S AREG800A, enable file transfer via SMB (samba).

3. Select "System Config > Setup > Remote Access > Network".
Select:

a) "Address Mode > Auto (DHCP)"
b) Check that the "DNS Suffix" and "DNS Server" are correct.

4. In the "Save/Recall" dialog, select "File Manager > Map Network Share".

5. In the "Map Network Share" dialog, select:

a) In the "Network Folder" field, enter //<IP Address>/user or //
<Server Name>/user.

b) In the "Local Folder" field, enter an alias name, e.g. setups.
c) Enter the "User Name" and "Password" of a user with a remote access permis-

sion to the selected network folder.
d) If necessary, enable "Reconnect at Startup".
e) Select "Connect".

The selected network folder is mapped to your instrument. The list of mapped net-
work folders is updated.

Using the file manager
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6. Close the "Map Network Share" dialog.

The navigation tree in the "File Manager" dialog displays the mapped network
folder as /shares/Setups.

If the connection does not succeed, consider to check the following:
● Is the network folder or computer you try to map turned on?
● Is the network folder or computer enabled for remote access?
● Does the selected user name have the necessary permissions?

See also Chapter 9.7.5, "Using a file server for test files exchange", on page 226.

9.7  How to transfer files from and to the instrument

As explained in "File handling" on page 204, you access the file system of the
R&S AREG800A via one of the following ways:
● Via the built-in "File Manager"

See Chapter 9.6, "Using the file manager", on page 214.
● On an instrument connected to a LAN:

– Via one of the standard functions FTP or SMB (samba)
See Chapter 9.7.2, "Accessing the file system of the R&S AREG800A over
FTP", on page 222 and
Chapter 9.7.3, "Accessing the R&S AREG800A file system using SMB
(Samba)", on page 223

– Via mapped network drives
See Chapter 9.6.4, "How to map a network folder", on page 218.

● Via a connected USB storage device
See Chapter 9.7.4, "Using a USB storage device for file transfer", on page 225

How to transfer files from and to the instrument
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Mainly because of security reasons, the access to the file system of your
R&S AREG800A can be denied, because one or all these access methods are deliber-
ately disabled. Access to the file system via LAN and/or USB requires that the corre-
sponding service is enabled and a write access to the file system is enabled. Refer to
Chapter 9.7.1, "Removing file system protection", on page 221 for description of the
required steps.

This section provides an introduction to the topic. For comprehensive information, refer
to the application note 1GP72: Connectivity of Rohde&Schwarz Signal Generators.

● Removing file system protection........................................................................... 221
● Accessing the file system of the R&S AREG800A over FTP................................222
● Accessing the R&S AREG800A file system using SMB (Samba).........................223
● Using a USB storage device for file transfer......................................................... 225
● Using a file server for test files exchange............................................................. 226

9.7.1  Removing file system protection

Before you try to access the file system via FTP, SMB (samba) or USB, fulfill the follow-
ing:
● Disable write protection on the file system
● Enable the corresponding service or interface

To enable write permission on the file system

1. Select "System Config > Setup > Security > Security > General".

2. Select "Disk & Memory".

3. Enable "Volatile Mode".

4. Enter the "Security Password".
The default password is 123456. For more information, see Chapter 10.5, "Using
the security settings", on page 250.

The R&S AREG800A requests a reboot.

5. Confirm the request.

The system reboots. The enabled settings are active.

To enable file transfer over FTP

1. Select "System Config > Setup > Security > Security > LAN Services".

2. In the "Common Services" tab, enable "LAN Interface"

3. Enable "FTP"

4. Enter the "Security Password".
The default password is 123456. For more information, refer to Chapter 10.5,
"Using the security settings", on page 250.

5. Select "Accept".

How to transfer files from and to the instrument
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To enable file transfer over SMB (samba)

1. Select "System Config > Setup > Security > Security > LAN Services"

2. Enable "LAN Interface"

3. Select "Samba Services".

4. Enable the "SMB 1.0/2.0 Client".

5. Enable the "SMB 1.0/2.0 Server".

6. Enter the "Security Password".
The default password is 123456. For more information, refer to Chapter 10.5,
"Using the security settings", on page 250.

7. Select "Accept".

To enable file transfer over USB

1. Select "System Config > Setup > Security > Security > General"

2. Select "Disk & Memory".

3. Enable "USB Storage"

4. Enter the "Security Password".
The default password is 123456. For more information, refer to Chapter 10.5,
"Using the security settings", on page 250.

5. Select "Accept".

9.7.2  Accessing the file system of the R&S AREG800A over FTP

If the R&S AREG800A is connected to a LAN, you can use file transfer protocol (FTP)
to access the file system and to transfer files from and to the instrument.

How to: see Chapter 3.1.7, "Connecting to LAN", on page 25.

To access the file system over FTP

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via FTP

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.

4. In the address field, enter ftp://<"IP Address" of the Instrument>, e.g.
ftp://10.124.0.166.
Tip: The R&S AREG800A indicates its IP address on the home screen.

A log-on dialog opens and requests a password.

The default user name and password is instrument.

Tip:

How to transfer files from and to the instrument
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Default password
The FTP and SAMBA file access use the user "instrument" with default password
"instrument".
We recommend that you change this password in the "Setup > Security > Pass-
word Management > Change User Password" dialog before connecting the instru-
ment to the network.
See Chapter 10.5.4, "Password management", on page 260.

5. Enter the password to access the user directory.
The user directory corresponds to the /var/user/ directory of the instrument.

There, you can perform standard functions like creating directory, or saving files.

6. In the user directory, create a directory, e.g. test ftp.

7. Select "System Config > Save/Recall".
Open the /var/user/ directory.

The dialog displays the /var/user/test ftp directory.

9.7.3  Accessing the R&S AREG800A file system using SMB (Samba)

The SMB (Samba) protocol is an alternative way to access the file system of the instru-
ment from a remote PC. This protocol works if both the instrument and the PC are con-
nected to a LAN.

How to transfer files from and to the instrument
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How to: see Chapter 3.1.7, "Connecting to LAN", on page 25.

To access the file system over SMB

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via FTP

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.

4. In the address field, enter //<"IP Address" of the Instrument>, e.g. ftp://
10.124.0.166.
Tip: The R&S AREG800A indicates its IP address on the home screen.

The user directory corresponds to the /var/user/ directory of the instrument;
the volatile directory - to the /var/volatile directory.

To map the R&S AREG800A as a network drive to the remote PC

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via SMB (Samba)

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.
Open the "Map Network Drive" dialog.

a) Select a valid "Drive", e.g. W.
b) In the "Folder" field, enter //<"IP Address" of the Instrument>/user

or //<"Hostname" of the Instrument>/user
For example: //10.124.0.166/user or //AREG800A-102030/user.
Tip: The R&S AREG800A indicates its IP address on the screen.

c) Select "Finish".

A log-on dialog opens and requests a user name and a password.

Tip:
Default password
The FTP and SAMBA file access use the user "instrument" with default password
"instrument".

How to transfer files from and to the instrument
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We recommend that you change this password in the "Setup > Security > Pass-
word Management > Change User Password" dialog before connecting the instru-
ment to the network.
See Chapter 10.5.4, "Password management", on page 260.

4. Enter the user name and the password of your instrument.

The /var/user/ directory of the instrument is mapped to and displayed as a net-
work drive of the remote PC.

You can access the files in the /var/user/ directory, perform standard function
like creating directory, or saving files.

9.7.4  Using a USB storage device for file transfer

Alternatively to the file transfer possibility via LAN, you can use a USB storage device
for direct file transfer from and to the instrument.

We recommend that you transfer files with user data (like lists or instrument setup files)
to the instrument, rather than load and play them from a connected USB storage
device.

To transfer a file with user data to the instrument

1. Connect a USB storage device, for example a USB memory stick to one of the
USB interfaces of the instrument.

The R&S AREG800A recognizes the connected USB storage device automatically.

2. Enable file transfer via USB

3. Enable write permission on the file system

4. Select "System Config > Save/Recall".

The dialog displays the /var/user/ directory and the /usb/ drive.

5. In the "Save/Recall" dialog, select "File Manager".

6. In the directory tree, navigate to the /usb/ drive.
Select the required file with user data.

7. Select "Copy".

8. In the directory tree, navigate to the /var/user/ directory.
Select "Paste".

The file with user data is transferred to the instrument.

How to transfer files from and to the instrument
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9.7.5  Using a file server for test files exchange

You can use a central file storage location like a file server in your company network to
save setup files, SCPI scripts, application programs, or waveform files on it. Usually,
you would like to distribute the files to several instruments. If the R&S AREG800As are
connected to a LAN, you can create a shortcut on the instruments to the file server.

To access the file server

1. On each R&S AREG800A, map the required directory of the file server to the
instrument.
Perform the steps described in Chapter 9.6.4, "How to map a network folder",
on page 218.

2. On each R&S AREG800A, use the same alias name for the directory of the file
server, i.e. enter the same "Local Folder" (in this example Setups).

On any of the R&S AREG800A, you access the file server directly from the "File
Manager" and under the same name, e.g. /shares/Setups.
An extra advantage in remote control is that the same application program would
control the instruments.
For example, use the remote control command MMEMory:CDIRectory
"/shares/Setups" to set the default directory for mass storage.

9.8  Creating screenshots of current settings

The save/recall function enables you to save current settings in a file. To document the
most important settings for a performed signal generation, you can also save a hard-
copy of the current display.

● Hardcopy settings................................................................................................. 226
● How to save a hardcopy of the display................................................................. 229

9.8.1  Hardcopy settings

Access:

► Select "System Config > Setup > User Interface > Hardcopy".

Creating screenshots of current settings
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The remote commands required to define these settings are described in Chapter 12.9,
"HCOPy subsystem", on page 379.

Settings:

File.............................................................................................................................. 227
Format.........................................................................................................................228
Options........................................................................................................................228
Save............................................................................................................................ 228
Hardcopy Options > Common.....................................................................................228

└ Automatic Naming.........................................................................................228
└ Format...........................................................................................................228
└ Region...........................................................................................................228

Hardcopy Options > Automatic Naming......................................................................228
└ Path...............................................................................................................228
└ Clear Path.....................................................................................................229
└ Prefix, Year, Month, Day............................................................................... 229
└ Current Auto Number....................................................................................229

File...
In "Automatic Naming > Off" mode, accesses the standard file select dialog for select-
ing the filename and folder the hardcopy is stored in.
If you have enabled "Automatic Naming", the instrument displays the automatically
generated filename.
Remote command: 
:HCOPy:FILE[:NAME] on page 381

Creating screenshots of current settings
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Format
Selects the output file format, for example *.bmp, *.jpg*.xpm and *.png.

Remote command: 
:HCOPy:IMAGe:FORMat on page 380
:HCOPy:DEVice:LANGuage on page 380

Options...
Accesses Hardcopy Options dialog.

Save
Saves a hardcopy of the current display as a file.
Remote command: 
:HCOPy[:EXECute] on page 381

Hardcopy Options > Common
Access: select "Hardcopy > Options... > Common".
With the provided settings, you can customize the file format and the syntax of the
automatically assigned filename.

Automatic Naming ← Hardcopy Options > Common
If enabled, creates the output filenames automatically according to the rules set with
the Hardcopy Options > Automatic Naming settings.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:STATe on page 383

Format ← Hardcopy Options > Common
Selects the output file format, for example *.bmp, *.jpg*.xpm and *.png.

Remote command: 
:HCOPy:IMAGe:FORMat on page 380
:HCOPy:DEVice:LANGuage on page 380

Region ← Hardcopy Options > Common
Displays the snapshot area.
Remote command: 
:HCOPy:REGion on page 381

Hardcopy Options > Automatic Naming
Access: select "Hardcopy > Options... > Automatic Naming".
Provided are the following settings:

Path... ← Hardcopy Options > Automatic Naming
Selects the directory.
Note: To select the destination path, specify also a filename. Otherwise an error mes-
sage is displayed and selection is canceled.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:DIRectory on page 382

Creating screenshots of current settings
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Clear Path ← Hardcopy Options > Automatic Naming
Deletes all image files with extensions *.bmp, *.jpg, *.png and *.xmp in the direc-
tory set for automatic naming.
Before the command is executed, a warning message prompts you to confirm the dele-
tion of the files.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar on page 382

Prefix, Year, Month, Day ← Hardcopy Options > Automatic Naming
Determines the rules for "Automatic Naming".
Per default, the automatically generated filename is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>, where Y, M and D mean
year, month, Day; Number is the Current Auto Number.

You can activate or deactivate each component separately.
The "Resulting filename" indicates the current filename syntax.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix on page 384
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe on page 384
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe on page 383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe on page 383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe on page 383

Current Auto Number ← Hardcopy Options > Automatic Naming
Indicates the number which is used in the automatically generated filename.
Note: When initially switching on the instrument, the number is reset to the lowest pos-
sible value. Starting with number 0 the output directory is scanned for existing files. As
long as files with the same name are existing, the number is increased by 1. The num-
ber is automatically set so that the resulting filename is unique within the selected path.
The current number is not in the save/recall file but is temporarily stored within the
database. At the following save operation, the number is increased.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer? on page 383

9.8.2  How to save a hardcopy of the display

1. Select "System Config > Setup > User Interface > Hardcopy".
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2. To define the output format, select "Format > JPG".

3. To enable the instrument to create output filenames, select "Automatic Naming >
On".

4. Select "Options...".

5. In the "Hardcopy Options" dialog:

a) To change the default directory the file is saved in, select "Automatic Naming
Settings > Path" and define a path and a filename. For example, select the
default directory /var/user.

b) If necessary, disable or change some of the parameters in the "Automatic Nam-
ing Settings".

c) Close the "Hardcopy Options" dialog.

6. In the "Hardcopy" dialog, select "Save".

The instrument saves a hardcopy of the current instrument display as a *.jpg file.
The filename is automatically created.

7. To print the hardcopy, connect the instrument to a LAN and:

a) Transfer the file to a remote computer as described in Chapter 9.7, "How to
transfer files from and to the instrument", on page 220.

b) On the remote computer, navigate through the file system.
c) Print the selected file.

For more information, refer to the online help of the operating system.

Creating screenshots of current settings
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10  General instrument functions
The general instrument functions include basic instrument settings, regardless of the
selected operating mode and measurement. Some of these settings like screen display
and peripherals are initially configured at the setup of the instrument, according to per-
sonal preferences and requirements. However, you can individually adjust the settings
at any time, for example, if necessary for specific applications.

The following special functions help you in service and basic system configuration:
● Chapter 10.1, "Customizing the user interface", on page 231

Allows you to adjust the display and keyboard language settings.
● Chapter 10.3, "Organizing frequently used settings as favorites", on page 236

Enables you to group user defined settings in a favorites list or to assign actions to
the [User] as quick access for later retrieval.

● Chapter 10.4, "Managing licenses and license keys", on page 241
If you have purchased an additional option for the R&S AREG800A, you can
enable it using a license key.

● Chapter 9.2, "Restoring the (default) instrument configuration", on page 205
At any time, you can restore a default configuration to start a measurement at a
defined instrument state, or set the instrument to factory preset.

● Chapter 10.5, "Using the security settings", on page 250
Special security and protection functions protect your instrument from unauthorized
use or activate specific test routines.

10.1  Customizing the user interface

The R&S AREG800A provides basic alignments of instrument settings regarding the
user interface, that means the touch panel (screen), the appearance of the displayed
dialogs and graphics, and an external keyboard.

Start / stop display update

The operating system of the R&S AREG800A refreshes the displayed settings by
default in almost real-time, to keep the display updated with the internally used values.
However, you can turn off this function to reduce settling times when the instrument is
remote controlled.

In detail described in the following paragraphs, you can:
● Set display and keyboard language, see Chapter 10.1.1, "Display and keyboard

settings", on page 232
● Set date and time for the system clock, see Chapter 15.3.2, "Date and time",

on page 547
● Configure and activate a Screen Saver
● Deactivate display update to improve performance, see Chapter 10.1.2, "Display

update settings", on page 233
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10.1.1  Display and keyboard settings

Access:

1. Select "System Config > Setup > User Interface > Display/Keyboard > Display".

2. Select "Display/Keyboard > USB Keyboard".

In the "Display/Keyboard" dialog, you can change regional and language options
for the GUI and an external keyboard, and define the screen saver settings.

The remote commands required to configure the display and keyboard are described in
Chapter 12.7, "DISPlay subsystem", on page 373 and Chapter 12.10, "KBOard sub-
system", on page 384.

Screen Saver.............................................................................................................. 232
Wait Time.................................................................................................................... 232
Display........................................................................................................................ 233
RF Hardkey................................................................................................................. 233
USB Keyboard > Layout..............................................................................................233

Screen Saver
Activates the screensaver.
If activated, the display including backlight is switched off after the selected Wait Time
elapses and if no entries via touch panel, front panel, external mouse, or external key-
board are made
Remote command: 
:DISPlay:PSAVe[:STATe] on page 374

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no
entries are made.
Remote command: 
:DISPlay:PSAVe:HOLDoff on page 374
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Display
Adjusts the brightness of the display.
Increase the value to turn up the display brightness.
Remote command: 
:DISPlay:BRIGhtness on page 374

RF Hardkey
Adjusts the brightness of the [RF On/Off] key.
Increase the value to change the contrast between the key and the front panel back-
ground color.
Remote command: 
:DISPlay:BUTTon:BRIGhtness on page 375

USB Keyboard > Layout
Selects the language of an externally connected keyboard via USB. The function
assigns the corresponding keys automatically.
Remote command: 
:KBOard:LAYout on page 384

10.1.2  Display update settings

Access:

► Select "System Config > Setup > User Interface > Start/Stop Display Update".

This dialog enables you, to deactivate updating the display.

The remote command to switch off the display update is described in Chapter 12.7,
"DISPlay subsystem", on page 373.

Display Update is
Disables the automatic refreshing of the displayed values.
Remote command: 
:DISPlay:UPDate[:STATe] on page 375
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10.1.3  How to set the initial instrument settings

This section describes how to set up the R&S AREG800A initially.

10.1.3.1  Setting the keyboard language

You can select the language of the external keyboard connected to the instrument.

To adjust the keyboard settings

1. Press the [Setup] key.

2. Select "User Interface > Keyboard".

3. Select the "Layout".

The dialog closes and the changes take effect immediately.

10.1.3.2  Setting the screen saver

You can enable a screen saver that automatically turns off the display after a user-
defined period of time. The screen saver is activated if no settings are made on the
touch screen, or via keys or the rotary knob during the selected wait time.

To activate the screen saver

1. Press the [Setup] key.

2. Select "User Interface > Display"

3. Activate the "Screen Saver".

4. Define the "Wait Time" in minutes.

The instrument turns off the display after the defined period of time.

5. To reactivate the display, tap the screen or press any key on the front panel.
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To deactivate the screen saver

1. Press the [Setup] key.

2. Select "User Interface > Display"

3. Disable the "Screen Saver" state.

10.2  Configuring global connectors

The R&S AREG800A is equipped with multipurpose bi-directional connectors.

10.2.1  Required options

The R&S AREG800A is equipped with two User interfaces.

Additional options are not required.

10.2.2  Global connectors

The R&S AREG800A is equipped with "User x" interfaces which can be freely
assigned a selection of signals and which can be configured as outputs.

Table 10-1 gives an overview of the signals that can be applied to and output at the
"User x" connector.
Table 10-1: Mapping control signals to the User x connectors

Connector Direction Assigned signal Remark

"User 1"

"User 2"

"Output" "Object Marker" An object setting event generates a marker signal

 "Not used" "None" Default setting for "User x" connectors

10.2.3  Global connectors settings

Access:

1. Select the "System Config" tile.

2. "Select Setup" > "General > Global Connectors".

Configuring global connectors



General instrument functionsR&S®AREG800A

236User Manual 1179.3615.02 ─ 06

3. Use the built-in Show Connector function to display the physical location of the
selected connector.

Settings:

Connector....................................................................................................................236
Show Connector..........................................................................................................236
Direction...................................................................................................................... 236
Signal.......................................................................................................................... 236

Connector
Displays the available User x connectors on the R&S AREG800A.

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Direction
Determines whether the connector is used as an output or is not used.
A connector with no specified direction is in a "Not Used" state.
Remote command: 
[:SOURce]:INPut:USER<ch>:DIRection on page 433

Signal
Selects the signal marker for the connector.
"Object
Marker"

Generates a marker signal when an object setting event occurs.
For the definition of the events, see Chapter 8.2.3, "Object marker
settings", on page 194.

Remote command: 
:OUTPut:USER<ch>:SIGNal on page 433

10.3  Organizing frequently used settings as favorites

The R&S AREG800A provides two possibilities to define frequently used settings and
procedures for later retrieval individually.

Organizing frequently used settings as favorites
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User menu and [User] key

These two functions work similar to the favorites function of a browser or other pro-
grams. They allow you to create a list of frequently used actions or to group frequently
used settings in one dialog.

You can collect the parameters of your configuration in a favorites list, i.e. in the "User
Menu", or define settings and actions with the [User] key:
● "User Menu" to group settings of specific tasks.

Similar to a favorites function, you can use this menu for:
– Grouping the settings required for a task in one dialog.
– Saving and recalling the settings of a task.
– Transferring the settings for use on multiple instruments.

● [User] key, with customizable function.
You can perform the following steps using this key:
– Open the "User Menu" (default functionality).
– Add or remove settings and functions.
– Execute actions and access functions.

Possible applications

The User key and the "User Menu" are useful for the following situations:
● There are functions or tasks you have to perform in a defined order but the setting

parameters are distributed across several dialogs.
● There are functions or tasks you have to perform frequently but they are not acces-

sible via the front panel keys.
● The required functions are grouped in a dialog that is not directly accessible from

the home screen.
● Your task involves the frequently loading and executing of certain SCPI scripts.

Refer to Chapter 11.13.4, "How to record / create SCPI lists", on page 337 for infor-
mation on how to create an SCPI script.

● A quick access to saved setups is required.
● There are functions and tasks you have to perform on several instruments.

Dialog identification

To identify each dialog, the instrument uses a dedicated dialog ID. The dialog ID con-
tains the dialog position on the display and the current active tab. The action that trig-
gers the instrument to open a dialog uses this identification.

Save/Recall vs. recall setup

If you need to restore a specific signal generation setup and perform further configura-
tions based on this particular instrument state, the R&S AREG800A provides two
options:
● "Save/Recall" function

For a detailed description, refer to Chapter 9.4, "Saving and recalling instrument
settings", on page 210.
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● "Recall Setup" function
If the "Recall Setup" is the only user action assigned to the [User] key, pressing this
key triggers the R&S AREG800A to load the user-defined preset file immediately.

10.3.1  User menu settings

The "User Menu" dialog contains function keys to organize, save and load a favorites
list. You can also modify, add or delete list entries directly in the dialog.

Clear User Menu
Removes all entries from the "User Menu" at once.

Save User Menu
Saves the current "User Menu" under the defined filename.

Recall User Menu
Loads the selected "User Menu" file.
This function enables you to use the user specific favorites file on another instrument.
However, if functions or parameters are not provided due to varying configuration of
the instrument, the settings of these particular parameters take no effect.

10.3.2  How to use the user menu for fast adjustments

Access:

1. Press the [User] key.

The "User Menu" dialog opens.
If you execute this action for the first time, the dialog displays instructions on how
to use the "User Menu".

2. If you already have a saved user menu file on the instrument, you can load with
"Recall User Menu".

Creating a user menu

To create your own user dialog with settings:

1. Open a dialog with settings you frequently use.

2. Select a parameter.

3. Open the context menu and select "Add to User Menu".
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A favorites icon  indicates that the parameter is used in the "User Menu".
The "User Menu" button in the taskbar confirms that you have created a "User
Menu" with at least one entry.

4. Press the [User] key.

The "User Menu" dialog shows all parameters that you have added to the list.
You can modify the parameter settings directly in this dialog, e.g .change a state or
set values, as you do in the particular dialog the parameter originally belongs to.

5. To remove an entry, select the parameter either in the "User Menu" or in the dialog
where it originally belongs to.

a) Open the context menu and select "Remove from User Menu".

6. To remove all entries at once, select "Clear User Menu".

7. To save your individual favorites list, select "Save User Menu", and follow the file
managing instructions.
The file system automatically assigns the file extension *.user_menu.

8. To recall a previously saved user menu, select "Recall User Menu" and proceed
accordingly.

Providing a user menu favorites list for several instruments

To transfer files from or to an instrument:

1. Create the favorites list, as described in "Creating a user menu" on page 238.

2. Save the favorites list.

3. To tansfer a file from or to an instrument, the R&S AREG800A provides several
options, see "File handling" on page 204.

10.3.3  Define user key actions settings

Access:

► Select "System Configuration > Setup > User Interface > Define User Key".

The dialog displays a list of the currently enabled actions and provides functions to
define new, edit or remove existing actions. If no actions have been defined, the list
is empty.
See Chapter 10.3.4, "How to assign actions to the [User] key", on page 240.
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The remote commands required to define these settings are described in Chapter 12.7,
"DISPlay subsystem", on page 373.

Name
Enters a user-defined name for the action.

Wizard
Defines the action to be executed.
"Load SCPI Script"

Selecting the action load and executes the SCPI script.
"Recall Setup" Load a setup for quick access to the user-defined settings.

Select
Depending on the selected "Wizard", provides access to:
● The standard "File Select" function for loading of an SCPI script or setup file
● A list of the dialog IDs of all currently opened dialogs. The dialog ID is used for dia-

log identification in the remote control.
See SCPI.

SCPI
For the currently selected action, displays the corresponding SCPI command with the
associated parameter for dialog identification (dialog ID). The automatically displayed
SCPIs are enabled for subsequent modification.
Remote command: 
:DISPlay:DIALog:OPEN on page 377
See also :DISPlay:DIALog:ID? on page 376

Add, Change, Remove
Standard functions for managing of the actions.

Back to Execute Mode
Opens the "Select Action to Execute" dialog. Select an Action form the list to execute
it.
To return to the "Define User Key Actions" dialogs, select Select Action to Execute >
Define Actions.

Select Action to Execute > Define Actions
Accesses the "Define User Key Actions" dialog.

10.3.4  How to assign actions to the [User] key

The customizable [User] key has no predefined function assigned. You can individually
define actions to be executed or functions to be accessed when pressing this key.

To assign a frequently used dialog to the [User] key:

1. Open the dialog you want to quickly access.
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2. Select "System Configuration > Setup > User Interface > Define User Key".

3. To create an action:

a) Specify the "Name".
b) Select "Wizard > Open Dialog"
c) Select "Select" and select the dialog ID from the list

The corresponding SCPI command is automatically displayed and can be later
modified.

4. Select "Add" to store the new action in the list of user key actions.

5. To execute the created action, press User.
In the list of actions ("Select Action to Execute" dialog), navigate to the required
action.

The R&S AREG800A executes the action and opens the dialog.

10.4  Managing licenses and license keys

An option is ready to operate after it is enabled with a license keycode supplied with
the option. The license key is delivered as a file or on paper. Unregistered licenses
must be registered for a particular instrument before the corresponding option can be
enabled for operation.

For reliable operation, a software option usually requires the latest firmware version.
The required version is specified in the delivery. If your instrument works with a former
firmware version, update the firmware before enabling the software option.
The firmware update is described in the release notes provided on the product page of
the R&S AREG800A.

10.4.1  Manage license keys settings

The "Manage Licnese Keys" dialog provides all information on the available licenses.
Instrument-related steps guide you through the process of registering or deactivating
licenses.

Access:

1. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Manage License Keys".

Managing licenses and license keys
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In this tab, you can activate licenses for newly purchased or newly registered
options.

2. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Installed License Keys".

This tab lists all active options, with information on the available number of an
option, the license type and registration. You can query inactive or disabled options
also.

3. Select "Open License Server".

The "Manage License Keys" dialog covers all required parameters for activating or
deactivating newly purchased or newly registered options, and provides access to
the onboard license server, see Chapter 10.4.2, "Using the license server",
on page 244.
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Settings

Device ID.....................................................................................................................243
Enter License Key....................................................................................................... 243
Import License Key from File...................................................................................... 243
Export Deactivation Response to File......................................................................... 243
License Installation Info...............................................................................................243
Installed License Keys................................................................................................ 243

└ Show Inactive................................................................................................243
└ Show Deactivated.........................................................................................243
└ Installed License Keys Table.........................................................................244

Open License Server.................................................................................................. 244

Device ID
Displays the instrument-specific identification number. The device ID is a unique string
with the following structure:
<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.
For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.
Use this function also to import the deactivation key file generated by the R&S License
Manager online tool (see How to move a portable license).

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file manage-
ment dialog to save the file.
This key is required during the unregistration process, e.g. when you want to deinstall
an option or have a portable option, which you want to register later on another instru-
ment (see How to move a portable license).

License Installation Info
Indicates status information on the performed actions.

Installed License Keys
Access: select "System Config > Setup > Instrument Assembly > Manage License
Keys > Installed License Keys".
Comprises information on the installed options.

Show Inactive ← Installed License Keys
Enables the display of the inactive (expired) licenses in the Installed License Keys
Table.

Show Deactivated ← Installed License Keys
Enables the display of the deactivated licenses in the Installed License Keys Table.
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See How to move a portable license for information on how to activate deactivated
licenses.

Installed License Keys Table ← Installed License Keys
Shows information on the currently installed options.
"Export License Key to File"

Opens a dialog to save the generated license key file. This file is
required during the unregistration process.
If you have a portable unregistered option, you can register it later on
another instrument (see How to move a portable license).

"Option" Displays the option short designation.
"License Count"

Displays the number of the licenses for the selected option key.
"License Type" Displays the type of license.

A license type determines the common qualification application dura-
tion and the portability of a license. The following license types are
provided: evaluation, permanent, portable, quantified, time-controlled
with a duration of 1, 3, 6 or 12 months. A license can also be deacti-
vated or expired.
For time limited licenses, the left time of applicability is displayed too.

"Registrations" (reserved for future use)

Open License Server
Opens the R&S License Server of the R&S AREG800A, see Chapter 10.4.2, "Using
the license server", on page 244.

10.4.2  Using the license server

The R&S AREG800A now supports handling of software licenses using the license
server from Rohde & Schwarz.

As a browser application you can access the R&S License Server either in a browser
and also directly in the R&S AREG800A. The onboard license server integrated in the
instrument firmware has connection to a local smartcard memory. The local smartcard
holds local licenses, i.e. licenses that are intended for use on this specific instrument.

To open the license server

Access:

1. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Installed License Keys".
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2. Select "Open License Server".

The license server browser opens in a browser window and starts initially in the
"Configuration" view.

Figure 10-1: R&S license server dialog

The selection button in the upper left enables you to access the "Analytics" or
"Licenses" views, see "Short glance at the main views" on page 245.

The icons at the upper right lead you to information on the license server:
● "About": shows the software version.
● "User Manual": opens the embedded license server user manual.
● "Help": provides the functional description on a specific dialog and its settings.

Short glance at the main views

The section provides a brief insight into the main windows of the license server. For
details and handling of the application, refer to the embedded user documentation.

1. To access a view, select the menu button.

2. Select "Configuration".
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Figure 10-2: Configuration menu

Accesses the license server, access lists and installed product definitions.

a) Select "Local license server".

Figure 10-3: Example of a local license server view

Shows the onboard license server of the instrument. With the column selection,
you can indicate or unhide characteristics of the available server. The task bar
buttons provide access to the corresponding functions and access lists.

b) Select "Product definitions".

Figure 10-4: Example of a product definition view

Shows installed product definitions. To view the available characteristics, use
the column selection.
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3. Select "Licenses".
Provides access to the available license servers.

The "License keys" view lists the license key options that are available on the
selected server. To show additional information, use the column selection.
The task bar functions enable you to activate or deactivate a license, to get details
on an option and export license keys or information on the selected product.

4. Select "Analytics".

Figure 10-5: Analytics menu

Provides access to the license providers, client applications and enables you to
export statistics data for evaluation in external applications.

Shows information on configured client applications, license providers and license
types. To show additional information, use the column selection.

To manage licenses on the R&S AREG800A

To request or return a license, proceed as follows:

1. Access: see "To open the license server" on page 244.

The browser application opens.

2. Select "Licenses"

3. Select a license server in the menu list, e.g. "R&S AREG800A".

The "License keys" view lists the enabled options available on the selected server.

4. Select "Status" > "Select all" to list also options that are currently deactivated.

The "Licenses" view shows all active, inactive and time limited options.

5. To get detailed information on a specific option:

a) Select the option in the list.
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b) In the task bar, select "Details".

Figure 10-6: Example of the license characteristics of an option

6. To enable a discontinued license: , select  in the taskbar.

a) Select the license you want to activate.
b) In the task bar, select .

7. To return a license, proceed the same way:

a) Select the license.
b) Deactivate the license with .

8. Follow the instructions on the screen.

10.4.3  How to move a portable license

This example is intended to explain how to perform the required steps at the instru-
ment.

Use a USB flash drive to transfer the license key files between the instruments and the
browser.

We assume knowledge about the handling of the R&S License Manager online tool
and the description of the whole process.

1. Open your browser. Enter https://extranet.rohde-schwarz.com/service.
Select "Manage Licenses > Move Portable License".

The first step requires the Device IDs of the source and target instruments.

2. To find out the Device IDs, proceed as follows:

Managing licenses and license keys
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a) On the source instrument, select "System Config > Setup > Instrument Assem-
bly > Manage License Keys > Manage License Keys > Device ID".

b) On the target instrument, select "System Config > Setup > Instrument Assem-
bly > Manage License Keys".

c) In the "Mange License Keys" tab, select "Device ID".
d) In the browser, select "Manage Licenses > Move Portable License > Select

Devices".
e) Enter the Device IDs.

3. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Installed License Keys > License Keys Table".

a) Navigate to the portable license that you want to move.
b) Select the "Export License to File" column.

A standard file manager dialog opens.

4. Enter a filename.

5. Save the exported license key, e.g. k123_portable_key_to_move.xml.

6. In the browser, select "Manage Licenses > Move Portable License > Select
License (from file)":

a) Select the exported license key.
b) Check the selection.
c) Create the deactivation key.
d) Save it to file.

7. Select the transferred deactivation key.

8. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Manage License Keys > Export Deactivation Response to
File".

9. In the browser, go to "Manage Licenses > Move Portable License > Install Deacti-
vation Key (from file)".

10. Enter the deactivation response of the instrument.

The license is deactivated for the source instrument.

11. In the "Manage Licenses > Move Portable License", go to step "Create License" to
generate a license key for this portable option and the selected target instrument.

a) Download the license key as a file.
b) Transfer it to the target instrument.

12. In the target instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > New License > Import License Keys from File".
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13. Select the created license key file.

The portable option is installed on the target instrument.

10.5  Using the security settings

The protection function of the R&S AREG800A offers several levels to activate particu-
lar functions like self-test or tests for service purposes specifically.

Protection

The five protection levels are automatically active on startup that means all protected
functions are locked.

To unlock a protection level:

► In the "System Config > Setup > Security > Protection" dialog, enter the correct
password.

To lock a protection level:

► Clear the corresponding checkbox.

Protection levels

The following functions are protected in the respective levels:
● Protection level 1

Protects against accidental changes, like, for example, the clock and date, several
internal adjustments functions and the self-test, as well as network settings or the
instrument hostname.
You can access this level with the password 123456.

● Protection level 2
Unlocks protected service functions. It is accessible to authorized personnel of
Rohde & Schwarz service department only.

● Protection level 3 to 5
Are reserved for internal use.

Security

The security concept of the R&S AREG800A helps you to protect your instrument
against uncontrolled access and changes. All provided security services require that
you enter the security password.

Provided security services are:
● General security parameters, such as:

– USB storage that secures controlled access to the mass memory of the instru-
ment

– Volatile mode that prevents information to be written to the internal memory
permanently.
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– Sanitizing that prevents the instrument from leaving a secure environment with
stored user information.

– Annotation frequency and amplitude prevent reading the display.
– Secure Update Policy check that verifies the integrity and origin of the firm-

ware package to be installed.
To access the settings of these topics, see Setting security parameters >
"Secure Update Policy" on page 253.

● Password management secures controlled user access to the instrument
With the two-step password concept, you can assign a user-defined password for
the operating system, and a security password for accessing the mass storage of
the instrument.
See Chapter 10.5.4, "Password management", on page 260.

● LAN services secure controlled network access
You can individually lock and unlock supported LAN interface services, including
the SMB client and SMB server that use versions 1.0 and 2.0 of the SMB protocol.
Remote control over LAN requires you have enabled the interface, but you can dis-
able not needed LAN services individually.
Note: Disabling LAN services needed for remote control over LAN locks the instru-
ment access persistently. You cannot address the instrument any longer.
See Chapter 10.5.3, "Configuring LAN services", on page 257.

● User interface prevents front panel operation and/or reading the display.

For more information, see the document R&S AREG800A Instrument Security Proce-
dures.

10.5.1  Protection level settings

Access:

► Select "System Config > Setup > Security > Protection".

The "Protection" dialog provides access to the unlocking of different protection lev-
els.
Several functions in the instrument are password-protected to prevent for example
accidental changes, "Protection" on page 250.
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The remote commands required to unlock a protected stage are described in Chap-
ter 12.12, "SYSTem subsystem", on page 395.

Protection Level/Password
Unlocks the selected level of protection, if you enter the correct password.
The default protection level 1 password is 123456.
To lock the protection level again, clear the checkbox.
Remote command: 
:SYSTem:PROTect<ch>[:STATe] on page 406

10.5.2  Setting security parameters

Access:

► Select "System Config > Setup > Security > Security > General".

In the "General" tab, you can determine the security level for firmware updates, and
configure the security settings for the mass memory and manual operation.

All modified settings in this dialog are not applied until you enter the Security Password
and confirm with Accept.

10.5.2.1  Update policy security settings

Access:

► Select "System Config > Setup > Security > Security > General > SW Update".
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The SW Update tab enables you to select the security mode for firmware updates.

The remote commands available to control security settings are described in Chap-
ter 12.12, "SYSTem subsystem", on page 395.

Secure Update Policy
Allows you to configure the automatic signature verification for firmware installation.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.
See also:
● Chapter 10.5, "Using the security settings", on page 250 for more information on

the security concept.
● The release notes for details on signature verification when installing new or former

firmware versions, available at www.rohde-schwarz.com/firmware/areg800a.
"Confirm Unsigned"

Performs the signature verification.
If the check detects any discrepancies, the instrument issues a warn-
ing message. You can still update the firmware or reject updating.
This setting also enables you to downgrade the firmware version.

"All Packages" Accepts all packages without signature verification.
"R&S Signed Packages"

Performs the signature check.
If the check detects any discrepancies, the instrument issues a warn-
ing message and locks the update to this firmware.

Remote command: 
:SYSTem:SECurity:SUPolicy on page 417

10.5.2.2  Disk & memory security settings

Access:

► Select "System Config > Setup > Security > Security > General > Disk & Memory".

Using the security settings
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The "Disk & Memory" tab secures controlled access to the mass memory and pre-
vents information from leaving a secure environment.

The remote commands available to control security settings are described in Chap-
ter 12.12, "SYSTem subsystem", on page 395.

USB Storage
Activates the access to external USB storage media.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.
See also Chapter 9.7.4, "Using a USB storage device for file transfer", on page 225.
Note: Remove all USB memory devices before disabling the USB storage. If any USB
memory device remains connected, disabling is blocked, and the instrument returns a
warning message.

Volatile Mode
Activates volatile mode, so that no user data can be written on the internal memory
permanently.
In volatile mode:
● Data that the instrument normally stores on the internal memory is redirected to

volatile memory.
● The user directory is mapped to the volatile memory. You access the temporary

data just as data stored in the /var/user/, see Chapter 9.3, "Protecting data",
on page 209.

● Data on the internal memory cannot be changed. It is protected against modifica-
tion or erasure.

● You can only save data:
– Temporarily in the volatile memory
– On a connected external storage device, such as a memory stick

To activate volatile mode: enter the security password, confirm with "Accept" and
reboot the instrument. Otherwise the change has no effect.
Activated volatile mode is indicated by the icon .
Remote command: 
:SYSTem:SECurity:VOLMode[:STATe] on page 418

Using the security settings
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Sanitize
Executes the erase procedure that sanitizes the internal memory.
The sanitizing function makes sure that no user information is stored on the instrument
when it leaves the secure environment.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.
Note: If the instrument is subject to high security, and you have disabled volatile mode,
the internal memory holds user-data, and thus poses a security risk.
See also Chapter 10.5, "Using the security settings", on page 250 for more information
on the security concept.
Remote command: 
:SYSTem:SECurity:SANitize[:STATe] on page 417

10.5.2.3  Manual operation security settings

Access:

► Select "System Config > Setup > Security > Security > General > Manual Opera-
tion".

The "SW Update" tab enables you to lock front panel operation and/or reading the
display.

The remote commands available to control security settings are described in:
● Chapter 12.7, "DISPlay subsystem", on page 373
● Chapter 12.12, "SYSTem subsystem", on page 395.

Annotation Frequency
Enables the display of the currently used frequency in the status bar.
How to: see "Disabling the frequency and level indication in the status bar"
on page 265.
Remote command: 
:DISPlay:ANNotation:FREQuency on page 375

Annotation Amplitude
Enables the display of the currently selected level in the status bar.

Using the security settings



General instrument functionsR&S®AREG800A

256User Manual 1179.3615.02 ─ 06

How to: see "Disabling the frequency and level indication in the status bar"
on page 265.
Remote command: 
:DISPlay:ANNotation:AMPLitude on page 375

User Interface
Allows you to lock the controls for manual operation and the display individually.
How to: see "Deactivating the user interface" on page 265.
See also Chapter 10.5, "Using the security settings", on page 250.
"Enabled" Enables the display and all controls for the manual operation of the

instrument.
"Touchscreen Off"

Locks the touch sensitivity of the screen.
This security feature protects the instrument against unintentional
change of settings by accidentally touching of the screen.
Still available controls for manual operation are:
● The keys at the front panel, including the rotary knob
● The external mouse and keyboard
● Remote operation over VNC
The instrument indicates the locked touchscreen by an icon .
Unlocking is possible via VNC, external controls or remote control.

"VNC Only" Locks the keys at the front panel, the touchscreen and externally con-
nected keyboard and mouse.
The display on the screen remains and shows the current settings
and changes.
The instrument indicates the activated "VNC only" feature by the icon

.
Unlocking is possible via VNC or turning off and on again.

"Display Only" Locks the manual operation of the instrument. The display on the
screen remains and shows the current settings and changes.
This security feature protects the instrument against unauthorized
access, but still shows the current settings and processes, for exam-
ple when you operate the instrument via remote control.
The function disables:
● The touchscreen functionality of the display
● The keys at the front panel of the instrument
● The external mouse and keyboard
The instrument indicates the locked controls by a padlock  softkey.
How to unlock: see "Unlocking (reactivating) the user interface for
manual operation" on page 265.
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"Disabled" Locks the display and all controls for the manual operation of the
instrument.
This security feature protects the instrument against unauthorized
reading and access, for example when you operate the instrument via
remote control.
The function disables:
● The display
● The touchscreen
● The keys at the front panel of the instrument
● The external mouse and keyboard
The screen shuts off and displays a padlock symbol  instead.
How to unlock: see "Unlocking (reactivating) the user interface for
manual operation" on page 265.

Remote command: 
:SYSTem:ULOCk on page 404
:SYSTem:DLOCk on page 403
:SYSTem:KLOCk on page 403

Enabling a locked user interface for manual operation
Follow the instructions listed in "Unlocking (reactivating) the user interface for manual
operation" on page 265.
Remote command: 
:SYSTem:ULOCk on page 404
:SYSTem:DLOCk on page 403
:SYSTem:KLOCk on page 403

10.5.3  Configuring LAN services

Access:

1. Select "System Config > Setup > Security > Security > LAN Services > Common
Services".

2. NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or the com-
mon services "SCPI over LAN", "VNC" and "HTTP" locks the remote access to the
instrument.
Do not disable the LAN interface or LAN services needed for remote control while
you operate the instrument remotely.
Proceed with step step 4 for troubleshooting disabled services.

In the "Common Services" side tab, you can individually disable the supported ser-
vices of the LAN interface.

3. Disable LAN services as needed.

a) Disable the service.
b) To confirm disabling, enter the security password.
c) Select "Accept".

Using the security settings
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4. If you have locked the access accidentally, you have the following options:
● Update the instrument firmware using ISO image

(<instrument>_<version-number>.iso).
Note: A firmware update with the ISO image resets the instrument. The instru-
ment reset dismisses user-specific configurations and deletes user data.
Contact the Rohde & Schwarz (https://www.rohde-schwarz.com/support) to get
the ISO image.

● Ship the instrument to your local service department. The service center
experts can enable the remote access over LAN without loosing user-specific
settings and data.
See http://www.services.rohde-schwarz.com.

5. Select "System Config > Setup > Security > Security > LAN Services > Samba Ser-
vices".

In the "Samba Services" side tab, you can activate former versions of the SMB cli-
ent and SMB server.

The remote commands available to control security settings are described in Chap-
ter 12.12, "SYSTem subsystem", on page 395.

How to:
● "Disabling the LAN interface" on page 264
● "Disabling LAN services" on page 264
● "Activating SMB version 1.0/2.0 client and server" on page 265

Common Services.......................................................................................................258
└ LAN...............................................................................................................258
└ LAN Services................................................................................................ 258

Samba Services.......................................................................................................... 260
└ SMB 1.0/2.0 Client........................................................................................260
└ SMB 1.0/2.0 Server.......................................................................................260

Security Password...................................................................................................... 260
Accept......................................................................................................................... 260

Common Services
Enables the LAN interface and supported LAN interface services.

LAN ← Common Services
Enables the LAN interface in general, and thus provides remote access over all
unlocked services.
Remote command: 
:SYSTem:SECurity:NETWork[:STATe] on page 417

LAN Services ← Common Services
Enables the supported LAN interface services individually.

Using the security settings
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"SCPI over LAN"
Access over LAN to control the instrument remotely, by using SCPI
(Standard Commands for Programmable Instruments) commands.
See also "To start remote control with R&S VISA" on page 326.
Remote command: 
:SYSTem:SECurity:NETWork:SOE[:STATe] on page 416

"VNC" Access over VNC (Virtual Network Computing) interface, a graphical
desktop sharing system that uses RFB protocol to control the instru-
ment remotely.
See also Chapter 11.14, "To operate the instrument using VNC",
on page 342.
Remote command: 
:SYSTem:SECurity:NETWork:VNC[:STATe] on page 417

"SSH (SCP)" Access over SSH (Secure Shell), a network protocol for secure data
communication.
Remote command: 
:SYSTem:SECurity:NETWork:SSH[:STATe] on page 416

"Remote Support"
Remote support over SSH (SCP).
The service provides communication for service purposes only.
Remote command: 
:SYSTem:SECurity:NETWork:REMSupport[:STATe]
on page 415

"HTTP" Access with HTTP (Hyper Text Transfer Protocol), the application pro-
tocol for hypermedia information systems.
Remote command: 
:SYSTem:SECurity:NETWork:HTTP[:STATe] on page 414

"FTP" Access with FTP (File Transfer Protocol), used to transfer files from a
host to the instrument and vice versa.
See also Chapter 9.7.2, "Accessing the file system of the
R&S AREG800A over FTP", on page 222.
Remote command: 
:SYSTem:SECurity:NETWork:FTP[:STATe] on page 414

"SMB (Samba)"
Access to SMB (Server Message Block), used for providing shared
access to files, printers and serial ports of a network.
See also Chapter 9.7.3, "Accessing the R&S AREG800A file system
using SMB (Samba)", on page 223.
Remote command: 
:SYSTem:SECurity:NETWork:SMB[:STATe] on page 415

"Avahi (Zeroconf)"
Avahi, a service for automatic configuration of the instrument in a net-
work environment.
Remote command: 
:SYSTem:SECurity:NETWork:AVAHi[:STATe] on page 414
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"Software Update"
Allows updating the software.
Remote command: 
:SYSTem:SECurity:NETWork:SWUPdate[:STATe] on page 416

Samba Services
Enables support of SMB client and SMB server version 1.0 and 2.0 of the SMB proto-
col.
Support of version 1.0 and 2.0 is additional to the current SMB protocol version sup-
ported in the firmware. This firmware supports SMB protocol up to version 3.1.1.

SMB 1.0/2.0 Client ← Samba Services
Enables support of the SMB client compatible with SMB protocol versions 1.0 and 2.0.

SMB 1.0/2.0 Server ← Samba Services
Enables support of the SMB server compatible with SMB protocol versions 1.0 and 2.0.

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is 123456.
How to: "Changing the default security password" on page 264

Accept
Applies the modified settings, provided the security password is entered and correct.

10.5.4  Password management

Access:

1. Select "System Config > Setup > Security > Security > Password Management >
User Password".

Using the security settings
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In this tab, you can assign the security and a user-defined password.

2. Select "System Config > Setup > Security > Security > Password Management >
Security Password".

How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

User Name
Indicates the user name used for access to the Linux operating system and valid for
VNC, FTP and SMB (Samba) access.

User Password
Allows you to change and confirm the user password.

Using the security settings
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Old Password ← User Password
Enters the current user password. The default password is "instrument".
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Chapter 13.10, "Contacting customer support", on page 540.

New Password ← User Password
Enters the new user password.
The security password can contain decimal characters only.

Confirm Password ← User Password
Confirms the new user password by repeating.
How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

Change Password ← User Password
Changes the user password accordingly.

Security Password
Enables you to change and confirm the security password.

Old Password ← Security Password
Enters the currently used security password. The default password is '123456'.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.
The security password is required when changing the status of the USB and LAN inter-
face or other security settings.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Chapter 13.10, "Contacting customer support", on page 540.

New Password ← Security Password
Enters the new security password.
The security password can contain decimal characters only.

Confirm Password ← Security Password
Confirms the new security password by repeating.
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How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

Change Password ← Security Password
Changes the password accordingly.

10.5.5  How to prevent unauthorized access

The default computer name and user password are instrument. The user password is
the password required for VNC, FTP and SMB (samba) connections. If for example,
the VNC service or FTP are enabled, anyone in the network who knows the computer
name and user password of the instrument can access it.

The default security password is 123456. The security password is required when
changing the status of the USB and LAN interfaces.

To prevent unauthorized access, use the following configurations exclusively or com-
plementary:
● "Changing the default user password of the instrument" on page 263
● "Changing the default security password" on page 264
● "Disabling the LAN interface" on page 264
● "Disabling LAN services" on page 264
● "Activating SMB version 1.0/2.0 client and server" on page 265
● "Disabling the frequency and level indication in the status bar" on page 265
● "Deactivating the user interface" on page 265

If security is a concern, see the document instrument security procedures for compre-
hensive description.

Changing the default user password of the instrument

► Note: We recommend that you change the default password before connecting the
instrument to a network.

How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

a) Select "System Config > Setup > Security > Security > Password Management
> User Password".

b) Enter the current password in the "Old Password" field.
c) Enter the new password in the "New Password" and "Confirm Password" fields.
d) Select "Change Password".

The user password is changed; the user name is displayed ("Security > Password
Management > User Password > User Name").

Using the security settings
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Changing the default security password

► Note: We recommend that you change the default password before connecting the
instrument to a network.

How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

a) Select "System Config > Setup > Security > Security > Password Management
> Security Password".

b) Enter the current password in the "Old Password" field.
The default password is 123456.

c) Enter the new password in the "New Password" and "Confirm Password" fields.
d) Select "Change Password".

Disabling the LAN interface

1. NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or certain
services lock the remote access to the instrument.
The following services lock the remote access when disabled: "LAN", "SCPI over
LAN", "VNC" and "HTTP".
If you have locked the access accidentally, you have the following options:
● Update the instrument firmware using ISO image

(<instrument>_<version-number>.iso).
Note: A firmware update with the ISO image resets the instrument. The instru-
ment reset dismisses user-specific configurations and deletes user data.
Contact the Rohde & Schwarz (https://www.rohde-schwarz.com/support) to get
the ISO image.

● Ship the instrument to your local service department. The service center
experts can enable the remote access over LAN without loosing user-specific
settings and data.
See http://www.services.rohde-schwarz.com.

2. Select "System Config > Setup > Security > Security > LAN Services > Common
Services".

3. Select "LAN > Off".

All LAN connections and hence all LAN services are disabled.

Disabling LAN services

1. Select "System Config > Setup > Security > Security > LAN Services > Common
Services".

2. Select, for example, "FTP > Off" or "VNC > Off".

3. Enter the Security Password.

4. Select "Accept".

Using the security settings
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Activating SMB version 1.0/2.0 client and server

By default, support of SMB client and SMB server of the SMB protocol versions 1.0
and 2.0 is deactivated.

Activate support only, if needed:

1. Select "System Config > Setup > Security > Security > LAN Services > Samba Ser-
vices".

2. Select "SMB 1.0/2.0 Client > On" and "SMB 1.0/2.0 Server > On".

3. Enter the Security Password.

4. Select "Accept".

Disabling the frequency and level indication in the status bar

These settings are useful to prevent unauthorized personnel from reading the display,
when you remotely control the instrument from a different location.

1. Select "System Config > Setup > Security > General > Manual Operation".

2. Select "Annotation Frequency > Off" or "Annotation Amplitude > Off".

3. Enter the Security Password.

4. Select "Accept".

Deactivating the user interface

1. Select "System Config > Setup > Security > General > Manual Operation".

2. Select "User Interface > Disabled".

3. Enter the Security Password.

4. Select "Accept".

The screen shuts off and displays a padlock symbol  instead.
There are further possible configurations. For details, see "User Interface"
on page 256.

Unlocking (reactivating) the user interface for manual operation

1. In manual operation:

a) On the instrument's keypad or external keyboard, press any key.
The instrument prompts you to enter the security password for unlocking.

If you press the character of the first key, the input field accepts the character
immediately.
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b) Delete the entry before inserting the password.
Enter the security password 123456.

2. In remote control mode:

a) Send the command SYST:ULOC ENABled to release all locks at once.
b) Send the command SYST:KLOC OFF to unlock the keyboard and touchscreen.
c) Send the command SYST:DLOC OFF to release all locks.

Via remote control, there is no password required.

10.6  Undoing or restoring actions

"Undo" is a function that removes the effect of the last action on the instrument and
reverts it to an older state. Conversely, "Redo" restores a previously undone action.

You can "Undo/Redo" actions according to two criteria:
● Step by step

Gradually undo/redo the actions in reverse order as previously performed.
Depending on the available memory the "Undo/Redo" steps may restore all
actions.

● Multiple steps at once
Select any specific action in the history list to "Undo/Redo" multiple actions in a sin-
gle step.
Note: This mode requires a system restoration file on the instrument.

Access:

► Select "Setup > Settings > Undo/Redo".

The dialog contains all functions for enabling the "Undo/Redo" functionality.

Settings:

State............................................................................................................................266
History List.................................................................................................................. 266
Clear History............................................................................................................... 266
Apply........................................................................................................................... 266

State
Enables the recording of the performed actions.

History List
Lists the performed actions, provided "Undo/Redo" state is "On".

Clear History
Deletes the recorded list of the performed steps.

Apply
Performs the "Undo/Redo".

Undoing or restoring actions
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If you select a previously performed action of the list, all subsequent actions are
undone. The list entries remain.
If you select a subsequently executed action, you can restore all the actions undone up
to this state.

10.7  Shutting down and rebooting the instrument

The [On/Standby] front panel key switches the instrument from the standby to the
ready state or vice versa. In remote operation from a remote computer or in manual
control, there is another possibility to shut down the instrument or to reboot the system.

Access:

► Select "System Config > Setup > Maintenance > Shut Down".

● :SYSTem:REBoot on page 424
● :SYSTem:SHUTdown on page 424

Shutting down and rebooting the instrument
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11  Network operation and remote control
As an alternative to the interactive operation directly at the instrument, you can operate
the R&S AREG800A also from a remote location.

The various interfaces provide flexible access to the instrument, such as remote con-
trol, remote operation or remote file access. These remote access modes are funda-
mentally different, although they are often considered interchangeable, as described in
Overview of remote access modes.

Figure 11-1 shows the possibilities of the physical connection (interfaces) for remote
access.

The following descriptions provide information required for operating the
R&S AREG800A remotely. The information applies to all applications and operating
modes supported by the instrument. Definitions specified in the SCPI standard are not
provided.
For basic knowledge on remote control operation and additional information, see the
following documents, available on the Rohde & Schwarz website:
● Remote control via SCPI
● 1GP72: Connectivity of Rohde&Schwarz Signal Generators
● 1MA208: Fast Remote Instrument Control with HiSLIP

Figure 11-1: Supported remote connections

● Overview of remote access modes.......................................................................269
● Remote control interfaces and protocols...............................................................270
● Remote control programs and libraries.................................................................275
● Status reporting system........................................................................................ 278
● Remote access settings........................................................................................286
● LXI settings........................................................................................................... 310
● To configure the instrument for remote access..................................................... 317
● To establish a remote control session over LAN...................................................322
● To establish a remote control session over GPIB................................................. 329
● To establish a remote control session over USB...................................................330

https://www.rohde-schwarz.com/rc-via-scpi
https://www.rohde-schwarz.com/appnote/1GP72.html
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● To trace messages with the LXI web browser interface........................................330
● To return to manual operation............................................................................... 331
● To automate tasks with remote command scripts................................................. 332
● To operate the instrument using VNC................................................................... 342
● References............................................................................................................347

11.1  Overview of remote access modes

This section outlines the possible access modes and their major characteristics.

Remote control (SCPI)

● A remote PC controls the instrument, usually via VISA (Virtual Instrument Software
Architecture) interfaces.

● Remote control disables the manual operation of the instrument; you can set differ-
ent lock states.

● The GUI is not visible.
● Remote control commands (SCPI) perform the settings, either individually or in

sequences (SCPI programs).
● Using SCPI programs is faster than the manual operation, since they automate

repeating applications.

Remote operation (VNC)

● A remote device accesses the instrument via the common platform technology
VNC (Virtual Network Computing).

● The protocol allows simultaneous operation from several remote devices and the
instrument nevertheless remains locally operable.

● The GUI is visible.
● To perform the settings, you can operate the instrument as with the manual control.
● During remote operation via VNC, the direct control of the instrument is not dis-

abled.
You can control the instrument from the front panel and via the remote computer
alternately.

● Clients supporting remote operation depend on the used remote device, see
Table 11-1.

● How to: see Chapter 11.14, "To operate the instrument using VNC", on page 342.

Overview of remote access modes
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Table 11-1: Supported VNC operation modes

Remote device VNC client Requirements Characteristics

Desktop

(Windows, Linux,
MacTMOS)

● Ultr@VNC
● Other dedicated client soft-

ware

Ultr@VNC or Client Software
must be installed.

Fast, supports several options like
full screen mode or auto-login.

 ● Any web browser Java Runtime must be installed
and activated in the browser set-
tings.

Fast and convenient - only the
instrument address required.

Java runtime is sometimes con-
sidered as security concern.

 ● Web browser with HTML5 Web sockets must be supported. Slower than the other modes.

No additional installation or acti-
vation required.

No security concern.

Smart device

(Tablet/ smartphone)

● Dedicated client App App must be installed. Fast, supports several options like
full screen mode or auto-login.

 ● Web browser with HTML5 Web sockets must be supported. Support of QR code scanning

Slower than a dedicated App.

Remote file access (FTP, SAMBA/SMB)

● A remote client accesses the instrument's file system, using the protocols FTP (file
transfer protocol) and SAMBA/SMB (server message block).

● The protocols enable you to transfer files from or to the instrument and to get direct
access to its file sharing directory share.

How to:

Chapter 9.7, "How to transfer files from and to the instrument", on page 220.

"Activating SMB version 1.0/2.0 client and server" on page 265

11.2  Remote control interfaces and protocols

The instrument supports various interfaces for remote control. Table 11-2 gives an
overview on the connectivity:

Remote control interfaces and protocols
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Table 11-2: Remote control interfaces and protocols

Interface Protocols, VISA*) address string and library Remarks

Local area network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol
(IVI-6.1)
TCPIP::host address::hislip0[::INSTR]
VISA

● VXI-11
TCPIP::host address[::
LAN device name][::INSTR]
VISA

● Socket communication (Raw Ethernet, simple
Telnet)
TCPIP::host address[::
LAN device name]::<port>::SOCKET
VISA or socket controller

The LAN connector is at the rear panel of the
instrument.

The interface is based on TCP/IP, see Chap-
ter 11.2.1, "LAN interface", on page 271 for
details on the address information.

USB ● USBTMC
USB::<vendor ID>::<product ID>::
<serial number>[::INSTR]
VISA

The USB Device connector is at the rear panel
of the instrument.

For a description of the interface, see Chap-
ter 11.2.2, "USB interface", on page 273

GPIB (IEC/IEEE Bus
Interface)

● VISA*) address string:
GPIB::<address>[::INSTR] (no secondary
address)
VISA (optional)

The optional GPIB bus interface according to
standard IEC 625.1/IEEE 488.1 is at the rear
panel of the instrument.

For a description of the interface, see Chap-
ter 11.2.3, "GPIB interface (IEC/IEEE bus inter-
face)", on page 274.

*) VISA (Virtual Instrument Software Architecture) is a standardized software interface library providing input and output functions to
communicate with instruments. A VISA installation on the controller is a prerequisite for remote control over LAN (when using
VXI-11 or HiSLIP protocol), USB and serial interface. When using socket communication or the GPIB interface, VISA installation is
optional. For basic information, see Remote control via SCPI.

http://www.rohde-schwarz.com/rsvisa provides the standardized I/O software library
R&S VISA for download at the Rohde & Schwarz website http://www.rohde-
schwarz.com/rsvisa.

How to: Chapter 11.8, "To establish a remote control session over LAN", on page 322
describes how to configure the remote control interfaces.

● LAN interface........................................................................................................ 271
● USB interface........................................................................................................273
● GPIB interface (IEC/IEEE bus interface)...............................................................274
● LXI browser interface............................................................................................ 275

11.2.1  LAN interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting
of a connector, a network interface card and protocols.

For remote control, the PC and the instrument must be connected over the LAN inter-
faces to a common network with TCP/IP network protocol. The instruments are con-
nected using a commercial RJ45 cable (shielded or unshielded twisted-pair category
5). The TCP/IP network protocol and the associated network services are preconfig-

Remote control interfaces and protocols
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ured on the instrument. Software for instrument control and, if necessary, the VISA pro-
gram library must be installed on the controller.

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

11.2.1.1  VISA resource strings

The VISA resource string is required to establish a communication session between
the controller and the instrument in the LAN. The resource string is a unique identifier,
composed of the specific IP address of the instrument and some network and VISA-
specific keywords.

TCPIP::<host address>[::<LAN device name>][::INSTR]

TCPIP = designates the network protocol
host address = designates the IP address or hostname of the instrument
[::LAN device name] = defines the protocol and the instance number of a subinstrument
[::INSTR] = indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to identify and
control the instrument. It is automatically assigned by the DHCP server the first time
the device is registered in the network. Optionally, you can also assign its LAN device
name.

If assigned, the IP address is displayed in the home screen. You can adjust it manually
with the parameter the "System Config > Remote Access > Network" > IP Address
Enabling a locked user interface for manual operation.

The following section lists the characteristics of the VISA resource strings for the corre-
sponding interface protocols. The emphasized characters determine the protocol.

For description of the interface protocols, control commands and messages, refer to
Remote control via SCPI.

HiSLIP

TCPIP::<host address>::hislip0[::INSTR]

hislip0 = HiSLIP device name, designates that the interface protocol HiSLIP is used (mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be
assigned.

Example: 
TCPIP::192.1.2.3::hislip0

Remote control interfaces and protocols
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VXI-11

TCPIP::<host address>[::inst0][::INSTR]

[::inst0] = LAN device name, indicates that the VXI-11 protocol is used (optional)

inst0 currently selects the VXI-11 protocol by default and can be omitted.

Example: 
TCPIP::192.1.2.3::INSTR

Socket communication

TCPIP::<host address>::<port>::SOCKET

port = determines the used port number
SOCKET = indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred to as
port number) and of "SOCKET" to complete the resource string.

Basically, instruments from Rohde & Schwarz use port number 5025 for socket com-
munication.

Example: 
TCPIP::192.1.2.3::5025::SOCKET

11.2.2  USB interface

For remote control using USB, the controller PC and the instrument must be connected
over the USB type B interface. Software for instrument control and the VISA program
library must be installed on the controller.

The serial interface "RS232" enables you to connect the instrument over serial inter-
face. You can connect to the interface by using the external USB/serial-adapter
R&S TS1-USB (see recommended extras in the data sheet) and a serial crossover
(null modem) cable.

VISA detects and configures the Rohde & Schwarz instrument automatically when the
USB connection is established. You do not have to install a separate driver.

USBTMC (USB Test & Measurement Class Specification) is a protocol that is built on
top of USB for communication with USB devices. It defines class code information of
the instrument, that identifies its functionality to load the respective device driver. Using
VISA library, the protocol supports service request, trigger, and other specific opera-
tions.

Remote control interfaces and protocols
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11.2.2.1  USB resource string

The resource string represents an addressing scheme that is used to establish a com-
munication session with the instrument. It is based on the instrument address and
some instrument- and vendor-specific information.

The USB resource string syntax is as follows:

USB::<vendor ID>::<product ID>::<serial number>[::INSTR]

USB = denotes the used interface
<vendor ID> = is the manufacturer ID for Rohde & Schwarz
<product ID> = is the product identification of the instrument
<serial number> = is the individual serial number at the rear of the instrument
[::INSTR] = indicates the instrument resource class (optional)

To set the USB resource string, see Remote access settings.

Example: 
USB::0x0AAD::0x01e1::100001::INSTR
0x0AAD is the vendor ID for Rohde & Schwarz.
0x01e1 is the product ID for the R&S AREG800A
100001 is the serial number of the particular instrument.

11.2.2.2  RS232 resource string

The RS232 resource string represents the addressing scheme for a device connected
to the serial interface of the instrument.

The USB resource string syntax is as follows:

ASRL<port number>[::INSTR]

ASRL is the name of the serial interface

<port number> is the number of the serial interface

Example: 
ASRL1::INSTR

11.2.3  GPIB interface (IEC/IEEE bus interface)

To control the R&S AREG800A over the GPIB bus, the instrument and the controller
PC must be connected with a GPIB bus cable. A GPIB bus card, the card drivers and
the program libraries for the used programming language must be installed on the con-
troller.

For description of the characteristics, control commands and messages of the GPIB
interface, refer to Remote control via SCPI.

Remote control interfaces and protocols
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GPIB address

The controller PC addresses the instrument with the GPIB bus channel, see Chap-
ter 11.5.3, "GPIB address settings", on page 294. GPIB provides channel addresses
from 0 to 30.

The GPIB resource string syntax is as follows:

GPIB:://<channel>[::INSTR]

GPIB = denotes the used interface
<channel address> = the used channel
[::INSTR] = indicates the instrument resource class (optional)

Note: If the VISA implementation supports the GPIB interface, you can optionally
define the VISA Instrument Control Resource (INSTR). It is used to define the basic
operations and attributes for a device, such as reading, writing, or triggering.

Example: 
GPIB::28::INSTR
28 is the selected GPIB bus channel

11.2.4  LXI browser interface

The LXI browser interface allows easy configuration of the LAN and remote control of
the R&S AREG800A without additional installation requirements. The instrument's LXI
browser interface works correctly with all W3C compliant browsers.

See Chapter 11.15.1, "LXI functionality", on page 347 for more about LXI.

The LAN settings are configured using the instrument's LXI browser interface descri-
bed in Chapter 11.6.2.1, "LAN configuration", on page 312.

11.3  Remote control programs and libraries

This section shows how the remote-control programs access the instrument, and the
libraries they require for the corresponding interface protocols.

Remote control programs and libraries
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Figure 11-2: Overview of remote control interfaces, protocols and libraries

Possible setups and access functions

The following examples give an overview of dependencies between the available libra-
ries, the possible interfaces and protocols, and whether an instrument driver is provi-
ded. For detailed information, see the application note 1GP72: Connectivity of
Rohde&Schwarz Signal Generators.

Example: Remote control (application) program using VISA

Figure 11-3: Application program using VISA

Protocol Remote control program

Socket viOpen (..., "TCPIP:AREG800A-102030::5025::SOCKET", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

VXI-11 viOpen (..., "TCPIP:AREG800A-102030::inst0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

Remote control programs and libraries
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Protocol Remote control program

HiSLIP viOpen (..., "TCPIP:AREG800A-102030::hislip0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

USBTMC viOpen (..., "USB::0x0AAD::0x01e1::100001::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

GPIB viOpen (..., "GPIB::28::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

Example: Remote control program using instrument driver (VISA available)

Figure 11-4: Application using instrument driver (VISA available)

Protocol Remote control program

Socket rsareg8_init ("TCPIP:AREG800A-102030::5025::SOCKET", ...)
rsareg8_SetFrequency (..., 2e9)

VXI-11 rsareg8_init ("TCPIP:AREG800A-102030::inst0::INSTR", ...)
rsareg8_SetFrequency (..., 2e9)

HiSLIP rsareg8_init ("TCPIP:AREG800A-102030::hislip0::INSTR", ...)
rsareg8_SetFrequency (..., 2e9)

USBTMC rsareg8_init ("USB::0x0AAD::0x01e1::100001::INSTR", ...)
rsareg8_SetFrequency (..., 2e9)

GPIB rsareg8_init ("GPIB::28::INSTR", ...)
rsareg8_SetFrequency (..., 2e9)

Remote control programs and libraries
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Example: Remote control program using instrument driver (VISA not available)

Figure 11-5: Remote control program using instrument driver (VISA not available)

Protocol Remote control program

Socket rsareg8_init ("TCPIP:AREG800A-102030::5025::SOCKET", ...)
rsareg8_SetFrequency (..., 2e9)

GPIB rsareg8_init ("GPIB::28::INSTR", ...)
rsareg8_SetFrequency (..., 2e9)

11.4  Status reporting system

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue.

You can query both with the commands of the STATus subsystem.

11.4.1  Hierarchy of the status registers

The Figure 11-6 shows the hierarchical structure of information in the status registers
(ascending from left to right).
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Figure 11-6: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation
ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Questionable Status Summary Bit
2 = Error- /Event-Queue
1, 0 = not used

Note: This legend explains the abbreviations to the Status Byte Register.

The R&S AREG800A uses the following status registers:
● Status Byte (STB) and Service Request Enable (SRE), see Chapter 11.4.3, "Sta-

tus byte (STB) and service request enable register (SRE)", on page 282.
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● Standard Event Status, i.e. the Event status Register (ESR) and the Event Status
Enable (ESE), see Chapter 11.4.4, "Event status register (ESR) and event status
enable register (ESE)", on page 283.

● Questionable Status and Operation Status, the (SCPI status registers, see
Chapter 11.4.2, "Structure of a SCPI status register", on page 280, Chapter 11.4.5,
"Questionable status register (STATus:QUEStionable)", on page 283 and Chap-
ter 11.4.6, "Operation status register (STATus:OPERation)", on page 284.

● Output-Queue
The output queue contains the messages that the instrument returns to the control-
ler. It is not part of the status reporting system but determines the value of the MAV
bit in the STB and thus is represented in the overview.

● Error-/Event-Queue
The error-/event-queue contains all errors and events that have occurred in the
past. When reading the queue, the instrument starts with the first occurred error/
event.

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR command.

11.4.2  Structure of a SCPI status register

Each SCPI status register consists of five parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number, which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus, the contents of the register parts
can be processed by the controller as positive integers.

Figure 11-7: The status-register model
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Description of the five status register parts

The five parts of a SCPI status register have different properties and functions:

● CONDition
The CONDition part is written directly by the hardware or it mirrors the sum bit of
the next lower register. Its contents reflect the current instrument status. This regis-
ter part can only be read, but not written into or cleared. Its contents are not affec-
ted by reading.

● PTRansition / NTRansition
The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.
– PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.
– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.
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The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

11.4.3  Status byte (STB) and service request enable register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB is read using the command *STB? or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *SRE and read
using the command *SRE?.

Table 11-3: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus:QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

6 MSS bit (main status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABle bit is set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus:OPERation status register.
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11.4.4  Event status register (ESR) and event status enable register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *ESE and read using the command
*ESE?.

Table 11-4: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

11.4.5  Questionable status register (STATus:QUEStionable)

This register contains information on questionable instrument states. Such states can
occur when the instrument is not operated in compliance with its specifications.

To read the register, use the query commands STAT:QUEST:COND? or
STAT:QUEST[:EVEN]?.
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Table 11-5: Meaning of the bits used in the questionable status register

Bit No. Meaning

0–15 Not used

11.4.6  Operation status register (STATus:OPERation)

This condition part contains information on the actions that the instrument currently
executes. The event part contains information on the actions that the instrument exe-
cuted since the last readout of the register.

To read the register, use the query commands STAT:OPER:COND? or
STAT:OPER[:EVEN]?.

Table 11-6: Meaning of the bits used in the operation status register

Bit No. Meaning

0 Calibrating

The bit is set during the calibration phase.

1–2 Not used

3  

4–15 Not used

11.4.7  Application of the status reporting system

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. For correct operation, the controller receives and eval-
uates the information of all devices. The status reporting system uses the following
standard methods:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller to find out

who sent an SRQ and why
● Query of a specific instrument status by commands
● Query of the error queue

11.4.7.1  Service request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which
the control program can react appropriately. An SRQ is always initiated if one or sev-
eral of bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these
bits combines the information of the error queue or the output buffer. To use the possi-
bilities of the service request effectively, set all bits to "1" in the enable registers SRE
and ESE.
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Example: 
Use command *OPC to generate an SRQ.
*ESE 1 - set bit 0 of ESE (Operation Complete)
*SRE 32 - set bit 5 of SRE (ESB).
After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program sets the instrument and initiates a service request if malfunctions
occur. The program reacts appropriately to the service request.

11.4.7.2  Serial poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

11.4.7.3  Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

11.4.7.4  Error queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem:ERRor[:NEXT]?. Each call of
SYSTem:ERRor[:NEXT]? provides one entry from the error queue. If no error mes-
sages are stored there any more, the instrument responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
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larly since faulty commands from the controller to the instrument are recorded there as
well.

11.4.8  Reset values of the status reporting system

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except for *RST and
SYSTem:PRESet affect the functional instrument settings. In particular, DCL does not
change the instrument settings.
Table 11-7: Resetting the status reporting system

Event Switching on supply
voltage
Power-On-Status-
Clear

DCL,
SDC
(Device
Clear,
Selected
Device
Clear)

*RST or
SYSTem:
PRESet

STATus:
PRESet

*CLS

Effect 0 1

Clear STB, ESR - Yes - - - Yes

Clear SRE, ESE - Yes - - - -

Clear PPE - Yes - - - -

Clear error queue Yes Yes - - - Yes

Clear output buffer Yes Yes Yes 1) 1) 1)

Clear command processing
and input buffer

Yes Yes Yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

11.5  Remote access settings

This section outlines the settings required for accessing and configuring the provided
remote control interfaces. It includes network settings, access addresses, emulation
settings for using the command sets of other generators, and the access whith smart
devices.

About instrument emulations

You can remotely control the R&S AREG800A using the command set of another sig-
nal generator. With this function you can, for example, replace a signal generator with
an R&S AREG800A in an automated test setup, without adjusting the command scripts
used.

You find the remote control command sets supported by the R&S AREG800A in a
selection list.
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The selected instrument also defines the identification string that is retrieved with query
*IDN?. If necessary, use the parameter Mode and IDN String to change this string.

As any other parameter, the remote control command set can also be changed
remotely by the command :SYSTem:LANGuage.

While working in an emulation mode, the R&S AREG800A specific command set is
disabled and the SCPI command :SYSTem:LANGuage is discarded.

To return to the SCPI command set of the R&S AREG800A, use the appropriate com-
mand of the selected command set.

About health and utilization monitoring system (HUMS)

The R&S AREG800A comes with a health and utilization monitoring system (HUMS)
providing information about the R&S AREG800A. Aim is to increase the overall utiliza-
tion, to avoid downtime and to increase the overall security level of a fleet of instru-
ments.

HUMS provides, for example, information about:
● Instrument identification, hardware components, software packages, licenses
● Usage of remote control, usage via keyboard / mouse, usage of test applications
● Hardware utilization and status, including S.M.A.R.T. data of the system drive
● User-defined static information, for example, an inventory code

Interfaces and protocols

The HUMS installation on the R&S AREG800A includes an SNMP agent and a REST
service with HTTP endpoints. So you can access the health and usage information via
LAN, using the SNMP protocol or the REST protocol. Accessing the data does not
interfere with remote control via SCPI commands or with measurement execution.

Reference information for both protocols is available on the R&S AREG800A at the
address http://<instrument>/api/hums/v1/documents?name=<interface>.

For <instrument>, enter the hostname (e.g. AREG800A-102030) or the IP address
(e.g. 10.121.0.34) of your instrument, as for access to the GUI.

For <interface> = snmp, you get a .zip file containing the MIB files for SNMP. For
<interface> = rest, you get a web page with the OpenAPI specification of the REST
API.

Address example: http://AREG800A-102030/api/hums/v1/documents?name=snmp.

The following table lists the REST endpoints and the SNMP MIB file names.

REST endpoint
/api/hums/v1/...

SNMP MIB Description Typical data

documents --- developer information SNMP MIB files, swagger specification of
HUMS REST endpoints

greetings RS-GREETINGS-MIB identity information manufacturer, model, serial number, version

equipment/bios RS-BIOS-INFO-MIB BIOS information BIOS manufacturer, version and release date

Remote access settings



Network operation and remote controlR&S®AREG800A

288User Manual 1179.3615.02 ─ 06

REST endpoint
/api/hums/v1/...

SNMP MIB Description Typical data

date-time RS-TIME-DATE-MIB time and date information UTC and local time, timezone, dst (daylight
savings time)

device-history RS-DEVICE-HISTORY-MIB history events instrument-specific event information and noti-
fications

device-tags RS-DEVICE-TAGS-MIB customer information user-definable key information, associated
with the instrument, e.g. asset number, owner,
location

equipment RS-EQUIPMENT-MIB footprint information hardware and software configuration, licenses

hums-info RS-HUMS-INFO-MIB basic information on the
HUMS service

HUMS version, counter of SNMP and REST
requests, amount of collected data, HUMS
database size

storage RS-STORAGE-MIB S.M.A.R.T. data of drive system drive temperature, drive health

system-info RS-SYSTEM-INFO-MIB a system overview OS and BIOS version, IP address, locale

system-status RS-SYSTEM-STATUS-MIB system status information global system status, static notifications

utilization RS-UTILIZATION-MIB utilization information instrument activity, e.g., power on time, RF on
time, option utilization, remote interface traffic

For detailed information about HUMS and its applications, refer to:
● The R&S®HUMS Health and Utilization Monitoring Service user manual, available

on the Rohde & Schwarz website.
● The application note GFM336: Instrument Health and Utilization Monitoring

11.5.1  Network settings

Access:

► Select "System Config" > "Remote Access" > "Network".

Remote access settings

https://www.rohde-schwarz.com/appnote/GFM336


Network operation and remote controlR&S®AREG800A

289User Manual 1179.3615.02 ─ 06

In the "Network" dialog, you can configure the settings of the general network envi-
ronment and specific identification parameters of the instrument in the network.

The remote commands required to configure the network remotely are described in
Chapter 12.12, "SYSTem subsystem", on page 395.

How to: see Chapter 3.1.7, "Connecting to LAN", on page 25.

Settings:

Network Status............................................................................................................289
Restart Network.......................................................................................................... 289
Hostname....................................................................................................................290
Workgroup...................................................................................................................290
Address Mode............................................................................................................. 290
IP Address...................................................................................................................290
Subnet Mask............................................................................................................... 291
Default Gateway..........................................................................................................291
DNS Suffix...................................................................................................................291
DNS Server................................................................................................................. 292
MAC Address.............................................................................................................. 292

Network Status
Indicates that the instrument is connected to the network.
Remote command: 
:SYSTem:COMMunicate:NETWork:STATus? on page 409

Restart Network
Terminates the network connection of the instrument and sets it up again. You can use
this function to fix network problems.
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Note: This function restarts only the connection of the instrument to the network. It
does not impact the network itself.
Remote command: 
:SYSTem:COMMunicate:NETWork:RESTart on page 408

Hostname
Displays the hostname.
Each instrument is delivered with an assigned hostname, a logical name which can be
used instead of the IP address. With the default network settings, the IP address is
allocated by the DHCP server. This address can change each time the instrument is
reconnected. Unlike the IP address, the hostname name does not change.
Note:
This function is password-protected. Unlock the protection level 1 to access it.
● We recommend that you do not change the default network settings or the host-

name to avoid problems with the network connection.
If you change the hostname, be sure to use a unique name.

Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname on page 409

Workgroup
Sets the individual windows workgroup name of the R&S AREG800A. This parameter
is required in case the instrument is integrated in a windows network.
This function is password-protected. Unlock the protection level 1 to access it.
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup on page 409

Address Mode
Selects the mode for assigning the IP address.
How to: Chapter 11.7.2.1, "How to assign the IP address", on page 318
"Auto (DHCP)"

Assigns the IP address automatically, provided the network supports
DHCP (Dynamic Host Configuration Protocol).

"Static" Enables you to assign the IP address manually.
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress:MODE on page 408

IP Address
Displays the IP address of the instrument in the network.
By default, the R&S AREG800A is configured to use dynamic TCP/IP configuration
and to obtain the address information automatically. Setting Address Mode > "AUTO
(DHCP)" denotes that the DHCP server is available. The instrument displays the
assigned IP address read-only.
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If the network does not support DHCP or there is no DHCP server available, the instru-
ment tries to obtain the IP address using Zeroconf (Avahi) protocol. This feature ena-
bles the instrument to self-configure an IP address and subnet mask. Zeroconf (Avahi)
IP addresses start with the number blocks 169.254.*.*, with the subnet mask of
255.255.

Note: An IP address that is assigned with the Zeroconf protocol although the network
requires an IP address assigned from the DHCP server can cause network connection
failures.
If both services fail to connect, you can configure the address manually.
How to: "To assign the IP address manually on the instrument" on page 319
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress on page 407

Subnet Mask
Displays the bit group of the subnet in the host identifier.
The TCP/IP protocol is preinstalled with the subnet mask 255.255.255.0. If the DHCP
server is available Address Mode A AUTO (DHCP), the setting is read-only. The sub-
net mask consists of four number blocks separated by dots. Each block contains 3
numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are allowed
in a block (as an example see the preinstalled address).
To assign the subnet mask manually, select Address Mode > Static.
Note: When assigning the subnet mask manually, make sure that the address matches
with the subnet mask of the controlling host interface.
How to: "To assign the IP address manually on the instrument" on page 319.
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK on page 410

Default Gateway
Displays the gateway address.
This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.
To assign the gateway address manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway on page 410

DNS Suffix
Displays the primary DNS (Domain Name System) suffix, that means the DNS name
without the hostname part.
The DNS system uses the suffix for registration and name resolution for unique identifi-
cation of the instrument in the entire network.
To assign the DNS suffix manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain on page 409
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DNS Server
Determines the preferred server for name resolution. The DNS server contains the
underlying numerical values that are required for name resolution of the hostname as
part of the IP address.
To select the DNS server manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS on page 410

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the R&S AREG800A.
Remote command: 
:SYSTem:COMMunicate:NETWork:MACaddress on page 408

11.5.2  VISA resource strings

Access:

► Select "System Config > Remote Access > Visa Resource Strings".

The "Visa Resource String" dialog displays the VISA resource strings provided for
remote control over the different interfaces.

The remote commands required to query the address information remotely are descri-
bed in Chapter 12.12, "SYSTem subsystem", on page 395.
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Settings:

HISLIP.........................................................................................................................293
VXI11...........................................................................................................................293
Socket......................................................................................................................... 293
GPIB............................................................................................................................293
USB.............................................................................................................................293
SERIAL....................................................................................................................... 293

HISLIP
Displays the visa resource string for remote control with HiSLIP protocol.
See also Chapter 11.2.1, "LAN interface", on page 271
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 407

VXI11
Displays the visa resource string for remote control over LAN.
See also Chapter 11.2.1, "LAN interface", on page 271
Remote command: 
:SYSTem:COMMunicate:NETWork:RESource? on page 408

Socket
Displays the visa resource string for remote control over LAN, using the socket com-
munication protocol.
See also Chapter 11.2.1, "LAN interface", on page 271
Remote command: 
:SYSTem:COMMunicate:SOCKet:RESource? on page 411

GPIB
Displays the visa resource string for remote control over the GPIB interface.
See also Chapter 11.2.3, "GPIB interface (IEC/IEEE bus interface)", on page 274.
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 407

USB
Displays the visa resource string for remote control over the USB interface.
See also Chapter 11.2.2, "USB interface", on page 273
Remote command: 
:SYSTem:COMMunicate:USB:RESource? on page 411

SERIAL
Displays the visa resource string for remote control over the serial interface.
See also Chapter 11.2.2, "USB interface", on page 273
Remote command: 
:SYSTem:COMMunicate:SERial:RESource? on page 411
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11.5.3  GPIB address settings

Access:

► Select "System Config > Remote Access > GPIB Address".

The "GPIB Address" enables you to select the channel for remote control over the
IEC/IEE bus interface.

The remote command to configure the setting remotely is described in Chapter 12.12,
"SYSTem subsystem", on page 395.

Settings

GPIB Channel Address............................................................................................... 294

GPIB Channel Address
Sets the GPIB (IEC/IEEE bus) channel address for the connected instrument.
Remote command: 
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess on page 407

11.5.4  RS232 settings

Access:

► Select "System Config > Remote Access > RS232".

The "RS232" dialog enables you to control the instrument over a serial interface
using a USB adapter. The controller and the instrument must be connected with
the external USB/serial-adapter R&S TS1-USB (see recommended extras in the
data sheet) and a serial crossover (null modem) cable. The USB connection
requires the Visa library to be installed on the controller. Visa detects and config-
ures the R&S AREG800A automatically when the USB connection is established.

Remote access settings



Network operation and remote controlR&S®AREG800A

295User Manual 1179.3615.02 ─ 06

The remote commands required to configure the parameters remotely are described in
Chapter 12.12, "SYSTem subsystem", on page 395.

Settings

Baud Rate
Sets the baudrate for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:BAUD on page 410

Parity
Sets the parity for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:PARity on page 410

Stop Bits
Sets the number of stop bits for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:SBITs on page 411

11.5.5  Instrument emulations settings

Access:

► Select "System Config > Remote Access > Instrument Emulations".

The "Instrument Emulations" dialog enables you to emulate a remote control com-
mand set of another signal generator.
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The remote commands required to configure the emulation settings remotely are
described in Chapter 12.12, "SYSTem subsystem", on page 395.

Settings

Language
Selects the instrument whose remote command set is emulated by the
R&S AREG800A.
Remote command: 
:SYSTem:LANGuage on page 413

Mode
Selects the way the instrument identification is performed.
"Automatic" Sets the "IDN String" and the "OPT String" automatically for the

instrument selected with the parameter Language.
"User Defined" Enables you to define the "IDN String" and the "OPT String".
Remote command: 
:SYSTem:IDENtification on page 412

Set to Default
In "Mode > User Defined", resets the *IDN and *OPT strings.

Remote command: 
:SYSTem:IDENtification:PRESet on page 412

IDN String
Indicates the identification string of the instrument when queried with the common
command *IDN?.

In addition to the preset values, you can define your own identification string so that
each generator uses an individual identification, like My_SigGen for instance, see
Mode .
Remote command: 
*IDN? on page 354
:SYSTem:IRESponse on page 413

OPT String
Indicates the option string of the instrument as queried with common command *OPT?.

In Mode > "User Defined", you can define your own option string. A query responds
with this option string instead of the automatically created option string.
Remote command: 
*OPT? on page 354
:SYSTem:ORESponse on page 413
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11.5.6  Remote connections settings

The "Remote Connections" dialog covers the active SCPI and TCP/IP connections,
and a history list of the connections that have accessed the instrument before.

11.5.6.1  Active connections

Access:

► Select "System Config > Remote Access > Remote Connections > Active".

The "Active" tab shows the currently active remote connections, and you can
enable the display of the active connections in the task bar.

Settings

Show Remote Connections in Taskbar....................................................................... 297
SCPI Connections.......................................................................................................297
TCP/IP Connections....................................................................................................298

Show Remote Connections in Taskbar
Displays the currently active connections in the taskbar.

SCPI Connections
Displays the VISA resources strings of the remote connections currently controlling the
instrument via the LAN interface.
Remote command: 
n.a.

Remote access settings



Network operation and remote controlR&S®AREG800A

298User Manual 1179.3615.02 ─ 06

TCP/IP Connections
Displays the types and client addresses of the remote connections currently controlling
the instrument via the LAN interface.
Remote command: 
n.a.

11.5.6.2  Closed connections

Access:

► Select "System Config > Remote Access > Remote Connections > Closed".

The "Closed" tab shows the currently active remote connections, and you can
enable the display of the active connections in the task bar.

Settings

SCPI Connections.......................................................................................................298
TCP/IP Connections....................................................................................................298

SCPI Connections
Lists the VISA resource strings of the last remote connections that have accessed the
instrument via the LAN interface before.
Remote command: 
n.a.

TCP/IP Connections
Lists the types and client addresses of the last remote connections that had accessed
the instrument via the LAN interface before.
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Remote command: 
n.a.

11.5.7  HUMS settings

Requires R&S AREG8-K980.

Access:

► Select "System Config > Remote Access > HUMS".

The dialog provides settings to configure the health and utilization monitoring sys-
tem (HUMS) of the R&S AREG800A.

The remote commands required to define these settings are described in Chapter 12.6,
"HUMS remote control commands", on page 365.

Settings

State............................................................................................................................299
Enhanced Settings...................................................................................................... 300
Delete History..............................................................................................................300
Export History..............................................................................................................300

State
Activates HUMS.
Data is only recorded, if HUMS is enabled. If disabled, already recorded data can still
be retrieved.
The setting is reset by a factory preset to "off".
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Remote command: 
DIAGnostic:HUMS:STATe on page 368

Enhanced Settings
Opens a dialog for configuring enhanced protocol settings, see Chapter 11.5.8, "HUMS
enhanced settings", on page 300.
Access is only available, when HUMS is enabled, see State.

Delete History
Deletes all information from the HUMS service including the device history.
Note: Regarding the instrument security, the sanitization procedure also deletes the
history of the HUMS service, see Chapter 10.5.2.2, "Disk & memory security settings",
on page 253.
Remote command: 
DIAGnostic:HUMS:DEVice:HISTory:DELete:ALL on page 367

Export History
Triggers an export of the logged data of the HUMS service into a *.zip file.

A standard file dialog opens, to save the log file. By default, the file is saved to the
directory /var/user/.
Remote command: 
DIAGnostic:HUMS:DEVice:HISTory? on page 366
DIAGnostic:HUMS:SAVE on page 367

11.5.8  HUMS enhanced settings

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".
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The dialog provides enhanced settings for configuring protocol settings and device
tags.

The remote commands required to define these settings are described in Chapter 12.6,
"HUMS remote control commands", on page 365.

● Protocol settings....................................................................................................301
● SNMP user settings.............................................................................................. 303
● Device tag settings................................................................................................307

11.5.8.1  Protocol settings

The "Protocol" tab of the "Enhanced HUMS Settings" dialog provides protocol settings
for SNMP or REST protocol.

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".

4. Select "Protocol".

The dialog provides enhanced settings for configuring protocol settings and device
tags.

Settings

SNMP..........................................................................................................................302
REST...........................................................................................................................302
SNMP Configuration................................................................................................... 302

└ Location........................................................................................................ 302
└ Contact..........................................................................................................302
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└ Access.......................................................................................................... 302
└ Community....................................................................................................303

User Settings...............................................................................................................303

SNMP
Enables the SNMP agent and selects the supported SNMP version to communicate
with the service.
The setting is reset by a factory preset to "v1/v2c".
"Off" The SNMP agent is disabled.
"v1/v2c" Selects SNMP version 2, which also enables version v1.
"v1/v2c/v3" Selects all SNMP version v1, v2c and v3.
"v3" Selects SNMP version v3.
Remote command: 
SYSTem:COMMunicate:SNMP:VERSion on page 372

REST
Enables the REST API protocol.
The setting is reset by a factory preset to "On".
Remote command: 
SYSTem:COMMunicate:REST:ENABle on page 369

SNMP Configuration
For SNMPv1 and SNMPv2c authentication, you can define "Access" and "Community".
For SNMPv3 authentication, you can define "User" profiles.

Location ← SNMP Configuration
Defines the SNMP location information. This information complies with the server's
physical location and is used for identification of the SNMP server. By default, this input
field is empty.
Remote command: 
SYSTem:COMMunicate:SNMP:LOCation on page 370

Contact ← SNMP Configuration
Sets the SNMP contact information. This information complies with the person who
manages the SNMP server and is used for identification of the SNMP server. By
default, this input field is empty.
Remote command: 
SYSTem:COMMunicate:SNMP:CONTact on page 370

Access ← SNMP Configuration
Defines the access type for SNMP community string.
For read access, you can use "Read" or "Read & Write". For write access, use "Read &
Write".
The setting is reset by a factory preset to "Read & Write".
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Remote command: 
SYSTem:COMMunicate:SNMP:COMMunity:RO on page 369
SYSTem:COMMunicate:SNMP:COMMunity:RW on page 370

Community ← SNMP Configuration
Defines the SNMP community string that can be a group of instruments with SNMP
version v2 support.
The setting is reset by a factory preset to the "<serial number>" of the instrument.

User Settings
Accesses the "Configure SNMP Users for HUMS" dialog.

11.5.8.2  SNMP user settings

For SNMPv3 authentication, you can define user profiles.

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".

4. In the protocol tab, select SNMP communication with SNMPv3, e.g. "SNMP >
v1/v2c/v3".

5. Select "User Settings".

The "Configure SNMP User for HUMS" dialog provides an overview of all defined
SNMP users and their profiles. With the "Add" and "Delete All" controls, you can
add or remove users.

Settings

Add..............................................................................................................................304
Delete All.....................................................................................................................304
User table....................................................................................................................304

Remote access settings



Network operation and remote controlR&S®AREG800A

304User Manual 1179.3615.02 ─ 06

└ Edit................................................................................................................304
└ Name............................................................................................................ 305
└ Prefix.............................................................................................................305
└ Level............................................................................................................. 305
└ Delete............................................................................................................305

Add SNMP User for HUMS......................................................................................... 305
└ SNMP User Name........................................................................................ 306
└ SNMP User Prefix.........................................................................................306
└ SNMP User Level......................................................................................... 306
└ SNMP User Public Passphrase.................................................................... 307
└ SNMP User Encrypted Passphrase..............................................................307
└ Add / Update.................................................................................................307

Add
Accesses the "Add SNMP User for HUMS" dialog.
In this dialog, you can define a user and its profile, see "Add SNMP User for HUMS"
on page 305.

Delete All
Removes all users from the list.
Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER:DELete:ALL on page 372

User table
Lists all defined SNMP users.

The table informs on the user name and its specified user profile.
Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER:ALL? on page 371

Edit ← User table
Accesses the "Edit SNMP Users for HUMS" dialog, where you can modify an already
defined user profile.
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For description on the entry fields, see Add SNMP User for HUMS.

Name ← User table
Shows the user name of the user who should have specific user rights.

Prefix ← User table
Shows the access right of the selected user.

Level ← User table
Shows the security level of the selected user.

Delete ← User table
Removes the selected user from the list.
Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER:DELete on page 372

Add SNMP User for HUMS
Configuration dialog for defining SNMP users and their profiles.
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Remote command: 
SYSTem:COMMunicate:SNMP:USM:USER on page 371

SNMP User Name ← Add SNMP User for HUMS
Defines the name of the user for assigning specific user rights. Entering a user name is
mandatory.

SNMP User Prefix ← Add SNMP User for HUMS
Defines the access right for a user.
"Read Only" Allows the user to only read information.
"Read & Write" Allows the user to read and modify information.

SNMP User Level ← Add SNMP User for HUMS
Defines the security level of the SNMP user. Depending on the security level, the ser-
vice requests user name and passphrases for authentication and encryption.
"No Authentication & No Privacy"

Low security level. Using this level, the service queries the user name
only. Password authentication and password for encrypted data trans-
fer is not requested.
See "SNMP User Public Passphrase" on page 307 and "SNMP User
Encrypted Passphrase" on page 307 for data transfer is not reques-
ted.

"Authentication & No Privacy"
Medium security level: Requests the user name and password
authentication, but no data transfer encryption.
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"Authentication & Privacy"
High security level: Requests the user name, and both, the password
authentication and the password for data transfer encryption.

SNMP User Public Passphrase ← Add SNMP User for HUMS
Defines the password for authentication. The password must have of 8 to 12 charac-
ters with any combination of ASCII characters.

SNMP User Encrypted Passphrase ← Add SNMP User for HUMS
Defines the password for encryption. This password must have at least 8 characters
with any combination of ASCII characters. When encryption is defined, the
R&S AREG800A supports the DES (directed enhanced services) protocol.

Add / Update ← Add SNMP User for HUMS
Assigns the defined user with its profile to the list.
If you change an already defined user profile, the instrument provides the "Update"
button to apply the modifications.

11.5.8.3  Device tag settings

The "Device Tags" tab of the "Enhanced HUMS Settings" dialogs displays the defined
device tags. You can also add or delete device tags here.

A device tag is a label to assign to your instrument. You can create any device tag for
your instrument and define it by a specific key and value.

Access:

1. Select "System Config > Remote Access > HUMS".

2. Select "State > ON".

3. Select "Enhanced Settings".
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Configures device tags for tagging user-defined information of the instrument in a
table. You can define up to 32 device tags, e.g., for HUMS history evaluation.
To add a device tag, define "Key" and "Value" of the device tag in the table. Click
"Add" to add all device tags of the table to the HUMS history.

Settings

ID.................................................................................................................................308
Key.............................................................................................................................. 308
Value........................................................................................................................... 308
Delete..........................................................................................................................309
Add..............................................................................................................................309
Delete All.....................................................................................................................309

ID
Identification count of a device tag entry.

Key
Sets the identification key of a device tag.
Remote command: 
DIAGnostic:HUMS:TAGS[:VALue] on page 369

Value
Sets the value of the identification key of a device tag.
Remote command: 
DIAGnostic:HUMS:TAGS[:VALue] on page 369
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Delete
Deletes the selected device tag from the HUMS history.
Remote command: 
DIAGnostic:HUMS:TAGS:DELete on page 368

Add
Adds a new device tag to the HUMS service.
Remote command: 
DIAGnostic:HUMS:TAGS[:VALue] on page 369
DIAGnostic:HUMS:TAGS:ALL? on page 368

Delete All
Removes all device tags from the HUMS history.
Remote command: 
DIAGnostic:HUMS:TAGS:DELete:ALL on page 369

11.5.9  QR code

Access:

► Select "System Config > Remote Access > QR Code".

The "QR Code" dialog shows the current instrument address (IP address) in quick
response (QR) format.

This functionality provides fast access to the instrument via VNC with, for example, a
smartphone or a tablet.
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See Chapter 11.14.3, "How to set up remote operation from a smart device",
on page 344.

11.6  LXI settings

On the R&S AREG800A, an LXI functionality is already installed and enabled, see LXI
status settings. Thus, you can access he instrument using any web browser to perform
the following tasks:
● Modifying network configurations, see Chapter 11.6.2.1, "LAN configuration",

on page 312.
● Accessing the instrument remotely
● Analyzing SCPI remote diagnostics

11.6.1  LXI status settings

Access:

► Select "System Config > Setup > Remote Access > LXI Status".

The LXI "LAN Status" dialog shows the parameters of the LAN connection.

Alternatively, you can change the LAN settings using the LXI web browser interface,
see Chapter 11.6.2.1, "LAN configuration", on page 312.

LAN Status
The LED indicates the LXI status.
"green" Normal operation
"green (flashing)"

Device identification

LXI settings
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"red" LAN fault

Hostname / MAC Address / IP Address
See "Hostname" on page 290.

LAN Reset
Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address, and IP address.
According to the LXI standard, a LAN reset must set the following network parameters
to a default state:

Parameter Value

TCP/IP mode DHCP + Auto IP address

Dynamic DNS Enabled

ICMP ping Enabled

Password for LAN configuration LxiWebIfc

The LAN reset also resets the following parameters for the Automotive Radar Echo
Generator:

Parameter  

Hostname Instrument-specific hostname

Description  

Negotiation Auto detect

VXI-11 discovery Enabled

11.6.2  LXI browser settings

The LXI browser functionality enables you to control the instrument remotely over a
web browser.

Access:

► In the address field of the browser, enter the URL address, composed of the instru-
ment's IP address or host name, for example http://10.113.1.151.
Note: Do not add the missing zeros in the IP address, while opening the instru-
ment homepage.

LXI settings
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The instrument homepage (welcome page) opens.

The navigation pane of the browser interface contains the following elements:
● "LXI"

– "Home" opens the instrument homepage.
The homepage displays the device information required by the LXI stan-
dard, including the VISA resource string in read-only format.

– "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LED flashes. A green LXI status symbol indicates
that a LAN connection has been established; a red symbol indicates that no
LAN cable is connected.

– "Lan Configuration" allows you to configure LAN parameters and to initiate
a ping, see "Ping client" on page 314.

– "Status" displays information about the LXI status of the instrument.
– "Utilities" provides access to the LXI event logging functionality required by

the LXI standard.
● "Instrument Control"

"Web Control" provides remote access to the instrument, see "To start remote
control with the LXI web browser" on page 322.

● "Diagnostics"
– "SCPI Remote Trace" records messages exchanged via the remote control

interface, see Chapter 11.6.2.2, "SCPI remote trace", on page 315.
● "Help"

– "Glossary" explains terms related to the LXI standard.
– www.rohde-schwarz.com opens the Rohde & Schwarz homepage.

11.6.2.1  LAN configuration

The "LAN Configuration" web page displays all mandatory LAN parameters and allows
their modification.

It comprises the following navigation entries.

LXI settings
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● IP configuration..................................................................................................... 313
● Advanced config....................................................................................................313
● Ping client..............................................................................................................314

IP configuration

The "IP configuration" web page displays all mandatory LAN parameters and allows
their modification.

The "IP Address Mode" selects a configuration mode for the IP address of the instru-
ment. With static configuration, the entered IP address, subnet mask, and default gate-
way are used. With dynamic configuration, DHCP or dynamic link local addressing
(automatic IP) is used to obtain the instrument IP address.

Changing the LAN configuration
This function is password-protected. Unlock the protection level 1 to access it.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

See Chapter 10.5.4, "Password management", on page 260.

Advanced config

The "Advanced Config" web page provides LAN settings that are not declared manda-
tory by the LXI standard.

LXI settings
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The following advanced parameters are available:
● "mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service

discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

● "ICMP Ping": Must be enabled to use the ping utility.
If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

● "VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.
If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.

Changing the LAN configuration
This function is password-protected. Unlock the protection level 1 to access it.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 263.
● "Changing the default security password" on page 264.

See Chapter 10.5.4, "Password management", on page 260.

Ping client

The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the ICMP echo request and echo reply
packets, this function checks whether the communication with a device via LAN is
working. Ping is useful for the diagnosis of IP network or router failures.

LXI settings
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To initiate a ping at the instrument:

1. On the "Ping Client" page, enter the IP address of the host in the "Destination
Address" field (for example 10.113.1.151).

2. Select "Submit".

11.6.2.2  SCPI remote trace

The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S AREG800A, see Chapter 11.11, "To trace mes-
sages with the LXI web browser interface", on page 330.

A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided by the lower toolbar to locate error mes-
sages and messages containing arbitrary search strings. You can also export the mes-
sage log to a *.csv file and evaluate the file using a suitable program.

To trace and display messages, switch on "logging" and "live mode" in the toolbar.

LXI settings
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Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

● "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

● "Filter": applies a filter to columns and/or rows when working (live mode off)
● "Refresh": reads the message log from the internal database and displays it
● "Download": stores the SCPI trace log to a *.csv file
● "Clear": deletes all message log entries in the database and at the screen
● "Details": displays details of the selected message, for example an SCPI command

in hex format (also possible by double\-clicking a message)

Columns

The following columns are available if no column filter is applied:

● "Rec": record number of the message within the message log
● I: number of the subinstrument
● "MT": indicates the type of the message. Possible values and related message

contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, highlighted by red color
– T = execution time, i.e. time required by the instrument to process the com-

mand internally.

LXI settings
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● "message": indicates the type of the message. Possible values and related mes-
sage contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, denoted in red
– T = execution time, i.e. time required by the instrument to process the com-

mand internally

11.7  To configure the instrument for remote access

The R&S AREG800A is equipped with a network interface and can be connected to an
Ethernet LAN (local area network).

There are two methods to establish a LAN connection to the instrument:
● A non-dedicated network (Ethernet) connection from the instrument to an existing

network.
● A dedicated network connection (Point-to-point connection) between the instru-

ment and a single computer.

How to: see Chapter 3.1.7, "Connecting to LAN", on page 25.

For identification in the network, all devices require an IP address.

How to:

● To find the VISA resource string............................................................................317
● To configure the accces over LAN........................................................................ 318

11.7.1  To find the VISA resource string

► Select "System Config > Remote Access > VISA Resource Strings".

To configure the instrument for remote access
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The dialog shows all specified resource strings of the supported remote control
interfaces.

Note: Using the RS232 serial interface via USB requires the USB serial adapter
R&S TS-USB1.

11.7.2  To configure the accces over LAN

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the DHCP protocol,

this service assigns all address information automatically.
● If the network does not support DHCP, the instrument tries to obtain the IP address

by using the Zeroconf (Avahi) protocol.

The automatic address configuration assigns the address information automatically.
Thus it is safe to establish a physical connection to the LAN without any previous
instrument configuration.

If the dynamic TCP/IP configuration does not succeed, or if the instrument is expected
to use alternate TCP/IP configuration, you must set the address information manually.

11.7.2.1  How to assign the IP address

If necessary, you can assign the IP address manually. It is assumed that you have con-
nected controller PC and the instrument.

To configure the instrument for remote access
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To assign the IP address manually on the instrument

1. Obtain the IP address and subnet mask for the R&S AREG800A and the IP
address for the local default gateway from your network administrator. If necessary,
also obtain the name of your DNS domain and the IP addresses of the DNS server
on your network.

2. On the instrument, select "System Config > Remote Access > Network".

3. Select "Address Mode > Static".

4. Select the "IP Address".

5. Enter the IP address, for example 192.168.0.1.

The IP address consists of four number blocks separated by dots. Each block con-
tains 3 numbers in maximum.

6. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.

The subnet mask consists of four number blocks separated by dots. Each block
contains 3 numbers in maximum.

Note: The subnet mask must be the same for both, the R&S AREG800A and the
host interface, the instrument is connected to.

To assign the IP address manually on the computer

► Obtain the necessary information from your network administrator. If you use more
than one LAN connector, you need separate address information for each connec-
tor.
For information on how to configure the address information, see the documenta-
tion of the operating system the computer uses.

11.7.2.2  How to use the hostname

In a LAN that uses a DNS server, each computer or instrument connected in the LAN
can be addressed with an unambiguous Hostname (also referred to as computer
name) instead of the IP address. The DNS server translates the hostname to the IP
address.

Using the hostname is useful in networks with dynamic TCP/IP and DHCP protocol
services, that assign the address information automatically. Thus, it can be that the
services assign a new IP address each time the instruments restarts, but they do not
change the hostname.

Each instrument is delivered with an assigned hostname, that remains constant as
long as it is not explicitly changed.

This function is password-protected. Unlock the protection level 1 to access it.

The default hostname name follows the syntax <INST>-<Serial Number>, where:
● <INST> is the short name of your instrument, as stated on the front panel.

To configure the instrument for remote access
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● <Serial Number> is the individual serial number of the instrument.
You can find the serial number at the rear panel of instrument. It is the third part of
the device ID printed on the barcode sticker.

Example: 
The default hostname of an R&S AREG800A with a serial number 102030 is
AREG800A-102030.

To query and change the hostname

1. Select "System Config > Remote Access > Network".

Section "Instrument Name" displays the assigned "Hostname".

Note: This function is password-protected. Unlock the protection level 1 to access
it.

2. Select "System Config > Setup > Security > Protection".

3. Enable the "Protection Level 1".
The default protection level 1 password is 123456.

The parameter "Hostname" in the "Network" tab is now enabled for configuration.

4. Change the "Hostname".

11.7.2.3  How to configure LAN interface access and services

By default, the LAN interface and the supported LAN interface services are enabled.

For security reasons, for example to protect the instrument against unauthorized
access, you can block either the LAN services individually, or the access over LAN in
general.

To disable LAN access in general

1. Select "System Config > Setup > Security".

2. Select "Security".

3. Select "LAN Services".

4. Disable "LAN" state.

5. Enter the Security Password.

6. Select "Accept".

When disabled, communication over the LAN connection is not possible.

To configure the instrument for remote access
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To disable LAN services individually

1. Select "System Config > Setup > Security".

2. Select "Security".

3. Select "LAN Services".

4. Enable "LAN" state.

5. In the "Common Services" side tab, uncheck all services you want to block.

6. Select the "Samba Services" sidetab.

7. For example, uncheck "SMB 1.0/2.0 Server" to block the access for the SMB
Samba server.

8. Enter the Security Password.

9. Select "Accept".

To configure the instrument for remote access
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11.8  To establish a remote control session over LAN

This section shows you how to establish remote control connections over the available
interfaces.

The following general prerequisites must be fulfilled:
● The instrument and the controller have to be connected over the corresponding

interface with the suitable cable.
● The instrument and the controller must be switched on.
● To operate the instrument remotely, it must be addressed using the defined inter-

face address.
See:
– Chapter 11.2.1, "LAN interface", on page 271
– Chapter 11.2.2, "USB interface", on page 273
– Chapter 11.2.3, "GPIB interface (IEC/IEEE bus interface)", on page 274

● A remote control program must open a connection to the instrument, before it can
send commands to and receive device responses from the instrument.

If security is a concern, see:
● Document Instrument Security Procedures.
● Chapter 10.5.5, "How to prevent unauthorized access", on page 263.

● To establish the connection with the LXI web browser......................................... 322
● To establish the connection using VXI-11 protocol................................................323
● To establish the connection using socket communication.................................... 328

11.8.1  To establish the connection with the LXI web browser

Using the LXI browser interface you can access and control the R&S AREG800A
instrument remotely from another PC without additional installation. File upload and
download between the instrument and the remote PC is also available.

To start remote control with the LXI web browser

1. On the instrument, make sure the LAN interface is enabled.Enable the LAN inter-
face on the instrument, if necessary.
See Chapter 10.5.3, "Configuring LAN services", on page 257.

2. Connect the remote PC and the instrument in the same network.
See Chapter 3.1.7, "Connecting to LAN", on page 25 .

3. On the remote PC, start a web browser that supports HTML5 (W3C compliant).

4. Enter the IP address of the R&S AREG800A in the browser's address bar.

The R&S AREG800A's welcome page is displayed.

5. In the navigation pane, select "Instrument Control" > "Web Control".

To establish a remote control session over LAN
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Remote access to the instrument requires the password. The default password is
instrument.

6. Enter the password and confirm with the [Enter] key.

After the connection is established, the current screen of the R&S AREG800A is
displayed in the browser window.

7. Use the mouse cursor and keyboard to access the functionality of the instrument
as you would directly perform on the instruments touchscreen and front panel.

11.8.2  To establish the connection using VXI-11 protocol

In this example, the I/O software library R&S VISA from Rohde & Schwarz is used to
set up a LAN remote control link and remotely control the R&S AREG800A. R&S VISA
is running on a controller PC with Windows operating system. When the connection is
set up, you can send commands to the instrument and receive the responses.

The remote control connection requires a VISA installation but no additional hardware
on the controller PC. The LAN I/O channel is selected at initialization time using the
VISA resource string (also referred to as "address string"). A VISA alias (short name) is
used to replace the complete resource string. The host address is the
R&S AREG800A's hostname or its IP address.

See also Chapter 11.2.1, "LAN interface", on page 271.

To set up the controller with R&S VISA

To remote control the R&S AREG800A, we use the R&S VISA Tester application. The
application communicates via TCP/IP protocol.

The instrument is preconfigured for networks using DHCP (dynamic host configuration
protocol). If this configuration is used, enter the computer name in the position of the IP
address.

1. On the instrument, make sure, that the LAN interface and "SCPI over LAN" are
enabled.
See Chapter 10.5.3, "Configuring LAN services", on page 257.

2. On the controller (remote PC), install the R&S VISA program.
See http://www.rohde-schwarz.com/rsvisa > "RS VISA Release Notes".

3. Connect the controller and the instrument in the same network (network cable).
Switch them on.
See also Chapter 3.1.7, "Connecting to LAN", on page 25.

4. On the controller, start "R&S VISA > Tester 32bit" or "R&S VISA > Tester 64bit".

To establish a remote control session over LAN
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5. In the menu bar, select "Choose VISA Implementation > Rohde & Schwarz Visa"
and confirm with "OK".

6. In the menu bar, select "Find Resource" to search for the instrument in the LAN.

7. Select "VXI-11" and "Find Resources".

R&S VISA scans the network for connected instruments and lists all detected
instruments in the "Resource" list.
Note: The search may take some time, particularly in large networks.

8. Select the required instrument and confirm with "Select".

To establish a remote control session over LAN
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The "Find and select resource" dialog closes and R&S VISA indicates the IP
address in the "Resource" field of the main application window.

9. As an alternative to the IP address, you can assign an alias name to the
R&S AREG800A:

a) In the menu bar, select "RsVisaConfig".

b) In the toolbar, select "+" to access the "VISA Resource String Composer".

To establish a remote control session over LAN
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c) Fill in the "Alias" name, the "VISA Resource String" and the "Device IP Address
or hostname" as shown in the figure, and confirm with "OK".

The "Alias" name is assigned.

d) Close the dialog.
The R&S AREG800A is registered in the program. It can be addressed via the
resource string or alias name.

10. In the main window, select "Connect".

R&S VISA establishes the connection to the R&S AREG800A.

You can send settings to configure the instrument and receive its responses.

Note: If the connection cannot be set up, R&S VISA displays an error in the log
view.
See also Chapter 13.5, "Resolving network connection failures", on page 533.

For further information on the functions to read and write to an open session, and
the utility applications the software provides, see the R&S VISA user manual.

To start remote control with R&S VISA

To set the instrument to remote control, you can use the addressed command &GTR or
send any command from the controller.

1. Start the R&S VISA Tester.
Establish the connection to the R&S AREG800A.
See "To set up the controller with R&S VISA" on page 323.

To establish a remote control session over LAN
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2. In the R&S VISA "Basics" tab, enter a SCPI command, e.g. "*IDN?". Confirm with
"Query".

The instrument is switched to remote control when it receives a command from the
controller.

3. Select "Read" to obtain the instrument response.

Tip: If the "Show Log" checkbox is checked, R&S VISA displays each VISA func-
tion call in the log-view on the left. If you check the "Write Log" checkbox, the log-
view entry is written to the log file as well. You can operate the log-view in two
modes: the "Live Mode" shows only the most recent messages whereas the "View
Mode" allows you to scroll the history.

4. To check the performed setting, SOUR1:FREQ? and select "Query".

While remote control is active, the "Remote" icon in the status bar indicates that the
instrument is in remote control mode. Currently ongoing communication (data
transfer) is indicated by green colored arrows in the icon.
Operating via the front and touch panel or via mouse and keyboard are locked,
allowing a remote control program to be performed without interruption. On the dis-
play, keys and entry fields are grayed out and cannot be activated or modified, but
you can still open dialogs, for example to verify settings.

5. To disable the access to the dialogs, use the command SYST:KLOC ON.

6. To prevent unintentional return to manual operation, use the command &LLO.

The instrument switches to "Remote LLO" state.
The [Setup] key is disabled.

7. To enable the [Setup] key, use the command &GTR.

To establish a remote control session over LAN
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8. To return to manual operation, see Chapter 11.12, "To return to manual operation",
on page 331.

Tip: Switching from manual operation to remote control and vice versa does not
affect the other instrument settings.

11.8.3  To establish the connection using socket communication

This section provides an example on how to establish a remote control connection over
Telnet client and a simple sockets-based program example that can be further devel-
oped.

The telnet client transmits information unencrypted. Therefore, for sensitive information
we recommend that you use a client which supports secure protocols, like SSH.

In the following example, we assume basic knowledge of programming and operation
of the controller. You can find information on the interface commands in the corre-
sponding manuals.

To set up a Telnet connection

To control the software, only a Telnet program is required. The Telnet program is part of
every operating system.

1. On the instrument, make sure, that the LAN interface and "SCPI over LAN" are
enabled.
See Chapter 10.5.3, "Configuring LAN services", on page 257.

2. Connect the remote PC and the instrument in the same network.
See Chapter 3.1.7, "Connecting to LAN", on page 25.

3. On the remote PC, start the Telnet program.
Enter the socket address.
The socket address is a combination of the IP address or the hostname of the
R&S AREG800A and the number of the port configured for remote-control via Tel-
net.
Tip: The R&S AREG800A uses the port number 5025 for remote connection via
Telnet.

To establish a remote control session over LAN
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The connection to the instrument is set up and you can send remote-control com-
mands.

4. Telnet does not reflect your first entry.
Insert a command, e.g. *IDN and confirm with "Enter".

5. Observe the screen.

A response on the query confirms that the connection is working. The client dis-
plays all subsequent inputs and responses.

6. Even if the cursor is not visible on the screen, blindly enter a remote-control com-
mand. Confirm with Enter.

11.9  To establish a remote control session over GPIB

The program example in this section is written in VISUAL BASIC. A condition for pro-
gramming in VISUAL BASIC is that the modules NIGLOBAL (Niglobal.bas) and
VBIB32 (Vbib_32.bas) are added to the projects.

Drivers for instrument, for example IVI-COM and LabVIEW drivers, are available for
download area on the product page at:
https://www.rohde-schwarz.com/driver/areg100a/

To start remote control over GPIB

1. Connect instrument and controller using a GPIB cable.
Switch them on.

2. Select "System Config > Remote Access > GPIB Address" > "GPIB Channel
Address = 28".
The GPIB address of the instrument must be the default value of 28.

3. Execute the following commands on the controller:

a) Open the port to the instrument.
CALL IBFIND("DEV1", generator%)

b) Inform the controller about instrument address.
CALL IBPAD(generator%, 28)

To establish a remote control session over GPIB
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c) Reset the instrument.
CALL IBWRT(generator%, "*RST;*CLS")

d) Set the instrument to new address.
CALL IBWRT(generator%, "SYST:COMM:GPIB:ADDR 18")

e) Inform the controller about new address.
CALL IBPAD(generator%, 18)

The GPIB address of the instrument is changed.

4. To return to manual operation, press the Local key at the front panel.

11.10  To establish a remote control session over USB

For remote control, the PC and the instrument must be connected over the USB type B
interface. A USB connection requires the VISA library to be installed. VISA detects and
configures the R&S instrument automatically when the USB connection is established.
You do not have to enter an address string or install a separate driver.

To start remote control over USB

1. Connect instrument and controller using USB cable. Switch them on.

2. To return to manual operation, press the [Local] key.

11.11  To trace messages with the LXI web browser interface

The remote trace functionality allows you to trace commands and messages
exchanged via a remote control interface of the R&S AREG800A.

To activate SCPI remote trace

1. On the instrument, make sure, that the LAN interface and "SCPI over LAN" are
enabled.
See Chapter 10.5.3, "Configuring LAN services", on page 257.

2. Connect the remote PC and the instrument in the same network.
See also Chapter 3.1.7, "Connecting to LAN", on page 25.

3. Start a web browser that supports HTML5 (W3C compliant).

4. Enter the IP address of the R&S AREG800A in the browser's address bar.

The welcome page is displayed.

5. In the navigation pane, select "Diagnostics > SCPI Remote Trace".

6. In the toolbar bar of the "SCPI Remote Trace" page, select "live mode > on" and
"logging > on".

To trace messages with the LXI web browser interface
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"live mode > on" displays all commands and responses, and "logging > on" also
traces messages.

If you now control the R&S AREG800A with SCPI commands, using an appropriate
tool, the LXI function records the information sent and received.
The function records all sent commands, received responses and messages, and
saves them in an internal database. If "live mode" is disabled, you can display the
recent traces upon request, using the "refresh" button. You can also save the log in
a file.
Note: The diagnostics functionality is extended in later releases, e.g. to download
or upload SCPI command files from / to the instrument.

11.12  To return to manual operation

Before returning to manual control, command processing must be completed. Other-
wise, the instrument switches back to remote control immediately.

1. To return from "Remote" state to manual state, perform one of the following:

● On the controller, use the command &GTL
Note: If &NREN has been set before &GTL is locked. Use &GTR instead.

● In the status bar, select the "Remote" icon.
● On the front panel, press the [Local] key.
● In the block diagram, select "Context sensitive menu > Key Emulation > Local"

2. Note: In the local lockout state, the command &GTL and the [Local] key are locked.
You can unlock this state only over remote control.
To return from "Remote LLO" state to manual or to "Remote" state, perform one of
the following:

To return from "Remote LLO" state to manual or to "Remote" state, perform one of
the following:
● On the controller, use the command &LOCS.

This command switches directly to manual operation.
● Send the command &REMS.

This command changes the remote control state from "Remote LLO" to
"Remote".

● Use the Visual Basic command CALL IBLOC (generator%).
The command switches directly to manual operation.

● VISA function viGpibControlREN()
This function switches directly to manual operation.

To return to manual operation
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11.13  To automate tasks with remote command scripts

To achieve fast configuration, make complex test setups or repeating measurements
reproducible, you can automate the required settings with scripts. A script contains a
series of SCPI commands corresponding to the settings. When completed, it is conver-
ted to an executable format, saved in a file and can be run whenever needed.

If you frequently need to load and run a script, assign the script to the [User], and you
can quickly and easily perform the task.
See Chapter 10.3.4, "How to assign actions to the [User] key", on page 240.
In contrast to "Recall Setup" via the [User] key, an assigned script execution does not
close active dialogs and windows. On the contrary, even active window control (open /
close) is possible.

Figure 11-8: Steps for performing SCPI Scripts

In the graph, you can see the main steps required to work with a SCPI script.

Creating a SCPI list

With the SCPI record functions, you can create a SCPI command list directly in the
instrument and then export the list to the controller. If you want to edit or write a script
manually, use a suitable editor on the controller. Even for manually creating, the instru-
ment supports you by showing the corresponding command syntax and the current
settings value.

Directly in the instrument, you can create a SCPI list at any time of operation, in the
following ways:
● Recording steps

Both, automatic and manual SCPI recording of settings is possible. You can start,
stop and resume automatic recording, and also record individual commands man-
ually.
– Manually record the steps selectively

In manual recording mode, you can deliberately record a SCPI command with
the "Add CPI Command to Recording List" function, see How to record SCPI
lists manually.

– Automatically record all performed steps
The instrument records the SCPI command and settings value of each step
you perform, and then writes the commands to the file system, see How to
record SCPI lists automatically.
You can also add a SCPI command manually to the recording list during auto-
matic SCPI recording.

To automate tasks with remote command scripts
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Note: The Automotive Radar Echo Generator clears the SCPI list after booting
automatically.

● Generating all settings at once
Generates the SCPI commands of the current instrument settings in one step, and
writes the command list in a temporary list, see How to create a SCPI list with the
current instrument settings in one step.
Note: This function lists all commands in alphabetical order, in contrast to the
recording or manual creation, which consider the order the settings are configured.
Using this function can slow down the runtime or cause errors during execution.
Therefore, always check and revise a script if necessary, see "How to check a
SCPI list" on page 339.

● Manually create a command script with "Copy" and paste
Enables you to copy the SCPI command and the current setting, see Chap-
ter 11.13.1, "Show SCPI command", on page 334.

Some parameters cannot be set by a SCPI command.
If so, no SCPI command found is entered instead of a command when you record or
generate all settings at once.

The difference between Show SCPI Command and the provided cross-reference

If you want to enter your settings in a script, or use a remote control program, you must
know the corresponding SCPI command and the exact syntax.

If you need to look up the SCPI command, the instrument offers two ways to figure it
out quickly.
● "Show SCPI command" (context-sensitive menu)

Displays the SCPI command syntax of a selected parameter including the current
setting value, see "Finding out the SCPI command with the "Show SCPI Com-
mand" function" on page 341.
The "Copy" function enables you to write a SCPI script conveniently by hand.

● Instrument help ([Help] key)
Opens a help topic that describes the selected parameter or instrument function,
including a cross-reference to the corresponding SCPI command. The reference
leads you to the description of the SCPI command comprising the complete SCPI
syntax, all available setting values, value ranges, etc.
See "Finding out the SCPI command using the online help" on page 341.

Creating and exporting a script file

When the script list is completed, a code generator translates the SCPI commands into
the source code of a proprietary programming language, using a code template. There-
fore, each language requires an appropriate code template. When converted, you can
save the script in a file with an extension corresponding to the programming language.

The R&S AREG800A provides the following predefined code templates by default:
● Plain SCPI

Represents SCPI base format, that is ASCII format, saved as text file (*.txt).
● MATLAB
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A programming environment, frequently used in signal processing and test and
measurement applications (*.m).
You can directly use this format with MATLAB(c) Toolkit. For comprehensive infor-
mation on this topic, refer to the application note 1GP60: MATLAB Toolkit for R&S
Signal Generators.

● NICVI
An ANSI C programming environment designed for measurements and tests (*.c).
You can directly use this format with National Instruments LabWindows CVI.

● Python3
A general-purpose and high-level programming language (*.py).

You can also convert a script to a user-specific format. In this case, you need a code
template with the extension *.expcodetmpl.

For information on how to select the code template and save the script in a file, see
Chapter 11.13.3, "SCPI recording export settings", on page 336.

Executing a SCPI script

A SCPI script primarily runs on the controller PC. In addition, you can execute a script
directly on the instrument, by assigning the script to the [User] key.

See Chapter 10.3.4, "How to assign actions to the [User] key", on page 240.

11.13.1  Show SCPI command

Access:

1. Select the parameter.

2. Open the context-sensitive menu (tap and hold).

3. Select "Show SCPI Command".

This function provides the syntax of the remote command with the current setting.

Copy
Copies the command and the current setting.

Close
Exits the "SCPI Command" dialog.

11.13.2  Displaying an SCPI list

The instrument displays a recorded SCPI list and thus provides viewing the recorded
results before exporting.

► Depending on the starting point, you can access the "SCPI Recording List" dialog
as follows:

To automate tasks with remote command scripts
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● During recording
Select "Show SCPI Recording List" in the context-sensitive menu.

● At any time outside recording
Select "Show SCPI Recording List" in the context-sensitive menu.
This function assumes that at least one recording has been executed after
power-on.

● At the end of the recording
Select "Stop automatic SCPI recording". The dialog opens automatically.

● After you have exported the script to a file.
Select "SCPI Recording Export > Show file content"
See Chapter 11.13.3, "SCPI recording export settings", on page 336.

The "SCPI Recording List" shows the last recorded and exported commands.

SCPI Recording List
Lists the automatically or manually recorded recorded SCPI commands.

Export
Opens the SCPI Recording Export dialog for configuring the file parameters for export.

Remove All, Remove First, Remove Last
Deletes either the first, the last or all recorded SCPI commands.
To remove several recorded commands, repeat the removing.
For post processing, export the SCPI command list in a file, see Chapter 11.13.5, "How
to convert and save SCPI lists", on page 340.
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11.13.3  SCPI recording export settings

Scripts are configured and saved in the "SCPI Recording Export" dialog. This dialog
opens automatically, when you stop recording.

Access:

1. Select "Show SCPI Recording List" in the context-sensitive menu.

The "SCPI Recording List" dialog opens.

2. Select "Export".

The "SCPI Recording Export" dialog contains all functions required for export of
command lists to a file. It enables you to select the source code format, assign an
individual filename and display the file content.

Format
Selects the source code format for the command list.
"Plain SCPI" Uses SCPI syntax.
"Predefined Code Generator"

Accesses the predefined templates for common source code genera-
tors that convert the recorded settings in the programming languages
MATLAB or NICVI or Python.

"User Code Generator"
Use this setting to convert a script by a user-specific code generator.
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Select Code Template
Opens the standard "File Select" dialog and lists the predefined or user-defined code
templates.

File
Opens the standard file select dialog "Select Output File".

Export
Executes data export.
The SCPI list is saved in as file with the selected filename and in the selected directory,
see File.

Reload
Reloads a SCPI list from a file.
You can export recorded SCPI lists to files (see File and Export), that can be modified.

File content
Displays the content of the script in the selected format and code template.

11.13.4  How to record / create SCPI lists

How to record SCPI lists automatically

The following example briefly explains how to proceed when you want to record SCPI
lists.

For comprehensive description, see 1GP98: SCPI Recorder Test Automation on a Fin-
gertip.

1. On the screen, open the context-sensitive menu (touch and hold, or right mouse
click) and select "Start SCPI recording".

Starting from now, all steps you perform are recorded.

2. To stop SCPI recording, select "context-sensitive menu > Stop SCPI recording".

The "SCPI Recording List" dialog opens automatically.

3. Proceed with How to check a SCPI list.

To automate tasks with remote command scripts
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How to record SCPI lists manually

1. To retrace your settings, open the context-sensitive menu and select "Mark all
Parameters Changed from Preset".

This function identifies and highlights all settings you have changed, both in the
block diagram, and in the dialogs.

2. For selectively recording your steps:

a) Set the parameter.
b) Open the context-sensitive menu.
c) Select "Add SCPI Command to Recording List"

Tip: You cannot see "Add SCPI ..." in the menu?
A possible reason is opening the menu outside of a dialog or input field, for
example in a block diagram. Open the context-sensitive menu within the corre-
sponding dialog or input field, and the feature is available.

d) Continue with the next setting, and repeat steps a to b whenever needed.

Each time you select "Add SCPI ...", the SCPI command is appended to a tempo-
rary list.

3. To check the progress of the recording, select "Context-Sensitive > Show SCPI
Recording List".

The "SCPI Recording List" dialog opens, displaying all recorded settings so far.

4. Proceed with How to check a SCPI list.

How to create a SCPI list with the current instrument settings in one step

You can also generate a SCPI list from a manually created instrument state at any
time, in only one step.

To generate a SCPI list with commands for all settings performed:

1. Select "Save/Recall > SCPI Export".
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The instrument opens the standard file select dialog, see Chapter 9.4.1, "Save/
recall settings", on page 211.

2. In the "Format" entry field, select the source code.

3. Depending on the selected format, convert the script as described in Chap-
ter 11.13.5, "How to convert and save SCPI lists", on page 340

4. Enter a filename.

5. Select "Export".
The instrument writes all SCPI commands of the key parameters and the modified
settings in the file. Also assigns the file extension automatically according to the
source code format.

6. To preview the content of the SCPI list:

a) Select "System Config > Save/Recall".
b) Select "Operation Mode > SCPI-Export".
c) In the /var/user/ directory, select a previously saved file.
d) Select "Show SCPI List".

The list of all SCPI commands is displayed, for example, for a final check.

Exporting the SCPI list of the instrument state in one step is a fast and convenient
method. Nevertheless, it usually requires postprocessing on an external PC.

How to check a SCPI list

The easiest way to check a list, is to execute it. The generator returns a warning if a
setting could not be performed.

However, we recommend that you check the list and possibly rework. It can be that ...
● A parameter has not assigned a SCPI command or an element of the user inter-

face has not an assigned parameter. In these cases, :SYST:INF:SCPI 'SCPI
command not available' is entered in the list instead.

To automate tasks with remote command scripts
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Such entries are also detected during execution. The instrument recognizes these
incomplete commands and displays an error message.

● A preset has been executed, but several standards then perform some internal set-
tings that are also assigned to the list with "SCPI Export".

● After a preset still some settings are defined, which are then written to the list gen-
erated with "SCPI Export."

Some suggestions on how you can check and revise a list:

1. Search and remove missing command entries.

2. Remove unnecessary content written after a preset.

3. Rearrange the commands to a reasonable order. If you, for example, set a STATe
command to the last position of a list, you can avoid intermediate calculations of
the signal.

4. Preview the list for completeness by comparing it with the modified settings in the
manual mode.

a) To retrace your settings in manual operation, open the context-sensitive menu
and select "Mark all parameters changed from preset".
The function identifies all settings you have changed, both in the block dia-
gram, and in the dialogs. They appear orange.

b) Check whether there is a command in the list for all modified settings.

5. To perform modifications, export the list to a PC, using for example a USB flash
drive.

11.13.5  How to convert and save SCPI lists

After completing the recording, the "SCPI Recording Export" dialog opens.

1. Select the "Format" for the command syntax in which you want to save the list.

2. "Select Code Template"
Depending on the selected format, proceed accordingly:
Note: Select the code template before exporting.

a) Plain SCPI
Continue with the next step.

b) Predefined code generator
The "SCPI Recording Export - Select Predefined Code Template" dialog opens.
Select one of the predefined code templates.

c) User code generator
A file system ("SCPI Recording Export - Select User Code Template") dialog
opens.
Select your user-defined code template. The code template must have file
extension *.expcodetmpl.

3. Select "File..."
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The "SCPI Recording Export - Select Output File" dialog opens.

4. Select "New" and assign a filename for saving the recorded list.

5. In the "SCPI Recording Export" dialog, select "Export".
Saves the recorded data either in ASCII format (plain SCPI), or in the correspond-
ing format of the used code template, and shows the SCPI list in the "File Content"
section.

11.13.6  How to find out the SCPI commands for GUI functions

Finding out the SCPI command with the "Show SCPI Command" function

1. To find out the SCPI command of a parameter in manual operation, select the
parameter.

2. Open the context-sensitive menu and select "Show SCPI command"

You get the detailed command syntax, including the currently set value.

With the "Copy" function, you can conveniently paste the command including the
current setting, e.g., in a command script.

Finding out the SCPI command using the online help

If you are looking for the remote command to a function in manual operation, you find it
in the description of the online help.

1. To find out the SCPI command of a parameter in manual operation, select the
respective parameter.

2. To open the corresponding help topic, select one of the following:

● In the display, select "context-sensitive menu > Help".

● On the front panel, press the [Help] key.

The help topic opens. Apart from the function description, it contains the SCPI
command in detailed syntax.
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How to find the corresponding GUI function to a command
Conversely, if you are looking for a function in the GUI, which belongs to a SCPI, you
find it via a cross-reference in the online help and in the user manual.

11.14  To operate the instrument using VNC

This section shows you some examples of the various possibilities to set up remote
operation.

● Using a desktop system
– Chapter 11.14.2.1, "Using a web browser", on page 342
– Chapter 11.14.2.2, "Using a VNC client software", on page 343

● Using a smart device
– Chapter 11.14.3.1, "Using a VNC app", on page 346
– Chapter 11.14.3.2, "Using a web browser with HTML5", on page 346
– Chapter 11.14.3.3, "Special mode QR code", on page 347

11.14.1  How to enable the VNC service

1. NOTICE! Enabled VNC service can lead to unauthorized access.
Change the computer name and password of the instrument.
See Chapter 10.5.5, "How to prevent unauthorized access", on page 263.

2. Select "System Config > Setup > Security > Security > LAN Services".

3. Select "VNC > On".

4. Enter the Security Password.

5. Select "Accept".

11.14.2  How to set up remote operation from a desktop system

11.14.2.1  Using a web browser

The R&S AREG800A supports remote operation via VNC with any web browser, like
Windows Internet Explorer or Mozilla Firefox for instance, or alternatively, an HTML5
web browser.

To operate the instrument via a web browser remotely:

1. Install the JRE (Java Runtime Environment) on the remote computer.
Note: Skip this step if you are working with an HTML5 web browser.

To operate the instrument using VNC
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2. Type the instruments' IP address in the address field of the web browser on your
PC, e.g. http://10.113.1.151

The VNC authentication screen appears.

3. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated from the remote computer.

11.14.2.2  Using a VNC client software

A VNC client software is an application which can be used to access and control the
instrument from a remote computer through a LAN connection.

The VNC client software for setting up the connection is included in the operating sys-
tem Linux/Unix per default. For Windows operating systems, a VNC client software
must be installed manually.

Various free-of charge programs such as Ultr@VNC or similar VNC client programs
are available for download on the Internet.

Setting up the VNC connection on a Linux/Unix desktop client

1. Start a web browser on the remote computer. Enter the IP address of the instru-
ment.

2. Enter the following address:
vnc://<IP-address of the instrument>, for example vnc://10.113.1.151.

A dialog opens requesting the password for the remote VNC connection.

3. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated from the remote computer.

Setting up the VNC connection on a Windows desktop client

1. Install the VNC viewer program component on the remote computer.

a) On the Internet, select a VNC client program and download it onto your PC.
For example the free of charge software Ultr@VNC (vncviewer.exe is avail-
able, see http://www.uvnc.com/download/index.html.

b) Execute the VNC client installation.
c) Select the VNC viewer program component and follow the installation instruc-

tions.

2. Start VNC viewer program component on the PC.

To operate the instrument using VNC
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3. Select "VNC Server" and enter the IP address of the instrument.

4. To initialize the connection, select "Connect".

A dialog opens requesting the password.

5. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated from the remote computer.

Terminating VNC connection

► Perform one of the following:

a) On an external Unix/Linux PC, close the Internet browser or the signal genera-
tor window.

b) On an external Windows PC, close the VNC viewer program.

The connection is terminated but not disabled. It can be established again anytime.
In the "Active Connections" tab, the displayed TCP/IP connection disappears.
See Chapter 10.5.5, "How to prevent unauthorized access", on page 263.

11.14.3  How to set up remote operation from a smart device

The R&S AREG800A supports remote operation via VNC from a smart device (remote
client), like a tablet (tablet computer) or a smartphone. The smart device accesses the

To operate the instrument using VNC
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instrument via WLAN, either by a suitable App, or an HTML5 web browser, that means
with embedded javascript.

There are several possibilities to establish a WLAN connection between the smart
device and the R&S AREG800A. This section gives an example of how a network envi-
ronment can be built up, and some essential configuration steps.

For more information, see:
● 1MA216: Remote Operation of Windows Based Instruments with Apple iPad
● 7BM82: Apple iPad Remote Control of Broadcasting T&M Instruments

Example: 

Figure 11-9: Example of a network configuration for remote operation with a smart device

As shown in the figure, the R&S AREG800A and the WLAN router are connected to
the LAN router. The smart device accesses the Rohde & Schwarz instrument via the
WLAN router.

Prerequisites

For this network configuration, the following prerequisites must be met:
● The required equipment is:

– A LAN router
– A WLAN router (hot spot)

Required for accessing the R&S AREG800A
● The smart device must be known and accepted in the network of the

R&S AREG800A.
● The App or web browser implements the VNC functionality on the smart device for

remote operation.

It is recommended that all components in the network use DHCP, which automatically
assigns the relevant address information.

To operate the instrument using VNC
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With the configuration in the example, you can reach the instrument from a great dis-
tance, since the WLAN router acts as an additional access point.

11.14.3.1  Using a VNC app

Using a VNC App enables the smart device to access the R&S AREG800A via WLAN.

The VNC Apps are available from various manufacturers of the smart devices.

The list of supported devices is different according to the smart device.

1. Refer to the manufacturer's website to find out whether a VNC App is available for
your device, and how it is installed.

2. In the network, establish the connection of the WLAN router to the LAN router.
We assume the connection of the LAN router and the R&S AREG800A and their
configuration in the LAN.

3. Configure the WLAN router according to the manufacturer's instructions.

4. Install the required VNC App on your smart device.

5. On the smart device, start the VNC App.

6. In the address field, enter the IP address of the instrument.

A log-on dialog opens and requests the password for the VNC connection.

7. Enter the password to establish the remote access.
The default user name and password is instrument.
See Chapter 10.5.5, "How to prevent unauthorized access", on page 263.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated.

11.14.3.2  Using a web browser with HTML5

The R&S AREG800A supports remote operation from a smart device via VNC with any
HTML5 compliant web browser, like Internet Explorer, Firefox, Google Chrome, or
Safari for instance.

To operate the instrument remotely via a web browser, proceed as follows:

1. In the web browser enter the IP address of the instrument, e.g. http://10.113.1.151.

2. Type the instrument IP address in the address field of the web browser on your PC,
e.g. http://10.113.1.151

The VNC authentication screen appears.

3. Enter the password and confirm with "OK".
The default password is instrument.

To operate the instrument using VNC
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See Chapter 10.5.5, "How to prevent unauthorized access", on page 263.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated.

11.14.3.3  Special mode QR code

If your smart device is equipped with a camera and a QR code reader, you can scan
the instrument's IP address or access the instrument with the Safari web browser.

QR code readers are available from various manufacturers of the smart devices.

The list of supported devices is different according to the smart device.

1. Refer to the manufacturer's website of your smart device to find out whether a
reader is available for your device, and how it is installed.

2. Install the required QR code reader software on your device.

3. Start the reader.

4. On the R&S AREG800A, select "System Config > Remote Access".

5. In the "Remote Access" dialog, select the "QR-Code" tab.

6. Scan the QR code of the instrument with your smart device.

7. On the device, decode the scanned QR code and pass it to the web browser.

A dialog opens requesting the password for the VNC connection.

8. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated.

11.15  References

11.15.1  LXI functionality

LAN Extensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology.

The LXI implementation in the R&S AREG800A allows you to change certain LAN set-
tings, to reset the LAN connection, and to identify the instrument.

For information about the LXI standard, refer to the LXI website at http://www.lxistan-
dard.org.
See also "News from Rohde & Schwarz, article 2006/II - 190".

References
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The LXI functionality in the R&S AREG800A is characterized by a common LAN imple-
mentation, including an ICMP ping responder for diagnostics. Using a web browser,
you can configure the instrument. A LAN Configuration Initialize (LCI) mechanism
resets the LAN configuration. The instrument also supports automatic detection in a
LAN via the VXI-11 discovery protocol and programming by IVI drivers.

In addition, the R&S AREG800A provides the following LXI-related functionality:
● Integrated "LXI Status" dialog for LXI status indication and reset of the LAN config-

uration, see Chapter 11.6.1, "LXI status settings", on page 310.
● "LXI Browser Interface", as described in Chapter 11.6.2.1, "LAN configuration",

on page 312.
● "SCPI Remote Trace" utility, see Chapter 11.6.2.2, "SCPI remote trace",

on page 315.

Firmware update
To enable the full LXI functionality after a firmware update, shut down and restart the
instrument.

11.15.2  Code generator templates

This section describes the main structure of the code generator templates, and shows
the method with the NICVI template.

The code generation is controlled by templates with the following blocks:

Command Function

#EXTENSION_START
#EXTENSION_END

Defines the output file extension.

#INIT_CODE_START
#INIT_CODE_END

Contains initial entries, such as included files and
libraries, buffer size, commands for synchronization,
or creating a VISA session.

All entries between start and end are written once at
the beginning of the output file.

#COMMAND_CODE_START
#COMMAND_CODE_END

Frame for a SCPI command. A command is
accessed with %COMMAND.

#NO_COMMAND_CODE_START
#NO_COMMAND_CODE_END

Frame for a parameter with no SCPI command
available. A parameter is accessed with
%PARAMETER.

#EXIT_CODE_START
#EXIT_CODE_END

Closes the visa session.

All entries between start and end are written once at
the end of the output file.

Templates are created in ASCII format with file extension *.expcodetempl.

Example: 
Example to the code generator template NICVI.expcodetmpl:

References
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#EXTENSION_START
.c
#EXTENSION_END

#INIT_CODE_START
#include <ansi_c.h>
#include <visa.h>
#include <cvirte.h>

#define MAX_BUFFER_SIZE 200
static ViStatus status;
static ViSession defaultRM, handle;

static void write_command(char *command)
{
  char writeBuffer[MAX_BUFFER_SIZE];
        char readBuffer[MAX_BUFFER_SIZE];
        int length;
        int readCount;
        
        strcpy(writeBuffer, command);
        //append "*OPC?" to sync
        strcat(writeBuffer, ";*OPC?");
        length = strlen (writeBuffer);
        writeBuffer[length]='\n';
        length = length+1;
        viWrite (handle, writeBuffer, length, VI_NULL);
        //read result
        viRead(handle, readBuffer, 100, &readCount);
}     
int main (int argc, char *argv[])
{
  if (InitCVIRTE (0, argv, 0) == 0)
     return -1;    /* out of memory */
        //create a VISA session and return a handle to it
     viOpenDefaultRM (&defaultRM);
        //create a VISA session to the serial port and return a handle to it
        viOpen (defaultRM, (ViRsrc)"TCPIP::localhost::INSTR", VI_NULL, VI_NULL, 
&handle);
#INIT_CODE_END

#COMMAND_CODE_START
  write_command("%COMMAND");
#COMMAND_CODE_END

#NO_COMMAND_CODE_START
  //no SCPI command available for parameter %PARAMETER !
#NO_COMMAND_CODE_END

#EXIT_CODE_START

References
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  viClose (handle);
        viClose (defaultRM);
        return 0;
}
#EXIT_CODE_END

11.15.3  Remote control states

How to recognize if there is an active remote connection to the instrument

► Observe the indication on the taskbar.

A softkey in the taskbar indicates if and what kind of remote connections are cur-
rently set up.
See also Chapter 11.5.6, "Remote connections settings", on page 297.

The following table shows the different remote control states and the associated com-
mands or actions to return to manual control.

References
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12  Remote control commands
In the following, all remote-control commands are presented in detail with their param-
eters and the ranges of numerical values.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] to 8 Available IF output paths and radar channels

MAPPing<ch> [1] to 8 Available radar channels for channel mapping

OBJect<ch> [1] to 8 Available radar objects

QAT<ch> [1] to 8 Available QAT frontends

TRX<ch> [1] to 4 Available TRX frontends

SECondary<ch> [1] to 8 Available secondary R&S AREG800A instruments for
dynamic scenarios

Conventions used in SCPI command descriptions

The following conventions are used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitly.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S AREG800A follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

● Factory preset values
Default parameter values that are reset only by factory preset.
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● Default unit
The default unit is used for numeric values if no other unit is provided with the
parameter.

● Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

In all the examples we assume that:
● A remote PC is connected to the instrument.
● The remote PC and the instrument are switched on.
● A connection between them is established.
● The security setting "System Config > Setup > Security > SCPI over LAN" is

enabled.

● Programming examples........................................................................................ 352
● Common commands.............................................................................................353
● Preset commands................................................................................................. 357
● CALibration subsystem......................................................................................... 359
● DIAGnostic subsystem..........................................................................................362
● HUMS remote control commands.........................................................................365
● DISPlay subsystem...............................................................................................373
● FORMat subsystem.............................................................................................. 377
● HCOPy subsystem................................................................................................379
● KBOard subsystem............................................................................................... 384
● MMEMory subsystem............................................................................................384
● SYSTem subsystem..............................................................................................395
● SYSTem:COMMunicate:RT subsystem................................................................ 425
● SYSTem:COMMunicate:SYST subsystem............................................................427
● TEST subsystem...................................................................................................430
● SOURce subsystem..............................................................................................432
● SENSe, READ, INITiate and SLISt subsystems................................................... 509
● STATus subsystem................................................................................................523

12.1  Programming examples

The corresponding sections of the same title provide simple programming examples for
the R&S AREG800A. The purpose of the examples is to present all commands for a
given task. In real applications, one would rather reduce the examples to an appropri-
ate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (for example comments) start with two // characters.

At the beginning of most remote control programs, an instrument preset or reset is rec-
ommended to set the R&S AREG800A to a definite state. The commands *RST and

Programming examples
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SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

12.2  Common commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

*CLS.............................................................................................................................353
*ESE.............................................................................................................................353
*ESR?...........................................................................................................................354
*IDN?............................................................................................................................354
*IST?............................................................................................................................ 354
*OPC............................................................................................................................354
*OPT?...........................................................................................................................354
*PRE............................................................................................................................ 355
*PSC............................................................................................................................ 355
*RCL.............................................................................................................................355
*RST.............................................................................................................................355
*SAV.............................................................................................................................356
*SRE............................................................................................................................ 356
*STB?...........................................................................................................................356
*TRG............................................................................................................................ 356
*TST?........................................................................................................................... 357
*WAI.............................................................................................................................357

*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

Common commands
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*ESR?

Event status read

Returns the contents of the event status register in decimal form and then sets the reg-
ister to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Identification

Returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<part number>/<serial num-

ber>,<firmware version>"

Usage: Query only

Manual operation: See "IDN String" on page 296
See "Hardware Options/Software Options" on page 538

*IST?

Individual status query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query writes a "1" into the
output buffer when all preceding commands have been executed, which is useful for
command synchronization.

*OPT?

Option identification query

Queries the options included in the instrument. For a list of all available options and
their description, refer to the data sheet.

Common commands



Remote control commandsR&S®AREG800A

355User Manual 1179.3615.02 ─ 06

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

Manual operation: See "OPT String" on page 296
See "Hardware Options/Software Options" on page 538

*PRE <Value>

Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on status clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RCL <Number>

Recall

Loads the instrument settings from an intermediate memory identified by the specified
number. The instrument settings can be stored to this memory using the command
*SAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file_name.extension> command.

Manual operation: See "Recall Immediate x" on page 213

*RST

Reset

Common commands
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Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

Manual operation: See "Preset" on page 207

*SAV <Number>

Save

Stores the current instrument settings under the specified number in an intermediate
memory. The settings can be recalled using the command *RCL with the associated
number.

To transfer the stored instrument settings in a file, use the command :MMEMory:
STORe:STATe.

Manual operation: See "Save Immediate x" on page 212

*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

*TRG corresponds to the INITiate:IMMediate command.

Usage: Event

Common commands



Remote control commandsR&S®AREG800A

357User Manual 1179.3615.02 ─ 06

*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code.

Return values: 
<ErrorCode> integer > 0 (in decimal format)

An error occurred.
(For details, see the Service Manual supplied with the instru-
ment).
0
No errors occurred.

Usage: Query only

*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

12.3  Preset commands

The preset commands are not bundled in one subsystem. Therefore, they are listed
separately in this section.

Four presetting actions are available:
● Activating the default state of all internal instrument functions (*RST on page 355).

Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. reference oscillator source settings.

● Activating the preset state of the parameters related to the selected signal path (:
SOURce<hw>:PRESet on page 358)

● Activating the preset state of all parameters that are not related to the signal path
(:DEVice:PRESet on page 358)

● Activating the original state of delivery (factory reset, :SYSTem:FPReset
on page 358). Only functions that are protected by a password remain unchanged
as well as the passwords themselves.

When resetting, the following deviation between remote and manual control exists:
In contrast to the [Preset] key, the SCPI commands *RST and :SYSTem:PRESet do
not close open dialogs in the GUI.

Preset commands
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:DEVice:PRESet............................................................................................................ 358
:SOURce<hw>:PRESet.................................................................................................. 358
:SYSTem:PRESet.......................................................................................................... 358
:SYSTem:FPReset......................................................................................................... 358

:DEVice:PRESet

Presets all parameters which are not related to the signal path, including the LF gener-
ator.

Example: DEV:PRES
Presets all instruments settings that are not related to the signal
path.

Usage: Event

:SOURce<hw>:PRESet

Presets all parameters which are related to the selected signal path.

Example: SOUR:PRES
Presets all settings that are related to signal path

Usage: Event

:SYSTem:PRESet

Triggers an instrument reset. It has the same effect as:
● The *RST command

Example: SYST:PRES
All instrument settings (also the settings that are not currently
active) are reset to their default values.

Usage: Setting only

:SYSTem:FPReset

Triggers an instrument reset to the original state of delivery.

Example: SYST:FPR
All instrument settings (also the settings that are not currently
active) are reset to the factory values.

Usage: Event

Manual operation: See "Execute Factory Preset" on page 207

Preset commands
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12.4  CALibration subsystem

The CALibration subsystem contains the commands needed for performing internal
adjustments. This procedure is triggered by the query commands.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

CALibration<hw> [1] Optional suffix

Understanding the query response

● 0: error-free execution of the adjustments
● 1: indicates that an error occurred; the process has been canceled

:CALibration:ALL[:MEASure]?......................................................................................... 359
:CALibration<hw>:ALL:DATE?.........................................................................................359
:CALibration<hw>:ALL:INFormation?............................................................................... 360
:CALibration<hw>:ALL:TEMP?........................................................................................ 360
:CALibration<hw>:ALL:TIME?......................................................................................... 360
:CALibration<hw>:CONTinueonerror................................................................................361
:CALibration:DATA:EXPort.............................................................................................. 361
:CALibration:DATA:FACTory:DATE?.................................................................................361
:CALibration:DELay:MINutes...........................................................................................361
:CALibration:DELay:SHUTdown[:STATe].......................................................................... 362
:CALibration:DELay[:MEASure]?..................................................................................... 362

:CALibration:ALL[:MEASure]? [<Force>]

Starts all internal adjustments that do not need external measuring equipment.

Query parameters: 
<Force> string

Return values: 
<Measure> 1 | ON | 0 | OFF

Usage: Query only

Manual operation: See "Adjust All" on page 544

:CALibration<hw>:ALL:DATE?

Queries the date of the most recently executed full adjustment.

Suffix: 
<hw>

.
[1]
Optional suffix

CALibration subsystem
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Return values: 
<Date> string

Example: CAL:ALL:DATE?
// "2016-01-01"

Usage: Query only

Manual operation: See "Last Full Adjustment" on page 544

:CALibration<hw>:ALL:INFormation?

Queries the current state of the internal adjustment.

Return values: 
<CalInfoText> string

Example: CAL:ALL:INF?
"Instrument is calibrated, no adjustment required."
"UNCAL, instrument is warming up."
"UNCAL, Please perform full adjustment after warming up."
"UNCAL, Please perform full adjustment."

Usage: Query only

Manual operation: See "Information" on page 544

:CALibration<hw>:ALL:TEMP?

Queries the temperature deviation compared to the calibration temperature.

Suffix: 
<hw>

.
[1]
Optional suffix

Return values: 
<Temperature> string

Example: CALibration:ALL:TEMP?
// "+12.00 K"

Usage: Query only

Manual operation: See "Temperature Offset" on page 544

:CALibration<hw>:ALL:TIME?

Queries the time elapsed since the last full adjustment.

Return values: 
<Time> string

Example: CAL:ALL:TIME?
// "22 days"

Usage: Query only

CALibration subsystem
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Manual operation: See "Time" on page 544

:CALibration<hw>:CONTinueonerror <State>

Continues the calibration even though an error was detected. By default adjustments
are aborted on error.

Suffix: 
<hw>

.
[1]
Optional suffix

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: CAL:CONT ON
// Continues calibration after an error

Manual operation: See "Continue Adjustment on Error" on page 545

:CALibration:DATA:EXPort

Collects the internal adjustment data and provides the data for export in a zip file. You
can export the data for service and evaluation purposes.

Example: :CALibration:DATA:EXPort

Usage: Event

:CALibration:DATA:FACTory:DATE?

Queries the date of the last factory calibration.

Return values: 
<Date> string

Example: CAL:DATA:FACT:DATE? 
// "2016-01-01"

Usage: Query only

Manual operation: See "Last Factory Calibration" on page 536

:CALibration:DELay:MINutes <Minutes>

Sets the warm-up time to wait before internal adjustment starts automatically.

Automatic execution starts only, if you have enabled the calibration with command :
CALibration:DELay[:MEASure]? ON.

CALibration subsystem
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Parameters:
<Minutes> integer

Range: 30  to  120
*RST: n.a. (no preset. default: 60)

Example: :CALibration:DELay:MINutes 30
// sets the time delay for warm-up of the instrument.

Manual operation: See "Warm Up Time" on page 545

:CALibration:DELay:SHUTdown[:STATe] <Shutdown>

Enables the instrument to shut down automatically after calibration.

Parameters:
<Shutdown> 1 | ON | 0 | OFF

*RST: 0

Example: :CALibration:DELay:SHUTdown[:STATe] ON|1
// inititates that the instrument shuts down when the adjustments are completed.

Manual operation: See "Shutdown After Adjustment" on page 546

:CALibration:DELay[:MEASure]?

Starts the delayed adjustment process. When the warm-up time has elapsed (see :
CALibration:DELay:MINutes, it executes the internal adjustments.

If you have enabled automatic shutdown, :CALibration:DELay:SHUTdown[:
STATe] ON, the instrument shuts down when the adjustments are completed.

Return values: 
<Error> 1 | ON | 0 | OFF

*RST: n.a. (no preset. default: 0)

Example: :CALibration:DELay[:MEASure] ON|1
// enables the adjustment processs to start after the warm-up time automatically

Usage: Query only

Manual operation: See "Adjust All Delayed" on page 545

12.5  DIAGnostic subsystem

The DIAGnostic subsystem contains the commands used for instrument diagnosis
and servicing. SCPI does not define any DIAGnostic commands; the commands lis-
ted here are all device-specific. All DIAGnostic commands are query commands
which are not affected by *RST.

DIAGnostic subsystem
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The test functions are intended for services purposes.
They are thus password-protected functions. Unlock the corresponding protection level
to access them, see :SYSTem:PROTect<ch>[:STATe].
For more information, see R&S AREG800A Service Manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

DIAGnostic<hw> [1] Optional suffix

Example: Programming example
The example lists the commands required to query assemblies and test points for diag-
nosis purposes.
// Query the operating hours and number of power-on so far.
DIAGnostic:INFO:OTIMe?
// 112 h
DIAGnostic:INFO:POCount? 
// 14

Commands

:DIAGnostic<hw>:BGINfo:CATalog?.................................................................................363
:DIAGnostic<hw>:BGINfo?..............................................................................................363
:DIAGnostic:INFO:OTIMe?..............................................................................................364
:DIAGnostic:INFO:POCount?.......................................................................................... 364
:DIAGnostic<hw>:POINt:CATalog?...................................................................................365
:DIAGnostic<hw>[:MEASure]:POINt?...............................................................................365

:DIAGnostic<hw>:BGINfo:CATalog?

Queries the names of the assemblies available in the instrument.

Return values: 
<Catalog> string

List of all assemblies; the values are separated by commas
The length of the list is variable and depends on the instrument
equipment configuration.

Example: See Example"Programming example" on page 363.

Usage: Query only

:DIAGnostic<hw>:BGINfo? [<Board>]

Queries information on the modules available in the instrument, using the variant and
revision state.

DIAGnostic subsystem
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Query parameters: 
<Board> string

Module name, as queried with the command :
DIAGnostic<hw>:BGINfo:CATalog?.
To retrieve a complete list of all modules, omit the parameter.
The length of the list is variable and depends on the instrument
equipment configuration.

Return values: 
<BgInfo> <Module name> <Module stock number incl. variant> <Module

revision> <Module serial number>
List of comma-separated entries, one entry per module.
Each entry for one module consists of four parts that are separa-
ted by space characters.

Example: See Example"Programming example" on page 363.

Usage: Query only

Manual operation: See "Assembly" on page 536

:DIAGnostic:INFO:OTIMe?

Queries the operating hours of the instrument so far.

Return values: 
<OperationTime> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example"Programming example" on page 363.

Usage: Query only

Manual operation: See "Operation Time / h" on page 536

:DIAGnostic:INFO:POCount?

Queris how often the instrument has been turned on so far.

Return values: 
<PowerOnCount> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example"Programming example" on page 363.

Usage: Query only

Manual operation: See "Power On Count" on page 536

DIAGnostic subsystem
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:DIAGnostic<hw>:POINt:CATalog?

Queries the test points available in the instrument.

For more information, see R&S AREG800A Service Manual.

Return values: 
<Catalog> string

List of comma-separated values, each representing a test point

Example: See Example"Programming example" on page 363.

Usage: Query only

:DIAGnostic<hw>[:MEASure]:POINt? <Name>

Triggers the voltage measurement at the specified test point and returns the measured
voltage.

For more information, see R&S AREG800A Service Manual.

Query parameters: 
<Name> <test point identifier>

Test point name, as queried with the command :
DIAGnostic<hw>:POINt:CATalog?

Return values: 
<Value> <value><unit>

Example: See Example"Programming example" on page 363.

Usage: Query only

12.6  HUMS remote control commands

The remote control commands for the health and utilizations monitoring system
(HUMS) comprise commands of the DIAGnostic subsystem and the commands of
the SYSTem:COMMunicate:REST and SYSTem:COMMunicate:REST subsystems.

For all HUMS-related remote control commands, see refer to the "R&S®HUMS Health
and Utilization Monitoring Service" User Manual on the Internet.

Commands

DIAGnostic:HUMS:DELete:ALL....................................................................................... 366
DIAGnostic:HUMS:DEVice:HISTory?................................................................................366
DIAGnostic:HUMS:DEVice:HISTory:DELete:ALL............................................................... 367
DIAGnostic:HUMS:FORMat............................................................................................ 367
DIAGnostic:HUMS:SAVE................................................................................................ 367
DIAGnostic:HUMS:STATe............................................................................................... 368
DIAGnostic:HUMS:TAGS:ALL?....................................................................................... 368
DIAGnostic:HUMS:TAGS:DELete.................................................................................... 368
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DIAGnostic:HUMS:TAGS:DELete:ALL..............................................................................369
DIAGnostic:HUMS:TAGS[:VALue]....................................................................................369
SYSTem:COMMunicate:REST:ENABle.............................................................................369
SYSTem:COMMunicate:SNMP:COMMunity:RO................................................................ 369
SYSTem:COMMunicate:SNMP:COMMunity:RW................................................................370
SYSTem:COMMunicate:SNMP:CONTact..........................................................................370
SYSTem:COMMunicate:SNMP:LOCation......................................................................... 370
SYSTem:COMMunicate:SNMP:USM:USER......................................................................371
SYSTem:COMMunicate:SNMP:USM:USER:ALL?............................................................. 371
SYSTem:COMMunicate:SNMP:USM:USER:DELete.......................................................... 372
SYSTem:COMMunicate:SNMP:USM:USER:DELete:ALL................................................... 372
SYSTem:COMMunicate:SNMP:VERSion..........................................................................372

DIAGnostic:HUMS:DELete:ALL

Deletes the complete HUMS data. This includes device history, device tags, SCPI con-
nections, utilization history and utilizations.

Example: //Delete HUMS data
DIAG:HUMS:DEL:ALL

Usage: Event

DIAGnostic:HUMS:DEVice:HISTory?

Queries the device history information of the connected instrument. Depending on the
set data format, the queried data is either displayed in XML or JSON format. For more
information about setting the data format, see DIAGnostic:HUMS:FORMat
on page 367.

Return values: 
<HistoryInfo> <block_data>

Device history information of the connected instrument as block
data in a comma-separated list:
#blockdata[{event1},{event2},{event3}...]
With the following parameters:
<eventID>,<eventTimestamp>,<eventMessage>,
<eventDetails>,<eventSeverity>
Binary block data with the following syntax:
#<Digits><Length><Binarydata>
#
Indicates the start of the binary block
<Digits>
Decimal value
Gives the number of decimal digits used for the <Length>
value
<Length>
Decimal value
Number of bytes the follow in the <Binary data> part
<Binary data>
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Binary data in ASCII format

Example: //Return device history
DIAG:HUMS:DEV:HIST?
Returns for example:
#44715[{"eventId":32,"eventTimestamp":
"2021-02-02T17:25:39Z","eventMessage":
"Deviation from Self Alignment Temperature",
"eventDetails":
"Deviations resolved","eventSeverity":0}

Usage: Query only

Manual operation: See "Export History" on page 300

DIAGnostic:HUMS:DEVice:HISTory:DELete:ALL

Deletes the complete device history information of the connected instrument.

Example: //Delete complete device history
DIAG:HUMS:DEV:HIST:DEL:ALL

Usage: Event

Manual operation: See "Delete History" on page 300

DIAGnostic:HUMS:FORMat <DataFormat>

Selects the format for the queried HUMS data. You can query the HUMS data either in
JSON format or XML format.

The defined format affects all other commands that return block data.

Parameters:
<DataFormat> JSON | XML

JSON
Returns the HUMS data in JSON format.
XML
Returns the HUMS data in XML format.
*RST: JSON

Example: //Return data in JSON format
DIAG:HUMS:FORM JSON

DIAGnostic:HUMS:SAVE <path>

Saves the HUMS history as a ZIP file to your preferred path.

Setting parameters: 
<path>

Example: //Save HUMS history data
DIAG:HUMS:SAVE 'C:\HUMS\hums_2021.zip'
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Usage: Setting only

Manual operation: See "Export History" on page 300

DIAGnostic:HUMS:STATe <State>

Turns the HUMS service and data collection on and off.

Parameters:
<State> ON | OFF | 1 | 0

*RST: ON

Example: //Turn on HUMS service
DIAG:HUMS:STAT ON

Manual operation: See "State" on page 299

DIAGnostic:HUMS:TAGS:ALL?

Queries all key-value tags that you have assigend to the instrument. Depending on the
set data format, the queried data is either displayed in XML or JSON format. For more
information about setting the data format, see DIAGnostic:HUMS:FORMat
on page 367.

Return values: 
<ID> ID number of the defined tag.

<Key> String containing key name of the defined tag.

<Value> String containing value of the defined tag.

Example: //Return all tags
DIAG:HUMS:TAGS:ALL?
1,"location","building_11",2,"time zone","CET"

Usage: Query only

Manual operation: See "Add" on page 309

DIAGnostic:HUMS:TAGS:DELete <ID>

Deletes a certain tag you assigned to your instrument, including its key and value.

Setting parameters: 
<ID> ID number of the tag you want to delete.

To identify the ID number, query all device tags from the system
first. For more information, see DIAGnostic:HUMS:TAGS:
ALL? on page 368.

Example: //Delete tag
DIAG:HUMS:TAGS:DEL 0

Usage: Setting only

Manual operation: See "Delete" on page 309
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DIAGnostic:HUMS:TAGS:DELete:ALL

Deletes all key-value tags you have assigned to the instrument.

Example: //Delete all tags
DIAG:HUMS:TAGS:DEL:ALL

Usage: Event

Manual operation: See "Delete All" on page 309

DIAGnostic:HUMS:TAGS[:VALue] <ID>, <Key>, <Value>
DIAGnostic:HUMS:TAGS[:VALue]? <ID>

Adds or modifies a key-value pair (device tag).

The query returns the key-value pair for a given ID or an empty string if the ID is
unknown.

Parameters:
<Key> String containing key name of the queried tag.

<Value> String containing value of the queried tag.

Parameters for setting and query: 
<ID> 0 - 31

ID number of the tag you want to modify or query.
To identify the ID number, query all device tags from the system
first. For more information, read here DIAGnostic:HUMS:
TAGS:ALL? on page 368.

Example: //Add or modify a tag (tag 1)
DIAG:HUMS:TAGS 1,'location','building_11'

Manual operation: See "Key" on page 308
See "Value" on page 308
See "Add" on page 309

SYSTem:COMMunicate:REST:ENABle <RestState>

Turns communication via the REST API on and off.

Parameters:
<RestState> ON | OFF | 0 | 1

Example: //Return REST state
SYST:COMM:REST:ENAB?

Manual operation: See "REST" on page 302

SYSTem:COMMunicate:SNMP:COMMunity:RO <CommunityString>

Defines the SNMP community string for read-only access.
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Prerequisites for this command:
● Select an SNMP version that supports communities (SYSTem:COMMunicate:

SNMP:VERSion on page 372).

Setting parameters: 
<CommunityString> String containing the community name.

Example: //Set community name
SYST:COMM:SNMP:VERS V12
SYST:COMM:SNMP:COMM:RO 'ABC'

Usage: Setting only

Manual operation: See "Access" on page 302

SYSTem:COMMunicate:SNMP:COMMunity:RW <CommunityString>

Defines the SNMP community string for read-write access.

Prerequisites for this command:
● Select an SNMP version that supports communities (SYSTem:COMMunicate:

SNMP:VERSion on page 372).

Setting parameters: 
<CommunityString> String containing the community name.

Example: //Set read-write access
SYST:COMM:SNMP:VERS V12
SYST:COMM:SNMP:COMM:RW 'ABC'

Usage: Setting only

Manual operation: See "Access" on page 302

SYSTem:COMMunicate:SNMP:CONTact <SnmpContact>

Defines the SNMP contact information for the administrator.

You can also set the contact information via SNMP if you do not set it via SCPI.

Parameters for setting and query: 
<SnmpContact> String containing SNMP contact.

*RST: "" (empty string)

Example: //Set SNMP contact
SYST:COMM:SNMP:CONT 'ABC'

Manual operation: See "Contact" on page 302

SYSTem:COMMunicate:SNMP:LOCation <SnmpLocation>

Defines the SNMP location information for the administrator.

You can also set the location information via SNMP if you do not set it via SCPI.
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Parameters for setting and query: 
<SnmpLocation> String containing SNMP location.

*RST: "" (empty string)

Example: //Return SNMP location
SYST:COMM:SNMP:LOC?

Manual operation: See "Location" on page 302

SYSTem:COMMunicate:SNMP:USM:USER <Name>, <Access>, <Level>[,
<Auth_pwd>[, <Priv_pwd>]]

Defines an SNMP user profile.

Prerequisites for this command:
● Select SNMPv3 (SYSTem:COMMunicate:SNMP:VERSion on page 372).

Setting parameters: 
<Name> String containing name of the user.

<Access> RO | RW
Defines the access right a user can have.

<Level> NOAuth | AUTH | PRIVacy
Defines the security level.

<Auth_pwd> String containing the authentication password.

<Priv_pwd> String containing the privacy password.

Example: //Create user profile
SYST:COMM:SNMP:VERS V123
SYST:COMM:SNMP:USM:USER 'Peter','RO','PRIV',
'1234','XYZ'

Usage: Setting only

Manual operation: See "Add SNMP User for HUMS" on page 305

SYSTem:COMMunicate:SNMP:USM:USER:ALL?

Queries the number of users and a list of all SNMP users for SNMPv3.

Prerequisites for this command:
● Select SNMPv3 (SYSTem:COMMunicate:SNMP:VERSion on page 372).

Return values: 
<Count> Total number of registered SNMP users.

<Name> List of all user names as a comma-separated list.

Example: //Return all SNMP users
SYST:COMM:SNMP:USM:USER:ALL?

Usage: Query only
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Manual operation: See "User table" on page 304

SYSTem:COMMunicate:SNMP:USM:USER:DELete <UserName>

Deletes a specific SNMP user profile.

Setting parameters: 
<UserName> String containing name of SNMP user profile to be deleted.

Example: //Delete SNMP user profile
SYST:COMM:SNMP:USM:USER:DEL "Peter"

Usage: Setting only

Manual operation: See "Delete" on page 305

SYSTem:COMMunicate:SNMP:USM:USER:DELete:ALL

Deletes all SNMP user profiles.

Example: //Delete all SNMP user profiles
SYST:COMM:SNMP:USM:USER:DEL:ALL

Usage: Event

Manual operation: See "Delete All" on page 304

SYSTem:COMMunicate:SNMP:VERSion <SnmpVersion>

Selects the SNMP version.

Parameters for setting and query: 
<SnmpVersion> OFF | V12 | V123 | V3 | DEFault

OFF
SNMP communication is off.
V12
SNMP communication with SNMPv2 or lower.
V123
SNMP communication with SNMPv2 and SNMPv3.
V3
SNMP communication with SNMPv3.
*RST: V123

Example: //Select the SNMP version
SYST:COMM:SNMP:VERS V12

Manual operation: See "SNMP" on page 302
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12.7  DISPlay subsystem

The DISPlay system contains the commands to set the power-save mode of the
instrument.

Programming Examples

Example: Activating screen saver mode and display update
Use the following commands to switch on the screen saver of your instrument or to
automatic display. These settings are particularly useful when you control the instru-
ment remotely.

// Set the wait time interval and activate the screen saver
DISPlay:PSAVe:HOLDoff 10
DISPlay:PSAVe:STATe ON

// Disable the display of the current frequency and level values in remote control
DISPlay:ANNotation:ALL ON
// DISPlay:ANNotation:FREQuency ON
// DISPlay:ANNotation:AMPLitude ON

// Enable automatic update of the display at defined time intervals
DISPlay:UPDate[:STATe] ON

Example: Querying the dialog IDs, opening and closing dialogs
Use the following commands to query the dialog IDs of all currently open dialogs. The
dialog ID is a prerequisite for opening and closing dialogs via the remote control.

The dialog ID is also required to define user key actions.
See Chapter 10.3.4, "How to assign actions to the [User] key", on page 240.

// Query the dialog IDs of all open dialogs
DISPlay:DIALog:ID?
// CEUtraDLGenSetDlg,_,$A DlgKeyRf_Rosc

// Open and close dialogs via remote control
DISPlay:DIALog:OPEN "CEUtraDLGenSetDlg,_,$A"
DISPlay:DIALog:OPEN "DlgKeyRf_Rosc"
DISPlay:DIALog:CLOSe "DlgKeyRf_Rosc"
DISPlay:DIALog:CLOSe:ALL 

:DISPlay:PSAVe:HOLDoff............................................................................................... 374
:DISPlay:PSAVe[:STATe].................................................................................................374
:DISPlay:BRIGhtness..................................................................................................... 374
:DISPlay:BUTTon:BRIGhtness.........................................................................................375
:DISPlay:UPDate[:STATe]............................................................................................... 375
:DISPlay:ANNotation:AMPLitude..................................................................................... 375
:DISPlay:ANNotation:FREQuency....................................................................................375
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:DISPlay:ANNotation[:ALL]..............................................................................................376
:DISPlay:DIALog:ID?......................................................................................................376
:DISPlay:DIALog:OPEN..................................................................................................377
:DISPlay:DIALog:CLOSe................................................................................................ 377
:DISPlay:DIALog:CLOSe:ALL..........................................................................................377

:DISPlay:PSAVe:HOLDoff <HoldoffTimeMin>

Sets the wait time for the screen saver mode of the display.

Parameters:
<HoldoffTimeMin> integer

Range: 1  to  60
*RST: n.a. (factory preset: 10)
Default unit: minute

Example: see Example"Activating screen saver mode and display update"
on page 373

Manual operation: See "Wait Time" on page 232

:DISPlay:PSAVe[:STATe] <State>

Activates the screen saver mode of the display.

We recommend that you use this mode to protect the display, if you operate the instru-
ment in remote control.

To define the wait time, use the command :DISPlay:PSAVe:HOLDoff.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example"Activating screen saver mode and display update"
on page 373

Manual operation: See "Screen Saver" on page 232

:DISPlay:BRIGhtness <BRIGhtness>

Sets the brightness of the dispaly.

Parameters:
<BRIGhtness> float

Range: 1.0  to  20.0
Increment: 1.0
*RST: 14.0

Example: DISPlay:BRIGhtness 14

Manual operation: See "Display" on page 233
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:DISPlay:BUTTon:BRIGhtness <ButtonBrightnes>

Sets the brightness of the [RF On/Off] key.

Parameters:
<ButtonBrightnes> integer

Range: 1  to  20
*RST: n.a. (no preset. default: 14)

Example: DISPlay:BUTTon:BRIGhtness 15

Manual operation: See "RF Hardkey" on page 233

:DISPlay:UPDate[:STATe] <Update>

Activates the refresh mode of the display.

Parameters:
<Update> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example"Activating screen saver mode and display update"
on page 373

Manual operation: See "Display Update is" on page 233

:DISPlay:ANNotation:AMPLitude <State>

Indicates asterisks instead of the level values in the status bar.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example"Activating screen saver mode and display update"
on page 373

Manual operation: See "Annotation Amplitude" on page 255

:DISPlay:ANNotation:FREQuency <State>

Indicates asterisks instead of the frequency values in the status bar.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example"Activating screen saver mode and display update"
on page 373

Manual operation: See "Annotation Frequency" on page 255
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:DISPlay:ANNotation[:ALL] <State>

Displays asterisks instead of the level and frequency values in the status bar of the
instrument.

We recommend that you use this mode if you operate the instrument in remote control.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Activating screen saver mode and display update"
on page 373

:DISPlay:DIALog:ID?

Returns the dialog identifiers of the open dialogs in a string separated by blanks.

Return values: 
<DialogIdList> <DialogID#1>< ><DialogID#2>< > ... < ><DialogID#n>

Dialog identifiers are string without blanks. Blanks are represen-
ted as $$.
Dialog identifiers <DialogID> are composed of two main parts:
<DialogName>[<OptionalParts>]
<DialogName>
Meaningful information, mandatory input parameter for the com-
mands:
:DISPlay:DIALog:OPEN on page 377
:DISPlay:DIALog:CLOSe on page 377
<Optional parts>
String of $<X> values, where <X> is a character, interpreted as
follows:
$q<DialogQualifier>: optional dialog qualifier, usually the
letter A or B, as displayed in the dialog title.
$i<Instances>: comma-separated list of instance indexes,
given in the order h,c,s,d,g,u,0. Default is zero; the termi-
nating ",0" can be omitted.
$t<TabIds>: comma-separated indexes or tab names;
required, if a dialog is composed of several tabs.
$x<Left>$y<Top>$h<Left>$w<Top>: position and size;
superfluous information.

Example: See Example"Querying the dialog IDs, opening and closing dia-
logs" on page 373

Usage: Query only

Manual operation: See "SCPI" on page 240
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:DISPlay:DIALog:OPEN <DialogId>

Opens the specified dialog.

Setting parameters: 
<DialogId> string

To find out the dialog identifier, use the query :DISPlay:
DIALog:ID?.
The <DialogName> part of the query result is mandatory.

Example: See Example"Querying the dialog IDs, opening and closing dia-
logs" on page 373

Usage: Setting only

Manual operation: See "SCPI" on page 240

:DISPlay:DIALog:CLOSe <DialogId>

Closes the specified dialog.

Setting parameters: 
<DialogId> string

To find out the dialog identifier, use the query :DISPlay:
DIALog:ID?.
The <DialogName> part of the query result is sufficient.

Example: See Example"Querying the dialog IDs, opening and closing dia-
logs" on page 373

Usage: Setting only

:DISPlay:DIALog:CLOSe:ALL

Closes all open dialogs.

Example: See Example"Querying the dialog IDs, opening and closing dia-
logs" on page 373

Usage: Event

12.8  FORMat subsystem

The commands in the FORMat subsystem determine the format of data returned by the
R&S AREG800A to the controller. This affects all query commands that return a list of
numerical data or block data, noted in the descriptions of the commands. The set data
format applies to both paths.

:FORMat:BORDer..........................................................................................................378
:FORMat:SREGister.......................................................................................................378
:FORMat[:DATA]............................................................................................................ 378
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:FORMat:BORDer <Border>

Determines the sequence of bytes within a binary block. This only affects blocks which
use the IEEE754 format internally.

Parameters:
<Border> NORMal | SWAPped

NORMal
Expects/sends the least significant byte of each IEEE754 float-
ing-point number first and the most significant byte last.
SWAPped
Expects/sends the most significant byte of each IEEE754 float-
ing-point number first and the least significant byte last.
*RST: NORMal

Example: :FORM:BORD SWAP
transfers the data with the most significant bit first.

:FORMat:SREGister <Format>

Determines the numeric format for responses of the status register.

Parameters:
<Format> ASCii | BINary | HEXadecimal | OCTal

ASCii
Returns the register content as a decimal number.
BINary|HEXadecimal|OCTal
Returns the register content either as a binary, hexadecimal or
octal number. According to the selected format, the number
starts with #B (binary), #H (hexadecimal) or #O (octal).
*RST: ASCii

Example: :FORM:SREG HEX
returns the register content as a hexadecimal number.

:FORMat[:DATA] <Data>

Determines the data format the instrument uses to return data via the IEC/IEEE bus.

The instrument automatically detects the data format used by the controller, and
assigns it accordingly. Data format determined by this SCPI command is in this case
irrelevant.

Parameters:
<Data> ASCii | PACKed

ASCii
Transfers numerical data as plain text separated by commas.
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PACKed
Transfers numerical data as binary block data.
The format within the binary data depends on the command.
The various binary data formats are explained in the description
of the parameter types.
*RST: ASCii

Example: :FORM ASC
transfers the data as ASCII data.

12.9  HCOPy subsystem

The HCOPy subsystem contains the commands to generate and save a hard copy of
the display.

To access a stored hard copy file, use the commands of the MEMM subsystem.

Example: Store a hard copy of the display
The following example lists commands to configure and execute a hard copy to an
automatic named file.

:HCOPy:DEVice:LANGuage PNG
:HCOPy:FILE:NAME:AUTO:STATe 1
// defines the output format
// sets the instrument to automatically create output file names

// ******************************************************************
// Configure hard copy options, set automatic naming rules
// An automatically generated file name consists of:
// <Prefix><YYYY><MM><DD><Number>.<Format>
// ******************************************************************
:HCOPy:DEVice:LANGuage BMP
// defines output format *.bmp
:HCOPy:REGion DIALog    
// selects the region to be copied
:HCOPy:FILE:AUTO:DIR "/usb/HCopy" 
// sets destination directory of automatic named file
:HCOPy:FILE:NAME:AUTO:FILE:PREFix:STATe 1
:HCOPy:FILE:NAME:AUTO:FILE:PREFix:"hardcopy"
:HCOPy:FILE:NAME:AUTO:FILE:YEAR:STATe 1
:HCOPy:FILE:NAME:AUTO:FILE:MONTh:STATe 1
// uses automatic naming prefix
// sets automatic naming prefix to "hardcopy"
// uses automatic naming date parameters year and month

// ******************************************************************
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// Execute and transfer the hard copy
// ******************************************************************
:HCOPy:EXECute
:HCOPy:DATA 
// generates a hard copy
// transfers the hard copy to the remote client
:HCOPy:FILE:AUTO:FILE? 
// queries the automatic file name
// "hardcopy1607001.bmp"  
:HCOPy:FILE:AUTO:NUMBer? 
// queries the number in the automatic file name
// "001"  
:HCOPy:FILE:AUTO? 
// queries the path and file name of the automatically generated file
// "/usb/HCopy/hardcopy1607001.bmp"  

12.9.1  Hard copy settings

With the following commands, you can configure the settings of a hard copy.

:HCOPy:DATA?..............................................................................................................380
:HCOPy:IMAGe:FORMat................................................................................................ 380
:HCOPy:DEVice:LANGuage............................................................................................380
:HCOPy:REGion............................................................................................................ 381
:HCOPy:FILE[:NAME].....................................................................................................381
:HCOPy[:EXECute]........................................................................................................ 381

:HCOPy:DATA?

Transfers the hard copy data directly as a NByte stream to the remote client.

Return values: 
<Data> block data

Example: See Example"Store a hard copy of the display" on page 379

Usage: Query only

:HCOPy:IMAGe:FORMat <Format>
:HCOPy:DEVice:LANGuage <Language>
Selects the graphic format for the hard copy. You can use both commands alterna-
tively.

Parameters:
<Language> BMP | JPG | XPM | PNG

*RST: PNG

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "Format" on page 228
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:HCOPy:REGion <Region>

Selects the area to be copied.

You can create a snapshot of the screen or an active dialog.

Parameters:
<Region> ALL | DIALog

*RST: ALL

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "Region" on page 228

:HCOPy:FILE[:NAME] <Name>

Determines the file name and path to save the hard copy, provided automatic naming
is disabled.

Note: If you have enabled automatic naming, the instrument automatically generates
the file name and directory, see Chapter 12.9.2, "Automatic naming", on page 381.

Parameters:
<Name> string

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "File..." on page 227

:HCOPy[:EXECute]

Generates a hard copy of the current display. The output destination is a file.

Example: See Example"Store a hard copy of the display" on page 379

Usage: Event

Manual operation: See "Save" on page 228

12.9.2  Automatic naming

Use the following commands to automatically assign a file name.

:HCOPy:FILE[:NAME]:AUTO?.........................................................................................382
:HCOPy:FILE[:NAME]:AUTO:DIRectory........................................................................... 382
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar................................................................. 382
:HCOPy:FILE[:NAME]:AUTO:FILE?................................................................................. 382
:HCOPy:FILE[:NAME]:AUTO:STATe.................................................................................383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe................................................................383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe...........................................................383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe............................................................. 383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?.................................................................. 383
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix..................................................................... 384
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe........................................................... 384
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:HCOPy:FILE[:NAME]:AUTO?

Queries path and file name of the hardcopy file, if you have enabled Automatic Nam-
ing.

Return values: 
<Auto> string

Example: See Example"Store a hard copy of the display" on page 379

Usage: Query only

:HCOPy:FILE[:NAME]:AUTO:DIRectory <Directory>

Determines the path to save the hard copy, if you have enabled Automatic Naming.

If the directory does not yet exist, the instrument automatically creates a new directory,
using the instrument name and /var/user/ by default.

Parameters:
<Directory> string

*RST: /var/user/

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "Path..." on page 228

:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar

Deletes all files with extensions *.bmp, *.jpg, *.png and *.xpm in the directory set
for automatic naming.

Example: See Example"Store a hard copy of the display" on page 379

Usage: Event

Manual operation: See "Clear Path" on page 229

:HCOPy:FILE[:NAME]:AUTO:FILE?

Queries the name of the automatically named hard copy file.

An automatically generated file name consists of:

<Prefix><YYYY><MM><DD><Number>.<Format>.

You can activate each component separately, to individually design the file name.

Return values: 
<File> string

Example: See Example"Store a hard copy of the display" on page 379.

Usage: Query only
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:HCOPy:FILE[:NAME]:AUTO:STATe <State>

Activates automatic naming of the hard copy files.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "Automatic Naming" on page 228

:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe <State>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe <State>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe <State>
Uses the date parameters (year, month or day) for the automatic naming. You can acti-
vate each of the date parameters separately.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "Prefix, Year, Month, Day" on page 229

:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?

Queries the number that is used as part of the file name for the next hard copy in auto-
matic mode.

At the beginning, the count starts at 0. The R&S AREG800A searches the specified
output directory for the highest number in the stored files. It increases this number by
one to achieve a unique name for the new file.

The resulting auto number is appended to the resulting file name with at least three
digits.

Return values: 
<Number> integer

Range: 0  to  999999
*RST: 0

Example: See Example"Store a hard copy of the display" on page 379

Usage: Query only

Manual operation: See "Current Auto Number" on page 229

HCOPy subsystem



Remote control commandsR&S®AREG800A

384User Manual 1179.3615.02 ─ 06

:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix <Prefix>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe <State>
Uses the prefix for the automatic generation of the file name, provided PREF:STAT is
activated.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Store a hard copy of the display" on page 379

Manual operation: See "Prefix, Year, Month, Day" on page 229

12.10  KBOard subsystem

The KBOard subsystem contains the commands to set a connected keyboard.

:KBOard:LAYout.............................................................................................................384

:KBOard:LAYout <Layout>

Selects the language for an external keyboard and assigns the keys acccordingly.

Parameters:
<Layout> CHINese | DANish | DUTCh | DUTBe | ENGLish | ENGUK |

FINNish | FRENch | FREBe | FRECa | GERMan | ITALian |
JAPanese | KORean | NORWegian | PORTuguese | RUSSian |
SPANish | SWEDish | ENGUS
*RST: n.a. (factory preset: ENGLish)

Example: :KBOard:LAYout US
// activates American keyboard

Manual operation: See "USB Keyboard > Layout" on page 233

12.11  MMEMory subsystem

The MMEMory subsystem (Mass MEMory) contains the commands for managing files
and directories as well as for loading and saving complete instrument settings in files.

Mass storage location

Both, the user directory /var/user/ on the internal memory or the /usb/ directory
on the memory stick, can be used to preserve user-defined data. Any directory struc-
ture can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.
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Default storage location

The R&S AREG800A stores user data in the user directory.

In the file system, user directory is always indicated as /var/user/.

In manual control, you access this directory via the "File Manager", see Chapter 9.6,
"Using the file manager", on page 214. In remote control, you can query it with the
command :SYSTem:MMEMory:PATH:USER?.

To query and change the default directory used for mass storage, use the command :
MMEMory:CDIRectory.

12.11.1  File naming conventions

To enable files to be used in different file systems, consider the following file naming
conventions:
● The filename can be of any length and is case-sensitive, i.e it is distinguished

between uppercase and lowercase letters.
● All letters and numbers are permitted (numbers are, however, not permitted at the

beginning of the filename).
● Avoid using special characters.
● Do not use slashes "\" and "/". These symbols are used in file paths.
● Avoid using the following filenames: CLOCK$, CON, COM1 to COM4,

LPT1 to LPT3, NUL or PRN
They are reserved by the operating system.

Wildcards

The two characters "*" and "?" function as "wildcards", i.e. they are used for selecting
several files. The "?" character represents exactly one character, while the "*" charac-
ter represents all characters up to the end of the filename. "*.*" therefore represents all
files in a directory.

Filename and file path

When used in remote control commands, the parameter <filename> is specified as a
string parameter with quotation marks. It can contain either the complete path including
the root user directory /var/user and filename, or only the filename. The filename
must include the file extension. The same applies for the directory /var/volatile
and for the parameters <directory_name> and <path>.

Depending on how much information is provided, the values specified in the parameter
or with the command MMEM:CDIR are used for the path and drive setting in the com-
mands.
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12.11.2  Accessing files in the default or in a specified directory

For better overview and easy file handling, you may not save all user files in the user
directory /var/user but rater organize them into subdirectories.

The command syntax defines two general ways to access files with user data in a spe-
cific directory:
● Change the current default directory for mass memory storage and then directly

access the files in this default directory, like saved list files, files with user data or
save/recall files.
The subsequent commands for file handling (select, delete, read out files in the
directory, etc.) require only specification of the filename. File extension can be
omitted; after syntax evaluation of the used command, the R&S AREG800A filters
out the relevant files.

● Define the complete file path, including the user directory /var/user, created
subdirectories and filename (see Example"Load file with user data from a specific
directory" on page 386).
As a rule, whenever an complete file path is determined, it overwrites a previously
specified default directory.

The following example explains this rule as a principle. Exceptions of this general rule
are stated in the description of the corresponding command. The Chapter 12.11.3,
"Programming examples", on page 387 explains the general working principle with the
commands for mass memory storage.

The same rule applies to the /var/volatile directory, see Example"Working with
files in the volatile memory" on page 388.

Example: Load file with user data from a specific directory
This example shows the principle of file handling in remote environment by using list
commands. Working with the files of other subsystems is analogical. We assume that
the directory /var/user/my_files is existing and contains the files
list_test.lsw and list_2.lsw.

//Query files in the user diectory
SOURce1:LIST:CATalog?
// -
// no files

// Set the default directory
MMEMory:CDIRectory "/var/user/my_files"
SOURce1:LIST:CATalog?
// "list_test","list_2"

// Specify the complete path to select a list file (*.lsw) 
// in the specific directory
SOURce1:LIST:SELect "/var/user/my_files/list_test"
SOURce1:LIST:DELete "/var/user/my_files/list_2"
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12.11.3  Programming examples

Example: Saving and loading current settings
This example shows two ways of how to save the current instrument setting in the file
settings.savrcltxt in the directory /var/user/savrcl.

Before the instrument settings can be saved in a file, they have to be saved in an inter-
mediate memory using common command *SAV <number>. The specified number is
then used in the :MMEMory:STORe:STATe command.
Also, after loading a file with instrument settings with command :MMEMory:LOAD:
STATe, these settings have to be activated with the common command *RCL
<number>.

// Save the current settings in an intermediate memory with number 4
*SAV 4

// save the settings in a file in a specific directory;
// the complete path has to be specyfied
MMEMory:STORe:STATe 4,"/var/user/savrcl/settings.savrcltxt"

// save the settings in a file in the default directory;
// set the default directory; specify only the file name
MMEMory:CDIRectory  "/var/user/savrcl"
*SAV 4
MMEMory:STORe:STATe 4,"settings.savrcltxt"

// Load the saved settings in the intermediate memory 4 and activate them
MMEMory:LOAD:STATe 4,"/var/user/settings.savrcltxt"
*RCL 4

Example: Working with files and directories
This example shows how to list files in a directory, list the subdirectories, query the
number of files in a directory, create directory, rename and delete files.

// Query the current default directory for mass storage,
// change the directory to the default user directory "/var/user"
// and read out the files in it
MMEMory:CDIRectory?
// "/var/user/temp"
MMEMory:CDIRectory
MMEMory:CDIRectory?
// "/var/user/"
MMEMory:CATalog?
// 1282630,8102817792,".,DIR,4096","..,DIR,4096","Log,DIR,4096",
// "settings.savrcltxt,BIN,16949","temp,DIR,4096","test,DIR,4096",
// "list.lsw,BIN,1245201"
// the directory "/var/user" contains the predefined directory "Log",
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// the subdirectories "test" and "temp"
// as well as the files "settings.savrcltxt" and "list.lsw"

// query only the subdirectories of the current or specified directory
MMEMory:DCATalog? "/var/user"
// ".","..","Log","temp","test"

// query only number of subdirectories in the current or specified directory
MMEMory:DCATalog:LENGth? "/var/user"
// 5

// query number of files in the current or specified directory
MMEMory:CATalog:LENGth? "/var/user"
// 7

// Create a new directory for mass memory storage in the specified directory
MMEMory:MDIRectory "/var/user/new"

// Copy the file "settings.savrcltxt" into the new directory
MMEMory:COPY "/var/user/settings.savrcltxt","/var/user/new/settings.savrcltxt"

// Rename the file "settings.savrcltxt" into the new directory
// and read out the files in this specific directory
MMEMory:CDIRectory  "/var/user/new"
MMEMory:MOVE "settings.savrcltxt","settings_new.savrcltxt"
MMEMory:CATalog? "/var/user/new"
// 25141,8102789120,".,DIR,4096","..,DIR,4096","settings_new.savrcltxt,BIN,16949"

// Delete an empty directory, e.g. the "test" directory 
MMEMory:RDIRectory "/var/user/test"
// Delete the entire directory, including files and subdirectories 
:MMEMory:RDIRectory:RECursive "var/user/test"

Example: Working with files in the volatile memory
This example shows how to work with files in the /var/volatile directory.

// Change the default directory for mass storage,
// read out the files, load and play a file with the ARB 
MMEMory:CDIRectory "/var/volatile"
MMEMory:CDIRectory?
// "/var/volatile"
MMEMory:CATalog?
//13928,525352960,".,DIR,60","..,DIR,4096","list.lst,BIN,9772"

SOURce1:LIST:SELect "/var/volatile/list"
SOURce1:FREQuency:MODE LIST
OUTPut1:STATe 1
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12.11.4  Remote control commands

:MMEMory:CATalog?......................................................................................................389
:MMEMory:CATalog:LENGth?......................................................................................... 389
:MMEMory:CDIRectory...................................................................................................390
:MMEMory:COPY...........................................................................................................390
:MMEMory:DATA............................................................................................................391
:MMEMory:DCATalog?....................................................................................................391
:MMEMory:DCATalog:LENGth?....................................................................................... 392
:MMEMory:DELete.........................................................................................................392
:MMEMory:LOAD:STATe.................................................................................................392
:MMEMory:MDIRectory...................................................................................................392
:MMEMory:MOVE.......................................................................................................... 393
:MMEMory:MSIS............................................................................................................393
:MMEMory:RDIRectory...................................................................................................393
:MMEMory:RDIRectory:RECursive...................................................................................394
:MMEMory:STORe:STATe...............................................................................................394
:MEMory:HFRee?.......................................................................................................... 394

:MMEMory:CATalog? <path>

Returns the content of a particular directory.

Query parameters: 
<path> string

String parameter to specify the directory.
If you leave out the path, the command returns the contents of
the directory selected with :MMEMory:CDIRectory.
The path may be relative or absolute.

Return values: 
<UsedDiskSpace> Byte size of all files in the directory.

<FreeDiskSpace> Remaining disk space in bytes.

<FileInfo> <NameFileN>,<SuffixFileN>,<SizeFileN>
List of files, separated by commas
<NameFileN>
Name of the file.
<SuffixFileN>
Type of the file. Possible suffixes are: ASCii, BINary, DIRectory
<SizeFileN>
Size of the file in bytes.

Usage: Query only

Manual operation: See "Directory, File List and Filename" on page 211

:MMEMory:CATalog:LENGth? <Path>

Returns the number of files in the current or in the specified directory.
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Query parameters: 
<Path> string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<FileCount> integer

Number of files.

Usage: Query only

:MMEMory:CDIRectory <Directory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them.

Parameters:
<Directory> <directory_name>

String containing the path to another directory. The path can be
relative or absolute.
To change to a higher directory, use two dots '..' .

Usage: SCPI confirmed

Manual operation: See "Directory, File List and Filename" on page 211
See "Directory and Filename" on page 216

:MMEMory:COPY <SourceFile>[,<DestinationFile>]

Copies an existing file to a new file. Instead of just a file, this command can also be
used to copy a complete directory together with all its files.

Setting parameters: 
<SourceFile> string

String containing the path and file name of the source file

<DestinationFile> string
String containing the path and name of the target file. The path
can be relative or absolute.
If <DestinationFile> is not specified, the <SourceFile> is
copied to the current directory, queried with the :MMEMory:
CDIRectory command.
Note: Existing files with the same name in the destination direc-
tory are overwritten without an error message.

Usage: Setting only
SCPI confirmed

Manual operation: See "Cut, Copy&Paste and Delete" on page 216
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:MMEMory:DATA <Filename>, <BinaryBlock>
:MMEMory:DATA? <Filename>

The setting command writes the block data <BinaryBlock> to the file identified by
<Filename>.

Tip: Use this command to read/transfer stored instrument settings or waveforms
directly from/to the instrument.

Parameters:
<BinaryBlock> #<number><length_entry><data>

#: Hash sign; always comes first in the binary block
<number>: the first digit indicates how many digits the subse-
quent length entry has
<length_entry>: indicates the number of subsequent bytes
<data>: binary block data for the specified length.
For files with a size with more than nine digits (gigabytes), the
instrument allows the syntax #(<Length>), where <Length>
is the file size in decimal format.

Parameters for setting and query: 
<Filename> string

String parameter to specify the name of the file.

Example: MMEMory:DATA '/var/user/test.txt',#15hallo
Writes the block data to the file test.txt.
The digit 1 indicates a length entry of one digit; the digit 5 indi-
cate a length of the binary data (hallo) in bytes.
MMEMory:DATA? '/var/user/test.txt'
Sends the data of the file test.txt from the instrument to the
controller in the form of a binary block.
Response: #15hallo

Usage: SCPI confirmed

:MMEMory:DCATalog? <path>

Returns the subdirectories of a particular directory.

Query parameters: 
<path> String parameter to specify the directory. If the directory is omit-

ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<Catalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Usage: Query only
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:MMEMory:DCATalog:LENGth? [<Path>]

Returns the number of subdirectories in the current or specified directory.

Query parameters: 
<Path> String parameter to specify the directory. If the directory is omit-

ted, the command queries the contents of the current directory,
to be queried with :MMEMory:CDIRectory command.

Return values: 
<DirectoryCount> integer

Number of parent and subdirectories.

Usage: Query only

:MMEMory:DELete <Filename>

Removes a file from the specified directory.

Setting parameters: 
<Filename> string

String parameter to specify the name and directory of the file to
be removed.

Usage: Event
SCPI confirmed

Manual operation: See "Cut, Copy&Paste and Delete" on page 216

:MMEMory:LOAD:STATe <SavRclStateNumb>, <file_name>

Loads the specified file stored under the specified name in an internal memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.

Setting parameters: 
<SavRclStateNumb> Determines to the specific <number> to be used with the *RCL

command, e.g. *RCL 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Setting only

Manual operation: See "Recall" on page 212

:MMEMory:MDIRectory <Directory>

Creates a subdirectory for mass memory storage in the specified directory. If no direc-
tory is specified, a subdirectory is created in the default directory. This command can
also be used to create a directory tree.
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Setting parameters: 
<Directory> string

String parameter to specify the new directory.

Usage: Event

Manual operation: See "Create New Directory" on page 216

:MMEMory:MOVE <SourceFile>, <DestinationFile>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

Setting parameters: 
<SourceFile> string

String parameter to specify the name of the file to be moved.

<DestinationFile> string
String parameters to specify the name of the new file.

Usage: Event
SCPI confirmed

Manual operation: See "Rename" on page 216

:MMEMory:MSIS <Msis>

Defines the drive or network resource (in the case of networks) for instruments with
windows operating system, using msis (MSIS = Mass Storage Identification String).

Note: Instruments with Linux operating system ignore this command, since Linux does
not use drive letter assignment.

Usage: SCPI confirmed

:MMEMory:RDIRectory <Directory>

Removes an empty directory from the mass memory storage system. If no directory is
specified, the subdirectory with the specified name is deleted in the default directory.

To remove a directory with contents, use command :MMEMory:RDIRectory:
RECursive on page 394.

Setting parameters: 
<Directory> string

String parameter to specify the directory to be deleted.

Example: See Example"Working with files and directories" on page 387.

Usage: Event
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:MMEMory:RDIRectory:RECursive <Directory>

Removes the specified directory, including files and subdirectories from the mass
memory storage system. If no directory is specified, the command removes the subdir-
ectories of the default directory.

The command the entire directory without further prompt or notification.

Setting parameters: 
<Directory> string

String parameter to specify the directory to be deleted.

Example: See Example"Working with files and directories" on page 387.

Usage: Setting only

:MMEMory:STORe:STATe <savrcl_state_nr>, <file_name>

Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same num-
ber using the common command *SAV.

Setting parameters: 
<savrcl_state_nr> Corresponds to the specific <number> defined with the *SAV

command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Event

Manual operation: See "Save" on page 212

:MEMory:HFRee?

Returns the used and available memory in Kb.

Return values: 
<TotalPhysMemKb> integer

Total physical memory.

<ApplicMemKb> integer
Application memory.

<HeapUsedKb> integer
Used heap memory.

<HeapAvailableKb> integer
Available heap memory.

Usage: Query only
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12.12  SYSTem subsystem

The SYSTem subsystem contains a series of commands for general functions which do
not directly affect signal generation.

Example: Retrieving instrument specification
Note: The following values are merely an example.
// Retrieve information on data sheet versions.
// Query all data sheet versions saved on the instrument:
SYSTem:SPECification:VERSion:CATalog?
"04.03,04.02,04.01,04.00,03.04,03.03,03.02,03.01,03.00,02.96,02.95,02.94,
02.02,02.01,02.00,01.03,01.02,01.01,01.00"

// Query the initial data sheet version on delivery
SYSTem:SPECification:VERSion:FACTory?
// Response: "04.00"

// Select a specific data sheet version:
SYSTem:SPECification:VERSion "04.01"

// Retrieve information on parameters that belong to a particular data sheet.
// Query the IDs of all parameters listed in the selected version:
SYSTem:SPECification:VERSion "04.03"
SYSTem:SPECification:IDENtification:CATalog?
"ID_RF_FREQ_SETTING_TIME_ALC_ON_MS,ID_RF_FREQ_SETTING_TIME_MS,..."

// Query data sheet information on a specific parameter by its ID.
SYSTem:SPECification? "ID_RF_FREQ_SETTING_TIME_ALC_ON_MS"
// Returns the specified value of the parameter.

Example: Retrieving information on network-related settings
SYSTem:COMMunicate:NETWork:STATus?
// 1
SYSTem:PROTection1:STATe 0,123456

SYSTem:COMMunicate:NETWork:IPADdress:MODE STAT
SYSTem:COMMunicate:NETWork:IPADdress "10.113.0.104"
SYSTem:COMMunicate:NETWork:IPADdress:DNS "10.0.2.166"
SYSTem:COMMunicate:NETWork:COMMon:HOSTname?
// "AREG800A-102030"
SYSTem:COMMunicate:NETWork:COMMon:WORKgroup "instrument"
SYSTem:COMMunicate:NETWork:COMMon:DOMain "rsint.net"
SYSTem:COMMunicate:NETWork:IPADdress:GATeway "10.113.0.1"
SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:MASK "255.255.252.0"
SYSTem:COMMunicate:NETWork:MACaddress "08 00 27 a3 a1 70"
SYSTem:PROTection1:STATe 1
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Example: Restarting the network
SYSTem:COMMunicate:NETWork:RESTart
// terminates the network connection and sets it up again

Example: Finding out VISA resource strings
SYSTem:COMMunicate:NETWork:RESource?
// Response: "TCPIP::10.113.0.104::inst0::INSTR"

SYSTem:COMMunicate:HISLip:RESource?
// Response: "TCPIP::10.113.0.104::hislip0::INSTR"

SYSTem:COMMunicate:SOCKet:RESource?
// Response: "TCPIP::10.113.0.104::5025::SOCKET"

SYSTem:COMMunicate:USB:RESource?
// "USB::0x0AAD::0x01e1::100001::INSTR"

SYSTem:COMMunicate:GPIB:RESource?
// Response: "GPIB::28::INSTR"
SYSTem:COMMunicate:GPIB:SELF:ADDRess?
// Response: 28
SYSTem:COMMunicate:GPIB:LTERminator?
// Response: STAN

SYSTem:COMMunicate:SERial:RESource?
// Response: "ASRL1::INSTR"
SYSTem:COMMunicate:SERial:SBITs?
// Response: 1
SYSTem:COMMunicate:SERial:BAUD?
// Response: 115200
SYSTem:COMMunicate:SERial:PARity?
// Response: NONE

Disabling LAN services

► NOTICE! Risk of loosing access over LAN. Disabling the LAN interface or the com-
mon services "LAN", "SCPI over LAN", "VNC" and "HTTP" locks the remote access
to the instrument.
Use the commands in Example"To disable the LAN interface and LAN services"
on page 397 to disable or enable the LAN interface and LAN interface services
individually.

a) For the first parameter of the command, enter the security password of your
instrument.
The default password is 123456.

b) For the second parameter of the command, enter the state: 1 (ON), 0 (OFF)
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Example: To disable the LAN interface and LAN services
// *****************************************************************************
// Disable the LAN interface.
// *****************************************************************************
SYSTem:SECurity:NETWork:STATe "<password>", 0

// *****************************************************************************
// Disable the LAN services individually.
// *****************************************************************************
SYSTem:SECurity:NETWork:RAW:STATe "<password>", 0
// Disables remote access over raw socket. 
SYSTem:SECurity:NETWork:SOE:STATe "<password>", 0
// Disables SCPI over Ethernet/LAN communication.
SYSTem:SECurity:NETWork:VNC:STATe "<password>", 0
// Disables remote access over VNC.
SYSTem:SECurity:NETWork:HTTP:STATe "<password>", 0
// Disables remote access over HTTP.
SYSTem:SECurity:NETWork:RPC:STATe "<password>", 0
// Disables remote access over remote procedure call (RPC).
SYSTem:SECurity:NETWork:SSH:STATe "<password>", 0
// Disables SSH network protocol that is used for service purposes.
SYSTem:SECurity:NETWork:FTP:STATe "<password>", 0
//    Disables FTP for file transfer.
SYSTem:SECurity:NETWork:SMB:STATe "<password>", 0
// Disables shared access over SMB.
SYSTem:SECurity:NETWork:AVAHi:STATe "<password>", 0
// Disables Avahi service for automatic instrument configuration in the network.
SYSTem:SECurity:NETWork:SWUPdate:STATe "<password>", 0
// Disables software updates over LAN.

Example: Querying the error queue
SYSTem:ERRor:STATic?
// Response: -221,"Settings conflict", 153,"Input voltage out of range", ...
// Returns all static errors that are collected in the error queue.

SYSTem:ERRor:HISTory:ClEar
// Deletes the history entries.
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Example: Configuring date and time
// Query the date and time setting of the instrument
// Query the current timezone and setting
SYSTem:DATE?
// Response: 2023,1,16;1
SYSTem:TIME?
// Response: 18,15,17;1
SYStem:TIME:ZONE?
// Response: "";1  //default UTC setting
SYSTem:TIME:PROTocol?
// Response: "OFF";1 // no protocol selected
SYSTem:NTP:STATe?
// Response: 0;1  // NTP is disabled

// Setting the timezone and NTP time protocol
SYSTem:TIME:ZONE:CATalog? 
// Response: "UTC,leap-seconds.list,leapseconds,Africa/Abidjan,..."
SYSTem:TIME:ZONE "Europe/Berlin"  
SYSTem:NTP:HOST "timesource.net"  // sets the NTP server address
SYSTem:NTP:STATe?
// Response: 1  // the NTP time server is enabled

Commands

:SYSTem:ERRor:ALL?....................................................................................................400
:SYSTem:ERRor:CODE:ALL?......................................................................................... 400
:SYSTem:ERRor:CODE[:NEXT]?.....................................................................................401
:SYSTem:ERRor:COUNt?...............................................................................................401
:SYSTem:ERRor[:NEXT]?...............................................................................................402
:SYSTem:ERRor:GNEXt?............................................................................................... 402
:SYSTem:ERRor:HISTory:CLEar......................................................................................402
:SYSTem:ERRor:STATic?............................................................................................... 403
:SYSTem:DLOCk........................................................................................................... 403
:SYSTem:KLOCk........................................................................................................... 403
:SYSTem:NINFormation?................................................................................................403
:SYSTem:ULOCk........................................................................................................... 404
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:SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.

Return values: 
<All> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
A comma separated list of error number and a short description
of the error in FIFO order.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYSTem:ERRor:ALL? 
// queries all entries in the error queue. 
Response: 0, 'no error' 
// no errors have occurred since the error queue was last read out.

Usage: Query only

Manual operation: See "Clear History" on page 533

:SYSTem:ERRor:CODE:ALL?

Queries the error numbers of all entries in the error queue and then deletes them.

Return values: 
<All> string

Returns the error numbers. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
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Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYSTem:ERRor:CODE:ALL? 
// queries all entries in the error queue. 
Response: 0 
// no errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:CODE[:NEXT]?

Queries the error number of the oldest entry in the error queue and then deletes it.

Return values: 
<Next> string

Returns the error number. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYSTem:ERRor:CODE:NEXT? 
// queries the oldest entry in the error queue. 
Response: 0 
// no errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:COUNt?

Queries the number of entries in the error queue.

Return values: 
<Count> integer

0
The error queue is empty.

Example: SYSTem:ERRor:COUNt? 
// queries the number of entries in the error queue. 
Response: 1 
// one error has occurred since the error queue was last read out.

Usage: Query only
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:SYSTem:ERRor[:NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue.

Return values: 
<Next> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
Error number and a short description of the error.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYSTem:ERRor:NEXT? 
// queries the oldest entry in the error queue. 
Response: 0, 'no error' 
// no errors have occurred since the error queue was last read out.

Usage: Query only

Manual operation: See "Static Notifications/History" on page 533

:SYSTem:ERRor:GNEXt?

Similar to :SYSTem:ERRor[:NEXT]?, but queries the next entry from the global per-
sistant error/event queue.

Return values: 
<NextGlobalError> string

Error/event number, "Error/event description> [;Device depend-
ent info]"
An error number and a short description of the error.
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.

Example: SYSTem:ERRor:GNEXt?
// queries the next error message from the global error queue.

Usage: Query only

:SYSTem:ERRor:HISTory:CLEar

Clears the error history.

Example: See Example"Querying the error queue" on page 397

Usage: Event

Manual operation: See "Clear History" on page 533
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:SYSTem:ERRor:STATic?

Returns a list of all errors existing at the time when the query is started. This list corre-
sponds to the display on the info page under manual control.

Return values: 
<StaticErrors> string

Example: See Example"Querying the error queue" on page 397

Usage: Query only

Manual operation: See "Static Notifications/History" on page 533

:SYSTem:DLOCk <DispLockStat>

Disables the manual operation over the display, including the front panel keyboard of
the instrument.

Parameters:
<DispLockStat> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SYST:DLOC ON
Activates the display lock. The instrument cannot be operated
via the display until it has been enabled with SYST:DLOC OFF.

Manual operation: See "User Interface" on page 256
See "Enabling a locked user interface for manual operation"
on page 257

:SYSTem:KLOCk <State>

Disables the front panel keyboard of the instrument.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SYST:KLOC ON
Locks the front panel and external controls.
To enable the controls, send SYST:KLOC OFF.

Manual operation: See "User Interface" on page 256
See "Enabling a locked user interface for manual operation"
on page 257

:SYSTem:NINFormation?

Queries the oldest information message ("Error History > Level > Info") in the error/
event queue.
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Return values: 
<NextInfo> string

Example: :SYSTem:NINFormation?
Queries the oldest entry in the info message queue.
Response: 90,"Info;=== Instrument startup...
==="
Information message containing error number 90, that states,
that the instrument startup is complete.

Usage: Query only

:SYSTem:ULOCk <Mode>

Locks or unlocks the user interface of the instrument.

Parameters:
<Mode> ENABled | DONLy | DISabled | TOFF | VNConly

ENABled
Unlocks the display, the touchscreen and all controls for the
manual operation.
DONLy
Locks the touchscreen and controls for the manual operation of
the instrument. The display shows the current settings.
VNConly
Locks the touchscreen and controls for the manual operation,
and enables remote operation over VNC. The display shows the
current settings.
TOFF
Locks the touchscreen for the manual operation of the instru-
ment. The display shows the current settings.
DISabled
Locks the display, the touchscreen and all controls for the man-
ual operation.
*RST: n.a. (factory preset: ENABled)

Example: :SYST:ULOC DIS
Activates the user interface lock, including display and controls.

Manual operation: See "User Interface" on page 256
See "Enabling a locked user interface for manual operation"
on page 257

:SYSTem:LOCK:OWNer?

Queries the sessions that have locked the instrument currently.

If an exclusive lock is set, the query returns the owner of this exclusive lock, otherwise
it returns NONE.
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Return values: 
<Owner> string

Example: SYST:LOCK:OWN?
Returns the owner of locking.
Response: NONE
The instrument is not locked.

Usage: Query only

:SYSTem:LOCK:RELease:ALL

Revokes the exclusive access to the instrument.

Usage: Setting only

:SYSTem:LOCK:REQuest[:EXCLusive]?

Queries whether a lock for exclusive access to the instrument via ethernet exists. If
successful, the query returns a 1, otherwise 0.

Return values: 
<Success> integer

Example: SYST:LOCK:REQ?
Queries the state of exclusive locking.
Response: 1
The exclusive locking is active.

Usage: Query only

:SYSTem:SAV <Pathname>

Saves the current R&S AREG800A settings in a file. To deteremine the file name and
storage location, enter the directory and file name with the command. According to the
file type, the R&S AREG800A assigns the extension (*.savrcltxt) automatically.

Setting parameters: 
<Pathname> string

Example: SYSTem:SAV "/var/user/temp/Test" 
// saves the file "Test.savrcltxt" in the directory /var/user/temp/.

Usage: Setting only

:SYSTem:RCL <Pathname>

Selects and uploads a *.savrcltxt file with previously saved R&S AREG800A set-
tings from the default or a specified directory.

Setting parameters: 
<Pathname> string

SYSTem subsystem



Remote control commandsR&S®AREG800A

406User Manual 1179.3615.02 ─ 06

Example: SYSTem:RCL "/var/user/temp/Test" 
// loads the "Test.savrcltxt" file from the directory /var/user/temp/.

Usage: Setting only

:SYSTem:PROTect<ch>[:STATe] <State>[, <Key>]

Activates and deactivates the specified protection level.

Suffix: 
<ch>

.
Indicates the protection level.
See also "Protection" on page 250

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Setting parameters: 
<Key> integer

The respective functions are disabled when the protection level
is activated. No password is required for activation of a level.
A password must be entered to deactivate the protection level.
The default password for the first level is 123456.
This protection level is required to unlock internal adjustments
for example.

Example: To activate protection level:
SYSTem:PROTect1:STATe 1
Internal adjustments or hostname cannot be changed.
To unlock protection level 1:
SYSTem:PROTect1:STATe 0,123456
Internal adjustments are accessible.

Manual operation: See "Protection Level/Password" on page 252

:SYSTem:COMMunicate:GPIB:LTERminator <LTerminator>

Sets the terminator recognition for remote control via GPIB interface.

Parameters:
<LTerminator> STANdard | EOI

EOI
Recognizes an LF (Line Feed) as the terminator only when it is
sent with the line message EOI (End of Line). This setting is rec-
ommended particularly for binary block transmissions, as binary
blocks may coincidentally contain a characater with value LF
(Line Feed), although it is not determined as a terminator.
STANdard
Recognizes an LF (Line Feed) as the terminator regardless of
whether it is sent with or without EOI.
*RST: n.a. (factory preset: STANdard)
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Example: See Example"Finding out VISA resource strings" on page 396.

:SYSTem:COMMunicate:GPIB:RESource?

Queries the visa resource string for remote control via the GPIB interface.

To change the GPIB address, use the command :SYSTem:COMMunicate:GPIB[:
SELF]:ADDRess.

Return values: 
<Resource> string

Example: See Example"Finding out VISA resource strings" on page 396.

Usage: Query only

:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess <Address>

Sets the GPIB address.

Parameters:
<Address> integer

Range: 0  to  30
*RST: n.a. (factory preset: 28)

Example: See Example"Finding out VISA resource strings" on page 396.

Manual operation: See "GPIB Channel Address" on page 294

:SYSTem:COMMunicate:HISLip:RESource?

Queries the VISA resource string. This string is used for remote control of the instru-
ment with HiSLIP protocol.

Return values: 
<Resource> string

Example: See Example"Finding out VISA resource strings" on page 396.

Usage: Query only

Manual operation: See "HISLIP" on page 293
See "GPIB" on page 293

:SYSTem:COMMunicate:NETWork:IPADdress <IpAddress>

Sets the IP address.

Parameters:
<IpAddress> string

Range: 0.0.0.0.  to  ff.ff.ff.ff

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

SYSTem subsystem



Remote control commandsR&S®AREG800A

408User Manual 1179.3615.02 ─ 06

Manual operation: See "IP Address" on page 290

:SYSTem:COMMunicate:NETWork:IPADdress:MODE <Mode>

Selects manual or automatic setting of the IP address.

Parameters:
<Mode> AUTO | STATic

*RST: n.a. (factory preset: AUTO)

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "Address Mode" on page 290

:SYSTem:COMMunicate:NETWork:MACaddress <MacAddress>

Queries the MAC address of the network adapter.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<MacAddress> string

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "MAC Address" on page 292

:SYSTem:COMMunicate:NETWork:RESource?

Queries the visa resource string for Ethernet instruments.

Return values: 
<Resource> string

Example: See Example"Finding out VISA resource strings" on page 396.

Usage: Query only

Manual operation: See "VXI11" on page 293

:SYSTem:COMMunicate:NETWork:RESTart

Restarts the network.

Example: See Example"Restarting the network" on page 396.

Usage: Event

Manual operation: See "Restart Network" on page 289
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:SYSTem:COMMunicate:NETWork:STATus?

Queries the network configuration state.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Usage: Query only

Manual operation: See "Network Status" on page 289

:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain <Domain>

Determines the primary suffix of the network domain.

Parameters:
<Domain> string

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "DNS Suffix" on page 291

:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname <Hostname>

Sets an individual hostname for the Automotive Radar Echo Generator.

Note:We recommend that you do not change the hostname to avoid problems with the
network connection. If you change the hostname, be sure to use a unique name.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Hostname> string

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "Hostname" on page 290

:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup <Workgroup>

Sets an individual workgroup name for the instrument.

Parameters:
<Workgroup> string

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "Workgroup" on page 290
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:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS <DNS>

Determines or queries the network DNS server to resolve the name.

Parameters:
<DNS> string

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "DNS Server" on page 292

:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway <Gateway>

Sets the IP address of the default gateway.

Parameters:
<Gateway> string

Range: 0.0.0.0  to  ff.ff.ff.ff

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "Default Gateway" on page 291

:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK <Mask>

Sets the subnet mask.

Parameters:
<Mask> string

Example: See Example"Retrieving information on network-related set-
tings" on page 395.

Manual operation: See "Subnet Mask" on page 291

:SYSTem:COMMunicate:SERial:BAUD <Baud>

Defines the baudrate for the serial remote control interface.

Parameters:
<Baud> 2400 | 4800 | 9600 | 19200 | 38400 | 57600 | 115200

*RST: n.a. (factory preset: 115200)

Example: See Example"Finding out VISA resource strings" on page 396.

Manual operation: See "Baud Rate" on page 295

:SYSTem:COMMunicate:SERial:PARity <Parity>

Enters the parity for the serial remote control interface.
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Parameters:
<Parity> NONE | ODD | EVEN

*RST: n.a. (factory preset: NONE)

Example: See Example"Finding out VISA resource strings" on page 396.

Manual operation: See "Parity" on page 295

:SYSTem:COMMunicate:SERial:RESource?

Queries the visa resource string for the serial remote control interface. This string is
used for remote control of the instrument.

Return values: 
<Resource> string

Example: See Example"Finding out VISA resource strings" on page 396.

Usage: Query only

Manual operation: See "SERIAL" on page 293

:SYSTem:COMMunicate:SERial:SBITs <SBits>

Defines the number of stop bits for the serial remote control interface.

Parameters:
<SBits> 1 | 2

*RST: n.a. (factory preset: 1)

Example: See Example"Finding out VISA resource strings" on page 396.

Manual operation: See "Stop Bits" on page 295

:SYSTem:COMMunicate:SOCKet:RESource?

Queries the visa resource string for remote control via LAN interface, using TCP/IP
socket protocol.

Return values: 
<Resource> string

Example: See Example"Finding out VISA resource strings" on page 396.

Usage: Query only

Manual operation: See "Socket" on page 293

:SYSTem:COMMunicate:USB:RESource?

Queries the visa resource string for remote control via the USB interface.

Return values: 
<Resource> string
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Example: See Example"Finding out VISA resource strings" on page 396.

Usage: Query only

Manual operation: See "USB" on page 293

:SYSTem:HELP:EXPort

Saves the online help as zip archive in the user directory.

Example: :SYSTem:HELP:EXPort
MMEM:CDIR?
// "/var/user"
MMEM:CAT?
// ..,"Log,DIR,4096","help.tgz,BIN,69836600"
// confirms that help zip archive is saved.

Usage: Event

Manual operation:: "Setup > Help > Export Help to User Path"

:SYSTem:IDENtification <Identification>

Selects the mode to determine the "IDN String" and the "OPT String" for the instru-
ment, selected with command :SYSTem:LANGuage.

Note: While working in an emulation mode, the R&S AREG800A specific command set
is disabled, that is, the SCPI command SYST:IDEN is discarded.

Parameters:
<Identification> AUTO | USER

AUTO
Automatically determines the strings.
USER
User-defined strings can be selected.
*RST: n.a. (factory preset: AUTO)

Example: SYST:IDEN AUTO
Automatically assigns the OPT and IDN strings according to the
selected instrument language.

Manual operation: See "Mode" on page 296

:SYSTem:IDENtification:PRESet

Sets the *IDN and *OPT strings in user defined mode to default values.

Example: SYST:IDEN USER
SYST:IDEN:PRES

Usage: Event

Manual operation: See "Set to Default" on page 296
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:SYSTem:IRESponse <IdnResponse>

Defines the user defined identification string for *IDN.

Note: While working in an emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYST:IRES is discarded.

Parameters:
<IdnResponse> string

Example: SYST:IDEN USER
// Selects a user-defined identification
SYST:IRES "Test Device"
// Defines identification string 'test device'
*IDN?
// Response: 'test device'

Manual operation: See "IDN String" on page 296

:SYSTem:ORESponse <OResponse>

Defines the user defined response string for *OPT.

Note: While working in an emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYST:ORES is discarded.

Parameters:
<OResponse> string

Example: SYST:IDEN USER
// Selects a user-defined identification
SYST:ORES "Test Option"
// Defines the OPT string 'test option'
*OPT?
// Response: 'test option'

Manual operation: See "OPT String" on page 296

:SYSTem:LANGuage <Language>

Sets the remote control command set.

Parameters:
<Language> string

Example: SYSTem:LANGuage "SCPI"
// selects SCPI command set

Manual operation: See "Language" on page 296

:SYSTem:INFormation:SCPI <InfoString>

Inserts system information in recorded SCPI command lists, for example information
on a missing command.
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Parameters:
<InfoString> string

Example: SYST:INF:SCPI "missing command"
enters the information into a recorded SCPI command list.

:SYSTem:SECurity:NETWork:AVAHi[:STATe] <SecPassWord>, <AvahiState>

Disables the Avahi service for automatic configuration of the instrument in a network.

Parameters:
<AvahiState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork:FTP[:STATe] <SecPassWord>, <FtpState>

Disables FTP protocol for file transfer between the instrument and host.

Parameters:
<FtpState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork:HTTP[:STATe] <SecPassWord>, <HttpState>

Disables control of the instrument over HTTP, the protocol for hypermedia information
systems.

Parameters:
<HttpState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258
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:SYSTem:SECurity:NETWork:RAW[:STATe] <SecPassWord>, <RawState>

Disables the LAN interface for remote control of the instrument over raw socket port.

Parameters:
<RawState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

:SYSTem:SECurity:NETWork:REMSupport[:STATe] <NetRemSupport>

Disables communication over SSH (SCP) for service purposes.

Parameters:
<NetRemSupport> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork:RPC[:STATe] <SecPassWord>, <RpcState>

Enables the LAN interface for remote control of the instrument via remote procedure
calls (RPC).

Parameters:
<RpcState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

:SYSTem:SECurity:NETWork:SMB[:STATe] <SecPassWord>, <SmbState>

Disables access to the file system, printers and serial ports in a network over SMB.

Parameters:
<SmbState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.
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Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork:SOE[:STATe] <SecPassWord>, <SoeState>

Disables control of the instrument over LAN using SCPI commands.

Parameters:
<SoeState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork:SSH[:STATe] <SecPassWord>, <SshState>

Disables control of the instrument over LAN using the SSH network protocol.

Parameters:
<SshState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork:SWUPdate[:STATe] <SecPassWord>,
<SwUpdateState>

Disables software update over LAN.

Parameters:
<SwUpdateState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258
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:SYSTem:SECurity:NETWork:VNC[:STATe] <SecPassWord>, <VncState>

Disables the VNC interface for remote control of the instrument.

Parameters:
<VncState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.

Example: See Example"To disable the LAN interface and LAN services"
on page 397.

Manual operation: See "LAN Services" on page 258

:SYSTem:SECurity:NETWork[:STATe] <SecPassWord>, <LanStorState>

Disables the LAN interface in general, including all services.

Parameters:
<LanStorState> 1 | ON | 0 | OFF

Setting parameters: 
<SecPassWord> string

Current security password.
The default password is 123456.

Example: See Example"To disable the LAN interface and LAN services"
on page 397

Manual operation: See "LAN" on page 258

:SYSTem:SECurity:SANitize[:STATe] <SecPassWord>, <MmemProtState>

Sanitizes the internal memory.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

Setting parameters: 
<SecPassWord> string

Example: SYSTem:SECurity:SANitize[:STATe] 1

Manual operation: See "Sanitize" on page 255

:SYSTem:SECurity:SUPolicy <SecPassWord>, <UpdatePolicy>

Configures the automatic signature verification for firmware installation.
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Parameters:
<UpdatePolicy> STRict | CONFirm | IGNore

*RST: n.a. (factory preset: CONFirm)

Setting parameters: 
<SecPassWord> string

Manual operation: See "Secure Update Policy" on page 253

:SYSTem:SECurity:VOLMode[:STATe] <SecPassWord>, <MmemProtState>

Activates volatile mode, so that no user data can be written to the internal memory per-
manently.

To enable volatile mode, reboot the instrument. Otherwise the change has no effect.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

Setting parameters: 
<SecPassWord> string

Current security password
The default password is 123456.

Example: SYSTem:SECurity:VOLMode:STATe "123456", 1
SYSTem:REBoot

Manual operation: See "Volatile Mode" on page 254

:SYSTem:SPECification? <Id>

Retrieves data sheet information for a specific parameter.

Setting parameters: 
<Id> string

Identifies the name of the entry in the data sheet, as queried
with the command :SYSTem:SPECification:
IDENtification:CATalog? on page 419

Return values: 
<ValList> float

Comma-separated list with the specified and, if available, the
typical value of the parameter, as specified in the data sheet.

Example: See Example"Retrieving instrument specification" on page 395.

Usage: Query only

:SYSTem:SPECification:VERSion <Version>

Selects a data sheet version from the data sheets saved on the instrument.
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Further queries regarding the data sheet parameters (<Id>) and their values refer to
the selected data sheet.

To query the list of data sheet versions, use the command :SYSTem:
SPECification:VERSion:CATalog? on page 419.

Parameters:
<Version> string

Example: See :SYSTem:SPECification? on page 418.

:SYSTem:SPECification:IDENtification:CATalog?

Queries the parameter identifiers (<Id>) available in the data sheet.

Return values: 
<IdList> string

Comma-separated string of the parameter identifiers (<Id>)

Example: See :SYSTem:SPECification? on page 418.

Usage: Query only

:SYSTem:SPECification:PARameter? <Id>[, <Parameter>]

Retrieves data sheet information for a specific parameter.

Setting parameters: 
<Id> string

Identifies the name of the entry in the data sheet.
Query the data sheet parameters with the command :SYSTem:
SPECification:IDENtification:CATalog?.

<Parameter> float
An additional value the result (ValList) depends on.

Return values: 
<ValList> float

Comma-separated list with the specified and, if available, the
typical value of the parameter, as specified in the data sheet.

Example: Note: The following values are merely an example. Your instru-
ment may not support the same parameters.
SYST:SPEC:PAR? "ID_RF_FREQ_SETTING_TIME_MS",0.1
SYST:SPEC:PAR? "ID_RF_LEVEL_MAX_GENERAL_DBM",
0.1

Usage: Query only

:SYSTem:SPECification:VERSion:CATalog?

Queries all data sheet versions stored in the instrument.
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Return values: 
<VersCatalog> string

Example: See :SYSTem:SPECification? on page 418.

Usage: Query only

:SYSTem:SPECification:VERSion:FACTory?

Queries the data sheet version of the factory setting.

Return values: 
<Version> string

Example: See :SYSTem:SPECification? on page 418.

Usage: Query only

Manual operation: See "Versions" on page 538

:SYSTem:SRData?

Queris the SCPI recording data from the internal file.

This feature enables you to transfer an instrument configuration to other test environ-
ments, as e.g. laboratory virtual instruments.

Return values: 
<FileData> block data

Example: SYSTem:SRData? 
// #3118:SOURce1:ROSCillator:SOURce EXT
// :SOURce1:FREQuency:CW 4000000000
// :SOURce1:FREQuency:OFFSet 1000000
// :SOURce1:AM1:STATe 1
// :OUTPut1:STATe 1

Usage: Query only

:SYSTem:STARtup:COMPlete?

Queries if the startup of the instrument is completed.

Return values: 
<Complete> 1 | ON | 0 | OFF

*RST: 0

Example: SYSTem:STARtup:COMPlete? 
Response: 1 
// the instrument has started and is ready for operation.

Usage: Query only
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:SYSTem:DATE <Year>, <Month>, <Day>

Queries or sets the date for the instrument-internal calendar.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Year> integer

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See Example"Configuring date and time" on page 398.

Manual operation: See "Date" on page 548

:SYSTem:NTP:HOSTname <NTPName>

Sets the address of the NTP server. You can enter the IP address, or the hostname of
the time server, or even set up an own vendor zone. See the Internet for more informa-
tion on NTP.

Parameters:
<NTPName> string

Manual operation: See "NTP Address" on page 549

:SYSTem:NTP:STATe <UseNtpState>

Activates clock synchronization via NTP.

Parameters:
<UseNtpState> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example"Configuring date and time" on page 398.

Manual operation: See "NTP Address" on page 549

:SYSTem:TIME <Hour>, <Minute>, <Second>

Queries or sets the time for the instrument-internal clock.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59
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<Second> integer
Range: 0  to  59

Example: See Example"Configuring date and time" on page 398.

Manual operation: See "Time" on page 548

:SYSTem:TIME:ZONE <TimeZone>

Sets the timezone. You can query the list of the available timezones with :SYSTem:
TIME:ZONE:CATalog?.

Parameters:
<TimeZone> string

Example: See Example"Configuring date and time" on page 398.

Manual operation: See "Timezone" on page 549

:SYSTem:TIME:ZONE:CATalog?

Querys the list of available timezones.

Return values: 
<Catalog>

Example: See Example"Configuring date and time" on page 398.

Usage: Query only

Manual operation: See "Timezone" on page 549

:SYSTem:TIME:PROTocol <TimeProtocol>

Sets the date and time of the operating system.

Parameters:
<TimeProtocol> NONE | OFF | 0 | NTP | ON | 1 | GPTP

NONE
Sets the date and time according to the selected timezone,
see :SYSTem:TIME:ZONE:CATalog? on page 422 and :
SYSTem:TIME:ZONE on page 422.
NTP
Sets the date and time derived from the network time protocol.
To select the NTP time server, use the commands :SYSTem:
NTP:HOSTname on page 421 and :SYSTem:NTP:STATe
on page 421.
GPTP
Sets the date and time derived from the generic precision time
protocol (gPTP).
*RST: n.a. (factory preset: NONE)
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Example: See Example"Configuring date and time" on page 398.

Manual operation: See "Time Protocol" on page 549

:SYSTem:UPTime?

Queries the up time of the operating system.

Return values: 
<UpTime> "<ddd.hh:mm:ss>"

Example: SYSTem:UPTime?
Response: "0.08:11:00"

Usage: Query only

:SYSTem:BIOS:VERSion?

Queries the BIOS version of the instrument.

Return values: 
<Version> string

Example: SYST:BIOS:VERS?
queries the BIOS version.
Response: 123456

Usage: Query only

:SYSTem:VERSion?

Queries the SCPI version the instrument's command set complies with.

Return values: 
<Version> string

Example: SYSTem:VERSion 
// queries the SCPI version. 
Response: "1996" 
// the instrument complies with the SCPI version from 1996.

Usage: Query only

:SYSTem:OSYStem?

Queries the operating system of the instrument.

Return values: 
<OperSystem> string

Example: SYSTem:OSYStem?
Response: "Linux"

Usage: Query only
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:SYSTem:MMEMory:PATH:USER?

Queries the user directory, that means the directory the R&S AREG800A stores user
files on.

Return values: 
<PathUser> string

Example: SYSTem:MMEMory:PATH:USER? 
Response: "'/var/user/"

Usage: Query only

:SYSTem:DFPR?

Queries the device footprint of the instrument. The retrieved information is in machine-
readable form suitable for automatic further processing.

Return values: 
<DeviceFootprint> string

Information on the instrument type, device identification and
details on the installed FW version, hardware and software
options.

Example: :SYSTem:DFPR?
Usage: Query only

:SYSTem:REBoot

Reboots the instrument including the operating system.

Usage: Event

:SYSTem:RESTart

Restarts the instrument without restarting the operating system.

Usage: Event

:SYSTem:SHUTdown

Shuts down the instrument.

Usage: Event

Manual operation: See "Shut down" on page 554

:SYSTem:WAIT <TimeMs>

Delays the execution of the subsequent remote command by the specified time.
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This function is useful, for example to execute an SCPI sequence automatically but
with a defined time delay between some commands.

See Chapter 10.3.4, "How to assign actions to the [User] key", on page 240.

Setting parameters: 
<TimeMs> integer

Wait time in ms
Range: 0  to  10000
*RST: 0

Example: SYSTem:WAIT 10000
// Waits 10s before resetting the instrument.
*RST

Usage: Setting only

12.13  SYSTem:COMMunicate:RT subsystem

The SYSTem:COMMunicate:RT subsystem contains the commands for establishing a
control connection between R&S AREG800A and an external instrument via the real-
time control interface.

Example: Configuring the realtime control network interface
This example provides information on how to configure the connection between
R&S AREG800A and a control unit for hardware in the loop (HiL) or vehicle in the loop
(ViL) scenarios.
// *****************************************************************************
// Query, if the control unit is connected to the realtime control network.
// *****************************************************************************
SYSTem:COMMunicate:RT:NETWork:STATus?
// Response: "0"
// No external frontend is connected.
SYSTem:COMMunicate:RT:NETWork:RESTart
// Terminates the network connection and sets it up again.

// *****************************************************************************
// Connect the control unit.
// *****************************************************************************
SYSTem:COMMunicate:RT:NETWork:IPADdress:MODE?
// Response: "AUTO"
SYSTem:COMMunicate:RT:NETWork:IPADdress:MODE STAT
SYSTem:COMMunicate:RT:NETWork:IPADdress 10.123.4.567
SYSTem:COMMunicate:RT:NETWork:COMMon:HOSTname?
// Response: "HILCONTROL-123456"
SYSTem:COMMunicate:RT:NETWork:IPADdress:SUBNet:MASK 255.255.252.0
SYSTem:COMMunicate:RT:NETWork:MACaddress?
// Response: "08 00 27 12 34 56"
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SYSTem:COMMunicate:RT:NETWork:STATus?
// Response: "1"
// The control unit is connected to the realtime interface.

Commands

:SYSTem:COMMunicate:RT:NETWork:STATus................................................................. 426
:SYSTem:COMMunicate:RT:NETWork:RESTart.................................................................426
:SYSTem:COMMunicate:RT:NETWork[:COMMon]:HOSTname...........................................426
:SYSTem:COMMunicate:RT:NETWork:IPADdress............................................................. 427
:SYSTem:COMMunicate:RT:NETWork:IPADdress:MODE...................................................427
:SYSTem:COMMunicate:RT:NETWork[:IPADdress]:SUBNet:MASK.....................................427
:SYSTem:COMMunicate:RT:NETWork:MACaddress..........................................................427

:SYSTem:COMMunicate:RT:NETWork:STATus <ZynqNetStatus>

Queries the network configuration state.

Parameters:
<ZynqNetStatus> 1 | ON | 0 | OFF

*RST: n.a. (no preset. default: 0)

Example: See Example"Configuring the realtime control network interface"
on page 425.

Manual operation: See "Network Status" on page 199

:SYSTem:COMMunicate:RT:NETWork:RESTart

Restarts the network.

Example: See Example"Configuring the realtime control network interface"
on page 425.

Usage: Event

Manual operation: See "Restart Network" on page 199

:SYSTem:COMMunicate:RT:NETWork[:COMMon]:HOSTname <ZynqHostname>

Queries the hostname of the instrument connected to the R&S AREG800A via the real-
time control interface.

Parameters:
<ZynqHostname> string

Example: See Example"Configuring the realtime control network interface"
on page 425.

Manual operation: See "Hostname" on page 200
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:SYSTem:COMMunicate:RT:NETWork:IPADdress

Sets the IP address.

Example: See Example"Configuring the realtime control network interface"
on page 425.

Manual operation: See "IP Address" on page 200

:SYSTem:COMMunicate:RT:NETWork:IPADdress:MODE <ZynqMode>

Selects manual or automatic setting of the IP address.

Parameters:
<ZynqMode> AUTO | STATic

*RST: n.a. (factory preset: AUTO)

Example: See Example"Configuring the realtime control network interface"
on page 425.

Manual operation: See "Address Mode" on page 200

:SYSTem:COMMunicate:RT:NETWork[:IPADdress]:SUBNet:MASK

Sets the subnet mask.

Example: See Example"Configuring the realtime control network interface"
on page 425.

Manual operation: See "Subnet Mask" on page 200

:SYSTem:COMMunicate:RT:NETWork:MACaddress <ZynqMacaddress>

Queries the MAC address of the instrument connected to the R&S AREG800A via the
realtime control interface.

Parameters:
<ZynqMacaddress> string

Example: See Example"Configuring the realtime control network interface"
on page 425.

Manual operation: See "MAC Address" on page 200

12.14  SYSTem:COMMunicate:SYST subsystem

The SYSTem:COMMunicate:SYST subsystem contains the commands for establish-
ing a control connection between R&S AREG800A and an external frontend via the
system control interface.
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Example: Configuring the system control network interface
This example provides information on how to configure the connection between
R&S AREG800A and an external frontend.
// *****************************************************************************
// Query, if the external frontend is connected to the system control network.
// *****************************************************************************
SYSTem:COMMunicate:SYST:NETWork:STATus?
// Response: "0"
// No external frontend is connected.
SYSTem:COMMunicate:SYST:NETWork:RESTart
// Terminates the network connection and sets it up again.

// *****************************************************************************
// Connect the external frontend, e.g., an R&S QAT100.
// *****************************************************************************
SYSTem:COMMunicate:SYST:NETWork:IPADdress:MODE?
// Response: "AUTO"
SYSTem:COMMunicate:SYST:NETWork:IPADdress:MODE STAT
SYSTem:COMMunicate:SYST:NETWork:IPADdress 10.123.4.567
SYSTem:COMMunicate:SYST:NETWork:COMMon:HOSTname?
// Response: "QAT100-123456"
SYSTem:COMMunicate:SYST:NETWork:IPADdress:SUBNet:MASK 255.255.252.0
SYSTem:COMMunicate:SYST:NETWork:MACaddress?
// Response: "08 00 27 12 34 56"

SYSTem:COMMunicate:SYST:NETWork:STATus?
// Response: "1"
// The external frontend is connected to the realtime interface.

Commands

:SYSTem:COMMunicate:SYST:NETWork:STATus............................................................. 428
:SYSTem:COMMunicate:SYST:NETWork:RESTart............................................................ 429
:SYSTem:COMMunicate:SYST:NETWork[:COMMon]:HOSTname.......................................429
:SYSTem:COMMunicate:SYST:NETWork:IPADdress......................................................... 429
:SYSTem:COMMunicate:SYST:NETWork:IPADdress:MODE...............................................429
:SYSTem:COMMunicate:SYST:NETWork[:IPADdress]:SUBNet:MASK.................................429
:SYSTem:COMMunicate:SYST:NETWork:MACaddress......................................................430

:SYSTem:COMMunicate:SYST:NETWork:STATus <ZynqNetStatus>

Queries the network configuration state.

Parameters:
<ZynqNetStatus> 1 | ON | 0 | OFF

*RST: n.a. (no preset. default: 0)

Example: See Example"Configuring the system control network interface"
on page 428.

Manual operation: See "Network Status" on page 199
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:SYSTem:COMMunicate:SYST:NETWork:RESTart

Restarts the network.

Example: See Example"Configuring the system control network interface"
on page 428.

Usage: Event

Manual operation: See "Restart Network" on page 199

:SYSTem:COMMunicate:SYST:NETWork[:COMMon]:HOSTname <ZynqHostname>

Queries the hostname of the instrument connected to the R&S AREG800A via the sys-
tem control interface.

Parameters:
<ZynqHostname> string

Example: See Example"Configuring the system control network interface"
on page 428.

Manual operation: See "Hostname" on page 200

:SYSTem:COMMunicate:SYST:NETWork:IPADdress

Sets the IP address.

Example: See Example"Configuring the system control network interface"
on page 428.

Manual operation: See "IP Address" on page 200

:SYSTem:COMMunicate:SYST:NETWork:IPADdress:MODE <ZynqMode>

Selects manual or automatic setting of the IP address.

Parameters:
<ZynqMode> AUTO | STATic

*RST: n.a. (factory preset: AUTO)

Example: See Example"Configuring the system control network interface"
on page 428.

Manual operation: See "Address Mode" on page 200

:SYSTem:COMMunicate:SYST:NETWork[:IPADdress]:SUBNet:MASK

Sets the subnet mask.

Example: See Example"Configuring the system control network interface"
on page 428.

Manual operation: See "Subnet Mask" on page 200
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:SYSTem:COMMunicate:SYST:NETWork:MACaddress <ZynqMacaddress>

Queries the MAC address of the instrument connected to the R&S AREG800A via the
system control interface.

Parameters:
<ZynqMacaddress> string

Example: See Example"Configuring the system control network interface"
on page 428.

Manual operation: See "MAC Address" on page 200

12.15  TEST subsystem

The TEST subsystem contains the commands for performing test routines directly at
the hardware assemblies.

The selftetst responses with a 0 if the test is performed successfully, otherwise a value
other than 0 is returned. None of the commands of this system has a *RST value.

Example: Testing the screen display

// show the check screen
:TEST:PIXel:WINdow 1
// selct the color for the display, e.g. blue
TEST:PIXel:COLor BLUE
// select the sequence for changing the color automatically
TEST:PIXel:COLor AUTO //(~3s per color)
// select a specific RGB color, e.g. black
TEST:PIXel:RGBA 0,0,0,255
// turn on the gradient
TEST:PIXel:GRADient 1
// switch to text mode
 :TEST:PIXel:TEXT 1
// set the point size of the text
:TEST:PIXel:POINtsize 600 
// exit the check screen 
:TEST:PIXel:WINdow 0

:TEST<hw>:ALL:STARt.................................................................................................. 431
:TEST<hw>:ALL:RESult?................................................................................................431
:TEST:PIXel:COLor........................................................................................................ 431
:TEST:PIXel:GRADient................................................................................................... 431
:TEST:PIXel:POINtsize................................................................................................... 431
:TEST:PIXel:RGBA.........................................................................................................432
:TEST:PIXel:TEXT..........................................................................................................432
:TEST:PIXel:WINDow..................................................................................................... 432
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:TEST<hw>:ALL:STARt

Usage: Event

Starts the selftest. Use the command :TEST<hw>:ALL:RESult? to query the result.

:TEST<hw>:ALL:RESult?

Queries the result of the performed selftest. Start the selftest with :TEST<hw>:ALL:
STARt.

Return values: 
<Result> 0 | 1 | RUNning | STOPped

*RST: STOPped

Usage: Query only

:TEST:PIXel:COLor <PixTestColor>

Selects the color of the screen.

"AUTO" switches from one color to the next in tme intervals of approximately 3 s per
color.

Setting parameters: 
<PixTestColor> RED | BLUE | WHITe | GREen | AUTO | GR25 | GR50 | GR75 |

BLACk
*RST: RED

Example: See Example"Testing the screen display" on page 430.

Usage: Setting only

:TEST:PIXel:GRADient <PixTestGradStat>

Activates the gradient for display screen test.

Parameters:
<PixTestGradStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Testing the screen display" on page 430.

:TEST:PIXel:POINtsize <PixTestGradStat>

Sets the point size of the test text.

Parameters:
<PixTestGradStat> integer

Range: 0  to  999
*RST: n.a. (no preset. default: 0)
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Example: See Example"Testing the screen display" on page 430.

:TEST:PIXel:RGBA

Sets a specific RGBA color for the screen.

Example: See Example"Testing the screen display" on page 430.

:TEST:PIXel:TEXT <PixTestGradStat>

Activats the test text mode.

Parameters:
<PixTestGradStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Testing the screen display" on page 430.

:TEST:PIXel:WINDow <PixTestWindow>

Activates the check display screen.

Setting parameters: 
<PixTestWindow> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Testing the screen display" on page 430.

Usage: Setting only

12.16  SOURce subsystem
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12.16.1  Connector settings

This section describes the commands of the OUTPut and INPut subsystems, neces-
sary to configure the global connectors settings.

[:SOURce]:INPut:USER<ch>:DIRection............................................................................433
:OUTPut:USER<ch>:SIGNal........................................................................................... 433

[:SOURce]:INPut:USER<ch>:DIRection <Direction>

Determines whether the connector is used as an output or is not used.

Parameters:
<Direction> INPut | OUTPut | UNUSed

OUTPut
The connector is used as output.
UNUSed
The connector is not used.

Manual operation: See "Direction" on page 236

:OUTPut:USER<ch>:SIGNal <Signal>

Selects the signal marker for the connector.

Parameters:
<Signal> OBJect

OBJect
A marker signal is generated when an object setting event
occurs.
*RST: OBJect

Manual operation: See "Signal" on page 236

12.16.2  Frequency commands

This section describes the commands necessary to configure the frequency settings.

[:SOURce<hw>]:FREQuency[:CW|FIXed].........................................................................433
[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL................................................................. 434

[:SOURce<hw>]:FREQuency[:CW|FIXed] <Frequency>

R&S AREG8-B124/-B177: queries the center frequency.

R&S AREG8-B181: sets the center frequency of the RF output signal.
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Parameters:
<Frequency> float

Range: R&S AREG8-B124: 24 GHz, R&S AREG8-B177: 77
GHz, R&S AREG8-B181: 78 GHz and 79 GHz

Increment: dynamic

[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL <Rcl>

Set whether the RF frequency value is retained or taken from a loaded instrument con-
figuration, when you recall instrument settings with command *RCL.

Parameters:
<Rcl> INCLude | EXCLude

INCLude
Takes the frequency value of the loaded settings.
EXCLude
Retains the current frequency when an instrument configuration
is loaded.
*RST: INCLude

Example: SOURce1:FREQuency:CW:RCL INCLude
Manual operation: See "Exclude Frequency" on page 212

12.16.3  Radar object commands

This section describes the commands necessary to configure radar objects.
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Example: Configuring static radar objects
This example provides information on how to configure radar objects for a dedicated IF
path (channel). In the following, a static two-path scenario is presented with two radar
objects per channel.
The values of the range, attenuation and radar cross section (RCS) are inter-depend-
ent, see Chapter 4.3, "Radar equation", on page 65.
Note: Before you configure parameter values, you can query the value range of the
parameter.
// Query the value range of a parameter with minimum and maximum value
// Example: value range of attenuation
SOURce1:AREGenerator:OBJect1:ATTenuation? min
// Response: -90
SOURce1:AREGenerator:OBJect1:ATTenuation? max
// Response: 90

 
// *****************************************************************************
// Configure for a static operation setup with the origin as object reference.
// *****************************************************************************
SOURce1:AREGenerator:OSETup:MODE STATic
SOURce1:AREGenerator:OSETup:REFerence ORIGin
SOURce1:AREGenerator:OSETup:APPLy
// Applies the operation setup settings for static scenario.

// *****************************************************************************
// Configure radar objects for the first channel.
// *****************************************************************************
// Configure the first object "Object1".
SOURce1:AREGenerator:OBJect1:STATe?
// Response: "0"
// The first object is not simulated in the first channel.
SOURce1:AREGenerator:OBJect1:RANGe 20
// The range of the first object is 20 m.
SOURce1:AREGenerator:OBJect1:ATTenuation 50
// The attenuation of the echo of the first object is 50 dB.
SOURce1:AREGenerator:OBJect1:DOPPler:SPEed 200
// The doppler speed of the first object is 200 km/h.
SOURce1:AREGenerator:OBJect1:ANGle:HORizontal?
// Response: "90"
// The horizontal angle of the first object is 90 degrees.
SOURce1:AREGenerator:OBJect1:RCS?
// Response: "84.4"
// The radar cross section of the first object is 84.4 dB/m².

// Configure the second object "Object2".
SOURce1:AREGenerator:OBJect2:STATe?
// Response: "1"
// The second object is simulated in the first channel.
SOURce1:AREGenerator:OBJect3:STATe 0
SOURce1:AREGenerator:OBJect4:STATe 0
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SOURce1:AREGenerator:OBJect5:STATe 0
SOURce1:AREGenerator:OBJect6:STATe 0
SOURce1:AREGenerator:OBJect7:STATe 0
SOURce1:AREGenerator:OBJect8:STATe 0
SOURce1:AREGenerator:OBJect2:ATTenuation 25
// The attenuation of the echo of the second object is 25 dB.
SOURce1:AREGenerator:OBJect2:RANGe 10
// Message: value clipped
SOURce1:AREGenerator:OBJect2:RANGe?
// Response: "16.86"
// The minimum range of the second object is 16.86 m.
SOURce1:AREGenerator:OBJect2:DOPPler:SPEed 400
// The doppler speed of the second object is 400 km/h.
SOURce1:AREGenerator:OBJect2:ANGle:HORizontal?
// Response: "90"
// The horizontal angle of the second object is 90 degrees.
SOURce1:AREGenerator:OBJect2:RCS?
// Response: "106.4"
// The radar cross section of the second object is 106.4 dB/m².

// *****************************************************************************
// Configure radar objects for the second channel.
// *****************************************************************************
SOURce2:AREGenerator:OBJect1:STATe 1
SOURce2:AREGenerator:OBJect2:STATe 1
SOURce2:AREGenerator:OBJect3:STATe 0
SOURce2:AREGenerator:OBJect4:STATe 0
SOURce2:AREGenerator:OBJect5:STATe 0
SOURce2:AREGenerator:OBJect6:STATe 0
SOURce2:AREGenerator:OBJect7:STATe 0
SOURce2:AREGenerator:OBJect8:STATe 0
SOURce2:AREGenerator:OBJect1:RANGe 20
SOURce2:AREGenerator:OBJect2:RANGe 16.86
SOURce2:AREGenerator:OBJect1:ATTenuation 50
SOURce2:AREGenerator:OBJect2:ATTenuation 25
SOURce2:AREGenerator:OBJect1:DOPPler:SPEed 200
SOURce2:AREGenerator:OBJect2:DOPPler:SPEed 400
SOURce2:AREGenerator:OBJect1:ANGle:HORizontal?
// Response: "90"
SOURce2:AREGenerator:OBJect2:ANGle:HORizontal?
// Response: "90"
SOURce2:AREGenerator:OBJect1:RCS?
// Response: "84.4"
SOURce2:AREGenerator:OBJect2:RCS?
// Response: "106.4"

// *****************************************************************************
// Optionally, activate all radar objects for the first and second channel.
// *****************************************************************************
SOURce1:AREGenerator:OBJect:ALL:STATe 1
SOURce2:AREGenerator:OBJect:ALL:STATe 1

SOURce subsystem



Remote control commandsR&S®AREG800A

437User Manual 1179.3615.02 ─ 06

// *****************************************************************************
// Optionally, query invalid radar objects for the first and second channel.
// *****************************************************************************
SOURce1:AREGenerator:OBJects:INValid?
// Response: "6"
// Six objects in the first channel are invalid.
SOURce2:AREGenerator:OBJects:INValid?
// Response: "0"
// No objects in the second channel are invalid.

Example: Working with scenarios in dynamic mode
This example shows you how to load a dynamic scenario and work with it.
// Set the operation setup mode 
SOURce1:AREGenerator:OSETup:MODE DYNamic
SOURce1:AREGenerator:OSETup:SOURce SCENario
SOURce1:AREGenerator:OSETup:APPLy
 
// Query available scenario files
SOURce1:AREGenerator:SCENario:FILE:CATalog?
// Response: 1_myFile,2_testScenario
// Load a scenario file
SOURce1:AREGenerator:SCENario:FILE "/var/user/2_testScenario.osi"

//Configure the mode, start-time and stop-time for playing the scenario
SOURce1:AREGenerator:SCENario:REPLay:MODE SINGle
SOURce1:AREGenerator:SCENario:POSition:STARt 0
SOURce1:AREGenerator:SCENario:POSition:STOP 8000

// Start, query the actual postion, pause, stop and reset the scenario
SOURce1:AREGenerator:SCENario:STARt
SOURce1:AREGenerator:SCENario:POSition:ACTual?
// Response in ms: 2895.249
SOURce1:AREGenerator:SCENario:PAUSe 
SOURce1:AREGenerator:SCENario:STOP 
SOURce1:AREGenerator:SCENario:RESet 

Commands

[:SOURce<hw>]:AREGenerator:OBJect:ALL[:STATe].........................................................438
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:STATe]........................................................ 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>][:STATe]............................ 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>:ANGLe:HORizontal....................................... 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ANGLe:HORizontal........... 439
[:SOURce<hw>]:AREGenerator:OBJect<ch>:ATTenuation................................................. 439
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ATTenuation..................... 439
[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler[:SPEed]..........................................440
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler[:SPEed]..............440
[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler:FREQuency....................................441
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler:FREQuency........ 441

SOURce subsystem



Remote control commandsR&S®AREG800A

438User Manual 1179.3615.02 ─ 06

[:SOURce<hw>]:AREGenerator:OBJect<ch>:RANGe........................................................442
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RANGe............................ 442
[:SOURce<hw>]:AREGenerator:OBJect<ch>:RCS............................................................ 442
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RCS.................................443
[:SOURce<hw>]:AREGenerator:OBJects:VALid................................................................ 443
[:SOURce<hw>]:AREGenerator:OBJects:VALid:CATalog?..................................................443
[:SOURce<hw>]:AREGenerator:OBJects:INValid?.............................................................443
[:SOURce<hw>]:AREGenerator:OBJects:INValid:CATalog?................................................444
[:SOURce<hw>]:AREGenerator:OMONitoring:HOSTname.................................................444
[:SOURce<hw>]:AREGenerator:OMONitoring:PORT......................................................... 444
[:SOURce<hw>]:AREGenerator:OMONitoring[:STATe].......................................................444

[:SOURce<hw>]:AREGenerator:OBJect:ALL[:STATe] <GlobalObjStat>

Activates all available radar objects for a specific channel.

Parameters:
<GlobalObjStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring static radar objects" on page 435.

Manual operation: See "State" on page 105

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:STATe] <AregObjState>

Activates individual radar objects for a specific channel.

Parameters:
<AregObjState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring static radar objects" on page 435.

Manual operation: See "State" on page 105

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>][:STATe]
<AregObjState>

Activates simulation of the radar object.

Parameters:
<AregObjState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "State" on page 105

[:SOURce<hw>]:AREGenerator:OBJect<ch>:ANGLe:HORizontal
<AregObjHorAngle>

Sets the horizontal angle of the radar object.
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Parameters:
<AregObjHorAngle> float

Range: -90  to  90
Increment: 0.1
*RST: 0

Example: See Example"Configuring static radar objects" on page 435.

Manual operation: See "Horizontal Angle" on page 106

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ANGLe:
HORizontal <AregObjHorAngle>

Sets the horizontal angle of the simulated radar object.

Parameters:
<AregObjHorAngle> float

Range: -90  to  90
Increment: 0.1
*RST: 0

Manual operation: See "Horizontal Angle" on page 106

[:SOURce<hw>]:AREGenerator:OBJect<ch>:ATTenuation <AregObjAtt>

Requires [:SOURce<hw>]:AREGenerator:UNITs:KCONstant ATT.

Sets the attenuation of the simulated radar object.

The attenuation depends on the input power, i.e. a lower input signal can be amplified
more. If the gain control reaches the upper limit, a message is displayed.

Parameters:
<AregObjAtt> float

Range: -90  to  90
Increment: 0.01
*RST: 50

Example: See also Example"Configuring static radar objects"
on page 435.

Manual operation: See "Attenuation" on page 106

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ATTenuation
<AregObjAtt>

Requires [:SOURce<hw>]:AREGenerator:UNITs:KCONstant ATT.

Sets the attenuation of the simulated radar object.

The attenuation depends on the input power, i.e. a lower input signal can be amplified
more. If the gain control reaches the upper limit, a message is displayed.
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Parameters:
<AregObjAtt> float

Range: -90  to  90
Increment: 0.01
*RST: 50

Manual operation: See "Attenuation" on page 106

[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler[:SPEed] <AregObjectDopp>

Requires [:SOURce<hw>]:AREGenerator:UNITs:DOPPler SPEed.

Sets the Doppler speed of the radar object.

If you do not specify a speed unit, the default unit is used.

Parameters:
<AregObjectDopp> float

Range: -500  to  500
Increment: depends on options
*RST: 0
Default unit: km/h

Example: SOURce1:AREGenerator:UNITs:DOPPler SPEed
SOURce1:AREGenerator:OBJect4:DOPPler 80
// Sets the Doppler speed to 80 km/h.
SOURce1:AREGenerator:OBJect4:DOPPler 80mph
// Sets the Doppler speed to 80 mph (miles per hour).
SOURce1:AREGenerator:OBJect4:DOPPler 80mps
// Sets the Doppler speed to 80 m/s (meters per second).

Example: See also Example"Configuring static radar objects"
on page 435.

Manual operation: See "Doppler Speed" on page 106

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler[:
SPEed] <AregObjectDopp>

Requires [:SOURce<hw>]:AREGenerator:UNITs:DOPPler SPEed.

Sets the Doppler speed of the simulated radar object.

Parameters:
<AregObjectDopp> float

Range: -500  to  500
Increment: depends on options
*RST: 0

Manual operation: See "Doppler Speed" on page 106
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[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler:FREQuency
<AregObDoppFreq>

Requires [:SOURce<hw>]:AREGenerator:UNITs:DOPPler FREQuency.

Sets the doppler shift of the simulated radar object.

Parameters:
<AregObDoppFreq> float

Range: depends on settings  to  depends on settings
Increment: depends on options
*RST: 0

Example: SOURce1:AREGenerator:UNITs:DOPPler SPEed
SOURce1:AREGenerator:OBJect4:DOPPler 200
// Sets the Doppler speed to 200 km/h.
SOURce1:AREGenerator:UNITs:DOPPler FREQ
// Sets for the Doppler frequency setting.
SOURce1:AREGenerator:OBJect4:DOPPler?
// Response: "32625.218"
// The doppler shift that corresponds to 200 km/h is
// about 32.625 kHz.

Example: See also Example"Configuring static radar objects"
on page 435.

Options: R&S AREG8-K813: Install this option, if your test setup requires
simulation of radar objects with Doppler shifts higher than 100
kHz.

Manual operation: See "Doppler Shift" on page 106

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler:
FREQuency <AregObDoppFreq>

Requires [:SOURce<hw>]:AREGenerator:UNITs:DOPPler FREQuency.

Sets the doppler shift of the simulated radar object.

Parameters:
<AregObDoppFreq> float

Range: depends on settings  to  depends on settings
Increment: depends on options
*RST: 0

Options: R&S AREG8-K813: Install this option, if your test setup requires
simulation of radar objects with Doppler shifts higher than 100
kHz.

Manual operation: See "Doppler Shift" on page 106
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[:SOURce<hw>]:AREGenerator:OBJect<ch>:RANGe <AregObjRange>

Sets the range of the radar object.

The range depends on the installed option and on the cable delay settings, the air gap
and the bandwidth option.

Parameters:
<AregObjRange> float

Range: depends on settings  to  depends on settings
Increment: 0.1
*RST: n.a. (no preset)

Example: See Example"Configuring static radar objects" on page 435.

Manual operation: See "Range" on page 105

[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RANGe
<AregObjRange>

Sets the range of the simulated radar object.

The range depends on the installed option and on the cable delay settings, the air gap
and the bandwidth option.

Parameters:
<AregObjRange> float

Range: depends on settings  to  depends on settings
Increment: 0.1
*RST: n.a. (no preset)

Manual operation: See "Range" on page 105

[:SOURce<hw>]:AREGenerator:OBJect<ch>:RCS <AregObjRcs>

Requires [:SOURce<hw>]:AREGenerator:UNITs:KCONstant RCS.

Sets the radar cross section of the radar object.

The radar cross section is calculated with the corresponding values for attenuation via
the radar equation.

Parameters:
<AregObjRcs> float

Range: -100  to  100
Increment: 0.1
*RST: 0

Example: See Example"Configuring static radar objects" on page 435.

Manual operation: See "RCS" on page 107
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[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RCS
<AregObjRcs>

Requires [:SOURce<hw>]:AREGenerator:UNITs:KCONstant RCS.

Sets the radar cross section of the radar object.

The radar cross section is calculated with the corresponding values for attenuation via
the radar equation.

Parameters:
<AregObjRcs> float

Range: -100  to  100
Increment: 0.1
*RST: 0

Manual operation: See "RCS" on page 107

[:SOURce<hw>]:AREGenerator:OBJects:VALid <NumbOfValidObj>

Specifies the number of valid radar objects für a specific channel.

Parameters:
<NumbOfValidObj> integer

Range: 0  to  64
*RST: 0

Manual operation: See "Valid objects table" on page 119

[:SOURce<hw>]:AREGenerator:OBJects:VALid:CATalog?

Queries the content of the "valid objects" table.

Lists the header and all values for the respective object number.

Usage: Query only

Manual operation: See "Valid objects table" on page 119

[:SOURce<hw>]:AREGenerator:OBJects:INValid?

Specifies the number of invalid radar objects for a specific channel.

Return values: 
<NumbOfInvalidOb> integer

Range: 0  to  8
*RST: 0

Example: See Example"Configuring static radar objects" on page 435.

Usage: Query only

Manual operation: See "Invalid objects table" on page 119
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[:SOURce<hw>]:AREGenerator:OBJects:INValid:CATalog?

Queries the content of the "Invalid objects" table.

Lists the header and all values for the respective object number.

Usage: Query only

Manual operation: See "Invalid objects table" on page 119

[:SOURce<hw>]:AREGenerator:OMONitoring:HOSTname <MonHostname>

Sets hostname or IP address of the host (external PC) where the objects get streamed
to.

Parameters:
<MonHostname> string

*RST: OFF

Manual operation: See "Host IP Address / Hostname" on page 120

[:SOURce<hw>]:AREGenerator:OMONitoring:PORT <MonPort>

Sets the port of the host (external PC) where the objects get streamed to.

Parameters:
<MonPort> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Host Port" on page 120

[:SOURce<hw>]:AREGenerator:OMONitoring[:STATe] <MonState>

Sets the streaming state.

Parameters:
<MonState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Streaming Active" on page 120

12.16.4  Units commands

This section describes the commands of the UNITs subsystems, necessary for internal
calculations.

[:SOURce<hw>]:AREGenerator:UNITs:RANGe.................................................................445
[:SOURce<hw>]:AREGenerator:UNITs:RCS..................................................................... 445
[:SOURce<hw>]:AREGenerator:UNITs:ANGLe................................................................. 445
[:SOURce<hw>]:AREGenerator:UNITs:DOPPler............................................................... 446
[:SOURce<hw>]:AREGenerator:UNITs:SPEed.................................................................. 446
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[:SOURce<hw>]:AREGenerator:UNITs:SHIFt....................................................................446
[:SOURce<hw>]:AREGenerator:UNITs:KCONstant............................................................447
[:SOURce<hw>]:AREGenerator:UNITs:C..........................................................................447

[:SOURce<hw>]:AREGenerator:UNITs:RANGe <AregUnitRange>

Defines the range unit.

Parameters:
<AregUnitRange> M | CM | FT

M
Meter
CM
Centimeter
FT
Feet
*RST: M

Example: :SOURce:AREGenerator:UNITs:RANGe FT
Manual operation: See "Range Unit" on page 113

[:SOURce<hw>]:AREGenerator:UNITs:RCS <AregUnitRcs>

Defines the unit of the radar cross section.

Parameters:
<AregUnitRcs> DBSM | SM

DBSM
dB relative to one square meter.
SM
m2 (square meters).
*RST: DBSM

Example: SOURce:AREGenerator:UNITs:RCS SM
Manual operation: See "RCS Unit" on page 113

[:SOURce<hw>]:AREGenerator:UNITs:ANGLe <AregUnitAgle>

Sets the unit of the horizontal angle of the simulated radar object.

Parameters:
<AregUnitAgle> DEGree | RADian

*RST: DEGree

Manual operation: See "Horizontal Angle Unit" on page 113
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[:SOURce<hw>]:AREGenerator:UNITs:DOPPler <AregObjDoppUnit>

Defines if the radial velocity is defined as Doppler speed or frequency.

Parameters:
<AregObjDoppUnit> SPEed | FREQuency

*RST: SPEed

Manual operation: See "Doppler Format" on page 113

[:SOURce<hw>]:AREGenerator:UNITs:SPEed <AregUnitSpeed>

Defines the speed unit.

Parameters:
<AregUnitSpeed> KMH | MPH | MPS

KMH
Kilometer per hour
MPH
Miles per Hour
MPS
Meter per Seconds
*RST: KMH

Example: SOURce:AREGenerator:UNITs:SPEed KMH
Manual operation: See "Speed Unit" on page 114

[:SOURce<hw>]:AREGenerator:UNITs:SHIFt <AregUnitShift>

Defines the unit for the Doppler shift.

Parameters:
<AregUnitShift> HZ | KHZ | MHZ

HZ
Hertz
KHZ
Kilohertz
MHZ
Megahertz
*RST: HZ

Manual operation: See "Shift Unit" on page 114
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[:SOURce<hw>]:AREGenerator:UNITs:KCONstant <AregKeepConst>

Selects the parameter used as constant value for the calculation of the simulated radar
object.

Parameters:
<AregKeepConst> ATTenuation | RCS

ATTenuation
Uses the current value for attenuation as constant for the calcu-
lation.
RCS
Uses the current value for RCS as constant for the calculation.
*RST: ATTenuation

Manual operation: See "Keep Constant" on page 114

[:SOURce<hw>]:AREGenerator:UNITs:C <AregUnitLigthSp>

Sets the value of speed of light for internal calculations.

The defined value of speed of light is used for calculation of the doppler shift, the dis-
tance and the RCS.

Parameters:
<AregUnitLigthSp> integer

Range: 2E8  to  3E8
*RST: 2.997E8

Manual operation: See "Speed of Light" on page 114

12.16.5  Scenario commands

This section describes the commands to load and work with scenarios.

For a command example, see Example"Working with scenarios in dynamic mode"
on page 437.

[:SOURce<hw>]:AREGenerator:SCENario:FILE................................................................448
[:SOURce<hw>]:AREGenerator:SCENario:FILE:CATalog...................................................448
[:SOURce<hw>]:AREGenerator:SCENario:PAUSe............................................................ 448
[:SOURce<hw>]:AREGenerator:SCENario:POSition:ACTual.............................................. 448
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STARt................................................448
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STOP................................................ 449
[:SOURce<hw>]:AREGenerator:SCENario:PROGress.......................................................449
[:SOURce<hw>]:AREGenerator:SCENario:REPLay[:MODE].............................................. 449
[:SOURce<hw>]:AREGenerator:SCENario:RESet............................................................. 450
[:SOURce<hw>]:AREGenerator:SCENario:STARt............................................................. 450
[:SOURce<hw>]:AREGenerator:SCENario:STATus........................................................... 450
[:SOURce<hw>]:AREGenerator:SCENario:STOP..............................................................450
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[:SOURce<hw>]:AREGenerator:SCENario:FILE <ScenarioFile>

Selects an existing scenario file from the default directory or from a specific directory.

Parameters:
<ScenarioFile> string

Example: Query the available scenario files and load a scenario file from
the default directory.
SOURce1:AREGenerator:SCENario:FILE:CATalog?
SOURce1:AREGenerator:SCENario:FILE
"/var/user/myScenario.osi"

Manual operation: See "Select File" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:FILE:CATalog

Queries the available scenario files.

Lists all *.osi and *.sm files available in the default directory /var/user/.

Manual operation: See "Select File" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:PAUSe

Pauses the player.

After pausing, you can resume playing by
[:SOURce<hw>]:AREGenerator:SCENario:STARt.

Usage: Event

Manual operation: See "Pause" on page 109

[:SOURce<hw>]:AREGenerator:SCENario:POSition:ACTual <ScenActPos>

Queries the current play position in the file.

Parameters:
<ScenActPos> integer

Range: 0  to  1E9
*RST: 0

Manual operation: See "Position [hh:mm:ss.fff]" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:POSition:STARt <ScenStartPos>

Sets the start position in the scenario file.

Data which chronologically precedes the start position is not replayed by the player.
The entered time stamp must chronologically always precede the defined
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STOP time stamp.
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Parameters:
<ScenStartPos> integer

Range: 0  to  1E9
*RST: 0

Manual operation: See "Start [hh:mm:ss.fff]" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:POSition:STOP <ScenStopPos>

Sets the end position in the file.

Data which chronologically follows the end position is not replayed by the player. When
the player reaches the Stop position, it returns to the Start position
([:SOURce<hw>]:AREGenerator:SCENario:REPLay:LOOP). The time stamp
must chronologically always follow the defined
[:SOURce<hw>]:AREGenerator:SCENario:STARt time stamp.

Parameters:
<ScenStopPos> integer

Range: 0  to  1E9
*RST: 0

Manual operation: See "Stop [hh:mm:ss.fff]" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:PROGress <ScenarioProgres>

Queries the current position in time while playing the file.

Query the current position via
[:SOURce<hw>]:AREGenerator:SCENario:PROGress?.

Parameters:
<ScenarioProgres> float

Range: 0  to  100
Increment: 0.1
*RST: 0

Manual operation: See "Running/Stop/Position Player" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:REPLay[:MODE] <ScenReplyMode>

Defines, if the files are played once or continuously. Files are replayed within the
defined start position and stop position.

Parameters:
<ScenReplyMode> SINGle | LOOP

SINGle
Files are played once within the defined positions in the file.
LOOP
Files are played continuously within the defined positions in the
file.
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*RST: SINGle

Manual operation: See "Replay Mode" on page 109

[:SOURce<hw>]:AREGenerator:SCENario:RESet

Resets the Start, Stop and Position parameters of the replayed scenario.

Usage: Event

Manual operation: See "Reset" on page 109

[:SOURce<hw>]:AREGenerator:SCENario:STARt

Starts the player.

Plays the scenario file from the beginning.

Usage: Event

Manual operation: See "Play" on page 109

[:SOURce<hw>]:AREGenerator:SCENario:STATus <ScenarioStatus>

Queries the status of the played scenario file.

Parameters:
<ScenarioStatus> RUNNing | STOPped

RUNNing
The replay of the scenario is ongoing.
STOPped
The replay of the scenario is stopped.
*RST: STOPped

Manual operation: See "Running/Stop/Position Player" on page 108

[:SOURce<hw>]:AREGenerator:SCENario:STOP

Stops the player.

After stopping, you can resume playing by
[:SOURce<hw>]:AREGenerator:SCENario:STARt. The file plays from the start
position.

Usage: Event

Manual operation: See "Stop" on page 109
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12.16.6  Data logging commands

This section describes the commands to acquire, manage and save logged data of
dynamic radar scenarios.

[:SOURce<hw>]:AREGenerator:DLOGging[:STATe]...........................................................451
[:SOURce<hw>]:AREGenerator:DLOGging:LEVel............................................................. 451
[:SOURce<hw>]:AREGenerator:DLOGging:DATA............................................................. 451
[:SOURce<hw>]:AREGenerator:DLOGging:CLEar............................................................ 452
[:SOURce<hw>]:AREGenerator:DLOGging:SAVE............................................................. 452
[:SOURce<hw>]:AREGenerator:DLOGging:NERRor?........................................................452
[:SOURce<hw>]:AREGenerator:DLOGging:NINFo?.......................................................... 452
[:SOURce<hw>]:AREGenerator:DLOGging:NWARning?....................................................452

[:SOURce<hw>]:AREGenerator:DLOGging[:STATe] <DynLoggState>

Activates logging.

Parameters:
<DynLoggState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "State" on page 110

[:SOURce<hw>]:AREGenerator:DLOGging:LEVel <DynLoggLevel>

Defines the scope of logged data.

Only logging information is collected, that corresponds to this scope.

Parameters:
<DynLoggLevel> ALL | EAWarning | ERRor

All
Logged data includes information on errors, warnings and info
messages.
EAWarning
Logged data includes information on errors and warnings.
ERRor
Logged data includes information on errors.
*RST: ALL

Manual operation: See "Logging Level" on page 110

[:SOURce<hw>]:AREGenerator:DLOGging:DATA

Queries all logging information in the logged data.

Manual operation: See "Logging table" on page 111
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[:SOURce<hw>]:AREGenerator:DLOGging:CLEar

Removes all logging information, that is collected in the logging data.

Query logging data via the command [:SOURce<hw>]:AREGenerator:DLOGging:
DATA on page 451.

Usage: Event

Manual operation: See "Clear" on page 112

[:SOURce<hw>]:AREGenerator:DLOGging:SAVE <DynLoggSave>

Saves logged data to a file with file extension *.csv.

The file extension is added automatically.

Parameters:
<DynLoggSave> string

Manual operation: See "Save" on page 112

[:SOURce<hw>]:AREGenerator:DLOGging:NERRor?

Queries the number of errors within the logged data.

Return values: 
<DynLoggNumOfErr> integer

Range: 0  to  100
*RST: 0

Usage: Query only

Manual operation: See "Error | Warning | Info" on page 112

[:SOURce<hw>]:AREGenerator:DLOGging:NINFo?

Queries the number of info messages within the logged data.

Return values: 
<DynLoggNumOfInf> integer

Range: 0  to  100
*RST: 0

Usage: Query only

Manual operation: See "Error | Warning | Info" on page 112

[:SOURce<hw>]:AREGenerator:DLOGging:NWARning?

Queries the number of warnings within the logged data.
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Return values: 
<DynLoggNumOfWar>integer

Range: 0  to  100
*RST: 0

Usage: Query only

Manual operation: See "Error | Warning | Info" on page 112

12.16.7  Measurement setup commands

This section describes the commands necessary to configure the frontends and chan-
nels in the measurement setup.

Example: Configuring TRX-type frontends
// *****************************************************************************
// Configure a TRX-type frontend
// *****************************************************************************
SOURce1:AREGenerator:OSETup:MODE STATic
SOURce1:AREGenerator:OSETup:APPLy 
// Set air gap = 40 cm
SOURce1:AREGenerator:FRONtend:TRX1:OTA:OFFSet 0.4
// Set angle frontend to sensor = 45 degrees
SOURce1:AREGenerator:FRONtend:TRX1:ATS 45
// Channel mapping of frontend and sensor
SOURce1:AREGenerator:MAPPing1:FE TRX1
SOURce1:AREGenerator:MAPPing1:SENSor SEN1
SOURce1:AREGenerator:MAPPing1:ADJust:LEVel 

 
// *****************************************************************************
// Configure a TRX-type frontend with predefined antenna
// *****************************************************************************
// Set antenna gain mode to import a list
SOURce1:AREGenerator:FRONtend:TRX2:ANTenna:CUSTom:MODE LIST
//Import a predefined list 
SOURce1:AREGenerator:FRONtend:TRX2:ANTenna:CUSTom:IMPort:PREDefined 
"/opt/data/Lists/AntGain/ANT_WR12_10DB_1324.5030.00.txt"
// Set the angle frontend to sensor
SOURce1:AREGenerator:FRONtend:TRX2:ATS 45
// Set the air gap
SOURce1:AREGenerator:FRONtend:TRX2:OTA:OFFSet 0.3
// Channel mapping of frontend and sensor
SOURce1:AREGenerator:MAPPing2:FE TRX2
SOURce1:AREGenerator:MAPPing2:SENSor SEN1
SOURce1:AREGenerator:MAPPing1:ADJust:ALL
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Example: Configuring QAT-type frontends
// *****************************************************************************
// Configure a QAT-type frontend
// *****************************************************************************
// Add a QAT-type frontend to the test setup
SOURce1:AREGenerator:FRONtend:QAT:ADD 
SOURce1:AREGenerator:FRONtend:LAST:QAT?
// Set the QAT hostname and connect the frontend
SOURce1:AREGenerator:FRONtend:QAT1:HOSTname "<localhost>"
SOURce1:AREGenerator:FRONtend:QAT1:CONNect 
// Set an air gap of 40 cm between QAT frontend and target.
SOURce1:AREGenerator:FRONtend:QAT1:OTA:OFFSet 0.4
//Set the geometry parameter "Angle Frontend to Sensor"
SOURce1:AREGenerator:FRONtend:QAT1:ATS 45
//Set the geometry parameter "Rotation Frontend to Sensor"
SOURce1:AREGenerator:FRONtend:QAT1:RTS 5
//Set the geometry parameter "Orientation"
SOURce1:AREGenerator:FRONtend:QAT1:OR HORizontal
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Example: Configuring FE-type frontends
// *****************************************************************************
// Configure a FE-type frontend
// *****************************************************************************
// Add FE-type frontend
SOURce1:AREGenerator:FRONtend:FE:ADD 
SOURce1:AREGenerator:FRONtend:LAST:FE?
// Set and connect the RX and TX frontend
SOURce1:AREGenerator:FRONtend:FE1:RX:EFRontend "FE44S-123456"
SOURce1:AREGenerator:FRONtend:FE1:TX:EFRontend "FE44S-123457"
SOURce1:AREGenerator:FRONtend:FE1:CONNect
// Set the air gap for RX (40 cm) and TX (60 cm) frontend 
SOURce1:AREGenerator:FRONtend:FE1:RX:OTA:OFFSet 0.4
SOURce1:AREGenerator:FRONtend:FE1:TX:OTA:OFFSet 0.6
// Set cable correction for RX and TX frontend
SOURce1:AREGenerator:FRONtend:FE1:CABLecorr:CONNector1:RX:MODE S2P
SOURce1:AREGenerator:FRONtend:FE1:CABLecorr:CONNector1:RX:USER:FILE "/var/user/<filename>.s2p"
SOURce1:AREGenerator:FRONtend:FE1:CABLecorr:CONNector1:TX:MODE USER
SOURce1:AREGenerator:FRONtend:FE1:CABLecorr:CONNector1:TX:USER:DELay 1
// Import antenna gain list
SOURce1:AREGenerator:FRONtend:FE1:ANTenna:CUSTom:IMPort "/var/user/<filename>"
// Set operating mode and source
SOURce1:AREGenerator:OSETup:MODE DYNamic
SOURce1:AREGenerator:OSETup:SOURce HIL
SOURce1:AREGenerator:OSETup:APPLy
// Set IF output bandwith and configuration (FMCW near range)
SOURce1:AREGenerator:OSETup:BW BW5G
SOURce1:AREGenerator:OSETup:CONFig NR
SOURce1:AREGenerator:OSETup:BW:APPLy
// Channel mapping of frontend and sensor
SOURce1:AREGenerator:MAPPing1:FE TRX1
SOURce1:AREGenerator:MAPPing1:SENSor SEN1
SOURce1:AREGenerator:MAPPing1:ADJust:LEVel 

// *****************************************************************************
// Configure a FE-type frontend with LO configuration
// *****************************************************************************
// Set the Bandwith of the IF output channel to 5 GHz
SOURce1:AREGenerator:OSETup:BW BW5G
SOURce1:AREGenerator:OSETup:BW:APPLy 
// Add an FE-type frontend
SOURce1:AREGenerator:FRONtend:FE:ADD 
// Set and connect the RX and TX frontend 
SOURce1:AREGenerator:FRONtend:FE1:RX:EFRontend "FE44S-123456"
SOURce1:AREGenerator:FRONtend:FE1:TX:EFRontend "FE44S-123457"
SOURce1:AREGenerator:FRONtend:FE1:CONNect 
// Set local oscillator on RX and TX frontend 
SOURce1:AREGenerator:EFRontend:FE1:RX:LOSCillator:MODE INTernal
SOURce1:AREGenerator:EFRontend:FE1:RX:LOSCillator:OUTPut:STATe 1
SOURce1:AREGenerator:EFRontend:FE1:TX:LOSCillator:MODE EXTernal
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// Map frontend and sensor to the channel and adjust level (optional)
SOURce1:AREGenerator:MAPPing1:FE FE1
SOURce1:AREGenerator:MAPPing1:SENSor SEN1
SOURce1:AREGenerator:MAPPing1:ADJust:LEVel

// *****************************************************************************
// Add an FE-type frontend to the list of available instruments
// *****************************************************************************
SOURce1:AREGenerator:EXTernal:REMote:EDIT:ISELect "New"
SOURce1:AREGenerator:EXTernal:REMote:EDIT:ALIas "<Name>"
SOURce1:AREGenerator:EXTernal:REMote:EDIT:HOSTname "<Hostname/IP address>"
SOURce1:AREGenerator:EXTernal:REMote:EDIT:DEVice:ID "<Device ID>"
SOURce1:AREGenerator:EXTernal:REMote:EDIT:APPLy

Commands
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12.16.7.1  General commands

[:SOURce<hw>]:AREGenerator:LAST:SENSor?................................................................456
[:SOURce<hw>]:AREGenerator:MEASurement:KEEPsettings............................................ 456

[:SOURce<hw>]:AREGenerator:LAST:SENSor?

Queries the last added sensor.

Displays the number included in the sensor ID, e.g. "3" for sensor ID "S3".

Return values: 
<AregLastSensor> integer

Range: 0  to  8
*RST: n.a. (factory preset: 0)

Usage: Query only

Manual operation: See "Add Sensor" on page 158

[:SOURce<hw>]:AREGenerator:MEASurement:KEEPsettings <KeepSettings>

Keeps the configurations and connection settings of connected external frontends if
preset is activated.

Parameters:
<KeepSettings> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Manual operation: See "Preset Behavior On" on page 122

SOURce subsystem



Remote control commandsR&S®AREG800A

457User Manual 1179.3615.02 ─ 06

12.16.7.2  Channel commands

[:SOURce<hw>]:AREGenerator:CHANnel:BW.................................................................. 457
[:SOURce<hw>]:AREGenerator:CHANnel:CATalog?..........................................................457
[:SOURce<hw>]:AREGenerator:CHANnel:CONDition........................................................458
[:SOURce<hw>]:AREGenerator:RADar:POWer:INDicator?................................................ 458
[:SOURce<hw>]:AREGenerator:CHANnel:CONDition:INFO............................................... 458
[:SOURce<hw>]:AREGenerator:CHANnel:ID?.................................................................. 459
[:SOURce<hw>]:AREGenerator:CHANnel:NAME.............................................................. 459
[:SOURce<hw>]:AREGenerator:CHANnel:OPTimization:MODE......................................... 459
[:SOURce<hw>]:AREGenerator:CHANnel[:STATe]............................................................ 459
[:SOURce<hw>]:AREGenerator:CHANnel:SYSTem:ALIGnment..........................................460
[:SOURce<hw>]:AREGenerator:CHANnel:INPut:NOMGain................................................ 460
[:SOURce<hw>]:AREGenerator:CHANnel:INPut:RELLevel?...............................................460
[:SOURce<hw>]:AREGenerator:SWUNit:RELays:CATalog?............................................... 461
[:SOURce<hw>]:AREGenerator:SWUNit:RX.....................................................................461
[:SOURce<hw>]:AREGenerator:SWUNit:TX..................................................................... 461
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:ALL............................................... 462
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel............................................ 462
[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:ADJust:LEVel.................462
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:DIGHeadroom.......................462
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:OTIMe..................................462
[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:FE................................ 463
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:SENSor.................................................... 464
[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:SENSor.........................464
[:SOURce<hw>]:AREGenerator:SWUNit:MAPPing<ch>[:SUBChannel<st>]:CONFig?...........464

[:SOURce<hw>]:AREGenerator:CHANnel:BW <AregChanBw>

Queries the channel bandwidth.

The channel bandwidth depends on the installed options.

Parameters:
<AregChanBw> BW1G | BW2G | BW5G

BW1G
Bandwidth = 1 GHz
BW1G2
Bandwidth = 2 GHz
BW5G
Bandwidth = 5 GHz
*RST: UNUSed

Manual operation: See "Channel Bandwidth" on page 161

[:SOURce<hw>]:AREGenerator:CHANnel:CATalog?

Queries the available channels and lists the respective channel IDs.

Usage: Query only
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[:SOURce<hw>]:AREGenerator:CHANnel:CONDition <AregPowLedStatu>

Displays the status of the power LED for the related radar channel.

Parameters:
<AregPowLedStatu> INACtive | WARNing | ERRor | OK

INACtive
The channel is inactive. The power LED lights grey.
WARNing
Displays a warning for the channel. The power LED lights yel-
low.
ERRor
Displays an error for the channel. The power LED lights red.
OK
The channel is active and works properly. The power LED lights
green.
*RST: INACtive

Manual operation: See "A1 to D2" on page 115

[:SOURce<hw>]:AREGenerator:RADar:POWer:INDicator?

The radar power indicator is a summary indicator for all radar object powers.

Return values: 
<PowIndicator> OFF | GOOD | WEAK | BAD

OFF
No or very weak RX power is detected.
GOOD
The RX power is in linear range.
WEAK
The RX power is strong, non-linear effects can occur.
BAD
The RX power is in a range, where the receiver is in saturation.
*RST: OFF

Usage: Query only

Manual operation: See "A1 to D2" on page 115

[:SOURce<hw>]:AREGenerator:CHANnel:CONDition:INFO <AregPowLEDInfo>

Displays a status message for the input power for the related radar channel.

Parameters:
<AregPowLEDInfo> string

Manual operation: See "Input power LED info" on page 116
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[:SOURce<hw>]:AREGenerator:CHANnel:ID?

Displays the identification name of the radar channel.

The radar channel is designated with a letter and a number, e.g. "A1".

Return values: 
<AregChanId> string

Usage: Query only

Manual operation: See "ID" on page 161
See "ID" on page 167

[:SOURce<hw>]:AREGenerator:CHANnel:NAME <AregChannelName>

Sets the alias of the radar channel, that is the channel name.

Parameters:
<AregChannelName> string

Manual operation: See "Alias/Channel" on page 161

[:SOURce<hw>]:AREGenerator:CHANnel:OPTimization:MODE <AregChanMode>

Selects the optimization mode of the radar channel.

Parameters:
<AregChanMode> FAST | QHIG

FAST
Fast optimization mode
This mode compensates I/Q skews and is suitable in time sensi-
tive environments and for narrowband signals.
QHIG
High-quality optimization mode
This mode compensates I/Q skews and uses frequency
response correction data. The mode generates flat signals over
large bandwidth but requires longer setting time and leads to
signal interruption.
*RST: FAST

Manual operation: See "Optimization Mode" on page 162

[:SOURce<hw>]:AREGenerator:CHANnel[:STATe] <AregChanState>

Acitvates the radar channel.

Parameters:
<AregChanState> 1 | ON | 0 | OFF

*RST: n.a.

Manual operation: See "State" on page 161
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[:SOURce<hw>]:AREGenerator:CHANnel:SYSTem:ALIGnment <SystAlign>

Enables the system alignment If the required option is available in the pre-configured
system.

Parameters:
<SystAlign> OFF | TABLe | ON

OFF
Default state. No option installed. System alignment is not used.
ON
Requires R&S AREG8 -B97.
System alignment is executed. All frontends included in the test
setup are mapped according to the factory alignment.
TABLe
Requires R&S AREG8 -B98.
System alignment is executed. Same mapping as for state"ON".
In addition, you can define a table of certain center frequencies
and bandwidths for an additional alignment procedure which has
an increased level linearity. The definitions in the table limit the
possible settings for the radar sensor settings in the
"Sensor/DUT Config" dialog. The frontend center frequency is
set read-only and selected according to the configured radar
sensor frequency..
*RST: n.a. (factory preset: OFF)

Manual operation: See "System Alignment" on page 163

[:SOURce<hw>]:AREGenerator:CHANnel:INPut:NOMGain <AregChanNomGain>

Sets a value to adjust the input gain of the channel manually.

The R&S AREG800A sets the nominal input gain automatically by using the
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel function in the
channel mapping. You can set the input gain manually, for example to restore the
value.

Parameters:
<AregChanNomGain>float

Range: -50  to  35
Increment: 0.01
*RST: 0

Manual operation: See "Nominal Input Gain" on page 163

[:SOURce<hw>]:AREGenerator:CHANnel:INPut:RELLevel?

Queries the actual input level of the analog to digital converter of the R&S AREG800A
in relation to full scale.
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This value is the maximum measured during the defined
[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:OTIMe (obser-
vation time for peak detection). If the value is not steady enough, we recommend pro-
longing the observation time.

Return values: 
<AregChanRelLev> float

Range: -50  to  35
Increment: 0.01
*RST: 0

Usage: Query only

Manual operation: See "Relative Input Level" on page 163

[:SOURce<hw>]:AREGenerator:SWUNit:RELays:CATalog?

Requires [:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe] 1.

Queries all available relays of the switching unit.

Lists all available relays as a comma-separated list.

Usage: Query only

Manual operation: See "Channel RX/Channel TX" on page 164

[:SOURce<hw>]:AREGenerator:SWUNit:RX <AregSwunitRxCh>

Requires [:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe] 1.

Selects the switching unit connector (relay) of the switching unit connected to the RX
channel of the R&S AREG800A.

Enter the name of the relay of the switching unit to connect to the RX channel.

Parameters:
<AregSwunitRxCh> string

Example: :SOURce1:AREGenerator:SWUNit:RX "M01 K11 1x2"
Manual operation: See "Channel RX/Channel TX" on page 164

[:SOURce<hw>]:AREGenerator:SWUNit:TX <AregSwunitTxCh>

Requires [:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe] 1.

Selects the switching unit connector (relay) of the switching unit connected to the TX
channel of the R&S AREG800A.

Enter the name of the relay of the switching unit to connect to the TX channel.

Parameters:
<AregSwunitTxCh> string

Example: :SOURce1:AREGenerator:SWUNit:TX "M01 K12 1x2"
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Manual operation: See "Channel RX/Channel TX" on page 164

[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:ALL

Adjusts the input attenuation of the R&S AREG800A for the applied signal automati-
cally for all output channels.

Usage: Event

Manual operation: See "Adjust All Levels" on page 168

[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel

Adjusts the input attenuation of the R&S AREG800A for the applied signal automati-
cally for the selected output channel.

Usage: Event

Manual operation: See "Adjust Level" on page 168

[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:ADJust:LEVel

Adjusts the input attenuation of the R&S AREG800A for the applied signal automati-
cally for the selected output channel.

Usage: Event

Manual operation: See "Adjust Level" on page 168

[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:DIGHeadroom
<AregAdjustDHead>

Sets the digital headroom of the channel output power.

Parameters:
<AregAdjustDHead> integer

Range: 0  to  30
*RST: 1

Manual operation: See "Digital Headroom" on page 169

[:SOURce<hw>]:AREGenerator:MAPPing<ch>:ADJust:LEVel:OTIMe
<AregAdjustOTime>

Sets the observation time to determine peaks of the channel output power level.

Parameters:
<AregAdjustOTime> integer

Range: 10  to  10000
*RST: 100

Manual operation: See "Observation Time for Peak Detection" on page 169
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[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:FE
<AregMappingCTF>

Maps the external frontend to the IF channel.

Parameters:
<AregMappingCTF> NONE | IFONly | TRX1 | TRX2 | TRX3 | TRX4 | QAT1CH1 |

QAT1CH2 | QAT1CH3 | QAT1CH4 | QAT1CH5 | QAT1CH6 |
QAT1CH7 | QAT1CH8 | QAT2CH1 | QAT2CH2 | QAT2CH3 |
QAT2CH4 | QAT2CH5 | QAT2CH6 | QAT2CH7 | QAT2CH8 |
QAT3CH1 | QAT3CH2 | QAT3CH3 | QAT3CH4 | QAT3CH5 |
QAT3CH6 | QAT3CH7 | QAT3CH8 | QAT4CH1 | QAT4CH2 |
QAT4CH3 | QAT4CH4 | QAT4CH5 | QAT4CH6 | QAT4CH7 |
QAT4CH8 | QAT5CH1 | QAT5CH2 | QAT5CH3 | QAT5CH4 |
QAT5CH5 | QAT5CH6 | QAT5CH7 | QAT5CH8 | QAT6CH1 |
QAT6CH2 | QAT6CH3 | QAT6CH4 | QAT6CH5 | QAT6CH6 |
QAT6CH7 | QAT6CH8 | QAT7CH1 | QAT7CH2 | QAT7CH3 |
QAT7CH4 | QAT7CH5 | QAT7CH6 | QAT7CH7 | QAT7CH8 |
QAT8CH1 | QAT8CH2 | QAT8CH3 | QAT8CH4 | QAT8CH5 |
QAT8CH6 | QAT8CH7 | QAT8CH8 | FE1 | FE2 | FE3 | FE4 |
CFE1 | CFE2 | CFE3 | CFE4
NONE
No frontend is mapped.
IFONly
Selects the IF interface without known frontend.
TRX1|TRX2|TRX3|TRX4
Selects the TRX-type frontend and maps it to the respective
radar channel.
QAT1CH1|QAT1CH2|QAT1CH3|QAT1CH4|QAT1CH5|
QAT1CH6|QAT1CH7|QAT1CH8|QAT2CH1|QAT2CH2|
QAT2CH3|QAT2CH4|QAT2CH5|QAT2CH6|QAT2CH7|
QAT2CH8|QAT3CH1|QAT3CH2|QAT3CH3|QAT3CH4|
QAT3CH5|QAT3CH6|QAT3CH7|QAT3CH8|QAT4CH1|
QAT4CH2|QAT4CH3|QAT4CH4|QAT4CH5|QAT4CH6|
QAT4CH7|QAT4CH8|QAT5CH1|QAT5CH2|QAT5CH3|
QAT5CH4|QAT5CH5|QAT5CH6|QAT5CH7|QAT5CH8|
QAT6CH1|QAT6CH2|QAT6CH3|QAT6CH4|QAT6CH5|
QAT6CH6|QAT6CH7|QAT6CH8|QAT7CH1|QAT7CH2|
QAT7CH3|QAT7CH4|QAT7CH5|QAT7CH6|QAT7CH7|
QAT7CH8|QAT8CH1|QAT8CH2|QAT8CH3|QAT8CH4|
QAT8CH5|QAT8CH6|QAT8CH7|QAT8CH8
Selects the QAT-type frontend and maps it to the respective
radar channel.
FE1|FE2|FE3|FE4
Selects the FE-type frontend and maps it to the respective radar
channel.
CFE1|CFE2|CFE3|CFE4
Selects the custom frontend and maps it to the respective radar
channel.
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*RST: NONE

Manual operation: See "Frontend" on page 167

[:SOURce<hw>]:AREGenerator:MAPPing<ch>:SENSor <AregMappingMTS>

Selects the sensor that is mapped to the radar channel.

Parameters:
<AregMappingMTS> NONE | SEN1 | SEN2 | SEN4 | SEN3 | SEN5 | SEN6 | SEN7 |

SEN8
NONE
No sensor is mapped.
SEN1|SEN2|SEN4|SEN3|SEN5|SEN6|SEN7|SEN8
Selects the respective sensor and maps it to the radar channel.
*RST: NONE

Manual operation: See "Sensor/DUT" on page 168

[:SOURce<hw>]:AREGenerator:MAPPing<ch>[:SUBChannel<st>]:SENSor
<AregMappingMTS>

Selects the sensor that is mapped to the radar channel.

Parameters:
<AregMappingMTS> NONE | SEN1 | SEN2 | SEN4 | SEN3 | SEN5 | SEN6 | SEN7 |

SEN8
NONE
No sensor is mapped.
SEN1|SEN2|SEN4|SEN3|SEN5|SEN6|SEN7|SEN8
Selects the respective sensor and maps it to the radar channel.
*RST: NONE

Manual operation: See "Sensor/DUT" on page 168

[:SOURce<hw>]:AREGenerator:SWUNit:MAPPing<ch>[:SUBChannel<st>]:
CONFig?

Requires [:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe] 1.

Queries the channel RX / channel TX configuration between the switching unit and the
R&S AREG800A.

Example: :SOURce1:AREGenerator:SWUNit:MAPPing1:CONFig?
"A1: M01 (0111) / M01 (0112)"

Usage: Query only

Manual operation: See "Switching Unit Con." on page 167
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12.16.7.3  Frontend commands

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:OTA:OFFSet......................467
[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>|CFE<ch>:RX|TX:OTA:OFFSet..............467
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:ATS........467
[:SOURce<hw>]:AREGenerator:FRONtend:LAST:QAT|FE|CFE?........................................ 468
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:ADD................................................ 468
[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>:ADD.................................................. 468
[:SOURce<hw>]:AREGenerator:FRONtend:CFE<ch>:ADD................................................ 468
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:CHANnels?......................................468
[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>:RX|TX:EFRontend.............................. 469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:CONNect|DISConnect...........469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:HOSTname......................................469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:IPADdress........................................469
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:OR.................................................. 470
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:MODE............................................. 470
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>|CFE<ch>:RMV..................... 470
[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:STATus?..............................470
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:STATe]................471
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:MODE]............... 471
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:FPOints................................................................................................ 471
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:EXPort..................................................................................................472
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:FLISt.................................................................................................... 472
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:FLISt:ROW<di>..................................................................................... 472
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:IMPort...................................................................................................473
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:IMPort:PREDefined................................................................................473
[:SOURce<hw>]:AREGenerator:FRONtend:ANTenna:CUSTom:IMPort:PREDefined:

CATalog?............................................................................................................ 473
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:RX|TX:GLISt..........................................................................................474
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:

CUSTom:RX|TX:GLISt:ROW<di>.......................................................................... 474
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:GAIN:RX........................... 474
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:GAIN:TX............................475
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:ALIas..... 475
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>:BW....................... 475
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:

CABLecorr:CONNector<di>:RX|TX:MODE............................................................. 475
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:MODE.............476
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:

CABLecorr:CONNector<di>:RX|TX:USER:ATTenuation........................................... 476
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:USER:

ATTenuation........................................................................................................ 477
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
CABLecorr:CONNector<di>:RX|TX:USER:DELay................................................... 477

[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:USER:DELay...477
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:

CABLecorr:CONNector<di>:RX|TX:USER:FILE...................................................... 478
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:USER:FILE......478
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CENTer.. 479
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:RTS....... 479
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:SNUMber.......................... 479
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:NAME?............................. 480
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:TYPE?... 480
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:ISELect........................................480
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:ADD.................................................... 480
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:ALIas...........................................481
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:HOSTname.................................. 481
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:DEVice[:ID]...................................481
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:APPLy......................................... 482
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:CLEan................................................. 482
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:DELete................................................ 482
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:LIST?...................................................482
[:SOURce<hw>]:AREGenerator:EXTernal:REMote:REName.............................................. 482
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP?............................................. 483
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP:PORT..................................... 483
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP:SENSor...................................483
[:SOURce<hw>]:AREGenerator:RADar:LSENsitivity..........................................................484
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:REFerence........... 484
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:REFerence:LIST?. 484
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CAL:ALL.................................484
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CONNection:STATe..................484
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CMODe.................................. 485
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:

CONFig:MODE....................................................................................................485
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:

CONFig:SELect...................................................................................................485
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:

CONFig:CATalog?................................................................................................486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND<ch>:

LOWer?.............................................................................................................. 486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND<ch>:

UPPer?...............................................................................................................486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:COUNt?..... 486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:IDN?.......................................486
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:OPT?..................................... 487
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:AMODe.................................. 487
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:POWer:ATTenuation................ 487
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:IPADdress?.............................488
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:NETWork................................488
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:MODE...................488
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[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:OUTPut:STATe.......489
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:INPut:FREQuency? 489
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:OUTPut:

FREQuency?.......................................................................................................489

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:OTA:OFFSet
<AregFeOtaOffset>

Specifies the length of the gap between frontend and target.

Parameters:
<AregFeOtaOffset> integer

Range: 0.01  to  30
*RST: 0.5

Example: See Example"Configuring TRX-type frontends" on page 453.

Example: See Example"Configuring QAT-type frontends" on page 454.

Manual operation: See "Air Gap" on page 127

[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>|CFE<ch>:RX|TX:OTA:OFFSet
<AregFeOtaOffset>

Specifies the length of the gap between frontend and target.

Parameters:
<AregFeOtaOffset> integer

Range: 0.01  to  30
*RST: 0.5

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "RX / TX Air Gap" on page 139

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
ATS <AregFeATS>

Sets the angle between frontend and radar sensor.

Reference point for the definition of the angle is the center of the frontend. The angle
describes the deviation of the position of the frontend from the 0° center position of the
field of view of the radar.

● Positive angle frontend to sensor: counter clockwise deviation of frontend position
to center position.

● Negative angle frontend to sensor: clockwise deviation of frontend position to cen-
ter position.
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Parameters:
<AregFeATS> float

Range: -90  to  90
Increment: 0.1
*RST: 0

Manual operation: See "Angle Frontend to Sensor" on page 137

[:SOURce<hw>]:AREGenerator:FRONtend:LAST:QAT|FE|CFE?

Queries the last added QAT-type, FE-type or custom frontend.

Displays the number included in the frontend ID, e.g. "3" for QAT-type frontend ID "Q3".

Return values: 
<AregFeLastAddQa> integer

Range: 0  to  8
*RST: n.a. (factory preset: 0)

Usage: Query only

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:ADD

Adds a configuration for a QAT-type frontend. A line with contiguous numeration is
added.

Usage: Event

Manual operation: See "Add" on page 125

[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>:ADD

Adds a configuration for an FE-type external frontend. A line with contiguous numera-
tion is added.

Example: See Example"Configuring FE-type frontends" on page 455.

Usage: Event

Manual operation: See "Add" on page 125

[:SOURce<hw>]:AREGenerator:FRONtend:CFE<ch>:ADD

Adds a configuration for a custom frontend. A line with contiguous numeration is
added.

Usage: Event

Manual operation: See "Add" on page 125

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:CHANnels?

Queries the number of channels set at the connected QAT-type frontend.
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The number of channels depends on the "QAT Channel Mode".

Return values: 
<AregFEQatChanne> integer

Range: 0  to  8
*RST: 0

Usage: Query only

Manual operation: See "QAT Channels" on page 134

[:SOURce<hw>]:AREGenerator:FRONtend:FE<ch>:RX|TX:EFRontend
<InstrName>

Selects the external frontend to connect to the R&S AREG800A.

Parameters:
<InstrName> string

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "RX / TX Frontend" on page 139

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:
CONNect|DISConnect

Triggers a connection procedure to connect the R&S AREG800A with the external
frontend in the network.

Example: See Example"Configuring QAT-type frontends" on page 454.

Example: See Example"Configuring FE-type frontends" on page 455.

Usage: Event

Manual operation: See "Connect" on page 133

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:HOSTname
<AregFeQatIpaddr>

Sets the hostname of the connected QAT-type frontend.

Parameters:
<AregFeQatIpaddr> string

Manual operation: See "QAT Hostname" on page 133

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:IPADdress
<AregFeQatIpaddr>

Sets the IP address of the connected QAT-type frontend.

Parameters:
<AregFeQatIpaddr> string
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Manual operation: See "QAT Hostname" on page 133

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:OR <AregFeOrient>

Sets the orientation parameter of the QAT in the test setup.

Parameters:
<AregFeOrient> VERTical | HORizontal

VERTical
The QAT is placed vertically in the test setup.
HORizontal
The QAT is placed horizontally in the test setup.
*RST: HORizontal

Manual operation: See "Orientation" on page 137

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>:MODE <AregFeQATMode>

Sets the channel mode including the channel settings for configuration of the channels
at the connected QAT-type frontend.

Parameters:
<AregFeQATMode> SINGle | MULTi

SINGle
Sets the configuration for single channel mode at the connected
QAT-type frontend.
MULTi
Sets the configuration for multi channel mode at the connected
QAT-type frontend.
*RST: SINGle

Manual operation: See "QAT Channel Mode" on page 133

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>|CFE<ch>:RMV

Removes the configuration of the connected QAT-type, FE-type or custom frontend.

Usage: Event

Manual operation: See "Remove" on page 125

[:SOURce<hw>]:AREGenerator:FRONtend:QAT<ch>|FE<ch>:STATus?

Queries the connection status of the connected QAT-type or FE-type frontend.

Return values: 
<AregFeQatStatus> DISConnected | DIALing | CONNected | CERRor | UPDate |

UERRor
DISConnected
Frontend is disconnected.
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DIALing
Tries to establish a frontend connection.
CONNected
Valid frontend connection is established.
CERRor
Network connection error.
UPDate
Update of the network connection is in progress.
UERRor
Update of the network connection failed.
*RST: DISConnected

Usage: Query only

Manual operation: See "Connect" on page 133

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:STATe]
<AregFeTrxAnCust>

Activates the configuration of a custom antenna assembly.

Parameters:
<AregFeTrxAnCust> OFF | ON | 1 | 0

*RST: OFF

Manual operation: See "Antenna Gain" on page 127

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:MODE]
<AregFeTrxAnCust>

Sets the source for defining the antenna gain.

Parameters:
<AregFeTrxAnCust> NONe | LIST

NONe
The antenna gain for TX and RX is defined by the antenna
mounted on the R&S AREG800A.
LIST
The antenna gain is defined in a list.
Define frequency points manually in a table or import an external
file with file extension *.csv or *.txt from a directory.
*RST: n.a. (factory preset: NONe)

Manual operation: See "Antenna Gain" on page 127

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:FPOints <AregFeCustAntFP>

Sets the number of frequencies that you want to define in the list.
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Parameters:
<AregFeCustAntFP> integer

Range: 1  to  512
*RST: 1

Manual operation: See "Frequency Points" on page 129

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:EXPort <ExportFilename>

Exports the defined frequency table to an external list file with file extension *.txt in a
directory.

Setting parameters: 
<ExportFilename> string

Example: :SOURce1:AREGenerator:FRONtend:TRX1:ANTenna:
CUSTom:EXPort "/var/user/MyTestAntenna"

Usage: Setting only

Manual operation: See "Export" on page 130

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:FLISt

For TRX-type frontend: Requires
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:
MODE] LIST.

Sets the values for frequency in the list. Enter all values of the list separated by
comma.

Example: //Set values of 72 GHz, 71 GHz, 70 GHz, 76GHz
:SOURce1:AREGenerator:FRONtend:TRX1:ANTenna:
CUSTom:FLISt
72000000000,71000000000,70000000000,76000000000

Manual operation: See "Frequency (GHz), Gain Rx (dBi), Gain Tx (dBi)"
on page 130

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:FLISt:ROW<di> <Frequency>

Sets the frequency value in the selected row of the list.

Parameters:
<Frequency> integer

Range: 500E6  to  1E12
*RST: 76E9

Manual operation: See "Frequency (GHz), Gain Rx (dBi), Gain Tx (dBi)"
on page 130
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:IMPort <ImportFileName>

Imports an external list with file extension *.txt from a directory.

The file format is a text file as comma-separated list with the list elements frequency,
RX gain and TX gain.

Setting parameters: 
<ImportFileName> string

Example: :SOURce1:AREGenerator:FRONtend:TRX1:ANTenna:
CUSTom:IMPort "/var/user/MyTestAntenna"

Usage: Setting only

Manual operation: See "Import" on page 129

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:IMPort:PREDefined <ImportFileName>

Imports a predefined file for standard antennas, stored on the R&S AREG800A.

Setting parameters: 
<ImportFileName> string

Example: :SOURce1:AREGenerator:FRONtend:TRX1:ANTenna:
CUSTom:IMPort:PREDefined
"ANT_WR12_10DB_1324.5030.00"

Usage: Setting only

Manual operation: See "Import" on page 129

[:SOURce<hw>]:AREGenerator:FRONtend:ANTenna:CUSTom:IMPort:
PREDefined:CATalog?

Queries all predefined files for standard antennas stored on the R&S AREG800A.

Return values: 
<>

Example: :SOURce1:AREGenerator:FRONtend:ANTenna:CUSTom:
IMPort:PREDefined:CATalog?
ANT_WR12_10DB_1324.5030.00

Usage: Query only

Manual operation: See "Import" on page 129
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:RX|TX:GLISt

For TRX-type frontend: Requires
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:
MODE] LIST.

Sets the values for antenna gain RX/TX in the list. Enter all values of the list separated
by comma.

Example: //Set values of 10 dBi, 12 dBi, 11 dBi, 15 dBi
as gain RX
:SOURce1:AREGenerator:FRONtend:TRX1:ANTenna:
CUSTom:RX:GLISt 10,12,11,15

Manual operation: See "Frequency (GHz), Gain Rx (dBi), Gain Tx (dBi)"
on page 130

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|FE<ch>|CFE<ch>:ANTenna:
CUSTom:RX|TX:GLISt:ROW<di> <Gain>

Sets the value for antenna gain RX/TX in the selected row of the list.

Parameters:
<Gain> integer

Range: -50  to  50
*RST: 10

Manual operation: See "Frequency (GHz), Gain Rx (dBi), Gain Tx (dBi)"
on page 130

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:GAIN:RX
<AregFeTrxAnRX>

Requires
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:
MODE] NONe.

Displays the antenna gain of the receiving antenna (RX) that is mounted on the
R&S AREG800A.

Parameters:
<AregFeTrxAnRX> float

Range: 0  to  30
Increment: 0.01
*RST: 10

Manual operation: See "AREG Antenna Gain RX" on page 128
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:GAIN:TX
<AregFeTrxGainTx>

Requires
[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:ANTenna:CUSTom[:
MODE] NONe.

Displays the antenna gain of the transmitting antenna (TX) that is mounted on the
R&S AREG800A.

Parameters:
<AregFeTrxGainTx> float

Range: 0  to  30
Increment: 0.01
*RST: 10

Manual operation: See "AREG Antenna Gain TX" on page 128

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
ALIas <AregFeAlias>

Sets the alias of the frontend.

Parameters:
<AregFeAlias> string

Manual operation: See "Alias" on page 125

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>:BW
<AregFeBw>

Displays the frequency bandwidth of the output signal of the connected frontend.

Parameters:
<AregFeBw> float

Range: 0  to  10E9
Increment: 0.1
*RST: 500E6

Manual operation: See "Frontend Bandwidth" on page 130

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
CABLecorr:CONNector<di>:RX|TX:MODE <aregCabelCorMod>

Selects the source for cable correction data.

Parameters:
<aregCabelCorMod> USER | S2P | FACTory

USER
Selects user-defined cable correction data, i.e. fixed values for
delay and attenuation.
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S2P
Selects cable correction data from a file with file extension
*.s2p.
FACTory
For TRX-type frontends only.
Selects cable correction data for the TRX frontend from factory
specification.
*RST: n.a. (factory preset: USER)

Manual operation: See "Source" on page 155

[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
MODE <AregCabelCorMod>

Selects the source for cable correction data.

Parameters:
<AregCabelCorMod> USER | S2P | FACTory

USER
Selects user-defined cable correction data, i.e. fixed values for
delay and attenuation.
S2P
Selects cable correction data from a file with file extension
*.s2p.
FACTory
For TRX-type frontends only.
Selects cable correction data for the TRX frontend from factory
specification.
*RST: n.a. (factory preset: USER)

Manual operation: See "Source" on page 155

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
CABLecorr:CONNector<di>:RX|TX:USER:ATTenuation <AregCableCorrAt>

Requires
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
MODE USER or
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
MODE S2P.

Sets a user-defined attenuation value.
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Parameters:
<AregCableCorrAt> float

Range: -50  to  50
Increment: 0.1
*RST: n.a. (factory preset: 0)

Manual operation: See "User Attenuation" on page 155

[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
USER:ATTenuation <AregCableCorrAt>

Requires
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
MODE USER or
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
MODE S2P.

Sets a user-defined attenuation value.

Parameters:
<AregCableCorrAt> float

Range: -50  to  50
Increment: 0.1
*RST: n.a. (factory preset: 0)

Manual operation: See "User Attenuation" on page 155

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
CABLecorr:CONNector<di>:RX|TX:USER:DELay <AregCableCorDel>

Requires
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
MODE USER.

Sets a user-defined delay value.

Parameters:
<AregCableCorDel> float

Range: 0  to  50
Increment: 0
*RST: n.a. (factory preset: 0)

Manual operation: See "User Delay" on page 155

[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
USER:DELay <AregCableCorDel>

Requires
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
MODE USER.
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Sets a user-defined delay value.

Parameters:
<AregCableCorDel> float

Range: 0  to  50
Increment: 0.1
*RST: n.a. (factory preset: 0)

Manual operation: See "User Delay" on page 155

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
CABLecorr:CONNector<di>:RX|TX:USER:FILE <AregCableCorFil>

Requires
[:SOURce<hw>]:AREGenerator:FRONtend:
TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:CABLecorr:CONNector<di>:RX|TX:
MODE S2P.

Loads a cable correction data file with file extension *.s2p from the default or the
specified directory.

Parameters:
<AregCableCorFil> string

Example: //Load correction file "100.s2p" from the default directory

SOURce1:AREGenerator:FRONtend:TRX1:CABLecorr:CONNector:TX:
USER:FILE "/var/user/100.s2p"

Manual operation: See "s2p File" on page 156

[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
USER:FILE <AregCableCorFil>

Requires
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:
MODE S2P.

Loads a cable correction data file with file extension *.s2p from the default or the
specified directory.

Parameters:
<AregCableCorFil> string

Example: //Load correction file "100.s2p" from the default directory

SOURce1:AREGenerator:SWUNit:CABLecorr:CONNector:TX:
USER:FILE "/var/user/100.s2p"

Manual operation: See "s2p File" on page 156
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
CENTer <AregFeCenterFre>

Sets the RF center frequency of the output signal of the connected frontend.

The frontend center frequency and frequency range depend on the configuration of the
R&S AREG800A and the configuration of the frontend included in the test setup. For
more information, see the data sheet.

When using custom frontends, the IF center frequency instead of the RF center fre-
quency is configurable in the frontend configuration. The IF center frequency with the
sensor bandwidth is used for the cable correction, whereas the sensor frequency and
bandwidth is used for the antenna correction.

Parameters:
<AregFeCenterFre> float

Range: 0  to  100E9
Increment: 0.1
*RST: 0

Manual operation: See "Frontend Center Frequency" on page 130

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
RTS <AregFeRTS>

Sets the rotation angle between frontend and sensor.

Reference point for the definition of the angle is the center of the frontend. The rotation
describes the deviation of the position of the frontend from a 90° angle to the direct line
of sight of the sensor.

For TRX-type or custom frontends this parameter has currently no impact, since it is a
single sensor and no sensor array.

Parameters:
<AregFeRTS> float

Range: -60  to  60
Increment: 0.1
*RST: 0

Manual operation: See "Rotation Frontend to Sensor" on page 137

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:SNUMber
<AregFeSerNumber>

Queries the 6-digit serial number of the connected frontend.

Parameters:
<AregFeSerNumber> string

Manual operation: See "Frontend Serial Number" on page 130
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>:NAME?

Queries the name of the connected frontend.

Return values: 
<AregFEName> string

Usage: Query only

Manual operation: See "Frontend Type" on page 131

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>|QAT<ch>|FE<ch>|CFE<ch>:
TYPE?

Queries the type of the connected frontend.

Return values: 
<FrontendType> TRX | QAT | NONE | FE | CFE

TRX
A TRX-type frontend is connected.
QAT
A QAT-type frontend is connected.
NONE
No frontend is connected.
FE
An FE-type frontend is connected.
CFE
A custom frontend is connected.
*RST: NONE

Usage: Query only

Manual operation: See "Type" on page 125

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:ISELect
<InstrumentName>

Enables the addition of an external instrument to the list of available instruments.

Parameters:
<InstrumentName> string

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "Add Instrument" on page 142

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:ADD <InstrName>, <HwChan>,
<HostnameOrIp>[, <DeviceId>]

Adds an external frontend to the list of available instruments.
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Parameters:
<HwChan> String

Range: "Frontend"  to  "Frontend"
*RST: "Frontend"

<HostnameOrIp> String

<DeviceId> String
*RST: "FE44S-123456"

Setting parameters: 
<InstrName> String

Usage: Setting only

Manual operation: See "Add Instrument" on page 142

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:ALIas <SymbolicName>

Requires SOURce1:AREGenerator:EXTernal:REMote:EDIT:ISELect "New" to
enable the function.

Sets the name of the FE-type frontend.

Parameters:
<SymbolicName> string

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "Add Instrument" on page 142

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:HOSTname
<HostnameOrIp>

Requires SOURce1:AREGenerator:EXTernal:REMote:EDIT:ISELect "New" to
enable the function.

Sets the hostname or IP address of the FE-type frontend.

Parameters:
<HostnameOrIp> string

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "Add Instrument" on page 142

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:DEVice[:ID] <DeviceId>

Requires SOURce1:AREGenerator:EXTernal:REMote:EDIT:ISELect "New" to
enable the function.

Sets the device ID of the FE-type frontend.

Parameters:
<DeviceId> string
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Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "Add Instrument" on page 142

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:EDIT:APPLy

Requires SOURce1:AREGenerator:EXTernal:REMote:EDIT:ISELect "New" to
enable the function.

Adds the defined external frontend to the list of available instruments.

Example: See Example"Configuring FE-type frontends" on page 455.

Usage: Event

Manual operation: See "Add Instrument" on page 142

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:CLEan

Removes all external frontends from list of available instruments.

Usage: Event

Manual operation: See "Delete All" on page 143

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:DELete

Removes the external frontend from the list of available instruments.

Usage: Setting only

Manual operation: See "External instrument information" on page 143

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:LIST?

Queries the list of all available external frontends.

Return values: 
<InstrNames> String

Usage: Query only

Manual operation: See "External instrument information" on page 143

[:SOURce<hw>]:AREGenerator:EXTernal:REMote:REName

Sets the alias name of the external instrument in the list of external instruments.

Usage: Setting only

Manual operation: See "External instrument information" on page 143
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[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP?

Queries the calculated Effective Isotropic Radiated Power of the power sensor connec-
ted to the TRX-type frontend.

Return values: 
<AregRadarEirp> float

Range: -150  to  150
Increment: 0.001
*RST: 0

Usage: Query only

Manual operation: See "Eirp" on page 131

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP:PORT <Port>

Selects the port of the connected R&S NRP power sensor for calculating the EIRP.

Parameters:
<Port> POW | AUX

POW
The R&S NRP power sensor is connected to the "RX power"
port of the frontend.
AUX
The R&S NRP power sensor is connected to the "Aux IF Out"
port of the R&S AREG800A.
*RST: n.a. (no preset. default: POW)

Manual operation: See "Meas. Port" on page 131

[:SOURce<hw>]:AREGenerator:FRONtend:TRX<ch>:EIRP:SENSor
<AregPowSenSelec>

Selects the R&S NRP power sensor connected to the TRX-type frontend for calculating
the EIRP value.

Parameters:
<AregPowSenSelec> SEN4 | SEN3 | SEN2 | SEN1 | UDEFined

SEN4|SEN3|SEN2|SEN1
Selects the respective R&S NRP power sensor for the TRX-type
frontend.
UDEFined
No R&S NRP power sensor is connected to the TRX-type fron-
tend.
*RST: n.a. (no preset. default: UNDefined)

Manual operation: See "Power Sensor" on page 131
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[:SOURce<hw>]:AREGenerator:RADar:LSENsitivity <AregRadarLowSen>

Defines if low sensitivity is used or not.

Parameters:
<AregRadarLowSen> 1 | ON | 0 | OFF

*RST: 1

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
REFerence <FERefFreq>

Sets the reference frequency, that is used for RF frequency conversion at the connec-
ted external frontend.

Parameters:
<FERefFreq> FG64 | F1G | F10M

FG64
640 MHz
F1G
1 GHz
F10M
10 MHz

Manual operation: See "Reference Frequency" on page 144

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
REFerence:LIST?

Queries reference frequencies of connected RF frontends in a comma-separated list.

Usage: Query only

Manual operation: See "Reference Frequency" on page 144

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CAL:ALL

Starts all internal calibration routines to adjust the connected external frontend.

Usage: Event

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CONNection:STATe
<ConnState>

Queries the state of the connection between R&S AREG800A and external frontend.

Parameters:
<ConnState> 1 | ON | 0 | OFF

*RST: 0
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[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:CMODe
<FeConnMode>

Sets the mode of the SSL control connection between R&S AREG800A and external
frontend.

Parameters:
<FeConnMode> AUTO | LOCK | RXTX

AUTO
The R&S AREG800A locks external frontend, when activating
the RF output at the R&S AREG800A ("RF" > "On") for output of
the IF signal.
The R&S AREG800A unlocks external frontend, when deactivat-
ing the RF output at the R&S AREG800A ("RF" > "Off").
This is the recommended setting for the R&S AREG800A.
LOCK
The external frontend is locked permanently. No other instru-
ment can take over control.
RXTX
Not available for R&S AREG800A.

Manual operation: See "Connection Mode" on page 145

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:
CONFig:MODE <Mode>

Sets the mode for frequency band configuration of the external frontend.

Parameters:
<Mode> AUTO | MANual

AUTO
Configures the frequency band automatically.
MANual
Uses the frequency band configured by [:SOURce<hw>]:
AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND:CONFig:SELect on page 485.
*RST: AUTO

Manual operation: See "Mode" on page 145

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:
CONFig:SELect <SelBandConfig>

Selects the frequency band configuration for the connected external frontend.

Enter the mode as string, e.g. "IF Low".

Parameters:
<SelBandConfig> string

Manual operation: See "Frequency Band Config" on page 145
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[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:
CONFig:CATalog? <CatalogFiles>

Queries the selectable frequency band configuration modes.

Parameters:
<CatalogFiles> string

Returns a string of selectable frequency band configuration
modes separated by commas.

Usage: Query only

Manual operation: See "Frequency Band Config" on page 145

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND<ch>:LOWer?

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:
BAND<ch>:UPPer?

Queries the lower/upper limit of the corresponding frequency band.

Return values: 
<FEFreqBandUp> float

Usage: Query only

Manual operation: See "Frequency Band x" on page 146

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:FREQuency:BAND:
COUNt?

Queries the number of frequency bands available at the connected external frontend.

Return values: 
<FEFreqCount> integer

Usage: Query only

Manual operation: See "Frequency Band x" on page 146

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:IDN?

Identification

Returns the IDN string, i.e. the identification of the external frontend.

Return values: 
<IdnString> string

Usage: Query only

Manual operation: See "Hardware Config" on page 147
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[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:OPT?

Option identification query

Queries the options included in the external frontend. For a list of all available options
and their description, refer to the data sheet.

Return values: 
<OptString> string

The query returns a list of options. The options are returned at
fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

Manual operation: See "Hardware Config" on page 147

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:AMODe
<AttenuationMode>

Sets the attenuator mode of the external frontend.

Parameters:
<AttenuationMode> AUTO | MANual | AOFFset

AUTO
Sets the attenuation value automatically to the attenuation value
provided from the connected external frontend.
MANual
Sets an attenuation value manually.
*RST: AUTO

Manual operation: See "Mode" on page 148

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:POWer:ATTenuation
<Attenuation>

Requires [SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:AMODe
MANual.

Sets the attenuation of the external frontend.

Parameters:
<Attenuation> float

Range: depends on connected device  to  depends on con-
nected device

Increment: depends on connected device
*RST: 0

Manual operation: See "Attenuation" on page 148
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[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:IPADdress?

Queries the IP address of the connected external frontend.

Return values: 
<IPAddress> string

Usage: Query only

Manual operation: See "IP Address" on page 149

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:NETWork
<IpAddress>, <SubnetMask>, <DhcpOn>

Sets network parameters of the external frontend.

Parameters:
<IpAddress> string

IP address of the external frontend
*RST: 127.0.0.1

<SubnetMask> string
Bit group of the subnet in the host identifier
*RST: 255.255.255.0

<DhcpOn> integer
DHCP state
Range: 0  to  1
*RST: 1

Manual operation: See "Apply" on page 150

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:MODE
<Mode>

Selects the LO input source for the connected external frontend.

Parameters:
<Mode> INTernal | EXTernal

INTernal
Uses the internally generated LO signal.
EXTernal
Uses an externally supplied LO signal.
*RST: n.a. (factory preset: INTernal)

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "Mode" on page 150
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[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:OUTPut:
STATe <OutState>

Activates or deactivates the LO output of the connected external frontend.

Parameters:
<OutState> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example"Configuring FE-type frontends" on page 455.

Manual operation: See "Out State" on page 151

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:INPut:
FREQuency?

Requires
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:
MODE EXTernal.

Queries the required frequency on the "LO In" connector of the connected external
frontend.

Return values: 
<LoInFreq> float

Usage: Query only

Manual operation: See "Mandatory LO IN Frequency" on page 151

[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:OUTPut:
FREQuency?

Requires
[:SOURce<hw>]:AREGenerator:EFRontend:FE<ch>:RX|TX:LOSCillator:
OUTPut:STATe 1.

Queries the current frequency on the "LO Out" connector of the connected external
frontend.

Return values: 
<OutputFrequency> float

Usage: Query only

Manual operation: See "LO OUT Frequency" on page 151

12.16.7.4  Switching unit commands

[:SOURce<hw>]:AREGenerator:SWUNit:HOSTname........................................................ 490
[:SOURce<hw>]:AREGenerator:SWUNit:CONNect|DISConnect......................................... 490
[:SOURce<hw>]:AREGenerator:SWUNit:STATus?............................................................ 490
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[:SOURce<hw>]:AREGenerator:SWUNit:HOSTname <AregSwunitHost>

Sets the IP address or hostname of the connected switching unit in the test setup.

Parameters:
<AregSwunitHost> string

Manual operation: See "IP / Hostname" on page 170

[:SOURce<hw>]:AREGenerator:SWUNit:CONNect|DISConnect

Triggers connection to the switching unit.

The R&S AREG800A connects or disconnects the switching unit as configured by its
IP address or hostname.

Usage: Event

Manual operation: See "Connect/Disconnect" on page 170

[:SOURce<hw>]:AREGenerator:SWUNit:STATus?

Queries the status of the switching unit.

Displays if the switching unit is connected or disconnected.

Return values: 
<AregSWunitStatu> string

Usage: Query only

Manual operation: See "Connect/Disconnect" on page 170

12.16.8  Sensor commands

This section describes the commands to configure the radar sensors in the test setup.

[:SOURce<hw>]:AREGenerator:SENSor<ch>:ADD........................................................... 490
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ALIas..........................................................491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ANGLe....................................................... 491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:BW.............................................................491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:CFACtor......................................................491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:CENTer.......................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:COUNt?......................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:DISTance....................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:DYNamic:ID................................................ 492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ID...............................................................493
[:SOURce<hw>]:AREGenerator:SENSor<ch>:RMV...........................................................493

[:SOURce<hw>]:AREGenerator:SENSor<ch>:ADD

Adds a configuration for a connected sensor. A line with contiguous numeration is
added.
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Usage: Event

Manual operation: See "Add Sensor" on page 158

[:SOURce<hw>]:AREGenerator:SENSor<ch>:ALIas <AregSensAlias>

Sets the alias of the radar sensor.

Parameters:
<AregSensAlias> string

Manual operation: See "Alias" on page 157

[:SOURce<hw>]:AREGenerator:SENSor<ch>:ANGLe <AregSensSTOAngl>

Sets the relative angle between radar sensor and origin.

Parameters:
<AregSensSTOAngl> integer

Range: -180  to  180
Increment: 0.1
*RST: 0

Manual operation: See "Relative Angle" on page 159

[:SOURce<hw>]:AREGenerator:SENSor<ch>:BW <AregSensBW>

Sets the bandwidth for the radar sensor.

Set it according to the bandwith of the radar sensor included in the test setup.

Parameters:
<AregSensBW> integer

Range: 0  to  10E9
Increment: 0.1
*RST: n.a. (factory preset: 1E9)

Manual operation: See "Bandwidth" on page 159

[:SOURce<hw>]:AREGenerator:SENSor<ch>:CFACtor <AregSensCrestFa>

Sets the crest factor for the signal.

Parameters:
<AregSensCrestFa> float

Range: 0  to  100
Increment: 0.1
*RST: n.a. (factory preset: 0)

Manual operation: See "Signal Crest Factor" on page 159
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[:SOURce<hw>]:AREGenerator:SENSor<ch>:CENTer <AregSensCentFre>

Sets the center frequency for the radar sensor.

Set it according to the center frequency of the radar sensor included in the test setup.

Parameters:
<AregSensCentFre> integer

Range: depends on settings  to  depends on settings
*RST: 0

Manual operation: See "Center Frequency" on page 159

[:SOURce<hw>]:AREGenerator:SENSor<ch>:COUNt?

Queries the number of radar sensors in the test setup.

Return values: 
<AregSensorCount> integer

Range: 0  to  8
*RST: n.a. (factory preset: 1)

Usage: Query only

[:SOURce<hw>]:AREGenerator:SENSor<ch>:DISTance <AregSensSTODist>

Sets the relative distance between radar sensor and origin.

Parameters:
<AregSensSTODist> integer

Range: 0  to  30
Increment: 0.01
*RST: 0

Manual operation: See "Relative Distance" on page 159

[:SOURce<hw>]:AREGenerator:SENSor<ch>:DYNamic:ID <AregSConfDynId>

Requires: [:SOURce<hw>]:AREGenerator:OSETup:REFerence MAPPed.

Sets the ID of the radar sensor according to the definition in the used protocol, e.g. in a
ZMQ OSI HiL protocol.

The mapping is defined in the object list of the used protocol, e.g. the "sensor_id" field
in the osi3::sensorData struct for all OSI protocols.

Parameters:
<AregSConfDynId> integer

Range: 0  to  1000
*RST: 0

Manual operation: See "Dynamic Mode ID" on page 159
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[:SOURce<hw>]:AREGenerator:SENSor<ch>:ID <AregSensID>

Queries the identification name of the radar sensor.

Parameters:
<AregSensID> integer

Range: 0  to  1000
*RST: 0

Manual operation: See "ID" on page 157

[:SOURce<hw>]:AREGenerator:SENSor<ch>:RMV

Removes the configuration of the radar sensor from the list.

Usage: Event

Manual operation: See "Remove Sensor" on page 157

12.16.9  Operation setup commands

This section describes the commands of the OSETup subsystem, necessary to config-
ure the general settings of the test setup, for example a HiL scenario, and to configure
marker settings or a multi-instrument setup.

Example: Configuring general operation setup settings

// Configure the operation setup mode
SOURce1:AREGenerator:OSETup:MODE STATic
SOURce1:AREGenerator:OSETup:APPLy
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Example: Configuring a HiL scenario
This example provides information on how to configure a HiL scenario.
// Configure the HiL test setup
SOURce1:AREGenerator:OSETup:MODE DYNamic
SOURce1:AREGenerator:OSETup:SOURce HIL
SOURce1:AREGenerator:OSETup:HOSTname "testhost"
SOURce1:AREGenerator:OSETup:PORT 1
SOURce1:AREGenerator:OSETup:PROTocol ZMQ
SOURce1:AREGenerator:OSETup:APPLy 

// Configure object reference, HiL update mode and timebase
SOURce1:AREGenerator:OSETup:REFerence ORIGin
SOURce1:AREGenerator:OSETup:HIL:UPD IMMediate
SOURce1:AREGenerator:OSETup:TBASe SIMulation
SOURce1:AREGenerator:MARKer:OBJect:SOURce HIL

// Configure the QAT-type frontend in the test setup
SOURce1:AREGenerator:FRONtend:QAT1:ADD 
SOURce1:AREGenerator:FRONtend:LAST:QAT?
SOURce1:AREGenerator:FRONtend:QAT1:HOSTname "myQAT"
SOURce1:AREGenerator:FRONtend:QAT1:CONNect
SOURce1:AREGenerator:FRONtend:QAT1:MODE SINGle

// Configure the geometry parameter of the frontend
SOURce1:AREGenerator:FRONtend:QAT1:ATS 45
SOURce1:AREGenerator:FRONtend:QAT1:RTS 10
SOURce1:AREGenerator:FRONtend:QAT1:OR HORizontal

// Channel mapping of frontend and sensor
SOURce1:AREGenerator:MAPPing1:SUBChannel1:FE QAT1CH1
SOURce1:AREGenerator:MAPPing1:SENSor SEN1
SOURce1:AREGenerator:MAPPing1:ADJust:ALL

Example: Configuring multi instrument settings
This example provides information on how to configure the connection between a pri-
mary R&S AREG800A instrument and four secondary R&S AREG800A instruments.
// *****************************************************************************
// Operate your R&S AREG800A as a control instrument.
// *****************************************************************************
SOURce1:AREGenerator:OSETup:MODE DYNamic
SOURce1:AREGenerator:OSETup:MULTinstrument:MODE?
// Response: "OFF"
// The R&S AREG800A operates in standalone mode.
// Set for primary mode.
SOURce1:AREGenerator:OSETup:MULTinstrument:MODE PRIM

// *****************************************************************************
// Remove connected secondary R&S AREG800A instruments.
// *****************************************************************************
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SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:HOSTname?
// Response: "AREG800A-00"
// Remove this secondary instrument with hostname AREG800A-00.
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:REMove
// The control connection to the primary instrument is terminated.
SOURce1:AREGenerator:OSETup:MULTiinstrument:SECondary1:CONNection:STATe?
// Response: "DISConnected"
// The firmware saves the hostname, if you want to add this secondary instrument
// for correct multi-instrument mapping.
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:ADD
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:HOSTname?
// Response: "AREG800A-00"

// *****************************************************************************
// Add and connect four secondary R&S AREG800A instruments.
// *****************************************************************************
// Specify and add the first secondary R&S AREG800A instrument for
// the control connection.
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:HOSTname AREG800A-01
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:ADD
// Specify and add the other secondary R&S AREG800A instruments.
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary2:HOSTname AREG800A-02
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary2:ADD
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary3:HOSTname AREG800A-03
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary3:ADD
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary4:HOSTname AREG800A-04
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary4:ADD
// Connect all secondary R&S AREG800A instruments.
SOURce1:AREGenerator:OSETup:MULTinstrument:CONNect
// Query connection states of the secondary R&S AREG800A instruments.
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary1:CONNection:STATe?
// Response: "CONNected"
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary2:CONNection:STATe?
// Response: "DISConnected"
// The second secondary instrument is disconnected form the control connection.
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary3:CONNection:STATe?
// Response: "TDISconnecting"
// Triggering disconneting the third secondary instrument. 
SOURce1:AREGenerator:OSETup:MULTinstrument:SECondary4:CONNection:STATe?
// Response: "CERRor"
// A connection error occurs for the control connection between the primary
// instrument and the fourth secondary instrument.

Commands

● General commands...............................................................................................496
● HiL/ViL commands................................................................................................498
● Object marker commands.....................................................................................501
● Multi instrument setup commands........................................................................ 502

SOURce subsystem



Remote control commandsR&S®AREG800A

496User Manual 1179.3615.02 ─ 06

12.16.9.1  General commands

[:SOURce<hw>]:AREGenerator:OSETup:APPLy...............................................................496
[:SOURce<hw>]:AREGenerator:OSETup:MODE...............................................................496
[:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe]................................................. 496
[:SOURce<hw>]:AREGenerator:OSETup:BW................................................................... 497
:SOURce<hw>:AREGenerator:OSETup:CONFig...............................................................497
[:SOURce<hw>]:AREGenerator:OSETup:BW:APPLy.........................................................497
[:SOURce<hw>]:AREGenerator:OSETup:REFerence........................................................ 497
[:SOURce<hw>]:AREGenerator:OSETup:TBASe.............................................................. 498
[:SOURce<hw>]:AREGenerator:OSETup:SOURce............................................................498

[:SOURce<hw>]:AREGenerator:OSETup:APPLy

Assigns and confirms the settings.

Example: Example"Configuring general operation setup settings"
on page 493.

Usage: Event

Manual operation: See "Apply" on page 191
See "Ok" on page 191

[:SOURce<hw>]:AREGenerator:OSETup:MODE <AregOSetMode>

Define the operation setup mode.

Parameters:
<AregOSetMode> STATic | DYNamic

STATic
Simulates static radar objects.
DYNamic
Simulates dynamic radar objects.
*RST: STATic

Example: Example"Configuring general operation setup settings"
on page 493.

Manual operation: See "Mode" on page 190

[:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe] <AregOSetSwUnit>

Activates using a switching unit in the test setup, e.g. R&S OSP open switch and con-
trol platform.

A switching unit in the test setup allows you to connect up to eight QAT channels to
less than eight R&S AREG800A IF ports.

Parameters:
<AregOSetSwUnit> 1 | ON | 0 | OFF

*RST: 0
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Manual operation: See "Use Switching Unit" on page 191

[:SOURce<hw>]:AREGenerator:OSETup:BW <AregOsetupBw>

Sets the bandwidth of the IF output channel frequencies.

Parameters:
<AregOsetupBw> BW1G | BW2G | BW5G

BW1G
Sets the bandwidth to 1 MHz.
BW2G
Sets the bandwidth to 2 MHz.
BW5G
Sets the bandwidth to 5 MHz.

Manual operation: See "Bandwidth x" on page 197

:SOURce<hw>:AREGenerator:OSETup:CONFig <ModeLLM>

Sets the configuration mode of the IF output channel.

Parameters:
<ModeLLM> STD | NR

STD
The IF output channel works in standard mode.
NR
Requires R&S AREG8-K814.
The IF output channel works in FMCW near range mode.
This setting provides low latency at the IF output and allows you
to simulate minimum distances between frontend and DUT of
the length of the air gap.
*RST: STD

Manual operation: See "Configuration x" on page 198

[:SOURce<hw>]:AREGenerator:OSETup:BW:APPLy

Assigns and confirms the settings.

Usage: Event

Manual operation: See "Apply/Ok" on page 198

[:SOURce<hw>]:AREGenerator:OSETup:REFerence <AregOsetupRef>

Sets the object reference.

Parameters:
<AregOsetupRef> ORIGin | MAPPed
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ORIGin
Sets the object reference to the origin in the polar coordinates
map.
MAPPed
Sets a mapped sensor as object reference.
*RST: ORIGin

Manual operation: See "Object Reference" on page 192

[:SOURce<hw>]:AREGenerator:OSETup:TBASe <SetupTimeBase>

Sets the time base of the logged data.

Parameters:
<SetupTimeBase> SYSTem | SIMulation

SYSTem
The system time from the setup menu serves as time base.
SIMulation
The time stamp from the used scenario, e.g. from an OSI mes-
sage, serves as time base.
*RST: SIMulation

Manual operation: See "Timebase" on page 192

[:SOURce<hw>]:AREGenerator:OSETup:SOURce <AregOSetSource>

Requires [:SOURce<hw>]:AREGenerator:OSETup:MODE DYNamic.

Sets the data source for the dynamic operation.

Parameters:
<AregOSetSource> SCENario | HIL

SCENario
Sets for dynamic radar object simulation scenarios.
HIL
Sets the data source to hardware in the loop (HiL) or vehicle in
the loop (ViL) scenarios.
*RST: SCENario

Manual operation: See "Data Source" on page 190

12.16.9.2  HiL/ViL commands

[:SOURce<hw>]:AREGenerator:HIL:RATE?......................................................................499
[:SOURce<hw>]:AREGenerator:HIL:RECeived................................................................. 499
[:SOURce<hw>]:AREGenerator:OSETup:HOSTname....................................................... 499
[:SOURce<hw>]:AREGenerator:OSETup:IPADdress......................................................... 499
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[:SOURce<hw>]:AREGenerator:OSETup:PORT................................................................500
[:SOURce<hw>]:AREGenerator:OSETup:PROTocol.......................................................... 500
[:SOURce<hw>]:AREGenerator:OSETup:HIL:UPD............................................................501

[:SOURce<hw>]:AREGenerator:HIL:RATE?

Queries the update rate of HiL/ViL commands that are transmitted via the open simula-
tion interface (OSI).

Return values: 
<HiL> float

Range: 0  to  1E9
Increment: 1E3
*RST: 0

Example: See Example"Configuring the realtime control network interface"
on page 425.

Usage: Query only

[:SOURce<hw>]:AREGenerator:HIL:RECeived <HilDataReceived>

Queries the receive state of HiL/ViL data via the open simulation interface (OSI).

Parameters:
<HilDataReceived> NOData | RECeived | NOTHil

NOData
No data received via OSI.
RECeived
Receives data via OSI.
NOTHil
Non HiL/ViL-compliant data received via OSI.
*RST: NOData

Example: See Example"Configuring the realtime control network interface"
on page 425.

[:SOURce<hw>]:AREGenerator:OSETup:HOSTname

Requires "Data Source > HiL/ViL".

Sets the hostname of the R&S AREG800A for the hardware in the loop (HiL) or vehicle
in the loop (ViL) scenario controller.

Manual operation: See "Host IP Adress/ Hostname" on page 190

[:SOURce<hw>]:AREGenerator:OSETup:IPADdress

Requires "Data Source > HiL/ViL".
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Sets the IP address of the R&S AREG800A for the hardware in the loop (HiL) or vehi-
cle in the loop (ViL) scenario controller.

Parameters:
<IpAddress> string

Range: 0.0.0.0.  to  ff.ff.ff.ff

Manual operation: See "Host IP Adress/ Hostname" on page 190

[:SOURce<hw>]:AREGenerator:OSETup:PORT <AregOSetPort>

Requires "Data Source > HiL/ViL".

Sets the host port of the instrument for the hardware in the loop (HiL) or vehicle in the
loop (ViL) scenario controller.

Parameters:
<AregOSetPort> integer

Range: 0  to  64000
*RST: 0

Manual operation: See "Host Port" on page 191

[:SOURce<hw>]:AREGenerator:OSETup:PROTocol <AregOSetProtoco>

Sets the protocol type for protocol data of hardware in the loop (HiL) or vehicle in the
loop (ViL) scenarios.

Parameters:
<AregOSetProtocol> ZMQ | DCP | UDP | UDPR

ZMQ
Zero message queue (ZMQ) asynchronous messaging library.
The expected payload is the SensorData defined in the open
simulation interface (OSI).
DCP
Distributed co-simulation protocol (DCP).
The expected payload is the SensorData defined in the open
simulation interface (OSI).
UDP
User datagram protocol (UDP).
The expected payload is the SensorData defined in the open
simulation interface (OSI).
UDPR
User datagram protocol (UDP) raw data.
Raw is a Rohde & Schwarz proprietary format.
*RST: ZMQ

Manual operation: See "HiL - Protocol" on page 190
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[:SOURce<hw>]:AREGenerator:OSETup:HIL:UPD <UpdMode>

Sets the update mode for the HiL interface.

The timestamp is an optional part of the OSI packets.

Parameters:
<UpdMode> IMMediate | TIMestamp

IMMediate
Updates the simulated objects immediately on arrival of the OSI
packet. If there is a timestamp in the OSI packet, the timestamp
is not regarded.
TIMestamp
Updates the simulated objetcts when the system time reaches
the timestamp of the OSI packet.
*RST: IMMediate

Manual operation: See "HiL - Update Mode" on page 193

12.16.9.3  Object marker commands

[:SOURce<hw>]:AREGenerator:MARKer:OBJect:DELay................................................... 501
[:SOURce<hw>]:AREGenerator:MARKer:OBJect:ONTime................................................. 501
[:SOURce<hw>]:AREGenerator:MARKer:OBJect:SOURce................................................ 502

[:SOURce<hw>]:AREGenerator:MARKer:OBJect:DELay <ObjMarkerDelay>

Sets a delay time for the start of the object marker.

The delay time delays the marker signal at the marker output relative to the signal gen-
eration start.

Parameters:
<ObjMarkerDelay> integer

Range: -150000  to  150000
*RST: 0

Manual operation: See "Delay" on page 194

[:SOURce<hw>]:AREGenerator:MARKer:OBJect:ONTime <ObjMarkerOnTime>

Sets the on time (pulse width) of the object marker.

Parameters:
<ObjMarkerOnTime> float

Range: 10  to  150000
Increment: 5
*RST: 1000

Manual operation: See "On Time" on page 194
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[:SOURce<hw>]:AREGenerator:MARKer:OBJect:SOURce <ObjMarkerSource>

Sets the marker source used in the test setup.

Parameters:
<ObjMarkerSource> SETTing | SCENario | HIL

SETTing
Sets the object marker after a change in the radar object set-
tings.
SCENario
Requires: [:SOURce<hw>]:AREGenerator:OSETup:MODE
DYNamic and
[:SOURce<hw>]:AREGenerator:OSETup:SOURce
SCENario.
Sets the object marker at the restart of the replayed scenario.
HIL
Requires: [:SOURce<hw>]:AREGenerator:OSETup:MODE
DYNamic.
For [:SOURce<hw>]:AREGenerator:OSETup:SOURce HIL:
requires
[:SOURce<hw>]:AREGenerator:OSETup:PROTocol
ZMQ|DCP|UDP.
Sets the object marker according to a timestamp defined in the
open simulation interface (OSI) protocol.
*RST: SETTing

Manual operation: See "Marker Source" on page 194

12.16.9.4  Multi instrument setup commands

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:CONNect..................................502
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:MODE......................................503
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary:ADD....................... 503
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:

CONNection[:STATe]?.......................................................................................... 503
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:HOSTname.......504
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:REMove........... 504

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:CONNect

Triggers connection to all secondary instruments by establishing a control connection
via LAN.

The R&S AREG800A connects all secondary instruments as configured by their IP
address or hostname. See [:SOURce<hw>]:AREGenerator:OSETup:
MULTiinstrument:SECondary<st>:HOSTname on page 504.

Example: See Example"Configuring multi instrument settings"
on page 494.
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Usage: Event

Manual operation: See "Connect" on page 197

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:MODE <Mode>

Defines the operation mode of the R&S AREG800A in a multi-instrument setup.

Parameters:
<Mode> PRIMary | OFF | SECondary

PRIMary
The R&S AREG800A operates as a primary instrument. In this
mode, the R&S AREG800A controls several R&S AREG800A
instruments.
OFF
The R&S AREG800A operates in a standalone mode.
SECondary
Requires a control connection between this R&S AREG800A
instrument and a primary R&S AREG800A instrument.
The R&S AREG800A operates as a secondary instrument. In
this mode, the R&S AREG800A is controlled by a primary
R&S AREG800A instrument.
*RST: PRIMary

Example: See Example"Configuring multi instrument settings"
on page 494.

Manual operation: See "Multi Instrument Mode" on page 196

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary:ADD

Adds the configuration of the secondary instrument. Also triggers connecting the pri-
mary instrument for control the secondary instrument.

You can add previous secondary instruments configurations without specifying the
hostname again. The firmware saves hostname of the secondary instrument for correct
mapping.

Suffix: 
SECondary<st>

.
1 to 8

Example: See Example"Configuring multi instrument settings"
on page 494.

Usage: Event

Manual operation: See "Add Secondary" on page 196

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:
CONNection[:STATe]?

Queries the connection state of the secondary instrument.
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If you remove a secondary instrument, the connection state of this secondary instru-
ment is DISConnected.

Suffix: 
SECondary<st>

.
1 to 8

Return values: 
<ConnState> DISConnected | CONNected | TCONnencting | TDISconnecting |

CERRor
DISConnected
The secondary instrument is disconnected.
DISConnected
The secondary instrument is connected.
TDISconnecting
Triggers disconnecting the secondary instrument.
CERRor
Connection error.
*RST: CONNected

Example: See Example"Configuring multi instrument settings"
on page 494.

Usage: Query only

Manual operation: See "Status" on page 196

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:
HOSTname <Hostname>

Sets the IP address or hostname of the secondary instrument.

If you remove the secondary instrument, the firmware saves hostname of the secon-
dary instrument for correct mapping. For example, if you want to add the secondary
instrument again.

Suffix: 
SECondary<st>

.
1 to 8

Parameters:
<Hostname> string

Example: See Example"Configuring multi instrument settings"
on page 494.

Manual operation: See "Host Name/IP Address" on page 196

[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:
REMove

Removes the secondary instrument from connected R&S AREG800A instruments that
are listed in the primary instrument.
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Also, this command terminates the control connection between primary instrument and
the secondary instrument.

The firmware saves hostname of the secondary instrument for correct mapping. For
example, if you want to add the secondary instrument again.

Suffix: 
SECondary<st>

.
1 to 8

Example: See Example"Configuring multi instrument settings"
on page 494.

Usage: Event

Manual operation: See "Remove Secondary" on page 196

12.16.10  SOURce:ROSCillator subsystem

The SOURce:ROSCillator subsystem contains the commands for setting the exter-
nal and internal reference frequency.

The commands of this subsystem are not affected by an instrument reset (*RST
on page 355).
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Example: Configuring the reference oscillator
// Using the internal reference frequency
SOURce:ROSCillator:SOURce INT
// 10 MHz output
SOURce:ROSCillator:OUTPut:FREQuency:MODE DER10M

// using 10 MHz extenal reference frequency
SOURce:ROSCillator:PRESet 
SOURce:ROSCillator:SOURce EXT
SOURce:ROSCillator:EXTernal:RFOFf:STATe 1
SOURce:ROSCillator:EXTernal:FREQuency 10MHZ
SOURce:ROSCillator:EXTernal:SBANdwidth WIDE

// Query calibration value
CALibration:ROSCillator?
// 32767
// Set an internal source 
// Activate user-defined adjustment value of 1000
SOURce:ROSCillator:SOURce INT
SOURce:ROSCillator:INTernal:ADJust:STATe 1
SOURce:ROSCillator:INTernal:ADJust:VALue 1000

// to resume calibrated state
SOURce:ROSCillator:INTernal:ADJust:VALue 0
SOURce:ROSCillator:INTernal:ADJust:STATe 0
// or 
// SYSTem:FPRest

[:SOURce]:ROSCillator:PRESet...................................................................................... 506
[:SOURce]:ROSCillator:SOURce..................................................................................... 506
[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe].............................................................. 507
[:SOURce]:ROSCillator:EXTernal:FREQuency.................................................................. 507
[:SOURce]:ROSCillator:EXTernal:SBANdwidth..................................................................507
[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE......................................................... 508
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue.............................................................. 508
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe].............................................................508

[:SOURce]:ROSCillator:PRESet

Resets the reference oscillator settings.

Example: See Example"Configuring the reference oscillator" on page 506.

Usage: Event

Manual operation: See "Set to Default" on page 171

[:SOURce]:ROSCillator:SOURce <Source>

Selects between internal or external reference frequency.
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Parameters:
<Source> INTernal | EXTernal

*RST: n.a. (factory preset: INTernal)

Example: See Example"Configuring the reference oscillator" on page 506.

Manual operation: See "Source" on page 172

[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe] <State>

Determines that the RF output is turned off when the external reference signal is
selected, but missing.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example"Configuring the reference oscillator" on page 506.

Manual operation: See "Deactivate RF Output (if external reference is missing)"
on page 172

[:SOURce]:ROSCillator:EXTernal:FREQuency <Frequency>

Sets the frequency of the external reference.

Parameters:
<Frequency> 10MHZ | 3200MHZ

*RST: n.a. (factory preset: 10MHZ)

Example: See Example"Configuring the reference oscillator" on page 506.

Manual operation: See "External Reference Frequency" on page 172

[:SOURce]:ROSCillator:EXTernal:SBANdwidth <SBandwidth>

Selects the synchronization bandwidth for the external reference signal.

See [:SOURce]:ROSCillator:SOURce > External.

Depending on the RF hardware version, and the installed options, the synchronization
bandwidth varies.

For more information, see data sheet.

Parameters:
<SBandwidth> WIDE | NARRow

NARRow
The synchronization bandwidth is a few Hz.
WIDE
Uses the widest possible synchronization bandwidth.
*RST: n.a. (factory preset: WIDE)
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Example: See Example"Configuring the reference oscillator" on page 506.

Manual operation: See "Synchronization Bandwidth" on page 172

[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE <OutpFreqMode>

Selects the mode for the output reference frequency.

Parameters:
<OutpFreqMode> DER10M | OFF

DER10M
Sets the output reference frequency to 10 MHz.
The reference frequency is derived from the internal reference
frequency.
OFF
Disables the output.
*RST: n.a. (factory preset: DER10M)

Example: See Example"Configuring the reference oscillator" on page 506.

Manual operation: See "Reference Output" on page 173

[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue <Value>

Specifies the frequency correction value (adjustment value).

Parameters:
<Value> integer

*RST: 0

Example: See [:SOURce]:ROSCillator[:INTernal]:ADJust[:
STATe] on page 508

Manual operation: See "Adjustment Value" on page 174

[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] <State>

Determines whether the calibrated (off) or a user-defined (on) adjustment value is
used for fine adjustment of the frequency.

Parameters:
<State> 1 | ON | 0 | OFF

0
Fine adjustment with the calibrated frequency value
1
User-defined adjustment value.
The instrument is no longer in the calibrated state.
The calibration value is, however, not changed. The instrument
resumes the calibrated state if you send
SOURce:ROSCillator:INTernal:ADJust:STATe 0.
*RST: n.a. (factory preset: 0)
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Manual operation: See "Adjustment Active" on page 174

12.17  SENSe, READ, INITiate and SLISt subsystems

These subsystems contain the commands for configuring the power measurements
with R&S NRP power sensor connected to the R&S AREG800A.

The local state is set with the INIT command. Switching off the local state enhances
the measurement performance. Measurements results can be retrieved in local state
on or off.
Sensor parameters are set with the SENSe commands.
To start the measurement and retrieve the result, use the :READ<ch>[:POWer]?
command.

Suffix Value range Description

SENSe<ch> [1] to 4 Indicates the sensor

Use the :SLISt commands to change the sensor mapping

READ<ch> [1] to 4 Sensor assignment

INIate<hw> [1] to 4 Sensor assignment

ELEMent<ch> [1] to 25 Sensor-mapping list
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Programming examples

Example: Detecting and assigning a power sensor
SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy"
// Lists all automatically detected sensors.

SLISt:SCAN:STATe 1
// Searches for sensors connected in the LAN or via the USBTMC protocol.

SLISt:SCAN:LSENsor 'NRQ6',101624 // sensor name, serial number
SLISt:SCAN:LSENsor 11.123.1.123, 101624 // IP address, serial number
// Adds sensors to the list, that are connected to LAN.

SLISt:SCAN:USENsor 'NRQ6',101624 //sensor name, serial number
SLISt:SCAN:USENsor #H15b,101624  //device ID (hexadecimal), serial number
SLISt:SCAN:USENsor 347,101624    //device ID (decimal), serial number
// Adds a sensor to the list, that is connected to the USB interface.

SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy",
// "NRP33SN-V-900005-USBTMC","NRP33SN-V-900011-LAN"
// Lists all automatically detected sensors.

SLISt:ELEMent3:MAPPing SENS1
// Maps the third sensor from the list to the first sensor channel.

SLISt:SENSor:MAP "NRPS18S-100654-USB Legacy", SENS3
// Maps the sensor to channel 3.

SLISt:CLEar[ALL]
// Remove all sensors from the list.
SLISt:CLEar:LAN 
// Remove all sensors from the list, that are connected over LAN.
SLISt:CLEar:USB 
// Remove all sensors from the list, that are connected over USB.

Example: Performing a simple power measurement
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
INITiate1:CONTinuous ON
// Switches the continous power measurement on.

READ1?
// Triggers the measurement and displays the results.
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Example: Performing a power measurement with a fixed filter
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
SENSe1:SOURce RF 
// Sensor measures the power of the RF signal.

SENSe1:FILTer:TYPE NSRatio
// Selects fixed noise filter mode.

SENSe1:FILTer:NSRatio 0.02 DB
// Sets the maximum noise component in the result to 0.02 DB.

SENSe1:FILTer:NSRatio:MTIMe 10
//Limits the settling time to 10 seconds.

SENSe1:APERture:DEFault:STATe 0
// Deactivates the default aperture time of the sensor.

SENSe1:APERture:TIMe 10e-6
// Sets the aperture time to 10 us.

SENSe1:UNIT DBM
// Selects unit dBm for the measured value.

INITiate:CONTinuous ON
// Switches the continous power measurement on.

READ?
// Triggers the measurement and displays the results.

:SLISt[:LIST]?................................................................................................................ 512
:SLISt:SCAN[:STATe]......................................................................................................512
:SLISt:SCAN:LSENsor....................................................................................................512
:SLISt:SCAN:USENsor................................................................................................... 513
:SLISt:CLEar:LAN.......................................................................................................... 513
:SLISt:CLEar:USB..........................................................................................................513
:SLISt:CLEar[:ALL].........................................................................................................514
:SLISt:ELEMent<ch>:MAPPing........................................................................................514
:SLISt:SENSor:MAP.......................................................................................................514
:INITiate<hw>[:POWer]:CONTinuous............................................................................... 514
:READ<ch>[:POWer]?.................................................................................................... 515
:SENSe<ch>:UNIT[:POWer]............................................................................................515
:SENSe<ch>[:POWer]:APERture:DEFault:STATe.............................................................. 516
:SENSe<ch>[:POWer]:APERture:TIMe.............................................................................516
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect.......................................................516
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe........................................................517
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?.........................................................517
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority.........................................................517
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe........................................................... 517
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?.................................................................. 518
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:SENSe<ch>[:POWer]:FILTer:LENGth[:USER].................................................................. 518
:SENSe<ch>[:POWer]:FILTer:NSRatio............................................................................. 519
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe.................................................................. 519
:SENSe<ch>[:POWer]:FILTer:SONCe.............................................................................. 519
:SENSe<ch>[:POWer]:FILTer:TYPE................................................................................. 520
:SENSe<ch>[:POWer]:FREQuency..................................................................................520
:SENSe<ch>[:POWer]:LOGGing:STATe............................................................................521
:SENSe<ch>[:POWer]:OFFSet........................................................................................ 521
:SENSe<ch>[:POWer]:OFFSet:STATe..............................................................................521
:SENSe<ch>[:POWer]:SNUMber?................................................................................... 521
:SENSe<ch>[:POWer]:SOURce.......................................................................................522
:SENSe<ch>[:POWer]:STATus[:DEVice]?......................................................................... 522
:SENSe<ch>[:POWer]:TYPE?......................................................................................... 522
:SENSe<ch>[:POWer]:ZERO.......................................................................................... 523

:SLISt[:LIST]?

Returns a list of all detected sensors in a comma-separated string.

Return values: 
<SensorList> String of comma-separated entries

Each entry contains information on the sensor type, serial num-
ber and interface.
The order of the entries does not correspond to the order the
sensors are displayed in the "NRP Sensor Mapping" dialog.

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Query only

Manual operation: See "Sensor Mapping List" on page 185

:SLISt:SCAN[:STATe] <State>

Starts the search for R&S NRP power sensors, connected in the LAN or via the
USBTMC protocol.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Manual operation: See "Scan" on page 186

:SLISt:SCAN:LSENsor <IP>

Scans for R&S NRP power sensors connected in the LAN.
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Setting parameters: 
<IP> string

*RST: 0

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Setting only

Manual operation: See "Add LAN Sensor settings" on page 186

:SLISt:SCAN:USENsor <DeviceID>, <Serial>

Scans for R&S NRP power sensors connected over a USB interface.

Parameters:
<Serial> integer

Range: 0  to  999999

Setting parameters: 
<DeviceID> String or Integer

Range: 0  to  999999
*RST: 0

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Setting only

Manual operation: See "Add USB Sensor settings" on page 186

:SLISt:CLEar:LAN

Removes all R&S NRP power sensors connected in the LAN from the list.

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Event

Manual operation: See "Clear" on page 186

:SLISt:CLEar:USB

Removes all R&S NRP power sensors connected over USB from the list.

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Event

Manual operation: See "Clear" on page 186
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:SLISt:CLEar[:ALL]

Removes all R&S NRP power sensors from the list.

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Event

Manual operation: See "Clear" on page 186

:SLISt:ELEMent<ch>:MAPPing <Mapping>

Assigns an entry from the :SLISt[:LIST]? to one of the four sensor channels.

Parameters:
<Mapping> SENS1 | SENSor1 | SENS2 | SENSor2 | SENS3 | SENSor3 |

SENS4 | SENSor4 | UNMapped
Sensor channel.
*RST: UNMapped

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Manual operation: See "Sensor Mapping List" on page 185

:SLISt:SENSor:MAP <SensorId>, <Mapping>

Assigns a sensor directly to one of the sensor channels, using the sensor name and
serial number.

To find out the the sensor name and ID, you can get it from the label of the R&S NRP,
or using the command :SLISt:SCAN[:STATe]. This command detects all R&S NRP
power sensors connected in the LAN or via 'USBTMC protocol.

Setting parameters: 
<SensorId> string

<Mapping> enum

Example: See Example"Detecting and assigning a power sensor"
on page 510.

Usage: Setting only

Manual operation: See "Sensor Mapping List" on page 185

:INITiate<hw>[:POWer]:CONTinuous <Continuous>

Switches the local state of the continuous power measurement by R&S NRP power
sensors on and off. Switching off local state enhances the measurement performance
during remote control.
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The remote measurement is triggered with :READ<ch>[:POWer]?). This command
also returns the measurement results. The local state is not affected, measurement
results can be retrieved with local state on or off.

Parameters:
<Continuous> 1 | ON | 0 | OFF

*RST: 0

Example: INIT1:CONT ON
Switches on the local state of continuous power measurement.

Manual operation: See "State" on page 181

:READ<ch>[:POWer]?

Triggers power measurement and displays the results.

Note: This command does not affect the local state, i.e. you can get results with local
state on or off. For long measurement times, we recommend that you use an SRQ for
command synchronization (MAV bit).

Suffix: 
<ch>

.
1 to 3

Return values: 
<Power> float or float,float

The sensor returns the result in the unit set with command :
SENSe<ch>:UNIT[:POWer]
Certain power sensors, such as the R&S NRP-Z81, return two
values, first the value of the average level and - separated by a
comma - the peak value.

Example: :SENS1:UNIT DBM
Selects unit dBm for presentation of measurement result.
:READ1?
Queries the measurement result of the sensor.
-45.6246576745440230
-45.6 dBm were measured at the given frequency.

Example: R&S NRP-Z81
:READ1?
-55.62403263352178,-22.419472478812476
-55.6 dBm is the measured average level, -22. 4 dBm is the
measured peak level at the given frequency.

Usage: Query only

Manual operation: See "Level (Peak) / Level (Average)" on page 181

:SENSe<ch>:UNIT[:POWer] <Power>

Selects the unit (Watt, dBm or dBμV) of measurement result display, queried with :
READ<ch>[:POWer]?.
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Parameters:
<Power> DBM | DBUV | WATT

*RST: DBM

Example: :SENS2:UNIT DBM
Selects dBm as unit for the measured value returned by com-
mand READ.
:READ2?
Response: 7.34
7.34 dBm are measured by sensor 2.

Manual operation: See "Level (Peak) / Level (Average)" on page 181

:SENSe<ch>[:POWer]:APERture:DEFault:STATe <UseDefAp>

Deactivates the default aperture time of the respective sensor.

To specify a user-defined value, use the command :SENSe<ch>[:POWer]:
APERture:TIMe on page 516.

Parameters:
<UseDefAp> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 511.

Manual operation: See "Default Aperture Time" on page 183

:SENSe<ch>[:POWer]:APERture:TIMe <ApTime>

Defines the aperture time (size of the acquisition interval) for the corresponding sensor.

Parameters:
<ApTime> float

Range: depends on connected power sensor
Increment: 1E-9
*RST: depends on connected power sensor

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 511.

Manual operation: See "Aperture Time" on page 183

:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect <Select>

Several S-parameter tables can be stored in a sensor. The command selects a loaded
data set for S-parameter correction for the corresponding sensor.

Parameters:
<Select> float

*RST: 0
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Manual operation: See "S-Parameter" on page 184

:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe <State>

Activates the use of the S-parameter correction data.

Note: If you use power sensors with attenuator, the instrument automatically activates
the use of S-parameter data.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENSe1:POWer:CORRection:SPDevice:STATe 1
Activates the use of the S-parameters correction data.

Manual operation: See "S-Parameter" on page 184

:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?

Queries the list of the S-parameter data sets that have been loaded to the power sen-
sor.

Return values: 
<List> string list

*RST: 0

Usage: Query only

Manual operation: See "S-Parameter" on page 184

:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority <Priority>

Selects average or peak power for permanent display.

Parameters:
<Priority> AVERage | PEAK

*RST: AVERage

Example: :SENS1:DISP:PERM:STAT ON
Turns on the permanent view.
:SENS1:DISP:PERM:PRI AVER
Sets the average power for display.

Manual operation: See "Display" on page 181

:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe <State>

Activates the permanent display of the measured power level results. The instrument
also indicates the sensor type, the connection, the measurement source and the offset
if set.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:POW:DISP:PERM:STAT ON
Turns on the permanent view.

Manual operation: See "Permanent" on page 181

:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?

Queries the current filter length in filter mode AUTO (:SENSe<ch>[:POWer]:
FILTer:TYPE)

Return values: 
<Auto> float

Range: 1  to  65536

Example: :SENS1:FILT:TYPE AUTO
Selects auto filter.
:SENS1:FILT:LENG:AUTO?
Queries the automatically set filter length.
Response: 1024

Usage: Query only

Manual operation: See "Filter Length" on page 183

:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] <User>

Selects the filter length for SENS:POW:FILT:TYPE USER. As the filter length works as
a multiplier for the time window, a constant filter length results in a constant measure-
ment time (see also "About the measuring principle, averaging filter, filter length, and
achieving stable results" on page 176).

The R&S NRP power sensors provide different resolutions for setting the filter length,
depending on the used sensor type:
● Resolution = 1 for R&S NRPxx power sensors
● Resolution = 2n for sensors of the R&S NRP-Zxx family, with n = 1 to 16

Parameters:
<User> float

Range: 1  to  65536
*RST: 1

Example: :SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:LENG 16
Sets a filter length of 16. E.g. using a sensor with 20 ms time
window, the resulting measurement time is 640 ms (2x16x20
ms)
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Manual operation: See "Filter Length" on page 183

:SENSe<ch>[:POWer]:FILTer:NSRatio <NSRatio>

Sets an upper limit for the relative noise content in fixed noise filter mode (:
SENSe<ch>[:POWer]:FILTer:TYPE). This value determines the proportion of intrin-
sic noise in the measurement results.

Parameters:
<NSRatio> float

Range: 0.001  to  1
Increment: 0.001
*RST: 0.01

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 511.

Manual operation: See "Noise/Signal Ratio" on page 183

:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe <MTime>

Sets an upper limit for the settling time of the auto-averaging filter in the NSRatio
mode and thus limits the length of the filter. The filter type is set with command :
SENSe<ch>[:POWer]:FILTer:TYPE.

Parameters:
<MTime> float

Range: 1  to  999.99
Increment: 0.01
*RST: 4

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 511.

Manual operation: See "Timeout" on page 183

:SENSe<ch>[:POWer]:FILTer:SONCe

Starts searching the optimum filter length for the current measurement conditions. You
can check the result with command :SENS1:POW:FILT:LENG:USER? in filter mode
USER (:SENSe<ch>[:POWer]:FILTer:TYPE).

Example: SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:SONC
Activates the search for the optimum filter length.
:SENS1:FILT:LENG?
Returns the found optimum filter length.
Response: 128

Usage: Event
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Manual operation: See "Auto Once" on page 183

:SENSe<ch>[:POWer]:FILTer:TYPE <Type>

Selects the filter mode. The filter length is the multiplier for the time window and thus
directly affects the measurement time.

Parameters:
<Type> AUTO | USER | NSRatio

AUTO
Automatically selects the filter length, depending on the mea-
sured value. The higher the power, the shorter the filter length,
and vice versa.
USER
Allows you to set the filter length manually. As the filter-length
takes effect as a multiplier of the measurement time, you can
achieve constant measurement times.
NSRatio
Selects the filter length (averaging factor) according to the crite-
rion that the intrinsic noise of the sensor (2 standard deviations)
does not exceed the specified noise content. You can define the
noise content with command :SENSe<ch>[:POWer]:FILTer:
NSRatio.
Note: To avoid long settling times when the power is low, you
can limit the averaging factor limited with the "timeout" parame-
ter (:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe).
*RST: AUTO

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 511.

Manual operation: See "Filter" on page 182

:SENSe<ch>[:POWer]:FREQuency <Frequency>

Sets the RF frequency of the signal, if signal source :SENSe<ch>[:POWer]:SOURce
USER is selected.

Parameters:
<Frequency> float

*RST: 1 GHz

Example: :SENS1:SOUR USER
Selects user-defined source.
:SENS1:FREQ 2.44GHz
Sets the RF frequency of the source which is 2.44 GHz.

Manual operation: See "Frequency" on page 182

SENSe, READ, INITiate and SLISt subsystems
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:SENSe<ch>[:POWer]:LOGGing:STATe <State>

Activates the recording of the power values, measured by a connected R&S NRP
power sensor.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS:LOGG:STAT ON
Activates recording of the power measurement of the first sen-
sor.

Manual operation: See "Enable Logging" on page 184

:SENSe<ch>[:POWer]:OFFSet <Offset>

Sets a level offset which is added to the measured level value after activation with
command :SENSe<ch>[:POWer]:OFFSet:STATe. The level offset allows, e.g. to
consider an attenuator in the signal path.

Parameters:
<Offset> float

Range: -100.0  to  100.0
*RST: 0
Default unit: dB

Example: :SENS1:POW:OFFS 10.0
Sets a level offset of 10 dB

Manual operation: See "Level Offset State,Level Offset" on page 182

:SENSe<ch>[:POWer]:OFFSet:STATe <State>

Activates the addition of the level offset to the measured value. The level offset value is
set with command :SENSe<ch>[:POWer]:OFFSet.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:POW:OFFS 0.4dB
Sets a level offset of 0.4 dB
:SENS1:POW:OFFS:STAT ON
A level offset of 0.4 dB is added to the measured value.

Manual operation: See "Level Offset State,Level Offset" on page 182

:SENSe<ch>[:POWer]:SNUMber?

Queries the serial number of the sensor.
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Return values: 
<SNumber> string

Example: :SENS1:SNUM?
Queries the serial number.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 181

:SENSe<ch>[:POWer]:SOURce <Source>

Determines the signal to be measured.

Note: When measuring the RF signal, the sensor considers the corresponding correc-
tion factor at that frequency, and uses the level setting of the instrument as reference
level.

Parameters:
<Source> USER

*RST: USER

Example: See Example"Performing a power measurement with a fixed fil-
ter" on page 511.

Manual operation: See "Use Frequency Of" on page 182

:SENSe<ch>[:POWer]:STATus[:DEVice]?

Queries if a sensor is connected to the instrument.

Return values: 
<Status> 1 | ON | 0 | OFF

*RST: 0

Example: :SENS1:STAT?
Response: 1
A sensor is connected.

Usage: Query only

Manual operation: See "State" on page 181

:SENSe<ch>[:POWer]:TYPE?

Queries the sensor type. The type is automatically detected.

Return values: 
<Type> string

Example: :SENS1:TYPE?
Queries the type of sensor.
Response: NRP-Z21
The R&S NRP-Z21 sensor is used.

SENSe, READ, INITiate and SLISt subsystems
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Usage: Query only

Manual operation: See "Sensor type and serial number" on page 181

:SENSe<ch>[:POWer]:ZERO

Performs zeroing of the sensor.

Zeroing is required after warm-up, i.e. after connecting the sensor.

Note: Switch off or disconnect the RF power source from the sensor before zeroing.

We recommend that you zero in regular intervals (at least once a day), if:
● The temperature has varied more than about 5 °C.
● The sensor has been replaced.
● You want to measure very low power.

Example: :SENS1:ZERO
Executes zeroing.

Usage: Event

Manual operation: See "Zero" on page 181

12.18  STATus subsystem

This system contains the commands for the status reporting system. See also Chap-
ter 11.4, "Status reporting system", on page 278 for detailed information.

*RST on page 355 has no effect on the status registers.

Value ranges

● Queries return the current value of the respective register, which permits a check of
the device status.
Return values: A decimal value in the range 0 to 32767 (=215-1)

● The configuration commands set the respective register thus determining which
status changes of the R&S AREG800A cause the status registers to be changed.
Setting values: A decimal value in the range 0 to 32767 (=215-1)

:STATus:OPERation:CONDition?.....................................................................................524
:STATus:OPERation:ENABle...........................................................................................524
:STATus:OPERation[:EVENt]...........................................................................................524
:STATus:OPERation:NTRansition.................................................................................... 524
:STATus:OPERation:PTRansition.....................................................................................525
:STATus:PRESet............................................................................................................525
:STATus:QUEStionable:CONDition.................................................................................. 525
:STATus:QUEStionable:ENABle.......................................................................................525
:STATus:QUEStionable[:EVENt]...................................................................................... 526
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:STATus:QUEStionable:NTRansition................................................................................ 526
:STATus:QUEStionable:PTRansition................................................................................ 526
:STATus:QUEue[:NEXT]?................................................................................................527

:STATus:OPERation:CONDition?

Quieries the content of the CONDition part of the STATus:OPERation register.

This part contains information on the action currently being performed in the instru-
ment. The content is not deleted after being read out because it indicates the current
hardware status.

Return values: 
<Condition> string

Example: :STATus:OPERation:CONDition?

Usage: Query only

:STATus:OPERation:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:OPERation register. This setting deter-
mines which events of the Status-Event part are forwarded to the sum bit in the status
byte. These events can be used for a service request.

Parameters:
<Enable> string

Example: :STAT:OPER:ENAB 32767
all events are forwarded to the sum bit of the status byte.

:STATus:OPERation[:EVENt] <Event>

Queries the content of the EVENt part of the STATus:OPERation register. This part
contains information on the actions performed in the instrument since the last readout.
The content of the EVENt part is deleted after being read out.

Parameters:
<Event> string

Example: :STAT:OPER:EVEN?
queries the STATus:OPERation:EVENt register.

:STATus:OPERation:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 1 to 0 in the condition part causes an entry to be made in the EVENt
part of the register. The disappearance of an event in the hardware is thus registered,
for example the end of an adjustment.

Parameters:
<Ntransition> string

STATus subsystem
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Example: :STAT:OPER:NTR 0
a transition from 1 to 0 in the condition part of the Status:Opera-
tion register does not cause an entry to be made in the EVENt
part.

:STATus:OPERation:PTRansition <Ptransition>

Sets the bits of the PTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 0 to 1 in the condition part causes an entry to be made in the EVENt
part of the register. A new event in the hardware is thus registered, for example the
start of an adjustment.

Parameters:
<Ptransition> string

Example: :STAT:OPER:PTR 32767
all transitions from 0 to 1 in the condition part of the Status:Oper-
ation register cause an entry to be made in the EVENt part.

:STATus:PRESet <Preset>

Resets the status registers. All PTRansition parts are set to FFFFh (32767), i.e. all
transitions from 0 to 1 are detected. All NTRansition parts are set to 0, i.e. a transition
from 1 to 0 in a CONDition bit is not detected. The ENABle parts of STATus:OPERation
and STATus:QUEStionable are set to 0, i.e. all events in these registers are not passed
on.

Parameters:
<Preset> string

Example: STAT:PRES
resets the status registers.

:STATus:QUEStionable:CONDition <Condition>

Queries the content of the CONDition part of the STATus:QUEStionable register. This
part contains information on the action currently being performed in the instrument.
The content is not deleted after being read out since it indicates the current hardware
status.

Parameters:
<Condition> string

Example: :STATus:QUEStionable:CONDition?
queries the Status:Questionable:Condition register.

:STATus:QUEStionable:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:QUEStionable register. The enable part
determines which events of the STATus:EVENt part are enabled for the summary bit in
the status byte. These events can be used for a service request.

STATus subsystem
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If a bit in the ENABle part is 1, and the correesponding EVENt bit is true, a positive
transition occurs in the summary bit. This transition is reportet to the next higher level.

Parameters:
<Enable> string

Example: STAT:QUES:ENAB 1
Problems when performing an adjustment cause an entry to be
made in the sum bit.

:STATus:QUEStionable[:EVENt] <Event>

Queries the content of the EVENt part of the STATus:QUEStionable register. This
part contains information on the actions performed in the instrument since the last
readout. The content of the EVENt part is deleted after being read out.

Parameters:
<Event> string

Example: STAT:QUES:EVEN?
queries the Status:Questionable:Event register.

:STATus:QUEStionable:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<Ntransition> string

Example: STAT:QUES:NTR 0
a transition from 1 to 0 in the condition part of the STA-
Tus:QUEStionable register does not cause an entry to be made
in the EVENt part

:STATus:QUEStionable:PTRansition <PTransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<PTransition> string

Example: STAT:QUES:PTR 32767
all transitions from 0 to 1 in the condition part of the STA-
Tus:QUEStionable register cause an entry to be made in the
EVENt part
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:STATus:QUEue[:NEXT]?

Queries the oldest entry in the error queue and then deletes it. Positive error numbers
denote device-specific errors, and negative error numbers denote error messages
defined by SCPI. If the error queue is empty, 0 ("No error") is returned.

The command is identical to :SYSTem:ERRor[:NEXT]? on page 402.

Return values: 
<Next> string

Example: :STATus:QUEue?
queries the oldest entry in the error queue.
Response: 0, 'no error'
no errors have occurred since the error queue was last read out

Usage: Query only

STATus subsystem
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13  Troubleshooting and notifications
Handling R&S AREG800A start-up issues

If the product does not start, a blown fuse in the power supply can be the cause. Con-
tact the Rohde & Schwarz customer service to confirm the fault symptoms. If the power
supply has a blown fuse, you must return the product to the Rohde & Schwarz cus-
tomer service to have the power supply replaced. Follow the instructions from the
Rohde & Schwarz customer service.

If you need to transport or ship the instrument, see Chapter 14, "Transporting",
on page 542.

Understanding R&S AREG800A notifications

The R&S AREG800A distinguishes between various notifications caused by events or
functions. It displays a notification in the "Info" line on the screen temporarily, and
saves all notifications in a history list. In addition, an event initiates an entry in the
event/error queue of the status reporting system.

See:
● Chapter 11.4, "Status reporting system", on page 278
● Chapter 13.4, "Querying notifications", on page 532

13.1  Notifications

Notifications inform about operation states of the instrument, and point out deviations,
deficiencies or imperfection of functions that initiate an event in the instrument. The
instrument distinguishes the notifications according to the significance of the events by
different icons.

Some events require that you eliminate the deviation to make sure that the instrument
operates correctly.

To access the notifications and history list dialog, see Chapter 13.4, "Querying notifica-
tions", on page 532. In remote control mode, you can query the notifications using the
command :SYSTem:ERRor:ALL? on page 400.

13.1.1  Volatile notifications

Volatile notifications report automatic settings in the instrument (e.g. switching off
incompatible types of modulation) or on entries that are not accepted by the instrument
(e.g. range violations).

Volatile notifications do not normally demand user actions and disappear automatically
after a short period of time. They are saved in the history list, however.

Notifications
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Remote command:

:SYSTem:ERRor:ALL? or

:SYSTem:ERRor:CODE[:NEXT]?

13.1.2  Permanent notifications

Permanent notifications are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signaled by a permanent notification must
be eliminated before correct instrument operation can be continued.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

Remote command:

:SYSTem:ERRor:STATic?

13.2  SCPI notifications

The SCPI notifications are similar for all SCPI instruments. Detailed information and an
overview of all notifications as defined in SCPI standard can be found in the corre-
sponding documentation.

SCPI notifications have negative codes (numbers). The error text being entered into
the error/event queue or being displayed is printed in bold face on the left together with
the error code. Below the error text, there is an explanation to the respective error.

13.3  Device-specific notifications

The following table contains all error messages specific for the instrument, marked by
positive error codes in numerical order and an explanation of the error situation.

The device-specific error messages set bit 3 in the ESR register.

The index provides a list of the error messages sorted according to their error codes.

Device-specific notifications
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Error
code

Error Description Remedy

50 Extern reference out of
range or disconnected

External reference is selected but no external sig-
nal is applied or the signal is out of range.

● Check the selected reference signal
source (internal or external) in the
"Setup > Reference Oscillator" dia-
log.

● Change setting to 'internal' if no
appropriate external source is avail-
able.

80 See Table 13-1   

180 Adjustment failed Adjustment could not be executed. Generate the adjustment data and load
it into the device

182 Adjustment data missing Adjustment data is missing. Generate the adjustment data and load
it into the device

183 Adjustment data invalid Adjustment data is invalid and must be restored. Generate the adjustment data and load
it into the device

200 Cannot access hardware The data transmission to a module was unsuc-
cessful.

The module is not installed, not properly
installed or missing.

201 Hardware revision out of
date

A later version of certain parts of the instrument is
necessary to execute the function selected.

The driver does not support the installed
version of a module.

202 Cannot access the
EEPROM

An error occurs when writing or reading a
EEPROM.

The EEPROM is possibly defect.
Replace it.

203 Invalid EEPROM data Reading a EEPROM is possible, however the
data are inconsistent.

 

204 Driver initialization failed Initialization of a driver fails when booting the
instrument firmware.

The driver is not compatible with the
hardware or software configuration of
the instrument.

241 No current list There is no list selected. To execute the required
operation, a list has to be selected in the related
dialog. If no list is available, a new list must be
created.

 

242 Unknown list type speci-
fied

The list type selected is not valid for the required
operation.

Check the selected list type.

300 No tachometer signal
detected on fan #x

Fan number #x is not working. Send the R&S AREG800A to your local
Rohde & Schwarz service center.

300 Temperature too high

See Table 13-2

The R&S AREG800A is overheated and/or the
fan openings of the R&S AREG800A are covered.

Relocate the R&S AREG800A to cool
down and remove all coverings from the
R&S AREG800A, see also Chap-
ter 3.1.4, "Setting up the
R&S AREG800A", on page 22. After
cooling down switch on the
R&S AREG800A.

If you still encounter problems, contact
the Rohde & Schwarz service center.

460 Cannot open the file The selected file cannot be opened. Check the path and file name.

461 Cannot write file The file cannot be written. Check if the file is read-only.

462 Cannot read file The file cannot be read. Check if the file contents are compatible
with the file type.

Device-specific notifications
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Error
code

Error Description Remedy

463 Filename missing The required operation cannot be executed
because the file name is not specified.

Enter file name when creating list.

464 Invalid filename extension The file extension is not valid for the required
operation.

Check the file extension.

465 File contains invalid data The selected file contains data that is not valid for
the file type.

The file extension determines the data that is
valid for this file type. If the file extension is
changed, the lists are no longer recognized and
the data is therefore invalid.

Check the file extension.

Table 13-1: Device-specific messages: error code 80

Error Description Remedy

Frontend 100 MHz PLL not
locked

● Cable IF TX CBL between R&S AREG800A base
unit and frontend module is not connected or

● External reference is selected but no external 10
MHz signal is applied or

● The signal level is out of range

● Check connection of IF TX CBL
● Apply 10 MHz external reference sig-

nal or select "AREG Configuration >
Reference Frequency > Source =
Internal".

Object attenuation range
exceeded

The configured attenuation cannot be reached by the
internal attenuators in the R&S AREG800A signal
path

Set a higher or lower attenuation.

Frontend RX PLL not locked

Frontend TX PLL not locked

The local oscillator in the frontend module is out of
lock.

Check the cabling between frontend and
R&S AREG800A base unit and reboot the
R&S AREG800A.

If the problem persists, contact customer
support.

See Chapter 13.10, "Contacting customer
support", on page 540.

Frontend has been
changed. Please run "Adjust
All".

Alignment data for the currently connected frontend
module is not available.

Select "System Config > Setup > General >
Internal Adjustments" and select "Adjust
All".

Adjustment missing. Please
run "Adjust All".

Alignment data is not available. Select "System Config > Setup > General >
Internal Adjustments" and select "Adjust
All".

Table 13-2: Device-specific messages: error code 300

Error Description Remedy

MB_RO: Instrument temper-
ature too high

The temperature of the R&S AREG800A exceeds the
warning threshold.

The measurement values may be out of tolerance.

Check for additional cooling.

MB_RO: Instrument temper-
ature critical.

The temperature of the R&S AREG800A exceeds the
critical threshold.

The R&S AREG800A shuts down automati-
cally after 6 s.

Operating temperature of
frontend too low.

The temperature of the connected TRX frontend is too
low.

The output may be unleveled.

Wait until the system has warmed up.

Device-specific notifications
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Error Description Remedy

The instrument is overhea-
ted.

The temperature of the connected TRX frontend
exceeds the warning threshold.

If the temperature still increases, the R&S AREG800A
shuts down automatically.

● Shut down the R&S AREG800A.
● Wait 10 minutes and switch on the

R&S AREG800A again.

If the problem still occurs, contact customer
support.

See Chapter 13.10, "Contacting customer
support", on page 540.

The temperature control
detects a critical error!

The temperature of the connected TRX frontend
exceeds the critical threshold.

The R&S AREG800A shuts down automati-
cally after 10 s.

13.4  Querying notifications

The R&S AREG800A monitors the functions performed and automatically detects
irregularities. The instrument displays corresponding notifications in the "Info" line and
collects all notifications in a history with a detailed description.

Find details to the system notifications in Chapter 13, "Troubleshooting and notifica-
tions", on page 528.

To display information on static notifications and history

► For some notifications, the information line appears briefly on the home screen.
Selecting the info line also opens the dialog.

● The "Static Notifications" dialog lists the recently monitored notifications chro-
nologically and displays additional information on the highlighted message.

● The "History" dialog lists the accumulated messages with a short description.
Volatile notifications are reported once. If identical errors occur subsequently,
they are not reported repeatedly.

Querying notifications
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In the "Info" line, identical errors are displayed repeatedly only if the original
error has already disappeared from the display. If queried by SCPI command,
identical errors are only reported if the original error has already been retrieved
from (and hence not any more present in) the error queue.

Indication and handling of permanent notifications
If any critical error occurs, the R&S AREG800A automatically shows the  icon in the
taskbar. Select the icon to obtain information on the error and the number of occurren-
ces.
The icon is assigned to permanent notifications. The notification and icon are displayed
until the error is eliminated.

Static Notifications/History
Toggles between "Static Notifications" and the "History" tab in the info dialog.
Remote command: 
:SYSTem:ERRor[:NEXT]? on page 402
Each time a SYST:ERR:NEXT? query is sent, the eldest entry in the error queue is
returned and at the same time cleared in the list.
:SYSTem:ERRor:STATic? on page 403
Queries the list of all errors.

Clear History
Clears all messages in the "History" tab.
Remote command: 
:SYSTem:ERRor:ALL? on page 400
Each time a SYST:ERR:ALL? query is sent, the error queue is returned and at the
same time cleared.
:SYSTem:ERRor:HISTory:CLEar on page 402
Clears the messages in the "History" view.

13.5  Resolving network connection failures

Several issues may cause failures in the network connection to the instrument. This
section lists the most likely reasons and the recommended solutions.

Common reasons for network connection failures

● Network connecting cables and cable connectors of poor quality
● Incompatibility between the network interface of the R&S AREG800A and certain

switches or routers available on the market
● An invalid IP address assigned to the instrument

Possible solutions to network connection failures

1. NOTICE! Risk of network failure. Connecting to the network can cause network
failure. Errors can affect the entire network.

Resolving network connection failures
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Consult your network administrator before performing the following tasks:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

2. Try out the following to resolve network connection failures:

● Check the network infrastructure. Exchange connecting cables, if obvious dam-
age is visible.
See also "Cable selection and electromagnetic interference (EMI)" on page 24.

● Observe the link status LED on the R&S AREG800A or the connected network
device. The link status LED is located next to the LAN connector.
If a link failure is detected, connect the instrument to a different device port or
to a different network device.

● Check whether the LAN interface and the required LAN services are enabled.
See Chapter 10.5.3, "Configuring LAN services", on page 257.

● If the IP address is set manually (no DHCP) or obtained with the Zeroconf
(Avahi) protocol:
– Check whether the IP address of the instrument is within the network's

address range.
– Check whether the IP address is valid.
See also "IP Address" on page 290.

13.6  Resolving errors during internal adjustments

Internal adjustments can fail for various reasons, e.g. if the adjustment data is invalid
or missing, or if any error causes process to abort.

To resolve a failed adjustment process, you have the following options:
● Abort on error (default setting), see "To resolve aborted internal adjustments"

on page 534
● Continue on error, see "To continue internal adjustments on error" on page 535

To resolve aborted internal adjustments

If an error occurs, the R&S AREG800A displays a notification in the "Information" field
and saves the notification in the history list.

1. Select "Info".

2. Look up the error code of the notification in the overview of device-specific notifica-
tions, see Chapter 13.3, "Device-specific notifications", on page 529.

The overview provides a brief explanation of all notifications and information on
how to fix an error.

3. To resolve an adjustment failure, generate adjustment data and load it into the
instrument.

Resolving errors during internal adjustments
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4. Restart internal adjustments as described in "Running internal adjustments"
on page 546

If the error persists:
Contact the Rohde & Schwarz customer support, see Chapter 13.9, "Collecting
information for technical support", on page 539.

To continue internal adjustments on error

If the failed internal adjustments has no significant effect on your application, you can
skip it and continue the calibration despite the error message. This function is pass-
word-protected.

1. Select "System Config > Setup > Security > Protection".

2. Unlock protection level 1, see"Protection Level/Password" on page 252.

3. Select "System Config > Setup > Internal Adjustment > Configuration > Continue
Adjustment on Error > On".

4. Proceed as described in "Running internal adjustments" on page 546.

13.7  Measuring USB cable quality

To check the quality of the USB cable, see the service manual of the R&S AREG800A.

13.8  Requesting instrument configuration and specifica-
tions

The R&S AREG800A is equipped with various hardware and software components. To
get an overview of what your instrument is equipped with, you can request the assem-
blies, hardware and software options, and the firmware version. The components are
structured according to the hardware configuration, software options, including the
license management, and externally used Rohde & Schwarz equipment, like R&S NRP
power sensors.

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option. How to install options is described in
chapter 4 of the R&S AREG800A service manual.
The installation of hardware options purchased at a later stage is also described in
chapter 4 of the service manual. Most of the hardware options have to be installed at
an authorized Rohde & Schwarz service center.

Requesting instrument configuration and specifications
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13.8.1  Hardware configuration settings

Access:

► Select "System Config > Setup > Instrument Assembly > Hardware Config".

The "Hardware Config" dialog lists all installed assemblies and externally connec-
ted instruments with information on their part and serial numbers, and revision
states. The BIOS version is also listed; firmware updates do not update the BIOS
version.
The dialog is divided in tabs, according to the hardware components of the signal
domains. The "Counter" tab provides information on the operation time and number
of times the instrument was powered on.

The remote commands required to query the hardware configuration are described in
Chapter 12.5, "DIAGnostic subsystem", on page 362.

Assembly
The tables in the tabs show characteristics of the installed assemblies.
"Assembly" Assembly designation.
"Part Number" Part number of the assembly.
"Serial Number"

Serial number of the assembly.
"Revision" Revision state of the assembly.
"Slot" Indicates whether the assembly is connected to the serial bus or PCI

bus.
Remote command: 
:DIAGnostic<hw>:BGINfo? on page 363

Counter
Displays information on the operation times of the R&S AREG800A.

Operation Time / h ← Counter
Displays the operation time in hours so far.
Remote command: 
:DIAGnostic:INFO:OTIMe? on page 364

Power On Count ← Counter
Displays the number the instrument has been turned on.
Remote command: 
:DIAGnostic:INFO:POCount? on page 364

Last Factory Calibration ← Counter
Displays the date of the last factory calibration.
Remote command: 
:CALibration:DATA:FACTory:DATE? on page 361

Requesting instrument configuration and specifications
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13.8.2  Versions/options settings

Access:

► Select "System Config > Setup > Instrument Assembly > Versions / Options".

The "Versions/Options" dialog shows the version of the installed instrument firm-
ware, the hardware and software options, the data sheet and the software compo-
nents of the firmware. The BIOS version is also listed; firmware updates do not
update the BIOS version.

The remote commands required to query the hardware configuration are described in
Chapter 12.5, "DIAGnostic subsystem", on page 362.

Firmware
Shows the firmware version and the version of the software platform.
Note: Your instrument is delivered with the latest firmware version available.
You can download firmware updates and the "Release Notes" that describe the modifi-
cations and the firmware update procedure.
Remote command: 
n.a.

Downgrade Info
Shows downgrade information, like factory firmware version and minimum firmware
version to that the instrument can be downgraded.
Remote command: 
n.a.

Show Open Source Acknowledgments
Accesses the list of the used open-source software packages and the corresponding
verbatim license texts.

LucasFonts RSCorpid EULA
Accesses copyright information on LucasFonts font type RSCorpid EULA.

Requesting instrument configuration and specifications
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Hardware Options/Software Options
The tables in the "Hardware" and "Software" tabs list the installed hardware and soft-
ware options.
"Option" Short name of option
"Designation" Name of option
"Expiration Date"

For regular options, "Permanent" is indicated in this column.
Remote command: 
*OPT? on page 354
*IDN? on page 354

Versions
The "Versions" tab shows the versions of the technical specification of the
R&S AREG800A and of the software components that comprise the firmware.

"Package" Name of the component.
"Version" Current issue of the component.
Remote command: 
:SYSTem:SPECification:VERSion:FACTory? on page 420

13.8.3  How to query instrument configuration

To get information on the components and installed options of the R&S AREG800A,
proceed as described in the following examples.

Checking the installed hardware options

To find out the installed options:

1. Select "System Config > Setup > Instrument Assembly > Versions/Options".

2. Select "Hardware Options".

The dialog lists all hardware options that are installed on the R&S AREG800A.

Proceed the same way to get information for instance on the firmware, or the installed
software options in the corresponding tab.

Checking the RF hardware assembly

To find out the installed RF hardware:

1. Select "System Config > Setup > Instrument Assembly > Hardware Config".

2. Select "RF Assembly".

The dialog lists the RF hardware components that are installed on the
R&S AREG800A.

Requesting instrument configuration and specifications



Troubleshooting and notificationsR&S®AREG800A

539User Manual 1179.3615.02 ─ 06

Proceed the same way to get information for instance on general or baseband hard-
ware modules, or on the operating times of the R&S AREG800A in the corresponding
tab.

13.9  Collecting information for technical support

If you encounter problems that you cannot solve yourself, contact your
Rohde & Schwarz support center at www.rohde-schwarz.com/support. Our support
center staff is optimally trained to assist you in solving problems.

The support center finds solutions more quickly and efficiently if you provide them with
information on the instrument and an error description.
● The following dialog boxes in the "Setup > Instrument Assembly" menu provide

useful information:
– Hardware Configuration: hardware assemblies
– Software and Options: the status of all software and hardware options instal-

led on your instrument
● System Messages: displayed in the "Info" line and provide information on any

errors that have occurred
● Support file: a special file (*.tar.gz file) with important support information that

can be created automatically.
The support *.tar.gz file has a user-definable name and contains the following
files and information:
– SgErrors.txt: chronological record of errors
– SystemRestaurationAREG800A.savrcltxt: instrument settings at the

last correct shutdown of the instrument
– UndoHistSuppInfo.xml: list of the last user interactions
– DeviceFootprint_<SerialNumber>_<Date>_<Time>.xml: service-rela-

ted information on the instrument's configuration.
– crashlog.txt, coredump: Postmortem debug info
– Several files with information on the last performed adjustment and self-test.

See also the description of error messages Chapter 13.1, "Notifications", on page 528.

To collect error information in a support file

1. Connect a USB device to the R&S AREG800A.

2. Select "System Config > Setup > Maintenance > Create R&S Support Information".

3. In the "Create R&S Support Information" dialog, navigate to the /usb directory.
Enter the support filename, for example RSSupport_DeviceInfo.

Collecting information for technical support
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The error information and further required data are collected automatically.
The support file RSSupport_DeviceInfo.tar.gz is created and stored in the /
usb directory.
Collect the error information and attach it to an email in which you describe the
problem. Send the email to the customer support address as listed on the Internet
(www.rohde-schwarz.com/support).

To remove sensitive data

► For information on how to handle or remove the sensitive data from your instru-
ment, refer to the description "R&S AREG800A Instrument Security Procedures".

To pack and transport the instrument

► If you need to transport or ship the instrument, see Chapter 14, "Transporting",
on page 542.

13.10  Contacting customer support

Technical support – where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this
QR code:

Contacting customer support

https://www.rohde-schwarz.com/support
https://www.rohde-schwarz.com/support
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Figure 13-1: QR code to the Rohde & Schwarz support page

Contacting customer support
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14  Transporting
Lifting and carrying

See:
● "Lifting and carrying the product" on page 14
● Chapter 3.1.1, "Lifting and carrying", on page 21

Packing

Use the original packaging material. It consists of antistatic wrap for electrostatic pro-
tection and packing material designed for the product.

If you do not have the original packaging, use similar materials that provide the same
level of protection. You can also contact your local Rohde & Schwarz service center for
advice.

Securing

When moving the R&S AREG800A in a vehicle or using transporting equipment, make
sure that the R&S AREG800A is properly secured. Only use items intended for secur-
ing objects.

Transport altitude

The maximum transport altitude without pressure compensation is specified in the data
sheet.
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15  Maintenance, storage and disposal
The product does not require regular maintenance. It only requires occasional clean-
ing. It is however advisable to check the nominal data from time to time.

15.1  Cleaning

How to clean the product is described in "Cleaning the product" on page 15.

Do not use any liquids for cleaning. Cleaning agents, solvents, acids and bases can
damage the front panel labeling, plastic parts and display.

15.2  Storage

Protect the product against dust. Ensure that the environmental conditions, e.g. tem-
perature range and climatic load, meet the values specified in the data sheet.

15.3  Performing maintenance tasks

The R&S AREG800A is accurate due to integrated adjustment procedures and addi-
tional test functions that assure correct functioning.

Internal adjustments are integrated self-calibration routines, which you can execute
directly on the instrument.

How to: See Chapter 15.3.1.3, "How to use the internal adjustments", on page 546.

Self-calibration routines that require additional equipment are performed at an author-
ized Rohde & Schwarz service center. For description, see the R&S AREG800A ser-
vice manual.

15.3.1  Internal adjustments

Using the integrated adjustment procedures, you can start the calibration directly on
the instrument.

Performing maintenance tasks



Maintenance, storage and disposalR&S®AREG800A

544User Manual 1179.3615.02 ─ 06

15.3.1.1  Internal adjustment settings

Access:

► Select "System Config > Setup > General > Internal Adjustments".

In this dialog, you can perform internal calibration routines, and get information on
the last performed calibration.
The "Temperature Offset" indicates the deviation of the current temperature of the
instrument, compared to the temperature of the last adjustment.

How to: See Chapter 15.3.1.3, "How to use the internal adjustments", on page 546.

Settings

Adjust All
Executes all available internal calibration routines of the instrument.
Note: Before you start the internal adjustment, make sure that you have connected a
termination resistor, if necessary.
Remote command: 
:CALibration:ALL[:MEASure]? on page 359

Last Full Adjustment
Displays the date of the last fully performed adjustment.
Remote command: 
:CALibration<hw>:ALL:DATE? on page 359

Time
Displays the elapsed time since the last full adjustment.
Remote command: 
:CALibration<hw>:ALL:TIME? on page 360

Temperature Offset
Displays the temperature difference, comparing the temperature of the last adjustment
to the current instrument temperature.
A green checkmark indícates that the offset is within the permitted range. If the temper-
ature deviates more than ±5 K, the instrument indicates a warning icon.
Remote command: 
:CALibration<hw>:ALL:TEMP? on page 360

Information
Displays information to the current adjustment state.
Remote command: 
:CALibration<hw>:ALL:INFormation? on page 360

Performing maintenance tasks
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Continue Adjustment on Error
Continues the calibration even though an error was detected. By default adjustments
are aborted on error.
This function is password-protected. Unlock the protection level 1 to access it.
Remote command: 
:CALibration<hw>:CONTinueonerror on page 361

15.3.1.2  Delayed adjustment settings

Access:

► Select "System Config > Setup > General > Delayed Adjustment".

In this dialog, you can set the internal adjustments to start automatically after the
selected warm up time and to switch off the instrument after calibration.

The remote commands required to define these settings are described in Chapter 12.4,
"CALibration subsystem", on page 359.

Settings

Adjust All Delayed....................................................................................................... 545
Warm Up Time............................................................................................................ 545
Shutdown After Adjustment.........................................................................................546

Adjust All Delayed
Performs all available internal calibration routines of the instrument.
How to: See Starting internal adjustments automatically.
Remote command: 
:CALibration:DELay[:MEASure]? on page 362

Warm Up Time
Sets the time for warming up the instrument before the calibration starts automatically.
How to: See Starting internal adjustments automatically.
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Remote command: 
:CALibration:DELay:MINutes on page 361

Shutdown After Adjustment
Enables the automatic shutdown after internal adjustments.
How to: See Starting internal adjustments automatically.
Remote command: 
:CALibration:DELay:SHUTdown[:STATe] on page 362

15.3.1.3  How to use the internal adjustments

Deciding whether to run internal adjustments

1. Select "System Config > Setup > Internal Adjustment".

2. Check the status and color indication in the section "Since Last Full Adjustment".

Green: internal adjustments are not required.
Red: internal adjustments are required. Observe also the indication in the "Informa-
tion" field.

3. We recommend that you run internal adjustments in the following cases:
● Before starting any application that requires a maximum of level accuracy.
● When a long period of time has passed since the last adjustments.
● If the ambient temperature of the instrument significantly differs from the one of

the last adjustments.

4. Proceed as described in "Running internal adjustments" on page 546.

Running internal adjustments

1. After switching on, the R&S AREG800A requires up to 30 minutes to warm up.
Wait until the instrument has reached operating temperature to achieve accurate
adjustments.

2. NOTICE! High power at the frontend waveguide can destroy connected equipment.
Disconnect the equipment.

3. Select "System Config > Setup > Internal Adjustment > Adjust All".

4. Confirm with "Ok".

The adjustment process starts.

The adjustment process takes some time depending on the equipment of the
instrument.
If any error occurs, the process aborts. To resolve adjustment issues, see Chap-
ter 13.6, "Resolving errors during internal adjustments", on page 534.

Performing maintenance tasks
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Starting internal adjustments automatically

The delayed adjustment function executes the adjustments automatically. You can set
the warm-up time and shut down after the adjustment process finishes. Using this func-
tion, you can execute adjustments without being on-site and start measurements
directly when back.

1. If necessary, terminate the RF output. See "Running internal adjustments"
on page 546.

2. Select "System Config > Setup > General > Internal Adjustment".

3. Select "Delayed Adjustment".

4. Set the "Warm Up Time", e.g. 40 min.

The R&S AREG800A requires a warm-up time of at least 30 min.

5. Enable "Shut Down After Adjustment"

6. Select "Adjust All Delayed".

The process starts with warming up the instrument, indicating the progress in a sta-
tus dialog. In this dialog, you can abort the process again, if necessary.
After warming up, the R&S AREG800A executes the internal adjustments and
shuts down when finished.

15.3.2  Date and time

The R&S AREG800A uses an internal real-time clock to determine the date and time. It
adjusts the time and date to the timezone of your location automatically, by providing a
selection list of continents and cities.

The instrument records the time whenever you create or modify files on your instru-
ment or you use timed licenses. By default, the instrument is set to the UTC timezone,
but you can select the timezone according to your location.

Moreover, the instrument supports NTP protocol for synchronizing all connected instru-
ments and computer systems to minimize time delays in the network.

Performing maintenance tasks
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15.3.2.1  Date and time settings

Access:

► Select "System Config > Setup > Maintenance > Date / Time".

The "Date / Time" dialog contains the time and data settings of the operating sys-
tem.
This function is password-protected. Unlock the protection level 1 to access it.
You can also set the time zone for your location, and select a time protocol control-
led by a time server for synchronization.

The required remote commands are described in Chapter 12.12, "SYSTem subsys-
tem", on page 395.

Settings:

Date.............................................................................................................................548
Time............................................................................................................................ 548
Timezone.....................................................................................................................549
Time Protocol.............................................................................................................. 549
NTP Address...............................................................................................................549

Date
Displays the date set in the operating system in the format [yyyy.mm.dd].
Remote command: 
:SYSTem:DATE on page 421

Time
Displays the time set in the operating system in the format [hh.mm.ss].
The time setting corresponds to the selected Timezone.
Remote command: 
:SYSTem:TIME on page 421

Performing maintenance tasks
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Timezone
Selects the timezone in the date and time settings of the operating system.
You can select the timezone according to the major cities on the respective continents.
Tip: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.
Remote command: 
:SYSTem:TIME:ZONE on page 422
:SYSTem:TIME:ZONE:CATalog? on page 422

Time Protocol
Enables the instrument to refer to a network time protocol.
A network time protocol synchronizes the system clocks of all participating devices in a
computer network (Ethernet). A time server in the network provides the time base for
the connected devices that refer to this time to synchronize events.
You can select a high-precision time protocol to achieve high clock accuracy and thus
reduce the impact of varying network delays.
"None" Refers to the selected timezone, see Timezone.
"NTP" Uses the network time protocol (NTP).
"gPTP" Uses the generic precision time protocol (gPTP), that complies with

IEEE 802.1AS.
This protocol provides high synchronization accuracy.
If you use an Ethernet switch in your test setup, the switch has to be
IEEE 802.1AS compliant.

Remote command: 
:SYSTem:TIME:PROTocol on page 422

NTP Address
Sets the IP address or host name of the NTP server.
When the server is detected and verified, the instrument enables the connection auto-
matically.
Remote command: 
:SYSTem:NTP:HOSTname on page 421
:SYSTem:NTP:STATe on page 421

15.3.2.2  How to set date and time

To select the timezone

1. Press the [Setup] key.

2. Select "Maintenance > Date /Time > Timezone".

3. Select continent and city of your location.
Tip: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.

Performing maintenance tasks
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4. Close the dialogs.

The instrument adjusts the time according to the selected location.

To set the date and time

1. NOTICE!
This function is password-protected. Unlock the protection level 1 to access it.
Since the date and time settings affect time-based options, changing the date and
time can therefore lead to loss of access to the function of the options. We recom-
mend that you only change the system time in urgent cases.
If the time is not displayed correctly, the internal CMOS battery can be discharged.
To change the battery, contact your Rohde & Schwarz support center at
www.rohde-schwarz.com/support.
Press the [Setup] key.

2. Select "Security > Protection".

3. Enable the "Protection Level 1".
The default password is 123456.

4. Select "Setup > Maintenance > Date / Time".

5. Adjust the settings.

6. Close the dialogs.

The instrument sets the new date and time.

15.3.3  Check front panel

Within this dialog, you can verify the functionality of the control keys.

How To: See Chapter 15.3.3.2, "How to test the front panel", on page 550

15.3.3.1  Check front panel settings

Access:

► Select "System Config > Setup > Maintenance > Check Front Panel".

Reflecting the front panel, the "Check Front Panel" dialog contains all functions to
test the operating elements of the instrument.

15.3.3.2  How to test the front panel

See:
● "Testing the key panel" on page 551
● "Testing the touchscreen" on page 551
● "Terminating the test" on page 552

Performing maintenance tasks
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● "Debugging" on page 552

Testing the key panel

To perform the key panel test, you operate the keys at the front panel, and check the
response of the instrument in the "Check Front Panel" dialog. To perform this test prop-
erly, check each key of the front panel. The test is only completed, when you have veri-
fied all keys.

During the test, the actual functions of the keys are disabled.

1. Press the [Setup] key.

2. Select "Maintenance > Check Front Panel"
The "Check Front Panel" dialog opens.

3. Press a key on the front panel.
Check if the corresponding key in the "Check Front Panel" dialog turns green.

4. Press the same key a second time.
Check that the key in the dialog turns red.
Note: Pressing the same key again has no further effect, except for the [Esc] key.
Pressing this key a third time, terminates the test procedure.

5. Continue with the next key on the front panel and repeat step 3 to  step 5 until all
keys are tested.

The test is completed, when each key is verified successfully, confirmed by a "Test
passed" message.

Testing the touchscreen

1. Press the [Setup] key.

2. Drag with your finger one or more lines, for example diagonally across the screen.
The test traces the movements of your finger on the screen.

The following results are expected:
● If the lines are uninterrupted, the touchscreen works properly.

● If there are any gaps, the touch-sensitive functionality is damaged.

Performing maintenance tasks
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● To return to the "Check Front Panel" dialog, press [Esc].

Terminating the test

► Press the [Esc] key.

Exits the "Check Front Panel" dialog.

Debugging

► If you detect a malfunction, for example, when you press the front panel key for the
first time, and the color of the button in the dialog turns red (instead of green), the
front panel key has probably stuck.

15.3.4  Check display screen

Using this function, you can verify the color depth and gradient, pixels and the text dis-
play of the screen.

Access:

► Select "System Config > Setup > Maintenance > Check Display Screen".

The R&S AREG800A fades out the current display and indicates the screen in red.
Short instructions on the screen explain how to execute the test.

The remote commands required to define these settings are described in Chap-
ter 12.15, "TEST subsystem", on page 430.

Testing the display screen

1. Press the [Setup] key.

2. Select "Maintenance > Check Display Screen"
The "Check Display Screen" window opens.

3. Test the color and gradient of the display screen:
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a) Use the [Help] key to hide the indicated text.
b) To toggle between the provided colors manually, use the navigation controls

[Left/Right] or the rotary knob.
The R&S AREG800A provides the colors red, green, blue, white, three levels of
gray shades and black.

c) To switch between the screen colors automatically, use the [Up] key.
d) To toggle the gradient, use the [Down] key.

4. Check if the R&S AREG800A indicates the text correctly:

a) Press [1] on the numeric keypad.
The R&S AREG800A displays a test text over the entire screen.

b) To inspect the text in detail, you can use the rotary knob to zoom it out.

5. To exit the test, press the [Esc] key.

15.3.5  FPGA/uC update settings

Access:

► Select "System Config > Setup > Maintenance > FPGA/µC Update".
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This dialog enables you to check for internal assembly updates and perform
updates.

Settings:

Check For Updates..................................................................................................... 554
Assembly.....................................................................................................................554
Install...........................................................................................................................554
Shut down................................................................................................................... 554

Check For Updates
Check for updates of the FPGA/µC.
Remote command: 
n.a.

Assembly
The table shows the installed assemblies and their states.
"Assembly" Assembly designation.
"State" Indicates the current state of installed assemblies.

Install
Install all available updates for the FPGA/µC.
Remote command: 
n.a.

Shut down
For at least one assembly "State = Done" and no pending assemblies, shuts the instru-
ment down to applies installed updates.

Performing maintenance tasks
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Remote command: 
:SYSTem:SHUTdown on page 424

15.4  Disposal

Rohde & Schwarz is committed to making careful, ecologically sound use of natural
resources and minimizing the environmental footprint of our products. Help us by dis-
posing of waste in a way that causes minimum environmental impact.

Disposing of electrical and electronic equipment

A product that is labeled as follows cannot be disposed of in normal household waste
after it has come to the end of its life. Even disposal via the municipal collection points
for waste electrical and electronic equipment is not permitted.

Figure 15-1: Labeling in line with EU directive WEEE

Rohde & Schwarz has developed a disposal concept for the eco-friendly disposal or
recycling of waste material. As a manufacturer, Rohde & Schwarz completely fulfills its
obligation to take back and dispose of electrical and electronic waste. Contact your
local service representative to dispose of the product.

Disposal
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Annex
A  Extensions for user files

The Table A-1 lists all available file extensions for user files. The currently available
files on the instrument depend on the installed options.
Table A-1: List of the automatically assigned file extensions in the instrument

Function List type Contents File suffix

Instrument State Settings Instrument settings *.savrcltxt

User Menu Settings User-defined favorite settings *.user_menu

License Key  License Key *.xml

"NRP Settings" Settings R&S NRP Settings *.nrp, *.rsu

SCPI command list List Export file containing list of SCPIs *.iec

SCPI command
script

 SCPI script file formats: Plain SCPI, MATLAB,
NICVI, Python3

*.txt, *.m,
*.c, *.py

R&S Support Info
Archive

Support File Automatically collected support information *.tar.gz

Tutorials Tutorial files Lists containing SCPIs and explanations *.tut
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B  Unit shortcuts
When specifying units or quantities during data entry, the R&S AREG800A provides
the following shortcuts for simplified input.

Shortcut Designation Context Unit

a, A ampere Current A

 atto- Area, surface am2

c, C centi- Distance, length cm

d, D deci- Distance, length dm

  Level, power dB, dBFS, dBm, dBU, dBW

 degree Phase, polar/spherical coordinates deg

e, E exa- Area, surface em2

f, F femto- Area, surface fm2

g, G giga- Area, surface Gm2

  Data rate, sample rate, symbol rate Gbit/s, Gsample/s, Gsymbol/s, Gchip/s

  Frequency GHz

  Impedance, resistance GΩ

h, H hertz Frequency Hz

k, K kilo- Area, surface km2

  Data rate, sample rate, symbol rate kbit/s, ksample/s, ksymbol/s, kchip/s

  Distance, length km

  Frequency kHz

  Impedance, resistance kΩ

  Velocity km/h

m, M milli- Area, surface mm2

  Current mA

  Distance, length mm

  Electromagnetic force, level mV

  Power mW

  Time, period, etc. ms

 mega- Area, surface Mm2

  Data rate, sample rate, symbol rate Mbit/s, Msample/s, Msym/s, Mchip/s

  Frequency MHz

  Impedance, resistance MΩ
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Shortcut Designation Context Unit

n, N nano- Area, surface nm2

  Current nA

  Distance, length nm

  Electromagnetic force, level nV

  Power nW

  Time, period, etc. ns

o, O ohm Impedance, resistance Ω

p, P peta- Area, surface pm2

 percent Level, ratio %

 pico- Area, surface pm2

  Current pA

  Electromagnetic force, level pV

  Power pW

  Time, period, etc. ps

r, R radiant Phase, polar/spherical coordinates rad

s, S second Time, period, etc. s

t, T terra- Area, surface Tm2

  Data rate, sample rate, symbol rate Tbit/s, Tsample/s, Tsym/s, Tchip/s

  Frequency THz

  Impedance, resistance TΩ

u, U micro- Current µA

  Distance, length µm

  Electromagnetic force, level µV

  Power µW

  Time, period, etc. µs

v, V volt Level, voltage V

w, W watt Level, power W



Hardware interfacesR&S®AREG800A

559User Manual 1179.3615.02 ─ 06

C  Hardware interfaces
This section covers hardware-related topics, like pin assignment of the IEC 625/IEEE
488 interface.

The remote control interfaces are described in details in Chapter 11, "Network opera-
tion and remote control", on page 268.

For more information, see data sheet.

C.1  GPIB-Bus interface

Pin assignment

Figure C-1: Pin assignment of GPIB-bus (IEEE 488) interface

Bus lines

● Data bus with 8 lines D0 to D7:
The transmission is bit-parallel and byte-serial in the ASCII/ISO code. D0 is the
least significant bit, D7 the most significant bit.

● Control bus with five lines:
IFC (Interface Clear): active LOW resets the interfaces of the instruments connec-
ted to the default setting.
ATN (Attention): active LOW signals the transmission of interface messages, inac-
tive HIGH signals the transmission of device messages.
SRQ (Service Request): active LOW enables the connected device to send a ser-
vice request to the controller.
REN (Remote Enable): active LOW permits switchover to remote control.

GPIB-Bus interface
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EOI (End or Identify): has two functions in connection with ATN:
– ATN=HIGH active LOW marks the end of data transmission.
– ATN=LOW active LOW triggers a parallel poll.

● Handshake bus with three lines:
DAV (Data Valid): active LOW signals a valid data byte on the data bus.
NRFD (Not Ready For Data): active LOW signals that one of the connected devi-
ces is not ready for data transfer.
NDAC (Not Data Accepted): active LOW signals that the instrument connected is
accepting the data on the data bus.

Interface functions

Instruments which can be controlled via GPIB-bus interface can be equipped with dif-
ferent interface functions. Table C-1 lists the interface functions for the
R&S AREG800A.

Table C-1: GPIB-bus interface functions

Control character Interface function

SH1 Handshake source function (source handshake), full capability

AH1 Handshake sink function (acceptor handshake), full capability

L4 Listener function, full capability, de-addressed by MTA.

T6 Talker function, full capability, ability to respond to serial poll, deaddressed
by MLA

SR1 Service request function (Service Request), full capability

PP1 Parallel poll function, full capability

RL1 Remote/Local switch over function, full capability

DC1 Reset function (Device Clear), full capability

DT1 Trigger function (Device Trigger), full capability

GPIB-Bus interface
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Glossary: Terms and abbreviations
A

Avahi: A licensed Zeroconf networking feature, including DNS service. The feature
enables a device to self-configure an IP address and subnet mask automatically, when
a DHCP server in the LAN is not available.

B
Base unit: This term describes a R&S AREG800A equipped with option R&S AREG8-
B9.

C
Clock: A mandatory internal or an external reference clock signal for generating the
timing pulse in the instrument.

Complete file path: The complete file path specifies the root directory and all subdir-
ectories that contain a file or folder.
Synonyms to this expression are "full file path" and "absolute file path".
See also Chapter 12.11.2, "Accessing files in the default or in a specified directory",
on page 386.

Computer name: Hostname

D
DHCP: Dynamic host configuration protocol

DNS: Domain name system server

E
e.g.: For example

External mass memory: External memory, connected to the instrument via USB con-
nector (Type A female). It can hold stored files with user data.
See also System drive and SD card

F
File transfer: The transmission of files from or to the instrument by a remote client.
The instrument supports the standard methods FTP and file sharing according to
SAMBA/SMB.

FTP: File transfer protocol

G
GUI: Graphical user interface
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H
HDD: Hard disk drive, see System drive

Hostname: An unambiguous indication of the instrument in a LAN that uses a DNS
server.
The default hostname follows the syntax AREG800A-<serial number>, e.g.
AREG800A-102030.
See Serial number.
Synonym: Computer name

HUMS: Health and utilization monitoring system.

I
i.e.: That is

L
LSB: Least significant bit

M
MSB: Most significant bit

N
NTP: A networking protocol for highly accurate clock synchronization between com-
puter systems and instruments in local area networks, or over the public internet.

P
PC: Personal computer

Power: A term describing the signal level of the RF signal

R
Remote access: Remote operation

Remote control: The operation of the R&S AREG800A by remote control commands
or programs to perform automated tests.
The instrument is connected to a system controller via LAN/VXI-11, GPIB or USB using
VISA. The instrument is controlled directly or supported by instrument drivers.

Remote device: External device controls the R&S AREG800A in remote operation
mode, see Remote operation.
Synonyms: External controller, client device

Remote operation: Allows you to operate the R&S AREG800A from a remote device
via VNC.
Both the R&S AREG800A and the remote device are connected in a LAN.
Synonym: Remote access
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Removable memory: General term describing mass memory that can be unmounted
from the instrument.
See also SD card

RF: Radio frequency

RUT: Radar under test

S
SAMBA/SMB: Server message protocol

SD card: Secure digital card is a type of removable memory storage, that can hold
files with user data.
Throughout this description, the SD card is referred as a removable memory.
See also System drive.

Serial number: Unique instrument identification, provided on the rear panel of the
instrument and required to build the Computer name.
The serial number are the last 6 digits in the string <stock no.>-<serial
number>, e.g. AREG800A-102030

System drive: The system drive is a built-in internal memory that holds the operating
system, the firmware, and the stored user data.
Throughout this description, the system drive is referred as an internal memory.
See also SD card and Removable memory

U
User directory: Describes the default file storage location for user data.
Depending on the installed options, the user directory is physically located on the Sys-
tem drive or on the Removable memory
In the file system, user directory is always indicated as /var/user

V
VISA: Virtual instrument software architecture

Z
Zeroconf: Zero-configuration, see Avahi.
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List of commands
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:CALibration:DATA:EXPort.............................................................................................................................361
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:DISPlay:ANNotation:FREQuency.................................................................................................................375
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:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe......................................................................................384
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe........................................................................................ 383
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:HCOPy:IMAGe:FORMat...............................................................................................................................380
:HCOPy:REGion............................................................................................................................................ 381
:HCOPy[:EXECute]........................................................................................................................................381
:INITiate<hw>[:POWer]:CONTinuous............................................................................................................ 514
:KBOard:LAYout.............................................................................................................................................384
:MEMory:HFRee?.......................................................................................................................................... 394
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:MMEMory:CATalog?..................................................................................................................................... 389
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:MMEMory:DATA........................................................................................................................................... 391
:MMEMory:DCATalog:LENGth?.....................................................................................................................392
:MMEMory:DCATalog?...................................................................................................................................391
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:MMEMory:MSIS............................................................................................................................................393
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:OUTPut:USER<ch>:SIGNal......................................................................................................................... 433
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:SENSe<ch>[:POWer]:APERture:DEFault:STATe......................................................................................... 516
:SENSe<ch>[:POWer]:APERture:TIMe......................................................................................................... 516
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?...................................................................................517
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect.................................................................................516
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:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority................................................................................... 517
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[:SOURce<hw>]:AREGenerator:MARKer:OBJect:ONTime...........................................................................501
[:SOURce<hw>]:AREGenerator:MARKer:OBJect:SOURce..........................................................................502
[:SOURce<hw>]:AREGenerator:MEASurement:KEEPsettings.....................................................................456
[:SOURce<hw>]:AREGenerator:OBJect:ALL[:STATe]...................................................................................438
[:SOURce<hw>]:AREGenerator:OBJect<ch>:ANGLe:HORizontal............................................................... 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>:ATTenuation...........................................................................439
[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler:FREQuency............................................................441
[:SOURce<hw>]:AREGenerator:OBJect<ch>:DOPPler[:SPEed].................................................................. 440
[:SOURce<hw>]:AREGenerator:OBJect<ch>:RANGe.................................................................................. 442
[:SOURce<hw>]:AREGenerator:OBJect<ch>:RCS.......................................................................................442
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:STATe].................................................................................. 438
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ANGLe:HORizontal.................................439
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:ATTenuation............................................439
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler:FREQuency.............................441
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:DOPPler[:SPEed]................................... 440
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RANGe................................................... 442
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>]:RCS........................................................ 443
[:SOURce<hw>]:AREGenerator:OBJect<ch>[:SUBChannel<st>][:STATe]................................................... 438
[:SOURce<hw>]:AREGenerator:OBJects:INValid:CATalog?......................................................................... 444
[:SOURce<hw>]:AREGenerator:OBJects:INValid?....................................................................................... 443
[:SOURce<hw>]:AREGenerator:OBJects:VALid........................................................................................... 443
[:SOURce<hw>]:AREGenerator:OBJects:VALid:CATalog?........................................................................... 443
[:SOURce<hw>]:AREGenerator:OMONitoring:HOSTname.......................................................................... 444
[:SOURce<hw>]:AREGenerator:OMONitoring:PORT................................................................................... 444
[:SOURce<hw>]:AREGenerator:OMONitoring[:STATe]................................................................................. 444
[:SOURce<hw>]:AREGenerator:OSETup:APPLy..........................................................................................496
[:SOURce<hw>]:AREGenerator:OSETup:BW...............................................................................................497
[:SOURce<hw>]:AREGenerator:OSETup:BW:APPLy................................................................................... 497
[:SOURce<hw>]:AREGenerator:OSETup:HIL:UPD...................................................................................... 501
[:SOURce<hw>]:AREGenerator:OSETup:HOSTname..................................................................................499
[:SOURce<hw>]:AREGenerator:OSETup:IPADdress....................................................................................499
[:SOURce<hw>]:AREGenerator:OSETup:MODE..........................................................................................496
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:CONNect......................................................... 502
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:MODE..............................................................503
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary:ADD..............................................503
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:CONNection[:STATe]?...........503
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:HOSTname........................... 504
[:SOURce<hw>]:AREGenerator:OSETup:MULTiinstrument:SECondary<st>:REMove................................ 504
[:SOURce<hw>]:AREGenerator:OSETup:PORT...........................................................................................500
[:SOURce<hw>]:AREGenerator:OSETup:PROTocol.................................................................................... 500
[:SOURce<hw>]:AREGenerator:OSETup:REFerence.................................................................................. 497
[:SOURce<hw>]:AREGenerator:OSETup:SOURce...................................................................................... 498
[:SOURce<hw>]:AREGenerator:OSETup:SWUNit[:STATe]...........................................................................496
[:SOURce<hw>]:AREGenerator:OSETup:TBASe......................................................................................... 498
[:SOURce<hw>]:AREGenerator:RADar:LSENsitivity.................................................................................... 484
[:SOURce<hw>]:AREGenerator:RADar:POWer:INDicator?..........................................................................458
[:SOURce<hw>]:AREGenerator:SCENario:FILE...........................................................................................448
[:SOURce<hw>]:AREGenerator:SCENario:FILE:CATalog............................................................................ 448



List of commandsR&S®AREG800A

572User Manual 1179.3615.02 ─ 06

[:SOURce<hw>]:AREGenerator:SCENario:PAUSe.......................................................................................448
[:SOURce<hw>]:AREGenerator:SCENario:POSition:ACTual....................................................................... 448
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STARt.........................................................................448
[:SOURce<hw>]:AREGenerator:SCENario:POSition:STOP......................................................................... 449
[:SOURce<hw>]:AREGenerator:SCENario:PROGress.................................................................................449
[:SOURce<hw>]:AREGenerator:SCENario:REPLay[:MODE]....................................................................... 449
[:SOURce<hw>]:AREGenerator:SCENario:RESet........................................................................................450
[:SOURce<hw>]:AREGenerator:SCENario:STARt........................................................................................450
[:SOURce<hw>]:AREGenerator:SCENario:STATus......................................................................................450
[:SOURce<hw>]:AREGenerator:SCENario:STOP.........................................................................................450
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ADD......................................................................................490
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ALIas.................................................................................... 491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ANGLe..................................................................................491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:BW........................................................................................491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:CENTer.................................................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:CFACtor................................................................................491
[:SOURce<hw>]:AREGenerator:SENSor<ch>:COUNt?................................................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:DISTance..............................................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:DYNamic:ID..........................................................................492
[:SOURce<hw>]:AREGenerator:SENSor<ch>:ID..........................................................................................493
[:SOURce<hw>]:AREGenerator:SENSor<ch>:RMV..................................................................................... 493
[:SOURce<hw>]:AREGenerator:SWUNit:CABLecorr:CONNector<di>:RX|TX:MODE.................................. 476
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